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Razor is a flexible, integrated and feature-rich configuration management
system providing process management, issue/problem tracking, version
control, and release management. Workflow, templates, rules, and controls
can be customized to match your process.


Process and Workflow Management: The standard process included in
Razor can be customized as required; controls for security and use access;
signature chains; detailed audit history; notifications via e-mail by event or
process condition; Razor supports team collaboration.


Issue/Problem Tracking: Issues can be linked to users, user groups, file
operations, or releases; approved task lists ensure that developers are
focused on solutions and results. In addition, with the purchase of Issue
Weaver you can capture the power of Razor's Issues client and bring it to
your web browser.


Version Control & Change Management: Tracks the who, what, when, and
why of changes; process rules which can be linked to ensure quality and
seamless change management.


Release Management: Release conditions are easy to set up; release
definitions are archived and can be reconstructed in the future; process
rules can be linked to release conditions to enforce required control.


The Razor tools may be used collectively as a tool suite or independently.
The tools share a common database. The database is composed of one or
more issues groups, one or more file-control groups, and a project group.
File and thread groups are linked, with a single project group existing for all
file/thread pairs in the database. Issues can be related to version control
and thread activity, or can be used in a standalone fashion. 


In almost no time, Razor  will streamline your development and issue
tracking functions to fully comply with the needs of your organization. 
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1 Razor introduction


Welcome to Razor!


The integrated problem tracking and configuration management tool.  Razor is a
registered trademark of Visible Systems.


We appreciate your taking the time to read our documentation. All too often, people in
our industry dive right into a product and try to figure things out as they go along. We're
pleased that Razor is straightforward enough that most people are able to pull it off, but
there's still something to be said for curling up with a good manual.


What's in this manual


The Razor manual is organized to lead you through a discovery process. If you read the
manual in order, you will be led from acquiring the product distribution, through
installation, usage, and finally to customization of Razor to meet your specific
requirements. It is our hope that this organization will provide you with the most cost-
effective learning experience. The manual is heavily cross-referenced so that it remains
an excellent reference manual for even the most seasoned veteran. This document is
divided into the following sections:


• Overview of Razor ,  provides insights into Razor, including some introductory
thoughts on the general philosophy and approach used by the product.
• Installation Instructions  outlines installation and provides suggestions for
general administration of the tool set. It's intended for whomever will be installing the
product on your system.
•Razor trilogy includes:


Using Issues
Using Versions
Using Threads


These programs are discussed from the user's point of view, and do not get into
the mechanics behind how everything is configured or implemented.


• Command Line Functionality   outlines the command line functionality of Razor,
while Chapter 7 describes some special features, such as use of e-mail and
synchronized problem tracking databases.
• Customization and Personalization  provide the details for the customization
and personalization of the Razor tool suite to better meet the requirements of your
organization, including how to write your own shell scripts for working with the Razor
database. These sections are intended for the more advanced user or administrator
of the tool.
 Razor Directories  The layout of Razor directories  and the format of Razor files


. These are nice resources for understanding the underpinnings of the tool.
 X Resources  provides information regarding X Resources and Appendix D
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provides a quick overview of regular expressions.
 Razor PC Applications   provides information regarding installation and use of


Razor's PC Applications including the PC client and the RazorSCC interface to
popular Windows Integrated Development Environments. 
 Installation/use of the remote UNIX client , and  installation/use of the Windows


2003 Server/2000/XP server .
 Multiple NIC's and IP Addresses  provides information on using Razor in


conjunction with servers and clients that have multiple Network Interface Cards
(NIC's) and Internet Protocol (IP) addresses.
• Common Questions   Common questions get answered, environment
variables get spelled out.  
• Glossary of Terms    where you'll find common terminology defined.


The Razor documentation set


Razor comes with an extensive manual. It covers the full scope of the product, from
installation and general use through heavy customization of the product. There is also an
add-on product  for the web enablement for Razor issues called IssueWeaver®.  See
the IssueWeaver manual for more details.


And, of course, there's a variety of supplemental documentation which comes along with
the product. They'll be in the form of 'README' files, release notes, comments within
our scripts, and help screens accessible from the GUI.


Since Razor is highly customizable, we opted to keep specifics on how the product may
be configured for various work environments out of this text.


NOTE: The screen images shown in this manual are simply examples. UNIX screen dumps
were used, but the PC applications are remarkably similar. What you see at your site may be very
different from the screens shown here. Razor is a highly configurable tool. For more information on how
this is handled, see the "Customization & Personalization."


Other documents


It's often handy to have a well-stocked bookshelf to supplement the information
presented in this document. Depending on your level of interest and expertise, we've
found the following references to be particularly helpful.


UNIX in a Nutshell and UNIX Power Tools, both from O'Reilly & Associates
Multi-Platform Code Management and Managing Projects with Make, again from the


people at O'Reilly.
•FAQ from the Usenet Newsgroup comp.software-eng
•FAQ from comp.software.config-mgmt


The two newsgroups mentioned above are useful not only for the static information
provided as part of the FAQs, but also for the dynamic (and occasionally heated)
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discussions they contain regarding recommended practices and products for software
engineering.


Conventions - Typographic/stylistic


This manual uses a small collection of fonts and typefaces to denote different aspects of
what is being discussed. Specifically...


Italics are used for the first appearance of a word or phrase within the manual or simply
to bring emphasis to a point.


A courier monowidth typeface is used to show file/script/program names, the contents
of files on the system, or a sample terminal output from a script or program.


Bold monowidth is used to distinguish what the user must type when entering text at
the command line, or in response to script prompts.


Where appropriate, the hash character ('#') will appear when displaying entries made at
the command line. It is meant to represent a generic system prompt.


On a similar note, there are instances where a single line of monowidth font won't fit
nicely on a single line of the manual. On such occasions, the text will be presented as
two lines and the first will finish with the standard UNIX line continuation character, '\'.
References to menu items and buttons are worded as "choose the ABC option from the
XYZ menu" or "click the ABC button." Accelerator keys, if appropriate, are mentioned in
parenthesis.


In the hope of clarity, the typographic convention " " is used to denote the tab
character and " " is used to denote an empty input (namely, the enter key). 


This manual occasionally refers to the generic user as male (he, him, his, etc.). Please
do the mental substitution of 'he/she', or 'his/her' as appropriate.


Directory diagrams


As necessary in this manual, we provide a textual diagram to illustrate a directory structure. For
example...


                /-- adm  - - - - - - -> ../var/adm
                |-- install
                |
                |-- nserve ------------ auth.info
                |
                |-- openwin ----------- modules
/etc -----------+
                |-- ppp
                |-- sm
                |-- spool  - - - - - -> ../var/spool
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                |-- tmp  - - - - - - -> ../var/tmp
                |
                \-- uucp -------------- OLD


In such a diagram, only the names of directories are shown. The broken dashed lines
represent a symbolic link to the actual directory.


Getting help


Visible Systems has an extremely high commitment to providing timely and accurate
assistance. Product quality and customer satisfaction are our highest priorities. With
that in mind, we truly encourage you to establish an open dialog with our support team.


TIP: Before you call, make sure you check the manual for answers. This manual is heavily
cross referenced and indexed. Also, take a look at the "Common questions and answers." We have tried
to incorporate some of the more frequent requests into a series of questions and answers.


By email


Send all e-mail queries and comments to...


razor_support@visible.com


Please bear the following in mind as you send us messages...


•Provide a concise subject line (something better than "Razor problem").
•Identify yourself. When you were given license keys, you were also issued a customer
ID number. Please try to use that ID number in any correspondence with us. We have
installations all over the world, and are often installed at multiple sites for the same
company. The return address of your e-mail is not always sufficient to help us figure out
who you are. Also, please provide a phone number in case we need to call you.
•Provide as much detail as you can. Let us know the specifics of what you were doing
and what the related error messages were. If possible, cut and paste ALL the error
codes into the message itself along with your commentary.
•When appropriate, attach copies of the Info and History files from within the database
directory.


NOTE: Should an error occur while using one of the graphical interfaces, a pop-up display will
appear with all sorts of debugging information. One of the buttons on the display will send the full output
directly to our support address, making the reporting of difficulties much more effective and simple.


Support by phone or email


For simple questions, feel free to call Visible support at...


800-6-VISIBLE



mailto:razor_support@visible.com
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Feedback


We take every aspect of our product and our support system very seriously, and we rely
heavily upon the user community for feedback. Your comments are extremely important
to us. If we've completely missed the boat on some topic, or even if there's a tiny detail
we've overlooked, please let us know.


Email us at: Razor_Support@visible.com



mailto:Razor_Support@visible.com
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2 Overview of Razor


Overview of Razor
Razor is an integrated suite of tools which combines a tailorable issue tracking system with traditional
configuration management and build coordination capabilities. Through Razor, engineers, customer
support personnel, Configuration Managers (CM), Quality Assurance (QA) and managers are able to
organize and track their efforts with a single system.


The name ‘Razor’


The engineers involved with the writing of this package had only one driving force that helped them
decide on a name for the product; they were all sick and tired of acronyms. It seemed that the whole
industry had become overrun by them... SCCS, RCS, CMF, CVS, etc., etc. All of their meanings had
become clouded, and it became rough to speak of them in conversation without confusion.‘Razor’ has no
direct intended meaning. Although a variety of cute sayings and sales pitches could be made relating
the name to one theme or another, we have decided to avoid doing that. There’s too much of that in the
industry already. The name is just a name.Long after that issue had been settled, however, the editors at
SunExpert magazine found a link between ‘Razor’ and William of Occam that we found interesting.


Occam’s RazorThe following is quoted from The Academic American Encyclopedia, on-line edition,
Grolier Electronic Publishing, Danbury, CT., 1991, courtesy of Compuserve.Occam’s razor is a logical
principle attributed to William of Occam, although it was used by some scholastic philosophers prior to
him. The principle states that a person should not increase, beyond what is necessary, the number of
entities required to explain anything1, or that the person should not make more assumptions than the
minimum
needed. This principle is often called the principle of parsimony. Since the Middle Ages it has played an
important role in eliminating fictitious or unnecessary elements from explanations. In the development of
logic, logicians such as Bertrand Russel removed traditional metaphysical concepts by applying
Occam’s razor.


Product trilogy


There are three main elements to the Razor tool suite.


• Issues : a problem tracking system; provides a mechanism for organizing, coordinating, and
tracking various tasks or issues through a site-defined life cycle.


• Versions : a file version control system; used to archive and monitor the evolution of changes made
to files over the duration of a project. It is conceptually similar to SCCS or RCS. Razor requires RCS
version 5.7 or higher.


• Threads : a build management tool; through this tool, users are able to define and track large groups
of files as a single unit.


Although often seen as an "engineer's" tool, Razor's scope is easily extended to aid anyone within an
organization. Its highly configurable interface allows for easy integration into a wide variety of
environments. Its pieces can be used together or independently to suit varying needs.
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Product highlights include...


 Highly configurable graphical interface for easy insertion into existing processes.


 Command line interface allows for imbedding Razor actions into shell scripts.


 Ability to easily import existing SCCS and RCS investments into Razor.


 Uses either SCCS or RCS archival engines.


 Emphasizes e-mail interaction. Introduction of new issues, check-in/check-out of files, and database
queries can be accessed via 
e-mail, simplifying interaction with customers and offsite personnel.


 Extremely easy to use; users typically need only minutes of training.


 Built on a non-proprietary, easily parsed, ASCII database which greatly simplifies the generation of
site-specific query scripts.


 Attachment of user-defined actions both before and after tool events to implement process-specific
requirements.


 Network-based client/server applications.


 GUI-based report definition. Also, batch and interactive report execution.


 Interface to popular Microsoft Windows Integrated Development Environments, such as Microsoft
Visual Studio.


A view from the top


Understanding what Razor is, begins with what it is not. Razor is not a programming "environment." By
design, it does not concern itself with the type or purpose of the files being tracked. It does not have any
inherent abilities to do impact analysis, analyze code integrity, insure conformity to coding standards,
etc. You can, however, add a great deal of this functionality to Razor through judicious attachment of
scripts to its actions. In other words, Razor provides the means to make the tool behave in a way that
fits your needs, rather than dictating how you should do your work. 


Architecture


In its simplest form, the Razor architecture is made up of one license manager, one or more database
servers, and one or more client applications (issues, versions, threads, or Razor command line.) A client
application communicates with its server, the server in turn verifies the license with the license manager,
the server interacts with the database 
through an archive engine. 
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Razor records all actions against files in its database; what happened, who did it, when, and what the
stated reasons were at the time. All of this information can be queried through very simple means. There
are very few restrictions imposed on the users as the tool is generically installed. Razor's natural stance
is to allow the user to perform his job while holding him accountable for his actions. Since all information
is archived by the tool, there is no risk of losing data. 


The database is made up of one or more issues groups, (one or more file-control groups), and a project
group. File and thread groups are linked, with a single project group existing for all file/thread pairs in the
database. Issues can be related to both version and thread activity, or can stand alone.
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Razor and the network


Razor is a networked application. It makes the most of your present network investment and leverages it
to your advantage. Razor components can run on a single machine, multiple machines, and across
multiple platforms on your network. Below is a network topology where each box represents a user
running a Razor application.


Used as a tool suite


From its inception, Razor was intended to address the related concerns of problem tracking and file
version control.
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Consider that you are at a single, moving point in time. In front of you are tasks to be addressed and
resolved. Behind you are the things you have already accomplished. As your project moves along in
time, the issues in front of you (hopefully) become your history. Razor helps manage that flow of events
and maintains some logical continuity between the two.


In a typical engineering environment, the issues program would be configured to hold all the outstanding
tasks for the project team. All issues, no matter how significant or trivial, would be entered into the
system. In this way, all members of a team can have a single place to look to understand all the
outstanding points. This allows engineers, management, QA personnel, and testers to work in a
coordinated fashion.


The versions tool would be used to manage, control, and track changes to files in the project. Changes
to files, no matter how insignificant they might seem, would be associated to issues.


Finally, the threads tools ties things together by gathering specific file versions, as controlled by the
versions tool, and associated with project issues, tracked by the issues tool. Repeatability in project
build, test, and release are essential elements in solid engineering practices. Razor provides these
functions in a consistent and integrated fashion and is highly customizable to your requirements.


Used as independent pieces


Razor does not have to be used as described above. A great many sites have found the tool to be very
effective for just tracking problems. Others already have existing solutions for problem tracking, and use
Razor just for its file version control and build management capabilities.


There is nothing forcing you to use Razor's entire functionality, and the programs will work
independently. 


Razor's approach


The initial, "out-of-the-box" approach employed by Razor is straightforward and open. Razor is not
intended to be used "as-is" but the initial set up is intended to illustrate the possibilities.


The database


Razor maintains its information in memory via a database server and is flushed to ASCII files as updates
are made. These ASCII files are read by the database server only at startup time to load its data
structures. All of the files in the database are readable and easily parsed. This provides users with the
ability to augment the report and analysis capabilities provided by Razor to meet site-specific needs.
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Record everything


All operations which occur within Razor that modify files, issues, threads or their attributes are recorded
in History files. These History files specify who performed the operation, what the operation was, when
the operation occurred, the version of the object being modified, the associated commentary and the
directory the file was checked in from or checked out to. This information provides a complete audit trail
of the activities that have taken place on the database.


UNIX and more UNIX


Note: Even under Windows 2000, XP, Razor makes use of Posix-compliant UNIX-like features and
utilities.


Since the Razor database is maintained in ASCII files, it is easily parsed using standard UNIX utilities
such as awk, perl, grep, etc. Access to the database is also augmented by the use of standard UNIX
permissions. Permissions are controlled within Razor with the use of control files.


A day in the life
Perhaps the best way to understand what Razor is and how it will affect your process is by example.
The scenarios described here are for a company that offers a nice text editor that already has a couple
of major releases in the field. By reading through the following events you may better see how Razor
may help out in your environment.


Scenario 1


 The general reception to the recent release of the product has been favorable, but as always, there's
room for improvement. Managers, engineers, QA personnel and customers are providing a steady flow of
requests for extensions and improvements to the product. Each comment is entered into the issues
program which assigns a unique id number.


 The newly submitted issues are periodically reviewed by a lead engineer, who determines the relative
priority of each issue, as well as other related information such as estimated cost/effort, scope, etc. The
lead engineer may choose to directly assign each issue or leave it in an open job-jar format.


 As an engineer decides to address an issue, he will begin to check out various files from the version
control program (versions). As he obtains editable copies into his work area, he will note the reason for
obtaining the files through simple prose and by directly relating the issue to the action via a simple
mouse/clipboard maneuver. These notes will prove important later as his actions are reviewed.


 During the process, more files can be checked in and out of the version control system, each time
relating the actions to the reason (issue) for the change.


 Eventually, the engineer will need to incorporate his efforts into a product build based on related
issues. Through the threads program, he can define a test thread to consist of the files which went into
the last product release as well as incorporating his recent efforts. This ability isolates test concerns
from the ongoing development by other members of the team.


 After some number of iterations, the issue is brought to a close. The latest version of the engineer's
test thread can be compared with other threads generated by the rest of the team, files are checked in
for the final time, and the issue can be formally signed off. The project thread can then be updated
based on the completed issue.
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 Immediately prior to sending the next major release of the product to the field for beta test, a report
can be quickly generated which lists the issue numbers for those items closed out since the last major
release. These can be used to generate release notes, and serve as fuel for metrics analysis.


Scenario 2


This scenario illustrates how Razor can be used with e-mail to track and coordinate changes being
made.


 The system is configured to allow customers to e-mail in their concerns or problems. This e-mail
automatically creates a new issue, assigns it a unique id number and sends notification back to the
customer. E-mail is also forwarded to a project leader whose responsibility is to review the report and
assign it to a support engineer. This causes an attached script to run automatically, notifying the
assigned engineer via e-mail of the new assignment.


 When files need to be modified to solve a problem, the engineer selects the files to be changed and
checks them out for edit. A script is attached to the Check-out Apply button which prevents the engineer
from getting the files until at least one issue has been related to the operation and each of these related
issues have achieved the proper signature level. 


 When the changes have been made and tested, the files are selected for check-in. The Check-in dialog
shows the engineer the comments made during check-out and the issues that were related. Any
changes or updates to this information can be made at this time. A script is attached to the Check-in
Apply button which validates the format of the files being checked in and informs him of any problems
with the files.


 Each evening, a batch job runs to parse the database and provide reports which detail outstanding
issues, open tasks, files which have been out for edit over a long period, etc. These reports are routed
via e-mail to the appropriate individuals for resolution and a summary is sent to the management team.


 Meanwhile, a salesman is at an offsite sales meeting, and e-mail's in a request for the status of all
outstanding issues. The query is caught and handled by Razor and the report is automatically e-mailed
back.


Scenarios 3, 4, 5, 6...


A sampling of other things which Razor can be configured to do.


 One of the engineers is doing a special project for his masters program and sets up his own Razor
database with his own set of rules, attributes, and issues. 


 The marketing team sets up a database simply as a job jar in preparation for a big conference coming
up, never using the version control aspect of the tool at all.


 A special cooperative effort begins between your company and an affiliate on another continent. You
set up parallel issue tracking databases using the remote database synchronization capability of Razor
to coordinate efforts.


 Your product is out for field test and an engineer, sent to verify installation, identifies and fixes a bug.
Using the remote client and a modem, the appropriate file is checked out, fixed, and checked back in
again.


The main point is that Razor is generic enough to meet many needs. It can be used to manage
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software for a project developing millions of lines of code or control a database of customers or collect
favorite recipes. The Razor tool may be tailored by you to meet your specific needs.


2.1 Product basics


Using mouse buttons


Throughout our discussion in this manual, we'll refer to the mouse buttons by name, rather than
position. Not all mice are created equal. PC's for example typically only have two buttons and thus may not


support the Extend feature. This is primarily to accommodate people that may have configured their
system for left-handed operation.


The Select button is used most often. It activates buttons on the display and is used to select single
items on a scrolling list. Double clicking the Select button views an issue, browses a file/folder, or edits
a thread.


The Extend button can be used to select additional files and issues off the main scrolling list for the
respective programs.


The Menu button will occasionally bring up a special menu when depressed over some of our scrolling
lists. These hidden menus will perform functions unique to that scrolling list.
(See "Hidden menus" below)


Scrolling list behavior


The behavior of button selections within scrolling lists follows the following paradigm:
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Keyboard accelerators
Several keyboard accelerators have been defined for the main window of issues, versions and threads to
help improve user interaction. The accelerators are listed in the table below. In addition to those shown,
the <ESC> key can be used on most dialogs to dismiss (popdown) the dialog.


Ok, Apply, and Cancel buttons


The following rules apply to the selection of the Ok, Apply, and Cancel buttons.
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•The Ok button will perform the operation and dismiss the dialog.
•The Apply button will perform the operation and leave the dialog on the screen.
•The Cancel button will dismiss the dialog from the screen without performing any action.


Hidden menus


Additional or "hidden" menus may be found on some of the panels. For instance, selecting the Menu
button on the issue program's main scrolling list will display a popup menu. This new menu will provide
options to select all items, deselect all items or copy selected issues. Another such "hidden" menu is
available on the Check-out panel of versions. Selecting the Menu button in the issues list on the Check-
out form will provide options to select all items, deselect all items, delete selections or paste issues.







Part
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3 Installation/General Administration


This section deals with the mechanics of how to obtain, install, configure, and perform general
administration of the Razor product. It is meant for the more advanced user; somebody who is already
familiar with UNIX and simple system administration concerns.


NOTE: For installation and general instruction regarding the Razor 2003/2000/XP Server, refer to
"Installing Razor on Windows" in "2003/2000/XP Server".  For the Razor PC client application, refer to
"Razor PC Applications".  For the remote client, refer to "Remote UNIX Client Applications."


As a brief summary, the steps necessary to get Razor up and running are as follows...


•Prepare your Razor account


•Obtain a copy of the software


•Unload the release onto your system and install it


•Obtain and install license keys


•Create your first database


•Bring everything up


3.1 Overview


Three distinct directory structures come into play as a result of the installation and use of Razor...


1. ...where the Razor product release itself is installed. This is often a "public" area on a server, but it
can actually be pretty much anywhere, even under a single user's home directory. We refer to this
location as $RAZOR_HOME.


2. ...where information about the licensing of Razor resides. The most significant element of this area is
the Licenses file, which is used to control the number of concurrent invocations of Razor allowed. This
directory is pointed to by the environment variable $RAZOR_LICENSE_DIR.


3. ...and finally, where the database itself is stored. We refer to this area as the
$RAZOR_UNIVERSE_DIR. If your site has multiple databases, then you will have multiple
$RAZOR_UNIVERSE_DIRs. This also implies that you will be changing the value of
$RAZOR_UNIVERSE_DIR, most likely by sourcing multiple rz_prep files to access these databases.


The nature and shape of each of the above areas is described elsewhere in this manual. (See "Razor
Directory Layouts ".) What's important to understand at this point is that there are three separate
areas, and how they interact.


Razor was designed so that a great deal of the administrative work can be done without having
super user privileges. If you wish, you can have the product release, the license directory, and the
database directories set up in a single user's home directory BUT WE DON'T RECOMMEND THIS AS A
PERMANENT SOLUTION. This is sometimes done during the evaluation phase, as a new site
investigates whether Razor is an appropriate fit for their needs.
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A more typical situation requires that 3rd party products be formally installed by the system
administration department into a public area. The database directory (or directories) are then located in a
separate public area for use by the various teams and team members.


When we use the term "Razor Administrator" in this manual, we don't mean that someone is going to be
burdened with massive administrative tasks. We use that term to refer to the person or group that will
implement and maintain the controls required to enforce the site-specific Configuration Management
procedures that will be honored by Razor. So don't get scared if someone tapped you on the shoulder
and said you are the "Razor Administrator". Razor is designed to grow in capability and control as your
requirements demand.


3.2 System Requirements


Below are the normal system requirements necessary for installing and running the Razor software.


 Either SCCS or RCS (Razor requires RCS version 5.7 or higher.)database server must be available on
the machine which will run the Razor.


 If you opt to use RCS as the archival engine, it must be release 5.7 or better.


 You also need the proper version of X11...


-If you're on a Sun using SunOS 4.1.x, you need at least X11R4 (which is pretty much a given already)


-All other platforms need X11R5 or better.


 A bare minimum of 16Mb memory installed on each database server


 For X Terminals, we recommend having more than 4 Mb of RAM installed on the machine.


 To view reports, specifically HTML, pie/bar charts, Razor requires a Java-capable browser. We
recommend using 


Firefox for your browser. 


For Microsoft Internet Explorer, Razor requires at least Version 5.


Motif libraries for Linux systems


For Linux systems, the legacy open motif libraries are required.  Please check your operating systems
manuals for specific package details and installation instructions.


For Windows systems, hardware DEP (data execution prevention) must be turned off (AlwaysOff).


NOTE: We recommend that an RCS database format be used . It's offers a portable upgrade path
and is the only engine available on Windows and Linux.
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3.3 Before you get started


At this point, you have probably been tasked with evaluating Razor, or worse someone dumped a CD
ROM on your desk and said "here, install this!" Even if this doesn't describe your situation, we would like
to make the evaluation process quick and painless. To that end, we'd like to share some advice that will
save you time and aggravation down the road. Trust us, we've seen this happen all too often not to at
least tell you


A suggested organization


We recommend that before proceeding, you create a dedicated Razor administration account. This will
become the central location for all Razor distributions, license managers, databases, etc. While you can
install Razor pretty much anywhere, like under a directory in your home account - we strongly
recommend against it. We know what happens; you download the software, install it, play around with it
for a while "kicking the tires," making some modifications to see just how powerful Razor is. Unless you
are the system administrator, it is probably a hassle to get a separate account. Don't let your youthful
enthusiasm cost you time down the road. With each modification you make, you will feel less and less
like blowing it all away to reinstall/reconfigure the tool in a central location - the way it should have been
done in the beginning.


Here is a reasonable organization...


                        /-- Razor - - - - - > Razor_<version>
                        |-- Razor_<version> 
/home/razoradm ---------+-- Razor_lm      
                        |                                                         
                        |                   /-- database1      
                        \-- razor_db -------+-- database2      
                                            \-- database3 


Note that some of this structure is created for you during the installation; namely the Razor symbolic
link, Razor_lm, and Razor_<version> directories.


You can control access to software releases and the database files through permissions granted on this
razoradm account. When future releases of Razor are issued, you will be really glad you set up a
reasonable organization.


What you'll need to know


Here is some information you will need to know in order to install and create your first Razor database.


 The full path for the Razor release to be installed


 The full path for the Razor license directory. Keep the license directory separate from the Razor release to
avoid overwrites during product upgrades.


 The full path for the Razor database. We suggest this directory be kept separate (in parallel with) from
the Razor release.


 Which archival engine you will be using, Razor supports either SCCS or RCS. For a discussion of
SCCS and RCS refer to "Which archival engine should I pick? "380
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Via the World Wide Web


An extremely popular and effective route for obtaining Razor is via the World Wide Web, (or just 'the
web', for short). Simply connect to the web with your favorite web browser then go to our web site at "
http://www.razor.visible.com." From our main page, select the "Downloads" link and follow the
instructions on how to obtain a copy of Razor. We strongly urge you to download the README files as
they contain information relevant to the installation process. Don't forget a copy of the manual, available
in Postscript and HTML formats.


Via CDROM


Razor is also available for an nominal fee on a stylish CDROM. The CDROM contains binaries for all of
the supported platforms as well as documentation. Plus it makes a nice coaster after the installation.


Please refer to the documentation on CDROM for the installation of the software, then return to this
manual for all other aspects of administering and working with Razor. Review the README files for
current installation instructions.


3.4 Installing the software


Having obtained the software (via one of the previous steps) you are now ready to install it on your
network. Refer to "Installing Razor on Windows" for installation instructions for 2003/2000/XP Server.


SUGGESTION: Before you dive right in, be sure to read the RELEASE_NOTES for important
information. This file contains updates, corrections, suggestions, and/or product changes that are not
contained in the manuals.


General guidelines


If you are loading Razor onto your system for a simple evaluation of the product, you may install the
release right under your home directory. Everything will work just fine, and it (perhaps) postpones the
need to involve your local sys-admin department. We do ask you to consider our words of wisdom
previously mentioned in "Before you get started "


For the sake of our discussion and examples, we'll assume that you'll be putting the product under a
globally accessible area called /home/razoradm, and that this directory is writable by you. You will need
to make substitutions as necessary in the following instructions.


Un-tarring the release
Uncompress and un-tar the Razor.tar.Z file into the Razor directory.


# cd /home/razoradm
# zcat Razor.tar.Z | tar xf -


A directory listing at this point would show you that a new directory has been created and populated with
the full Razor release. The version number of the release will be imbedded in the directory name.
Running rz_install
The next step is to run the installation script (See "Sample installation" refer to " Installation and General
Administration ."  It will perform a variety of system checks and prepare the release for general use.)
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1. Invoke the rz_install shell script. You will need to substitute the full release directory name for what is
shown below.


# /home/razoradm/Razor_<version>/scripts/rz_install


NOTE: that when the compressed file is expanded, it will contain a version identifier.


2. This script is used for new installations and upgrades. The script will ask you a series of questions
and provide informational messages along the way. Follow the instructions provided by the script. The
first question asked will be whether this is a new installation or an upgrade. For new installations, you
will be asked if you want to create a symbolic link to the Razor tools. We recommend you answer 'y',
(the default). This will help make product updates go more smoothly for you later on because users can
always point to the Razor executables in the 'Razor' directory. 
The script is fairly self explanatory. Unless you have specific reasons to do otherwise, accept the default
answers as supplied to the questions.


3. One key question that you will be asked is where the Razor license directory (Razor_lm) is to exist.
We suggest that it appear parallel to where the release itself now exists: In this example, /home/
razoradm. (Please... do not put the Razor_lm directory within the Razor release area itself; this will only
complicate things later.)
Please enter the fullpath to the directory where the
Razor_lm directory should be created: /home/razoradm


Make note of this directory. It will be used to install the license keys and to set the environment variable
RAZOR_LICENSE_DIR a little later. Remember, you will need to have write permission in the named
directory as you run the installation script.


4. Another key question will be whether you want to use RCS instead of SCCS for the underlying
archival mechanism. Razor will work fine with either (provided that you are running RCS version 5.7 or
better). If you aren't sure, answer 'n' to the question and SCCS will be used. 


NOTE: We recommend that the RCS database format be used . This offers a more portable
upgrade path and is the only engine available on Windows. Linux distributions offer RCS and not SCCS.


5. All of the text from running the rz_install script is stored in the file razor_install.info for your review.
The directory tree under the /home/razoradm installation area should now look something like that
shown below.


                /-- Razor  - - - -> /home/razoradm/Razor_<ver>
                | 
                |                 /-- Razor_iw_lib
                |                 |-- bin
                |                 |-- doc
                |                 |
                |                 |-- examples -------- small_glyphs
                |                 |
/home/razoradm -+-- Razor_<ver> --+-- glyphs
                |                 |-- help
                |                 |-- lib-------------- nls
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                |                 |-- scripts
                |                 |
                |                 |                /-- Issues_tables_templates
                |                 \-- templates ---+-- Threads_tables_templates
                |                                  \-- Versions_tables_templates
                | 
                \-- Razor_lm


You'll notice that the rz_install script created a symbolic link called Razor which points to where the true
installation resides. This makes product upgrades much easier to install.


Sample installation


Here is a sample Razor installation so that you can see that it is really quite straightforward. This
sample installation. Your mileage will vary depending upon your configuration, whether you performed a
previous Razor installation, etc. assumes the following:


-first-time installation


-symbolic link install (recommended)


-installation target directory /home/razoradm/Razor


-release has been untarred


# cd /home/razoradm/Razor
# ./scripts/rz_install


Checking your configuration...


Do you accept the Razor License Agreement (y/n/(r)eview)? [r] 


Welcome to the Razor product installation.


If at any point during this process you have questions
please contact us at:  razor_support@visible.com or by calling (315) 363-8000


Is this a product upgrade (y/n)? [n] 


A new installation.... Welcome aboard!


We recommend that you use a symbolic link to point to the current Razor executables.  This will prevent
your users from having to change database specific setup files (rz_prep AND rz_prep.sh) due to future
product upgrades.


Would you like to be configured this way (y/n)? [y] 


When referring to the Razor release directory, the Razor tools will use the directory:


/home/razoradm
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Is this correct (y/n)? [y] 


The Razor license manager controls the allocation of license tokens.  This installation will create a
Razor_lm directory in the location you specify.


Please enter the fullpath to the directory where the Razor_lm directory should be created: 


/home/razoradm


Checking for existing link...


None found.


Creating link...


A symbolic link to /home/razoradm/Razor_<release> has been created as /home/razoradm/Razor.


Your Razor License data is located in /home/razoradm/Razor_lm.


Please use this location when creating a new database.


Installation complete.


Please contact Visible Systems to obtain a demo or node key for your site.


Please have the Razor identification string of the machine that will be hosting the license server when
contacting Visible Systems.  The Razor identification string is obtained by invoking the command:


'/home/razoradm/Razor/bin/razor id'


Until this key is obtained, Razor will not execute.


A Razor database must now be created for the Razor tools to access. This should be done by the user
who will be the owner of the database. Database owners run the 'rz_new_database' script to add a
database.


If you have any problems or questions, please contact Visible Systems. The support number is:  (315)
363-8000


Or via e-mail: razor_support@visible.com


The installation information just presented is contained in this directory in the file: razor_install.info


License keys


Obtaining license keys


In order for Razor to run, you must now obtain and install some license keys. Demo keys may be
obtained automatically via our Web site at http://www.visible.com/Download/Razor/demo_keys.htm.



mailto:razor_support@visible.com
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Demo keys will permit you approximately three weeks to evaluate Razor. If you have problems or do not
have access to the Internet, contact us either via e-mail at "razor_licenses@visible.com" or by phone at
(315) 363-8000.


Permanent keys are obtained directly. To get the keys, you will need to provide the Razor identification
for the machine that will be hosting the Razor license manager (razor_lm). To obtain this identification
string, log onto the machine that will be hosting the license manager and enter the following command...


# /home/razoradm/Razor/bin/razor id


If you obtained Razor from a software reseller or distributor, contact them for a set of license keys. If you
are working directly with us, then contact them either via e-mail at "razor_licenses@visible.com" or by
phone at (315) 363-8000. Be sure to provide the entire output of the "razor id" command.


Installing keys


Razor provides a command line mechanism for entering the license keys.


1. The Razor command line program (appropriately named, razor) needs to know where the Licenses file
resides via an environment variable. If it is not already set (i.e., you've never done this before), then you
must set it by hand.


C shell:


# setenv RAZOR_LICENSE_DIR /home/razoradm/Razor_lm


Bourne/korn shell:


# RAZOR_LICENSE_DIR=/home/razoradm/Razor_lm


2. Invoke the razor program and enter the keys you have been provided.


# /home/razoradm/Razor/bin/razor license


Enter hostid [5300a282]: DEMO
Enter key 1: aa9e741b
Enter key 2: f4b70163
Enter key 3: f46cc463
Enter key 4: abcd69e5


If you have been supplied a DEMO license, then you need to actually enter the word "DEMO" as shown
in the example above. When running a demo license, the tools will not allow operations on files/issues/
threads beyond version 1.5 and will only allow 50 issues. This will allow you to get started, and once a
purchased key is installed, pick up right where you left off. If you are upgrading to new license keys,
then the existing keys will be provided to you as default settings within brackets.


TIP: Everything beyond the first two lines of the Licenses file is ignored by the Razor license
manager, so feel free to put whatever you wish in there, such as expiration date and your customer ID.
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3.4.1 Installing product upgrades


The mechanics for installing product upgrades mirrors that of doing a full, original installation - that is
they both are initiated by running the script rz_install (Refer to "Running rz_install" within the " Installation
and General Administration " section.) There are only a few points to keep in mind.


 Make sure that all database servers and the license manager are down. Nobody can be using the old
release while upgrading to a new one.


 Install the new beside the old. In other words, if you put the old release in /home/razoradm, put the new
release there as well. The installation script (rz_install) will move the symbolic link to point to the new
release.


 If you wish to drop back to an older release of the product, all you need to do is re-link Razor to point
to an earlier release.


 Once you are sure you do not need older releases, feel free to remove them from your system. The
upgrade NEVER removes previous versions.


 Be sure and read the file RELEASE_NOTES that accompany every release of Razor. These contain a
summary of the changes as well as important information regarding possible database updates, required
script changes, etc.


 If you are using IssueWeaver, you will also need to upgrade it as well. Refer to the IssueWeaver
manual Chapter 2, Installation for details about upgrading.


Databases, groups, and attributes


A database is the directory structure under which all Razor data and configuration information is stored.
The organization and structure of the data, the relationships between data components, the views used
to display the data, and the access methods are completely up to you. Each database consists of
Razor groups. A group is simply a specific collection within the database. There are groups dedicated to
file version control, issues, and threads which are created and named by the user to meet the user's
needs.
A database can be accessed by any machine on your network (e.g. LAN, WAN).


Once Razor has been properly installed on your system, unless you are only running Razor remote
clients (Refer to "Remote UNIX Client Applications " for more details about remote client set up.) you need
to make one or more databases for it to run against. You are allowed to have as many databases as you
wish. Each of the Razor tools can work on only one database at a time.


Each Razor group can take on its own persona. The information tracked, the process enforcement, the
reporting can all be unique to a Razor group. Razor provides a set of configurable attributes which may
be assigned to files, threads, projects, or issues. These attributes can be radio boxes, X-OF-MANY
selectors, pull-down menus, text fields, lists, checkboxes, time stamps, or states. The user can then
control the display and selection of objects based on the setting of attributes. Reports and queries can
also be generated which take advantage of these settings.


TIP: Take a look at the section entitled " Containers: databases, groups, and folders " for an
overview of the different organizational concepts employed by Razor. Having a good understanding of
these concepts will really help in laying out your database structure.
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3.4.2 Creating databases


To create a Razor database, you must first decide where the database itself will reside on your system
disk.
Since a Razor database is often meant to be a shared resource between a variety of people working on
the same project, it must be in a network-accessible location. The location of the database does not
matter very much, but minimizing network traffic can improve performance. The only requirement is that
the resultant directory tree and location are readable and writable by the server and readable by users.


NOTE: In order to minimize permissions and security issues, please do not have 'root' create the
database. The Razor Administrator should run the rz_new_database script. You may need/want root to
create the directory where the database will exist, but the ownership and permissions of that directory
should be changed to allow only the database owner to write into the directory. Database permissions
are controlled via the Access_list file, which is discussed in the " Razor File  Formats "  section and "
Access Controls ." 


In our example, we will assume that the database is for the StarGuide project, and that we want to have
the database tree be at the same level as the home directory of the various members of the team.
Please substitute your own directory names into the following flow as appropriate.


Creating a database repository


A good database organization recognizes the fact that multiple databases will be created. Creating a
single directory that will hold all databases is a reasonable thing to do. This provides a single root for
backups, permits sharing common files, scripts, etc., and just makes life a little simpler. A razor_db
directory is created under the razoradm home account path as follows:


# mkdir /home/razoradm/razor_db
Running rz_new_database


The example below puts the database in the directory named /home/razoradm/razor_db/Starguide, and
the installation in the directory 


/home/razoradm/Razor/scripts. Please substitute the directory path you have chosen. It also shows the
creation of a file control group called Devel.


# cd /home/razoradm/razor_db
# mkdir Starguide
# /home/razoradm/Razor/scripts/rz_new_database


Checking your configuration...


The Razor license info is already in /home/razoradm/Razor_lm
Do you want to use an alternate license area? [y/n]


NOTE: The script will look at your present configuration and ask some simple questions. Except
under very unusual circumstances, you should accept the defaults you are offered as shown in the
square brackets "[]". 


(answer 'n' if you're not sure) [n] 
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The Razor database contains all of the files related to the Razor programs.  It is accessible by all users
of these programs.


We offer a pre-configured DEMO database that highlights some of the Razor functionality.


NOTE: A tutorial may be installed.  Refer to $RAZOR_HOME/README.Tutorial for details.


Would you like to install it? [n] 


Where should I install your Razor database?


/home/razoradm/razor_db/Starguide


Creating the ISSUES group...


The default version control system used by Razor is SCCS. 


Razor also supports RCS, if you prefer. Even if you are only using Razor for problem tracking, a version
control engine is still required for issues. Razor allows you to specify a different archival engine for each
group. Once selected, you can't change it . Refer to the Common Q&A section "Which archive engine
should I pick?" for more details.


Would you like to use RCS for ++ISSUES++? [y/n] 


(answer 'n' if you're not sure) [n] 


Will you be using this database for file version control and/or build management? [y] 


Note: If you say no, you are all finished answering questions. You can always come back later and
decide to take advantage of the file version control aspect of the tool.


Razor groups are created to contain related information for teams (groups) of users.  To start with, you
must define at least one Razor group.  Additional groups may be added later by executing the script
'rz_add_group'.


What is the name of your first group: Devel


Note: A Razor group should not be confused with a UNIX group: they are different beasts. See "
Databases, groups, and attributes " within the Installation and general Administration section and "
Containers: databases, groups, and folders " in the  Customization and Personalization section.


The default version control system used by Razor is SCCS.  
Razor also supports RCS, if you prefer.


NOTE: Windows and Linux users must choose RCS when creating databases. 
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Would you like to use RCS for Devel? [y/n] 
(answer 'n' if you're not sure) [n] y


The group 'Devel' has been successfully added to the Razor database.


The PROJECT group has been added to the Razor database.


Note: The PROJECT group is used by the threads tool to manage a collection of related threads (a
thread of threads). See "Projects: Thread of threads " in the Using Threads section.


Installation complete.  Additional setup information is in the file:


/home/razoradm/razor_db/Starguide/RAZOR_UNIVERSE/rz_new_database.info


Would you like to display it now? [y] n


Database creation is now complete. The script wrote additional setup information into the file
rz_new_database.info in the RAZOR_UNIVERSE directory. Please take the time to read through it and
follow the directions as presented. If you don't, you'll have to figure out a bunch of things on your own
and could end up being totally frustrated. (We're trying to avoid that wherever possible!)


Directly under the initial directory will be two important files; rz_prep and rz_prep.sh. In order to take
advantage of the Razor programs, and access the desired database, the rz_prep files must utilized.  PC
and remote clients as described in "Razor PC Applications" or PC Applications section and  "Remote
UNIX Client Applications" will not have to perform this step. It is performed automatically as part of the
connection process.  C Shell users will need to "source" the rz_prep file. Bourne or Korn Shell users will
need to "dot" (.) in the rz_prep.sh file. In either case, we recommend putting the above step into each
user's .login or .profile file, as necessary.


3.4.2.1 Injecting existing SCCS/RCS investments


Razor does provide a mechanism to inject your existing SCCS/RCS database directly into a database.
Refer to
"Injecting existing SCCS/RCS investments " in the Using Versions section.


3.4.2.2 Making additional file control groups


You have the option of adding new groups to a Razor database at any time, even if you did not initially
indicate that you wanted to use Razor for file version control.


1. Bring the related database server down before doing any work.


# razor down


2. Execute the rz_add_group script (as the owner of the database)...


# rz_add_group <group_name>


... where <group_name> is what you've decided should be the name of the new group. You will be
prompted for the archival engine for this group.


3. If you wish, edit the Attributes file for the new group to suit your needs. You may even want to just
copy the Attributes file from an existing file control group.   See the "Customization & Personalization " for


a full discussion of how to set up the Attributes file. It controls a great deal of how the issues, versions and
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threads programs behave.


4. Bring the related database server back up.


# razor up


3.4.2.3 Making additional issues groups


You have the option of adding new issues groups to a Razor database at any time.


1. Bring the related database server down before doing any work.


# razor down


2. Execute the rz_add_issues_group script (as the owner of the database).


# rz_add_issues_group <group_name>


Where <group_name> is what you've decided should be the name of the new issues group. You will also
be prompted for the preferred archival engine.


NOTE: For issues groups, you will be prompted as to whether you would like to select an issue
number prefix other than the default of "I". Only single alphabetic characters (A-Z) are permitted.


3. If you wish, edit the Attributes file for the new group to suit your needs. You may even want to just
copy over the Attributes of an existing issues group. 


Note: See the "Customization & Personalization " section for a full discussion of how to set up the
Attributes file. It controls a great deal of how the issues, versions and threads programs behave.


4. Bring the related database server back up.


# razor up


3.4.2.4 Making additional custom groups


You also have the option of adding custom groups, either issues or file control, to a Razor database at
any time.


1. Bring the related database server down before doing any work.


# razor down


2. Execute the rz_add_custom_group script (as the owner of the database). You will be prompted for the
preconfigured group, group name, preferred archival engine, and prefix (for issues groups). Below is an
example of creating an issues group named "ai".


# rz_add_custom_group


The pre-configured file groups are...
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1) Code_development
2) Document_management
3) Web_development


The pre-configured issue groups are...


1) Action_items
2) Bug_tracking
3) Customer_tracking
4) Music
5) Peer_Review
6) Support_Helpdesk
7) ToDo


Would you like to add a pre-configured group? (y/n) [y] 


Would you like to add an issue(i) or file(f) group? (i/f) [i] 


The pre-configured issue groups are...


1) Action_items
2) Bug_tracking
3) Customer_tracking
4) Music
5) Peer_Review
6) Support_Helpdesk
7) ToDo


Please select the desired group (1-7): 1


Name of new group: [Action_items] ai


The default archival engine used by Razor is SCCS. Razor also supports RCS, if you prefer.


Would you prefer to use RCS for group [ ++ISSUES++.ai] ? [y/n]
(answer 'n' if you're not sure) [n] 


By default, all issue numbers will be preceded by the letter 'I'.  You can specify an alternate value.


Issue number prefix [I]: A


Checking selected prefix...


The issues group '++ISSUES++.ai' has been successfully added to the Razor database.


Configuring group [ ++ISSUES++.ai ] ...


Group configuration complete.


3. If you wish, edit the Attributes file for the new group to suit your needs. 


4. Bring the related database server back up.


# razor up
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3.4.2.5 Starting a Razor database


In order to start the Razor applications, the Razor license manager and a database server must be
running. The sections which follow describe how to do both. Before doing anything though, the Razor
environment must be defined. 


As mentioned earlier, an rz_prep and rz_prep.sh file have been created in the database directory as a
result of creating a new database. You must either source or dot one of these files depending on which
command shell you use.


NOTE: If RCS is selected as the archive engine for any group within a database, make sure that
the user who starts the server (typically the Razor administrator) includes RCS on his search path.


Following the example of the previous section in which the database is located in the directory /home/
razoradm/razor_db/Starguide, you should do the following (remember this is only an example and names
should be changed to reflect your setup).


•For C Shell users, source the rz_prep file:


# source /home/razoradm/razor_db/Starguide/rz_prep


•For Bourne and Korn shell users, dot the rz_prep.sh file:


# . /home/razoradm/razor_db/Starguide/rz_prep.sh


3.4.2.6 Razor license manager


The Razor license manager (razor_lm) is designed to run as a background task on one machine in your
network as specified in your Licenses file.


Note: You must have logged on to this machine to start the Razor license manager.


Once invoked, it runs silently, monitoring and controlling the number of Razor users on your network.
Razor does not care how many databases are in use, nor does it care where or by whom.


Note: See "LM_Access_list" in Razor Customization and Personalization for how to control access or "Razor
Directory Layouts" for more information.


The Razor license manager must be invoked by a user account that has write privilege to the directory
where the license is stored (i.e. /home/razoradm/Razor_lm/Licenses).


Modes


The license manager supports validation of the following files for remote user verification:


Note: Remote user's include connections via PC clients, UNIX remote clients, and/or IssueWeaver. 


 Razor password file (default)
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Note: Refer to "Remote client password " within the Installation and General Administration section.


 local password file (command line option -p)
 local and Razor password file (command line option -P)


To select a mode other than the default, the license manager may be started with the desired mode
parameter or the mode may be selected via the file $RAZOR_LICENSE_DIR/License.conf


Note: Refer to "License.conf" within the Razor File Formats section.


NOTE: The file $RAZOR_LICENSE_DIR/License.conf will be created for new installations.
Existing installations may copy the file $RAZOR_HOME/templates/License.conf.template to
$RAZOR_LICENSE_DIR/License.conf.


3.4.3 Starting the license manager


To start the license manager under Windows 2003/2000/XP, refer to "Environment Variables" or Multiple
"NIC's - 2003/2000/XP Server.


To start the license manager under UNIX using the Razor password file, enter:


•C-shell users:


# razor_lm &


•Bourne & Korn shell users:


# nohup razor_lm &


To start the license manager using the local password file, enter:


•C-shell users:


# razor_lm -p &


•Bourne & Korn shell users:


# nohup razor_lm -p &


Alternatively, to start the license manager using both the Razor password file and the local password
file, enter:


•C-shell users:


# razor_lm -P &


•Bourne & Korn shell users:


# nohup razor_lm -P &
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Wait for the razor_lm to indicate "razor_lm ready to serve!" before proceeding. You only need to start the
license manager one time or when the machine on which it is running is rebooted.


Stopping the license manager


To stop the license manager, execute the command.... 


# razor lm_down


This command ensures that no database connections are active before terminating the license manager.


You have the ability to limit who can execute the "razor lm_down" command. The file LM_Access_list
contains the Razor operation RAZOR_LM_DOWN and a list of users/groups/roles that may perform that
operation. See "Access Controls ." section for details on controlling who can do what.


3.4.4 Starting the database server


Once a database has been created and the license manager is running, you are able to invoke a
database server against it. The database to be started is based on the setting of the environment
parameter RAZOR_UNIVERSE_DIR. This parameter was set by sourcing (or dotting) the appropriate
rz_prep file.


To start the database server, enter the following command...


# razor up


Wait for the program to indicate "rz_server ready to serve!" before proceeding. Like the license manager,
the database server only needs to be started one time or whenever it is necessary to change the
Attributes file(Refer to "Customizing the Attributes file " for more information.) or the machine on
which the  server is running is rebooted. The "razor up" command will invoke a background daemon
process which will run until the machine is brought down or is terminated by the command "razor down".
 From this point forward, any user who has properly referenced the rz_prep file can bring up the various
Razor programs.


Difficulties starting the database server (rz_server)


Yes, this happens on occasion, and can prove somewhat frustrating. Here are a few tips we hope will
avoid the frustrations.


If you get complaints about environment parameters not being set, go back to the beginning of the
section and source the proper rz_prep file.


Also note that the rz_server program starts up another program called kid_of_server. If the rz_server is
still having trouble starting, make sure that both the rz_server and kid_of_server programs are not
executing. You can find this out by using the 'ps' command on SunOS:


# ps -auxww | grep server


or all other platforms


# ps -elf | grep server
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and then killing the processes by specifying the process id in the 'kill' command:


# kill <rz_server pid> <kid_of_server pid>


3.4.4.1 Viewing  server information


You can view server information by using the 'razor info' command, which indicates the license manager
mode as well as the connected processes and process id's, including the license manager. A razor info
might look like:


# razor info


The license manager is running on kermit, pid = 159
Remote Clients are using Razor Password file


Connections: 


Database '/home/razoradm/DB/DB_PROG/RAZOR_UNIVERSE',
is active on kermit, rz_server pid = 200,


          1 -   herman is running Issues   on machine waldorf, pid = 174
          2 -   herman is running Versions on machine waldorf, pid = 162
          3 -     bill is running Issues   on machine kermit, pid = 1117
          4 -     bill is running Versions on machine kermit, pid = 1119
          5 -      ted is running Issues   on machine kermit, pid = 1246
          6 -      ted is running Versions on machine kermit, pid = 1268
          7 -      ted is running Threads  on machine kermit, pid = 1270


Database '/home/razoradm/DB/DB_CONTACTS/RAZOR_UNIVERSE',
is active on kermit, rz_server pid = 182,


          1 -    alice is running Issues   on machine gobo, pid = 28901
          2 -    davis is running Issues   on machine gobo, pid = 28934


There are 9 applications connected.


You can also determine the license manager process if by using the 'ps' command (on SunOS):


# ps -auxww | grep razor_lm


or all others


# ps -elf | grep razor_lm


...which might produce


dave 159  0.0  0.1  112  160 ?  S N  08:52   0:00 /home/razoradm/Razor/bin/razor_lm
dave 4804  0.0  0.2   32  196 pa S    12:16   0:00 grep razor_lm
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3.4.4.2 Stopping the database server


To bring the related database server down, enter the following command:


# razor down


When attempting to bring a database server down, you will be warned if there are connections to the
database. If that is indeed the case, you will be given the option of abandoning or continuing with the
database shutdown sequence. 


You have the ability to limit who can execute the "razor down" command. The file Access_list can
contain the Razor operation RAZOR_DOWN and a list of users/groups/roles that may perform that
operation. See "Access Controls " section for details on controlling who can do what.


NOTE: Shutting down a database server while people are actively using the database is not only
impolite, but also "kills" their Razor sessions and has the potential of confusing members of the
development team.


3.4.4.3 Razor tools


Once the rz_server is running, you may start any one or all of the Razor tools. Refer to the appropriate
sections on issues , versions , and threads  for specific details on how to start the tools, but in
general...


To start the issues tool:


# issues &


To start the versions tool:


# versions &


To start the threads tool:


# threads &


3.4.4.4 Automatic start-up at boot time


Although the actual implementation will vary by operating system, there are some basic approaches to
take. Your System Administrator will be the best source for the proper procedure to perform an
automatic Razor startup at boot time.


The best start is to create a script called start_razor and place the following lines in it. Remember to
change the setting of RAZOR_PREP in our example to reflect the actual location of the rz_prep.sh file
for your database. Also, the Razor database server will inherit the search path of the user that starts it,
in this case, root. You may need to modify PATH to include a minimal path for the general purpose
utilities that Razor uses, for example, "cp". In most cases /usr/bin on the path would be sufficient. And
finally, if using RCS, you MUST update PATH to include its location.


#!/bin/sh
RAZOR_PREP=/home/razoradm/razor_dbs/rz_prep.sh
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#
# If you are using RCS, set the RCS_PATH to its location
#
RCS_PATH=
if [ -f $RAZOR_PREP ]
then
    #
    # Be sure a minimal path is set for general purpose 
    # utilities,eg./usr/bin, and if using RCS, it's
    # location is included in the search path.
    # Check w/Sys-admin for specifics at your site.
    #
      
    if [ "$PATH" = "" ]
    then
        if[ "$RCS_PATH" = "" ]
        then
            PATH=/usr/bin
        else
            PATH=/usr/bin:$RCS_PATH
        fi
    else
        if[ "$RCS_PATH" = "" ]
        then
            PATH=$PATH:/usr/bin
        else
            PATH=$PATH:/usr/bin:$RCS_PATH
        fi
    fi
    export PATH
    . $RAZOR_PREP
    nohup $RAZOR_HOME/bin/razor_lm &
    sleep 5
    $RAZOR_HOME/bin/razor up
fi


If starting more than one database, be sure to change RAZOR_PREP to the proper database file before
executing the subsequent "razor up" command. Make sure this script is readable and executable, by
setting the proper permissions for the script as follows:


# chmod a+rx start_razor


At boot time, this script will be executed by root. That may or may not be desirable, as it means that
your Razor License Manager process will be owned by root. Possibly not a problem, but you'll have to
be root to stop the process. To avoid this situation, you may want to run this script su'd as the owner of
the database. You could do this by executing the script from the initialization file as,


# su <owner_of_db> -c "/<path_to_script>/start_razor"


Your System Administrator is the best source of information on what is appropriate for your operating
system.
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3.4.5 Remote client password


Remote connections (PC clients, UNIX remote clients, and IssueWeaver) to Razor databases, require a
valid user and password. The Razor license manager verifies all user accounts using either the Razor
password file or the UNIX login information based on the license manager mode.


Note: Rules may be defined for IssueWeaver that do not require a Razor defined user login and password. 
Refer to the the IssueWeaver Manual for details.


Note: Refer to "Modes" in the Installation and General Administration section..


If the Razor password file will be used to validate remote logins, the Razor Administrator is responsible
for creating and maintaining it. Password file administration is performed using the Razor command line
interface described in "Password functions " section.


Password file entries


An entry in the Razor password file consists of user, password, password settings and user group. Each
entry in the password file is for Razor use only and need not have any association with UNIX/PC user
accounts, domains, passwords and/or groups.


NOTE: The user that starts the Razor license manager MUST have write privileges for the Razor
password file to allow subsequent additions and modifications of the file.  If the password file does not
exist, it will be created when the first user is added, and it will be owned by the owner of the license
manager process.


NOTE: inetd.conf needs to be configured to allow rexec commands from remote hosts in order for
remote clients to work..


Remote guest account


If the license manager mode is to use the Razor password file (default mode) and that file has not been
created, Razor will allow world access via the login "guest" (no password required).  Once the password
file has been created, access will only be allowed for valid Razor users. 


If the license manager mode uses the local password file either solely or in combination with the Razor
password file, users may not login as "guest". Remote access will only be allowed for users in the
appropriate password files.


Batch entry of passwords


Razor provides a shell script that reads a file of user entries. The script $RAZOR_HOME/scripts/
rz_add_users will read a file of user entries in the following format:


user [ password | * [  user group ] ]


Fields must be tab separated and should not be quoted. An asterisk (*) should be used to specify an
empty (null) password.
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The script is invoked as follows:


rz_add_users [ <file> [ <user group> ] ]


The first parameter is the file containing the list of user entries in the above format.  If not supplied, the
user will be prompted for a filename.


The second parameter will be used as the default group for all user entries that do not specify a user
group.  If not supplied, the user will be prompted for a user group upon the first occurrence of a user
entry that does not specify a user group.  This user group will be used for all subsequent entries where
no user group is defined.


Any user entry that does not contain a password will be assigned the empty password.


3.4.6 Handing Mixed operating environments


It's increasingly common to find a combination of different architectures in use by the same engineering
team, on the same network.   It's expected that this  trend will continue  and become more prominent as
the various hardware vendors strive to commoditize their wares and compete  for  market share. 
Although this is generally considered to be a good trend, it does present a  few points worth noting.


NOTE: See "How do I set up a single database to be accessed via multiple operating systems?"
See Installation and General Administration  section for more information on this topic.


Heterogeneous environments


If you have a mixed environment, where UNIX stations of different architectures coexist on the same net,
then we'll assume that you currently have mechanisms and procedures for handling the coordination of
the various binaries. You will also have to copy the appropriate binaries to the bin/<OS> directory. Refer to
"Moving a database to new location" on for details on all of the components that will be affected by having


multiple environments. We'll leave the complexity of this issue to your local sys-admin team, but you
might take a look at the file $RAZOR_HOME/examples/rz_prep.smart and $RAZOR_HOME/examples/
rz_prep.sh.smart for suggestions.


When you purchase Razor, you are entitled to all the binaries for all of our supported platforms, free of
charge. With one exception, the 2003/2000/XP Server requires a one-time licensing fee per platform.  Our
pricing and licensing system is only concerned with how many simultaneous users there are on your
net. This is independent of which architecture they are presently invoking the tool from.


All of the Razor programs can communicate freely with executables for each of our supported platforms.
You can have the license server running on architecture X, a database server running on architecture Y,
and a client program running on architecture Z. Please refer to the "Razor PC Applications " and "
Remote UNIX Client Applications " for implications and considerations of these heterogeneous
environments.


OpenLook vs. Motif (Sun only)


You can run the Motif form of Razor on an OpenLook window manager (olwm). The window manager
provides the decorations which surround the displays, but within the Razor windows, it will be a Motif
interface.
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X terminals, etc.


There are very few considerations when running Razor's GUI's from X terminals (or PCs/MACs acting as
X terminals). The two most common concerns relate to the fact that X terminals do not have the same
physical resources as a UNIX workstation.


If you are running the PC client application, please refer to the "Razor PC Applications" section.


Not enough memory


For X-terminals with limited memory, some of the Razor interfaces may have difficulty starting. In these
situations, we recommend restricting the vertical and/or horizontal size of the display via the following X
resources:


Issues*maxWidth:    nnn
Threads*maxWidth:   nnn
Versions*maxWidth:  nnn
Issues*maxHeight:   nnn
Threads*maxHeight:  nnn
Versions*maxHeight: nnn


Where in each of the above cases, "nnn" is the maximum size in pixels that you will need to display the
main program. These resources control and limit the amount of memory required to handle the display.


Not enough color


On monochrome displays our default color selection may result in an all black or all white presentation.
To correct this, simply set the following X resources:


Issues*background:   white
Issues*foreground:   black
Versions*background: white
Versions*foreground: black
Threads*background:  white
Threads*foreground:  black


PC Clients


The Razor applications issues, versions, and threads are available as client applications targeting
2003/2000/XP platforms. These applications operate in a true client/server fashion. Since they are true
clients there is no requirement to mount database directories. However, since clients require a server,
Razor must be installed on a UNIX or Windows 2003 Server/2000/XP platform which is network
accessible by the PC. 


All databases are maintained on the server machine. Platform-specific text file format differences are
handled automatically by Razor and are, therefore transparent to end users. For example, a text file
introduced from versions/UNIX and subsequently checked out by versions/PC will be placed on the PC in
PC text format. The same file checked out by versions/UNIX will be placed on the UNIX machine in UNIX
text format.


For installation and general instructions regarding the Razor PC clients refer to the "Razor PC
Applications" section.
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Remote UNIX Clients


Razor can be configured so that clients can access databases on remote machines/networks. See
"Remote UNIX Client Applications" section for details.


Web Clients


A separate product called IssueWeaver® is also available. IssueWeaver is a highly customizable
Web interface to your issues database.


3.4.7 Rearanging things later


For a number of reasons, you may decide to relocate either the Razor database, or the Razor
executables.


Moving a database to new location


A Razor database is stored on a disk as a directory tree and a broad collection of files (refer to
"$RAZOR_UNIVERSE_DIR  How a database lays out") Moving the database to a new disk or parent
directory can be down with whatever mechanisms you would use to move any other directory, i.e. UNIX
command "mv".  Prior to moving any Razor database, make sure that no client applications are
connected and that the database server is not running.  Remember to move the directory structure,
RAZOR_UNIVERSE, as well as the files rz_prep and rz_prep.sh.  Once the move is completed, edit the
files, rz_prep and rz_prep.sh, correcting the setting of RAZOR_UNIVERSE_DIR to refer to the new
location of the database.  Reset the Razor environment variables by sourcing (or dotting), refer to
"Starting Razor" within the Installation and General Administration  section, the modified rz_prep (or
rz_prep.sh) file.


If the database has been moved to a different operating system, the owner of the database must do the
following:


# cp $RAZOR_HOME/bin/rz_exec \$RAZOR_UNIVERSE_DIR/bin/<OS>/rz_db_exec ( Razor releases
prior to v4.1d did not create bin/<OS> in $RAZOR_UNIVERSE_DIR. Refer to "$RAZOR_UNIVERSE_DIR How a
database lays out"  for the operating system nomenclature.)


# chmod a+x $RAZOR_UNIVERSE_DIR/bin/<OS>/rz_db_exec


# chmod ug+s $RAZOR_UNIVERSE_DIR/bin/<OS>/rz_db_exec


Remember to change all references to the file rz_prep.sh in files that exist in the scripts directory
($RAZOR_UNIVERSE_DIR/Scripts) to reference the new location of this file.


You will also have to hunt down and modify all references to the original rz_prep files. A common trick is
to leave a "placebo" rz_prep file in the original location. The placebo file can simply echo out some
statements as to where the present rz_prep files now reside.


NOTE: If you are changing operating systems, you need the appropriate distribution for that new
system.
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See also...


 Getting help in the Razor Introduction


• Razor Directory Layouts


• Special Features


• Razor File Formats


• Razor PC Applications


• Remote UNIX Client Applications  -  It's expected that this trend will continue and become more
prominent as the various hardware vendors strive to commoditize their wares and compete for market
share. Although this is generally considered to be a good trend, it does present a few points worth
noting.
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4 Using Issues


The issues program is the problem tracking part of the Razor trilogy. It provides a very intuitive and
powerful interface to a configurable database. 


Although its most frequent implementation is as a problem tracking system, it can actually be
configured to satisfy all sorts of needs, such as managing customer contacts, serving as a phone and
address database, helping to manage help desk operations... whatever.


This section concentrates on how to work with the primary user interface. It is intended for the end user
of the tool, but not necessarily the person who administers it. Specific details on how to configure the
issues program, and its related database are discussed later in the manual.    See "Configuring the
issues program" in the Razor Customization and  Personalization  section and "Customizing the
Attributes file " section presumes that you are using a client-server interface, and that even if you are
using a PC, you are running X-emulation software. However, it is also possible to run the issues program
on a Windows 2003 system if the PC is connected to a UNIX/Windows machine that runs the Razor
program. It has the same functionality and the same look and feel as the full client-server configuration. 
See "Razor PC Applications ."


To start this program from a shell prompt, simply enter...


# issues &


Command line arguments are also permitted to override certain environment variable settings or permit
access to remote databases:


-universe <universe_dir>
-group <group>
-remote  See “Remote UNIX Client Applications”
-rc <file name> Permits the specification of an X resource file
-no_color  Use the default desktop colors instead of the Razor-defined colors


The manual presumes that you are using a client-server interface, and that even if you are using a PC,
you are running X-emulation software. However, it is also possible to run the issues program on a
Windows  system if the PC is connected to a UNIX/Windows machine that runs the Razor program. It
has the same functionality and the same look and feel as the full client-server configuration. See “Razor
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PC Applications.”


4.1 Issues display Screen


The main display
The main display of the issues program consists of a window header/footer, a menu bar, a tool bar, a
large scrolling list as shown below.


You choose commands from either a menu, tool bar button, or shortcut keys (shown with menu items).
The tool bar buttons provide convenient access to the more frequently used functions. 


Header/footer


The window header will contain the program name. It may also contain the issues group name. The left
footer of the display gives some simple metrics about how many issues are known to the system. 
"Filtering the collection" in the Using Issues section has details on how to limit the issues list., and how many
of those are actually represented in the scrolling list. The right footer will display the version number of
the release of Razor you are using (not as shown above).


Menu bar


The menu bar contains the menus File, View, Reports, Commands, Database, and Groups.


 File contains the file-related commands New Issue, Print setup..., and Exit.


 View consists of a collection of view manipulation and selection commands, such as selecting/
deselecting all items in the list, showing/hiding the tool bar, and various filtering/sorting options.


 Reports permits the creation/modification/execution of reports. The menu consists of database, user
and script reports. Reports can be run by selecting them from the menu. Script reports operate on items
selected in the issues list.


 Commands - Your configuration may not include a Commands menu. See "Running commands " in112
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Using Versions for momre details.


 Database (optional) consists of site-specific databases. Your configuration may not include a Databases
menu. Refer to "Subscribing to databases & issues groups" section above.


 Groups (optional) consists of a list of issues groups available for this database. If additional issues groups
(Refer to "Making additional issues groups .) have been created for this database, the Groups menu will be
available on the menu bar. Selecting from the Group list will access that group and update the title bar.


Tool bar


In order to simplify access to some of the more useful functions, the issues program shows a small
toolbar on the main display. The buttons provide quick access to themes discussed later in this section,
but a quick overview here may eliminate confusion later.


As you move the cursor over each of the above buttons, the right footer will provide a reminder of the
function of each button.


If you are also using the Razor program for version control, you may also have a 'Drag and Drop' icon on
the far right of the toolbar. At least one issue must be selected to enable drag-and-drop. See "The drag-and-
drop method " section.


Main list


By default, the scrolling list displays each issue contained within the indicated group. Each line on the
scrolling list represents a separate issue in the database, and consists of three sections; a collection of
glyphs offering information about the settings on the issue form, the issue number itself, and a one line
text summary. (optional) consists of site-specific commands.
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5 The sections of an issue form


All issue forms consist of the following...


 A fixed collection of attributes, presented as on-screen entry fields, selection boxes, toggle switches,
etc. (collectively known as widgets).


 Two text panes, free format text area, typically used to contain the initial definition of the issue to be
resolved and the resolution.


The attributes, as well as the initial text which may appear in either of the two text panes, are controlled
by a set of configuration files. These configuration files are typically defined and administered by a single
person. and are discussed elsewhere in this manual.  See "Configuring the issues program " section.


An example of an issue form is shown below.
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5.1 The attribute section (attribute types)


Attribute types


The attribute section (See "Attribute types defined" within the Razor Customization and Personalization


section.) of an issue form should be extremely easy for a user to navigate, particularly with any prior
exposure to a window-based GUI. In brief, the types of attributes which may be presented are...


 Text fields for the entry of a single line of textual information.


 Several types of widgets for choosing items from a fixed list of options. Some allow selection of only a
single option at a time, while others allow the selection of a mixed subset of the presented options.


 A checkbox, which you can either set, or leave un-set.


 A state selector, which functions as a special purpose one-of-many type widget, typically employed for
denoting the life-cycle state of an issue. This widget will always be initially presented with the first option
chosen at the time a new issue is created.


 A date/time field. It is presented much like a text field widget, and although you are allowed to type
directly into the field, most users prefer to work with the popup associated with it. By selecting the
button to the left of the field, a panel similar to the one below will appear, offering a more controlled
means of entering the data.


Note that if the format type included references to time, then the above panel would be larger and
would offer entries for hours, minutes, and seconds.


The Time pulldown menu includes some convenient shortcuts such as Tomorrow, One week from now,
etc.


 A label. This provides form separators or information for the user to help identify the data to be entered.


Conditional attributes (sensitivity)


It is also possible that Razor has been configured to have some of the attributes (widgets) be
conditionally grayed out, based on the settings of other attributes on the form. All of the data will still be
available for inspection; having a field be insensitive only makes it so that it can not be modified. For
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example, once an issue has entered a certain state, you may want to prevent users from modifying its
priority. See "Conditional attributes (sensitivity)" within the Using Issues section for more details.


5.2 Rules and restrictions


A requirement imposed by Razor is that the first field on the issue form be a text field  (The title field must
contain at least one non-blank character. This is especially important if the first field is readonly, then it must be


properly filled in with a preload script.) , and that users actually supply some text such as a brief
description of the issue. This string is what will is shown on the main display. Local conventions and
administration may have additional soft and hard rules concerning what type of information you are
encouraged to put on the form.


In this context, a "soft" rule is one purely of local convention. It is what you and your team members
have agreed upon, but there is nothing programmatically enforcing your adherence. A "hard" rule is one
which Razor will attempt to force you to follow. These are established through the optional attachment of
shell scripts ("Attaching scripts to buttons" within the Writing Your Own Shell Scripts  section has a lot of


detail in this regard.) to the Ok/Apply buttons. If a user has violated a "hard" rule, then an additional error
popup will appear with information about what the user may have done wrong.


If there is a STATE attribute on the issue form, new issues are always entered into the database in the
first state. Also, although many issues can be viewed simultaneously, only one can be created or
modified at a time.


5.3 Text panes


Working with text panes


Unlike the single line text fields which may be in the top of an issue form, these text sections  (Refer to
"Options" within the "Customizatiton and Personalization section for more details on the types of controls


available for text panes.) are effectively of infinite length. You are free to expand on them and fill them out
as you see fit. The normal paradigms of using the mouse to select the insertion point, etc. are honored.


Additionally, it is possible to define hot-keys to perform programmatic functions within a text pane, as
well as control the functionality of certain key combinations such as ^U and ^E. This provides the
opportunity for a great deal of customization in how you can enter information into a text pane.  For more
information, see "Special control over text widgets" within the X Resources  section.


Including files into the text panes


New issue forms will appear with some collection of initial text, as defined by your site's configuration
files. You are free to edit and add to whatever is already in those fields.   See "Pre-loading information into


the text panes " within the Razor Customizatiton  and Personalization  section.  Occasionally you may
wish to include the contents of another file directly into one of the text panes. It may contain source
code, an error log, or some other information you find useful. To facilitate this, a special extension to the
text fields has been provided. By holding down the menu button on the mouse, a menu will appear
allowing you to bring up the panel shown below.
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After you've maneuvered to find the text file you want included, select either Ok or Apply at the bottom of
the form. The contents of the selected file will be inserted directly into the text pane where you had last
left the insertion point.


5.4 Creating new issues


To create a new issue through the GUI, you can either


- select the New Issue option from the File menu, or...


- type ^N, the related hot key


Note, It's also possible to bring up a form by command line or from a script. See "Bringing up issue forms by


command line" within the Command Line Functionality  section., or...


- select the new issue button on the tool bar.


After selecting New issue, a new issue form will be displayed for modification. Complete the form with
the appropriate information, keeping in mind that local rules may be imposed. Refer to "Rules and
restrictions" of the Using Issues section. 


Once the form is filled out to your satisfaction, you can select the Ok or Apply buttons at the bottom of
the display. Choosing Ok will accept all the entries and remove the form from the display, while Apply
will keep the form up for view. The Cancel button will remove the form from the display and result in no
new entry to the database. The Reset button will clear any modifications you may have made to the form
and start you over with initial settings for each of the input areas.   An issue form can be in "the Sections of
an issue form ."


5.5 Attachments to issues


The main issue form has an 'Attachment' button. The button can be used to view or manage any file
attachments associated with the issue.
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The 'Attachment' button is active when the issue is in the 'modify' state. Selecting the 'Attachment'
button from the issue display produces the File Attachments for Issue # popup screen. If no files have
previously been attached to the issue, the File Attachments popup screen will have only the 'Add' button
active. For issues that have at least one file attached, the File Attachments for Issue # screen will have
buttons Add, Remove, View, Export and History available. The default behavior allows all users to add,
remove, view, and export file attachments. The Razor access list (see "Database Access List
(Access_list)" within the Razor Customization  and Personalization  section may be used to tailor
each of the file attachment related operations for a given user.
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Adding Attachments


When the 'Add' button is selected from the File Attachments for Issue #' screen, a directory chooser
appears. The user selects the file to be added, clicks 'OK' in the chooser and the requested file name
appears in the file pane of the File Attachments window. 


Removing Attachments


To remove an attachment, highlight the file name in the file pane of the File Attachments window and
select the 'Remove' button. The Razor Options file (at the DB or group level) dictates whether Razor will
create a hidden backup file when the file attachment is removed (see "makeBackupOnRemoveAttach"
within the Razor Customization and Personalization  section. 


Viewing Attachments


The viewer panel allows the user to view a file attachment with the application/viewer that Razor
associates with files with the same file extension as the file attachment.  The panel also allows the user
to browse (Windows) or specify (Unix) an alternate viewer.  The viewer panel has slightly different
implementations for Unix and Windows.  When a Razor user requests to view an issue's file attachment
the Razor client will pull a read-only copy of the attachment to a temporary location on the client
computer.  Razor is not performing versioning of an issue's file attachments.  Consequently, if the user
edits the read-only attachment (and saves to another filename) the edits will not be retained by Razor. 


An effort has been made to prevent users from 'viewing' executables on Windows PCs.  Executables 
(e.g. *.exe, *.bat, *.com, ...) can still be added, removed, exported as attachments. 


Exporting Attachments


When the export button is selected, a directory chooser appears which enables the user to export a
copy of the attachment to a specified location.


Attachment History


Users can also view the file attachment history from this panel. The file attachment history denotes the
file attachment Add, Remove operations performed.  For an Add operation the history includes the local
directory from which the attachment was introduced. For a Remove operation the history entry includes
the (optional) backup file created from the 'removed' file attachment. 


5.6 Viewing/modifying existing issues


There are two main mechanisms for bringing up an existing issue for review through the GUI.  It is also
possible to bring up an existing issue form to the GUI by use of a command line option. See "Bringing up issue
forms by command line" within the Command Line Functionality  section. Subject of course to any access


restrictions, discussed in the Issue States  (permissions) section. The first, and perhaps the most
intuitive, is to scroll through the main list until you see the one you are interested in, then double-click
the mouse over that line. 


A second method is to call it up directly by its issue number. To do this, use the Issue number option
from the View menu, press ^I, or use the related button on the toolbar. However you do it, the popup
shown below will appear.
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You can enter the issue number as either its fully annotated form (I..1-234) or simply as an integer. Entering a
carriage return is the same as selecting the Apply button.


The issue form will initially come up in Review mode. In order to make edits to the form, you must first
change the state of the toggle in the upper left corner of the form to Modify. By doing so, you are
preventing anyone else on the system from simultaneously making edits to the same issue. An example
of the issue form is shown below.


As with the creation of a new issue, there may be both soft and hard rules which you may need to
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consider as you modify a form. Additionally, your Razor configuration may impose certain restrictions on
which user ids may make state transitions. Please refer to " Issue STATEs  (permissions)" section
and "Attaching scripts to buttons" within the Writing your Own Shell Scripts  section for more
information on how controls can be placed on Razor functions.


Checking on related file activity


If an issue has been related to an activity in either the file version control or release management aspect
of Razor (the versions or threads programs), then a button labeled Activity will be available in the top
right corner of the issue form (refer back to the issue form in "Viewing /modifying existing issues  within
the Using Issues section). Selecting this button will result in a new popup being displayed (like the one
below), displaying a synopsis of all the related file, thread and project operations.


Remember that virtually all user actions are recorded in Razor in easily parsed ASCII files. This makes
integration with third party tools or locally generated reporting scripts fairly simple.


For information on how issues can be associated with file activity in the versions program, see "
Associating issues to editing activity " within the Using Versions section, or with the creation/update
of threads, see "Defining threads by related issues " within the Using Threads section.


Browsing Issues from the Versions GUI


It is possible to browse the contents of an Issue from the Versions GUI.


1. In Versions, go to Edit -> Tool Properties and uncheck "Hide issues groups".  Click OK.


2. Go to Groups -> Issues -> <issues_group_name>.  Now your Issues are displayed.


3. Highlight desired Issue and go to Utilities -> Browse.


4. Select the version of the Issue to browse and then click OK.  The contents of the Issue appear in a
Browse GUI.


Note: This is also handy if you want to view a Thread or Project through Versions as well. Simply
uncheck the "Hide thread groups" option.


Recording your modifications


After you have modified the information on the issue form, select either Ok or Apply at the bottom of the
form to record your edits with the database. Selecting Reset will undo all of your edits since you took
the issue into Modify mode. The Cancel button will pop up a dialog similar to the one below.
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Selecting "Yes, dismiss the form" dismisses the form and no changes will be applied to the database.
"No, don't dismiss the form" will return control back to the issue form.


It is possible that someone else may have modified an issue while you were viewing it. If so, you will see
this at the top of the issue form.  This form has been modified recently.


NOTE: You will not be able to modify this issue. Your only choice is to select Cancel and reselect
the issue.


5.7 Controlling your view


As its initial default, the issues program will display all entries known to the system in numerical order.
Over time, this can grow to be a very large and unwieldy collection. Razor provides you with a variety of
options for controlling and organizing what is presented to you.


Additional information on the main display


Glyphs...


Depending on how Razor has been configured for your system, you may have a number of glyphs
(pictures) associated with various attributes on the issue form. This is offered as a configuration option
specific to all issues within a database, and can not be customized on a user by user basis.


Often the glyphs are associated with information such as the priority, state, or level of effort noted on the
issue form. For information on how to configure this capability, see "Associating glyphs to attributes"
within the Razor Customization and Personalization section.


Date information...


As shown earlier, the main display of issues normally contains lines showing only the issue number, a
line of descriptive text, and possibly some glyphs. It is occasionally useful to also show information
relative to when the issue was last modified.


By enabling the Days since Last mod option (^l) from the View menu, the display will widen and add a
note of the number of days since the issue was last modified. Similarly, you can choose the Modification
date (^m) option from the View menu and the main display will now include the exact date of the last
modification of the issues.







The sections of an issue form 67


© 1992-2009 Visible Systems Corporation, All rights reserved.


Both of the above toggles can also be accessed from toolbar buttons.


As with the UNIX command ls, dates occurring more than 6 months ago are shown as the date and year
of the modification. Dates less than 6 months ago will display the date and time of day that the edit
occurred. 


Note that it's also possible to sort and filter the display based on modification dates. See "Sorting by
modificatiton dates..." within the Using Issues section.


Filtering the collection


As the list of issues grows, it may be necessary to limit it to just those that are of particular interest or
have something in common. Filtering the issues list provides a finer level of control of the issues display.


By choosing Filter & Sort from the View menu (or using the filter and sort toolbar option), a popup similar
to the one shown below will appear. You are free to move and resize it as necessary on your display.


Three menus provide control over various aspects of the filter operation.


•File contains a number of filter file operations including resetting the filter form, saving the current filter,
saving the current filter as another name, and modifying/deleting filter files.
•Options contains filter/sort controls such as invert sort order, sort by modification date, case-insensitive
sorting, and match while typing. Match while typing will continually display the number of matching
issues as the filter form is updated.
•Filter contains the list of saved filters. Selecting a saved filter recalls it and displays the filter/sort
options.


These options are described in more detail in this section.


You'll note that the widgets on the Filter & Sort display are closely mapped to the widgets that appear
on the top of an issue form. These are used to define which issues on the main collection are of interest
to you.


Filtering by matched settings...
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All of the attributes on the issue form which provide a choice of options are presented on the Filter &
Sort panel as an X_OF_MANY selector. As you toggle the options on the Filter panel, you are indicating
your interest or disinterest in issues which match your selections.


For example, if you were interested only in issues that were assigned a High priority, you would select
only the High option on the Filter panel. 


If you wanted to see every issue except the High priority ones, you would select the Medium and Low
boxes, but not the High.


Within a particular filter widget, an issue is considered a match if any of the selections hold true.


Filtering by matching text strings...


It is possible to filter the issue collection by matching particular text strings. Character sequences
entered into one of the text widgets on the Filter Panel form UNIX regular expressions which are
compared against each issue in the system. In their simplest forms, a regular expression just searches
for a string which contains what you have entered, and this is often sufficient.  A full discussion of the
syntax of regular expressions is beyond the scope of this manual set, but a summary has been included for
your reference. See "Regular Expressions " section.


As a convenience, the Options menu contains a checkbox which indicates whether or not you want the
text searches to be case sensitive. If it is not selected, then case is considered. If it is selected, then
the case is ignored.


As you enter the search string into the text field of the filter panel, the issues program does a pass
through the database for each character as you type. The left footer of the filter panel displays a count of
how many matching entries are found. If you prefer to not incur the slight performance hit this approach
presents, then you can turn off the match while typing feature from the Options menu. 


When disabled, the footer display is only updated when the keyboard focus moves someplace else.


Filtering by matching checkboxes...


On an issue form, a checkbox is either checked or it is not. Simple. On the filter panel, you must
indicate whether or not you are concerned with the setting of the related checkbox, as well as which
setting you want a match on.
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For checkboxes, if the setting of the checkbox is not important for your filter, then have the Ignore box
selected. If Ignore is not set, then an issue is considered a match if the related attribute on the form
matches what you have on the filter panel.


Filtering by time stamps...


A powerful mechanism for filtering what is to be shown on the primary display is by time stamp. If you
have a TIME_STAMP attribute on the issue form, then there will be a corresponding opportunity on your
filter panel. It presents itself as a text field with a button beside it instead of a label.


The text field itself is not directly editable. By selecting the related button however, a new popup will
appear which provides a more programmatic and controlled mechanism for entering the desired date
range.


Note: The dates shown in the example above represent the minimum and maximum date strings allowed. The
minimum is referred to as the epoch in UNIX circles. NOTE: All of the Razor programs are well positioned to
handle the end of millennium calendar roll-over.


As with entering timestamp information on the form itself, you use the pull down selectors to enter the
desired month and day, and type in the year. To make entry of certain fields easier, you can also take
advantage of the From and To menu entries which allow the setting of either field to specific relative
dates (yesterday, a week from now, etc.). Please note that the top field represents the beginning of the
desired date range and the lower field represents the ending of the date range.


Combination filters...


When you have made settings in more than one of the widgets on the Filter panel, you are creating a
more sophisticated match criteria. The effect is that a particular issue will end up on the main list only
when it matches each of the tests you have set up. For example:


In the filter above, an Issue winl match only if...


... it is in either the Active or Completed states, and


... the Due_by date is set to anytime in March, 1998, and


... the Okay checkbox has been set.
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Sorting the collection


If no sort specifications are indicated, then all of the issues which pass the filter criteria will be arranged
purely by the issue number (which is also indicative of the order in which they were entered into the
system). By setting the sort criteria however, you can adjust the natural presentation order more to your
liking.


Sorting by attribute setting...


On the filter panel, to the left of widgets that can be sorted, is a menu button, as shown below. 


By identifying an attribute as "1st", that will be the primary key used for ordering the issues on the main
display. In the case of tied values, the sort criteria resorts to the 2nd, and then the 3rd and 4th in order (if
defined).


Using this capability, you could arrange to have your main display ordered first by Priority, and secondly
by Product (or the inverse). This, in combination with effective filtering, provides for quick and powerful
insight into the collection of issues.


Sorting by modification dates...


In the case of tied sorts (as defined above), the main display will naturally resort to ordering the issues
by the issue number, which is indicative of the order in which they were introduced to the database.
Occasionally, it is useful to have the issues sorted by the last time modified. This gives insight as to
where the most recent or most distant activity has occurred.


To activate sorting by modification date, select the Sort by modification date option from the Options
menu of the filter panel. This setting will also be noted in the footer of the filter panel itself as a reminder.
Note that the setting of this toggle will not take effect until the user next selects the Apply button on the
filter panel.


Changing the sort order...
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Finally, the issues program naturally sorts the entries from lowest to highest value. You can invert this
tendency by choosing Invert sort order option from the Options menu. This setting is also noted in the
right footer of the filter panel as a reminder.


Note that the setting of this toggle will not take effect until the user next selects the Apply button on the
filter panel.


Saving and recalling sort/filter combinations


Since the issues program allows you so much flexibility and control over the filtering and sorting of the
main list, it also makes sense that users should be able to save their favorite settings.


Note: The actual filter/sort options are stored in the file $HOME/.razor-init.


To facilitate this, there are a collection of options under the File menu of the filter panel. Most of these
are self-explanatory, and do not warrant a detailed description. The key point is that you can create/
modify/save/delete filters and associate names to them. To designate one as the default filter applied
when issues is started, use the Modify/Delete Filters option, select the desired startup filter and select
the Use as startup default option. As shown, the startup filter is defined as "doc-4.1d".


Searching for matching text strings


The power to filter and sort the list of issues as described above is restricted to utilize only the
information contained in the collection of attributes at the top of the issues form. As such, they are very
fast and efficient. Occasionally however, you may want to search for text strings within the body of either
of the two free format text sections.


Selecting Text Match from either the View menu or from the toolbar, will bring up the Text Match popup.
Below is an example of a text match searching the Solutions text pane for issues that programmer MTD
has updated.







Razor Manual72


© 1992-2009 Visible Systems Corporation, All rights reserved.


The Text Match popup has File, Match, and Reports menus. 


•File contains the Exit window entry.
•Match permits matching using both or either of the two text areas.
•Reports contains the full list of reports that can be applied against the issues that match the text
search.


To perform a search for matching text strings, you would enter UNIX style regular expressions


Note: See "Regular Expressions " section. into either or both of the text lines at the top of the form.
Selecting the Apply button will cause the issues program to begin a scan through the pre-filtered
collection of issues. 


The first key is compared in the first of the two text fields on an issue form; the second key is compared
in the second text field. Either of these may be left blank by the user. Whether or not a 'hit' in both or
either of the text fields is required is controllable by the user through the Match menu at the top of the
panel. The right footer of the display shows a reminder as to what the prevailing logic is. In the example
shown, if a text match is found for either the top OR bottom panes, then it is considered a successful
hit.


Since entering a case insensitive regular expression is often tedious, you can have the issues program
do it for you by toggling the state of the checkbox just below where the keys are entered.
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TIP: Doing a text match search for issues is not as efficient as normal filter and sort operations of
the attributes. Since these searches are performed against only those issues on the main display of the
program, you can improve performance significantly by first filtering the list to those of interest.


Once a search has completed, the scrolling list on this panel will contain a static subset of the issues
on the main display. You may double click on lines in this subset to bring up a copy of the issue, just as
you would off the main display.


Please note that this subset list shows the results of a single pass through the issue collection.
Whereas the main issues scrolling list is dynamically updated to reflect changes that other users may
be making in the database, this subset list is not.


5.8 Printing - Getting more insight and output


Printer setup


The destination of printed issues is controlled by the print command which is configurable via the Print
Setup... option of the File pulldown. Selecting this option will display a Print Setup dialog similar to the
one below..


Enter the appropriate command for your system into the Print command and click OK. The print
command will receive the contents of the information to print on stdin.


Printing issues


In the upper right corner of each issue form is a Print button. Selecting that button will cause a copy of
the issue to be printed.
The format of the printed issue is controlled by a shell script (rz_issue_print), so you have a good degree
of flexibility in how this is handled.  You are free to write your own rz_issue_print script and place it
earlier on your search path. Details on this and other such customizations are covered in " Writing Your
Own Shell Scripts " section.


The destination of the printed issue is controlled by the user's print command which is configurable via
the Print Setup... item of the File pulldown menu. 


Running reports


The Reports menu bar option on the main display pulls down to a collection of locally defined reports.
Reports can be either database (accessible to everyone who has access to the database), user reports
(accessible only to you), and script reports (accessible to everyone who has access to the database).
Your Razor Administrator controls who can create and run each of these types of reports. For details on
creating reports, refer to 
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See "Defining reports " in the Running Reports section or Pre-defined reports in the generating reports
section.


Script reports are run against the items selected on the main list.


Note: See "Writing report scripts for issues" within the Writing Your Own Shell Scripts  section.  


For scripted reports activated off the menu bar, the selected report will only be generated for the issues
you have selected from the main display list, and it will be run against the issues in the order they
appear. Through combinations of filtering and sorting the collection (discussed previously) you have great
control over the scope of the report.


Depending on how the report script has been attached for use, you may see a small popup which gives
an indication of which issue is being worked on. Once completed, a window such as the one below may
appear, containing the output of the report. If the report script is attached to automatically print, the
output is not made visible but instead is sent directly to the print command.


Note: See "Automatic printing of reports" within the Writing Your Own Shell Scripts  section.


The output may be printed by clicking the Print button located at the bottom of the window. If you wish,
you may also use the Save button. It allows you to identify the name and location of a file where the
results of the report can be saved, perhaps for future printing or e-mailing to other team members.
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Note that the use of both environment variables and the ~ character are allowed.


NOTE: Since the reports can be generated by shell scripts, it's possible that some of the options
on the menu may send their output directly to a printer for you. In fact, they can be configured to do a
great deal more than simply produce textual output. It is up to you and your local administration to
determine what you want a "report" to actually do.


NOTE: Since the reports can be generated by shell scripts, it’s possible that some of the options
on the menu may send their output directly to a printer for you. In fact, they can be configured to do a
great deal more than simply produce textual output. It is up to you and your local administration to
determine what you want a “report” to actually do.


Running commands


If the $RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables/Commands file exists, then the
commands it defines will be listed in a Commands pull-down menu on the main display. Selecting from
the menu will simply invoke the command as defined in the Commands file. The result is presented to
the user in an output window. To add a visual separator to the list, put the SEPARATOR tag on a line by
itself in the Commands file. Below is an example of the main issues display with the Commands menu.
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A simple command would be something like...


Who am I? whoami


...in case you forget. The list of issues selected from the GUI is made available to the script via the
environment variable 


$RAZOR_FILE_LIST.


Subscribing to databases & issues groups


You may have more than one database in which to create issues. If so, create a file named Databases
in the $RAZOR_LICENSE_DIR directory. Refer to "Databases (issues only)" on Razor File Formats
section for the format of this file. Upon the next invocation of the issues tool, the Database selection list
will be available on the menu bar. When a different database is selected, the current issues database
will be exited and the new one will be accessed. The database server must be running to access its
issues. Now the Database menu item on the main issues screen will be enabled; selecting that menu
will display all possible database choices.


You may find it necessary to keep track of different kinds of information in one database. Putting
everything on one form causes confusion or makes the form too lengthy. Razor supports the creation of
multiple forms with different attributes against one database. To make use of different issues forms, you
will need to create an issues group for each form.  With the database server down, simply run the script
rz_add_issues_group (Refer back to "Making additional issues groups " on creating additional issues


groups). You will be given the opportunity to select a different prefix letter for each issues group.  You
can then edit the appropriate Attributes file to create unique forms.  The Attributes file will be found in
$RAZOR_UNIVERSE_DIR/DOMAIN_01/ ++ISSUES++.<group>/Tables/Attributes.


Once you have created an issues group, the Groups menu will appear on the menu bar of the issues
tool.  Selecting a group other than the default will subscribe to that group's issues and the name of this
newly selected group will appear in the title bar. Just select and go.  Below is an example of selecting
the Lab_test group.
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See also...


• "E-mail entry of issues "


• "Deleting issues "


• "Associating issues to editing activity "


• "Configuring the issues program "


• "Customizing the Attributes file "


 "Customizing printouts of issues"


 "Pre-loading an issues form"


• Attaching scripts to buttons  in "Issues"


• "Razor PC Applications "


• "Remote UNIX Client Applications "


• "Making additional issues groups "


• "Attaching scripts to buttons "


 Database (Your configuration may not include a Databases menu. Refer to "Subscribing to databases &
issues groups" section above.)


 Groups (Refer also to "Subscribing to databases & issues groups" section above.)
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6 Using Versions


The versions program is the backbone of the configuration management aspect of the Razor tool suite.
Versions provides a straightforward mechanism for controlling, monitoring, and archiving changes made
to files in your development environment. 


If you're already familiar with the concepts and paradigms encouraged by SCCS or RCS, then learning
and using the versions program should be quite easy. In fact, the Razor tool suite will use either of these
for its underlying archival engine, while providing additional functionality.


This section discusses general use of the versions program. Details of how the package can be installed
and configured are covered elsewhere in the manual.  


Note: See "Installation and General Administration" and "Razor Customization & Personalization." 
Also, the section Writing Your Own Shell Scripts  is extremely informative.


To start this program from the shell prompt, simply enter...


# versions &


Command line arguments are also permitted to override certain environment variable settings or permit
access to remote databases:


-universe <universe_dir>
-group <group>
-remote-rc <file name> See “Remote UNIX Client Applications.”
-rc <file name> Permits the specification of an X resource file.
-no_color Use the default desktop colors instead of the Razor-defined colors.


The primary display


The main display of the versions program is dominated by a large scrolling window, as shown below. As
with most windows-based applications, much of its functionality is available through a menu bar across
the top of the display. You choose commands from either a menu (along the top of the display), action
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buttons (along the right side of the display), or shortcut keys (shown with menu items). Action buttons
provide convenient access to the more frequently used functions.
 


Header/footer


The window header will contain the program name. The left footer of the display shows file statistics. The
right footer will normally display the version number of the release of Razor you are using (not as shown
above).


Menu bar


The menu bar contains the menus File, Edit, View, Utilities, Scripts, Commands, and Groups.


 File contains file-related commands such as New Folder, Rename, and Exit.


 Edit contains editable items, specifically Tool properties.


 View contains a collection of view manipulation and selection commands, like selecting/deselecting all
items in the list and various filtering/sorting options.


 Reports permits the creation/modification/execution of reports. The menu consists of database and
user reports. Reports can be run by selecting them from the menu.


 Utilities contains file-specific manipulation commands. This menu is only active when a file is selected
in the main list. Utility commands include file information, browse a specific version, revert to a specific
version, display differences between file versions, and merge versions back together.


 Scripts contains user-defined scripts that manipulate file/folders.


 Commands  (optional) contains site-specific commands. Note: Commands, See "Running commands" for
more details. Refer to "Commands" for details on how to configure the Commands file.
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 Groups contains a list of file control, issues, and threads groups available for this database.


Action buttons


To supplement the menu bar, a column of buttons appears down the right side of the panel for all of the
common file version control activities (checking files in, obtaining read-only copies, etc.). These buttons
will appear enabled or grayed out based on the status of the various files selected on the main list. For
example, if no files have been selected by the user, then only the Introduce button will be available. This
type of feedback and control makes use of the tool more intuitive.


Main list


The scrolling list displays all of the files contained within the indicated group. In addition to the
filenames, there are three extra columns of information about each file (In truth, you're allowed to have
more... See "Controlling your view" in the Using Versions section.).


A small glyph is shown on the left edge of each line, and is meant to give a quick indication of what the
name represents. Folders, used to represent a hierarchical directory structure, are displayed with a
"folder" icon. They will be either open or closed, depending on whether the contents of the folder are to
be shown. If the folder is open, then everything within the folder will be shown on subsequent lines,
indented slightly to help show the hierarchical relationship.


The next column shows the latest version of the file.


The third column gives a quick indication of whether the file is presently checked out for edit by anyone.
If the file is checked out for edit, then the login id of the person who locked the file will be shown.


Finally, although not illustrated in the above example, it is possible to have one or more glyphs
associated with each file under control. Whether or not they appear is a function of how your local
administrator has set up your environment. If present, these small graphic images will (hopefully) give
more insight into each file. To learn more about how this would be accomplished, please refer to the section
on "Associating glyphs to attributes" within the section Razor Customization and Personalization.


6.1 Subscribing to groups


Files within Razor are organized by groups. The versions GUI allows you to view only one group at a
time. The Groups menubar option provides a pull-down selection of all the groups available. Selecting
one will change the contents of the main scrolling list, and clears filter settings.


In addition to the 'real' group names, you'll also see special menu items at the end of the Groups list for
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Threads and Issues, like the one below...


Of course, your display may be different as these menu items can be turned on/off through the Tool
properties. Check out "Using Threads. These special groups allow you to view how thread, project, and
problem tracking data are stored within the Razor database. These powerful concepts are discussed in
more detail throughout this section.


6.2 Working with files/folders


The hierarchical database within the versions tool of Razor allows users to replicate an entire directory
structure within a single Razor file group. This is a natural fall out of how many development
environments are organized.


A hierarchy consists of files and folders (subdirectories). There is no limit to the depth of the hierarchy.
File names may be duplicated within a Razor file group as long as the files exist in different folders.


Creating folders


Folders are created with the New Folder option from the File menu (or type ^n), which brings up the
following display.
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Type in the name of the folder you wish to have created and select the Ok button.


Another, perhaps simpler, method of creating folders is to select one or more directories for introduction
from the Introduce dialog. Note that introducing a directory will introduce the directory and its entire tree,
creating the necessary folders as it goes.


File check-out/check-in from the hierarchy uses the specified directory as a base directory. When
checked out for edit or checked out read-only, files will be placed into the same hierarchy in the file
system as represented in the versions tool. The base of the hierarchy will be the directory specified in
the dialog. When checked back in, files are expected to be in the hierarchy off of the base directory.
There is an "Absolute Path" indication for file check-in/check-out. This is discussed in "Checking files back in


" within the Using Versions section.


The threads tool.  Threads is covered in detailed in "Using Threads" section will also honor your file
hierarchy when populating a thread from a thread script. The hierarchy can still be modified using the
Thread_rules file.


TIP: Organize the files in Razor the same as they will appear in your project hierarchy.


Get files in Unix text format


If Razor is installed on a UNIX server and there are PC Clients, you may want to instruct users to
activate the option "Get files in UNIX text format."  This will help avoid ^M characters being placed in
ASCII text files as a result of PC document formatting.


For PC Users to get files in UNIX format:


1. In the Versions GUI, choose Edit, Tool Properties from the main menu.


2. In the Versions Props GUI, turn on "Get files in UNIX text format."


3. Click OK.


6.3 Introducing new files


The first step in letting Razor help manage your version control needs is to introduce files into the
database. To do so, make sure that you've set the program to the proper Razor group. If you wish to
introduce files into an existing folder, you must select the destination in the files/folder list. Then, with
the destination selected, select the Introduce button from the main display. The following panel will
appear.
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Through this interface, you'll be able to guide the versions program around your directory system,
identifying the files of interest, and inserting them into the database.


NOTE: Razor will not allow you to introduce files with special characters (e.g. single or double
quotes) included in the filenames. A warning message will be displayed and the files will not be
introduced.


There are two ways of using the panel to navigate around your system, and it is up to personal
preference as to which is easier. The first is to type in the desired directory into the top text field. The
use of tilde ("~") and environment variables is allowed. Upon pressing the carriage return, the scrolling
list will update to show the contents of the directory. 


As an alternative, users may also 'walk' around the directory system. By toggling what is displayed in
the scrolling list, it is possible to display directory names in amongst the files. Double-clicking the
mouse over a directory will cause the panel to enter it and update the contents of the list accordingly.
Either way, the current directory is always displayed just below the scrolling list itself.


It is also possible to enter a filename pattern to restrict the files that are displayed in the list. The pattern
text can be specified as either a UNIX style wildcard or as a regular expression, based on how the toggle
on the panel is set.


TIP: it's possible to have the versions tool always start up at a specific directory, which eases or
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eliminates the need to drive the tool around in search of files. To learn more, see "Setting personal
preferences" within the Using Versions section.


To introduce files into the system, highlight the files you are interested in from the scrolling list. You can
select as many files as you wish  For a refresher on how this is done, refer to " Scrolling list behavior .
Then, set the attributes for the files from the options provided.  Refer to "Changing attributes of files
section for more information on modifying the values of attributes after the file has been introduced. Also, see "
Customizing the Attributes file " for a description of how to change the attributes for ALL files in this file


control group. (Remember, the meaning and nature of the attributes are completely up to your local
configuration, and may not resemble the collection shown here.)


The Expand Keywords option allows control over archive engine keyword expansion during check-out.
By default, keyword expansion is enabled, but you might have a reason not to if you have characters
that look like keywords.


If you had a folder selected on the main display of the versions program, then whatever files you select
on the introduce panel will end up being placed into the indicated folder. If no folders were selected on
the main display, then the files will be introduced at the top of the group. If you select a directory on the
introduce panel, then it will automatically create a folder of the same name, and recursively introduce
everything within it.  Actually, that's not entirely true. You may want to look over the programming tip .  Also,
hidden files will only be introduced if "Show hidden files" is enabled to allow them to be checked.


TIP: If you can't find your file in a folder after you introduced it, check the top-level group. You
might have forgotten to select a folder before you introduced the file.


Finally, decide how you'd like Razor to process the files by choosing one of the three possible actions
shown here.


Take the files tells Razor to check the files back into the database and remove the working copy from
the originating directory. Leave READ-ONLY copies will check the files in and leave a read-only copy in
the working directory. CHECK-OUT the files checks the files into the database and immediately checks
them back out again for edit. This last operation is commonly referred to as a checkpoint.


Once everything is set, selecting the Apply button will begin the procedure. A small popup will appear
giving a running tally of how it's going. Once the selected files have been introduced, their names will
appear on the main display list. Files already introduced will no longer be shown in the scrolling window
of the Introduce panel. This prevents you from accidentally entering two files with the same name into
the same Razor group.


The Introduce panel will stay on screen after the maneuver, allowing you to introduce more and more
files into the system. Selecting Cancel will remove the panel from the display (but will not undo the
introductions just made).


Renaming files / moving to new folders
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Razor permits the rename of files that are under version control. The same interface may be used to both
rename a file and move a file to a different location within the same Razor group. A move is simply
renaming a file to a different location. Highlight the file in the versions list and select the Rename option
from the File menu (or type ^r). This brings up the following dialog.


It will come up showing the current name and folder. Simply type in the new name and folder you want it
to have and select the Ok button. Note that any existing threads which refer to the old name will still
work properly.


Handling binary files


By default, Razor will try to use either SCCS or RCS as the underlying archival engine for the file version
control scheme. These systems work just fine in many situations, but some file formats require special
handling. These are often non-ASCII files, and can be of any type; tar files, CAD files, documents from a
word processor, etc.


To accommodate this, if a file is identified as being binary at the time of introduction, then Razor will
utilize its own scheme. In brief, the file will be compressed, renamed, and stored in the Razor database.
These steps will be transparent to the user.


The decision of whether or not a file is to be treated as ASCII or Binary must be made at the time of
introducing the file. If you toggle the Archival setting to Binary, it will force the program to treat it as
such. If you've chosen Auto-detect, then the versions program will try to decide for itself. If neither of
these is selected, then the file is assumed to be ASCII, and it will be treated as such.  Razor's PC Client
will only allow Binary or Auto-detect to be selected, you must have one selected - unlike the UNIX client.


Injecting existing SCCS/RCS investments


As mentioned earlier, the versions program will use either SCCS or RCS as the archival engine for its
operations. As such, it is possible to allow Razor to pick up where your present SCCS/RCS investment
leaves off.


NOTE: Since RCS is the underlying archive engine for CVS, you can inject these investments into
Razor.  First, you will need to find where CVS stores the RCS files. Then you'll want to follow the
procedure for Injecting existing investments, and use $RAZOR_HOME/scripts/rz_inject_rcs.


There are two shell scripts provided with the Razor release which facilitate this effort. They are found in
the directory $RAZOR_HOME/scripts, and are named rz_inject (for handling SCCS investments) and
rz_inject_rcs (for RCS investments). A liberal amount of commentary is provided within the scripts
regarding usage, and you are encouraged to refer directly to them for specific details. Below, however, is
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an overview of the steps involved.


1. Stop the database server (using the command 'razor down').


2. If you've not already done so, create a new Razor group with the rz_add_group script. Edit the related
Attributes file to suit your needs.


3. Bring the database back up (using the command razor up).


4. Introduce the desired files into the group with the versions program. This step is necessary to
establish the attribute settings for each file, if desired, and to establish a destination in the database.


NOTE: To best ensure the history is retained for an existing archive of a non-ASCII file, do not
choose an archival type on the Introduce dialog.


5. Stop the database server again, as in step 1.


6. Run the appropriate script; either rz_inject, or rz_inject_rcs.


7. Restart the database one final time.


NOTE: The above steps MUST be done by the local administrator of the Razor database rather
than a generic user. Also note that no harm will come to the existing SCCS/RCS files.


Setting initial attributes via scripts


Attributes can be set at introduction time from an introduce.apply before script. See $RAZOR_HOME/
examples/intro.before. See "Attaching scripts to buttons " for a sample of how to use this technique to
set the Filetype and Binary attributes based on file extension.


Outputting a tab separated list of Attribute/Value pairs to the file $RAZOR_ATTR_FILE (set by the
versions tool) allows scripts to override selections made by users (except STATES, aka Blessings).
Creating the file $RAZOR_TMP/RAZOR_BINARY.$RAZOR_PID will cause the file to be introduced as a
BINARY file. Razor will remove this temporary file for the user.


6.4 Checking files out for edit


Of course, the reason files are stored in Razor is to provide a controlled mechanism for access and
modification. Developers obtain writable copies of the files by selecting the ones of interest from the
main display of the versions program and selecting the Checkout for Edit button. Doing so will bring up
the following panel.


228







Razor Manual88


© 1992-2009 Visible Systems Corporation, All rights reserved.


The user must first decide where the writable copy of the file is to be placed. The directory name can be
typed directly into the Check-out to field, or the cd button can be used. Using the latter method brings
up its own panel which allows the user to ‘walk’ to the desired destination by mouse interaction with
scrolling lists (reminiscent of the methods discussed for introducing files).


For files being checked out that are included in one or more folders in the Razor database, they will be
placed into the Check-out to location including the appropriate subdirectories. When the Path is
absolute check box is selected, files will be placed directly into the Check-out to destination.


The Clear button can be used to clear the title and description entries. Cancel cancels the check out
action and returns to the main display. Help is, well, help.Filling in comments.


Filling in comments


There are two mechanisms for associating user comments with the check-out.


After specifying where the files should be placed, the user must enter a brief reason why he is checking
the files out. This Title field must be filled in with something for the check-out request to be processed.


Separately, the user has the option of entering a longer, more thorough set of comments in the
Description field. These notes may be of whatever length and purpose deemed necessary. They will be
stored in the Razor database, and can be recalled later as necessary to gain insight as to not only
which files the user checked out, but what the thinking was at the time.Associating issues to editing
activity


Note: Many version control systems allow comments only when the file is being checked back in.
Razor allows comments to be made both before and after changes are made to the files. The notes
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made during check-out of files can address what the developer is hoping to accomplish. These notes are
shown during the check-in process, and may be modified to reflect what actually got done.


Associating issues to editing activity


In addition to the above means of commenting on a check-out effort, users may directly relate the
activity to one or more issues in the problem tracking system. In many ways, this makes more sense
than making comments directly on the check-in or check-out panels themselves. 1. See “Defining
threads" by related issues.


This is very powerful. It allows you to use the problem tracking system as the heart of your
development process, allowing you to directly associate what you are doing against the stated reason of
why you’re doing it. This can come back and help later as you pull together threads which define your
product releases!1In order to do this type of association, you of course need to have both the issues and
versions tools running at the same time on your display against the same database. Given that, the first
step is to identify the relevant issues from the problem tracking system. Once done, there are two
different ways to perform the association.


The drag-and-drop method (This feature is not available in the PC Client)


Once one or more issues are selected on the main display of the issues program, a small icon will
appear to the right of the toolbar, just below the menu on the main display. Grabbing this icon with either
the Select or Extend mouse button allows you to drag it over to the small scrolling list on the check-in/
check-out panel. This icon only appears if you are using Razor’s version control tool and have groups
defined in the database. Of course, if you never create a versions control group, then you will never see
this icon. Razor’s “out-of-the-box” stance is to make this type of association optional; at the sole
discretion of the user. It is possible however to force users to make the association, based on local
rules.


You can repeat this maneuver as many times as necessary.


The copy-and-paste method


After selecting one or more issues from the main display of the issues program, the user may use the
menu button of the mouse to bring up a small list of options. Choosing Copy Issues will push the list
onto an internal clipboard area for later use.
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After the issues have been selected, the user then returns to the versions program and brings the cursor
over the small issues scroll area on the panel. Again, by using the menu button on the mouse, a short
list of options will appear. Selecting Paste Issues will drop the issue numbers into the scrolling list.


This Copy-Paste effort can be done as many times as necessary to get an accurate list. The menu
associated with the small issues list also allows the user to select and deselect all members of the list
as well as delete members from the list if necessary.The steps outlined here for associating issues to a
check-out activity are the same as those that can be used wherever version control commentary is
allowed. This includes checking a file back in, introducing new files to the database, etc.


TIP: If the issues program is running on your display against the same database (which it
probably is), you can double click on any of the issue numbers in the scrolling list to view a copy of the
full issue for review and possible modification.


The steps outlined here for associating issues to a check-out activity are the same as those that can be
used wherever version control commentary is allowed. This includes checking a file back in, introducing
new files to the database, etc.


6.5 Checking files back in


After files have been modified, they must be re-entered into the database. To do so, the user first selects
the relevant files from the main display of the versions program and selects the Checkin button.
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Since the user must have already checked out a file, many of the fields on this form will be familiar, and
don't warrant a repeat discussion.  You are, of course, free to go back and look... see " Checking files out for


edit ." The commentary fields (Title and Description) as well as the issues list may be modified at this
time. There are a few extra elements to the check-in effort though that do require some explanation.


As files are being checked back into the database, the user has the option of either having the edited
copies removed completely from the directory, having read-only copies left in their place, or of directly
checking the files back out again for edits. The preference is made in the upper right section of the form.
The latter case of doing an immediate re-checkout is a convenient mechanism for checkpointing efforts
into the database prior to a new wave of edits.


Razor normally keeps a backup file associated with each file that is checked out or introduced
(consistent with Razor's philosophy of "better safe than sorry"). This behavior is controlled by an
Xdefaults setting described in "Versions.makeBackup ."


As the files re-enter the system, the minor version number of each file will be incremented. For example,
a file that was at 1.22 will now be at 1.23. Local conventions may suggest that you occasionally
increment the major number of the files. Selecting the Increment release number toggle will cause all of
the files to resequence to the next major release number. In other words, a file that was at 1.22 will now
be at version 2.1.


Checking in multiple files


When multiple files are being put back into the system at the same time, the user has the option of
either having the same Title, Description, and related Issues be associated with all of the files, or have
the original commentary from the various check-out efforts be recycled for the check-in. This is
controlled through the Use toggle in the middle of the display.
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TIP: When multiple files are being checked back in, the comments from the first in the list are
offered to the user on the check-in panel as a reminder of why the files were checked out in the first
place. Highlighting different files in the scrolling list in the upper left of the display will cause the Title,
Description, and Issues information to update accordingly.


Forcing files to be changed on check-in


An Options file may be added to the Tables directory of a versions group and/or to the Tables directory of
the database. This file can be used to gain more control over the check-in process. A check-in operation
can permit no change to the file, warn the user if there is no change in the file, or require a change before
the file is checked in. See " Options " for details on the file format and usage. A dialog like this one
will appear when the file is checked in. Selecting More Info... will display more detailed information like
the dialog in the lower right.


NOTE: Occasionally, access to a checked-out file is required by someone other than the original
user. Users defined in the RAZOR_ADMIN role (see "Definable roles ") have permission to check a file
back in or uncheck it. This provides a work-around when a key implementor left a file checked out and
went on vacation.


6.6 Parallel development


Performing a branch


Branches are deviations from the main development line for a file. They are a convenient mechanism for
allowing two or more people to be working on the same file at the same time (perhaps for different goals).
A common scenario is having one person working to add new features to the product, while a second is
doing bug fixes on prior versions. Parallel development, branching, will also involve terminating branches; so
you will also want to read the sections on "Terminating a branch" below, " Seeing how versions/files differ ,''
and "Changing your mind ."
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The version numbers of branches can be a little confusing, and warrant a quick discussion. Version
numbers on the main development line have only two parts; a major and minor number. 


Branches have 4 parts to their numbering scheme. The first two parts represent the point at which the
branch split off the main line. The third number indicates which of the many possible branches it is. For
example, in the diagram above, we have only one branch originating from 1.5. As such, its numbering
starts at 1.5.1.1, and proceeds from there.


If a second branch is later formed from 1.5, then it's numbering will begin with 1.5.2.1, as shown below.


To create a branch, the user highlights the file of interest from the main display, and selects the Branch
button. A popup will appear, as shown below.
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As with checking a file out for edit, the user is required to enter some explanatory text in the Title field. A
more elaborate set of comments may be entered in the Description field. One or more issues may be
associated with the action.  The mechanics of how this are done were discussed earlier in this section. 


See "Associating issues to editing activity ". Once a branch has been created, it presents itself as a
separate line on the main versions display, and it can be checked in and out for edits as necessary.


You should also look at " Merging files " that will help significantly with this. After that occurs, the branch
has out lived its utility, no longer needs to evolve separately, and no longer needs to be presented on the
main scrolling list. 


Terminating a branch


It is expected that branches are used as a temporary means of allowing concurrent development on a
single file. Sooner or later, the edits made to the branched line will be incorporated into the main
evolutionary line for the file.  


To signal the end of the utility of a branch, highlight the branched file in the main scrolling list and select
the Terminate Branch button. The above popup will appear, asking for confirmation of the effort before
performing the action.
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Note that although a branch has been terminated, none of the work that went into it is lost. The branched
versions are still available from the database, threads which referenced them are still valid. New and
modified threads cannot reference terminated branches.


6.7 Merging Files


With Razor, you have two two options for merging files.  You can use Razor's merge capability,
described below, or you can use Guiffy SureMerge  (A Diff and Merge tool).


6.7.1 Merging with sdiff


Merging files


If development is being done in parallel, it is sometimes the case that two files must be merged into a
single file. An example of this is Mike has a file checked out implementing a new feature, a bug is
identified in the same file and needs to be resolved quickly. Al branches the source file to fix the bug
while the Mike continues his implementation. When Mike's new feature has been completed, the bug fix
needs to be rolled back in and the branch terminated (assuming Al finished his bug fix before Mike
finished his implementation :).


Merge compares (See the section " Seeing how versions/files differ " for information about displaying


differences between files.) three files (the two input files and the common ancestor), and displays the
comparison in a series of panes: one for each difference and common section. Each section, either
common or difference, can be independently included or excluded from the merge output. Wherever one
current version agrees with the ancestor, merge presumes that the other current version is a deliberate
change which should be kept in the merged version.


NOTE: Merge uses a common ancestor approach to control the merge selection algorithm. If a
common ancestor is not available, as in the case of merging a file outside of Razor, File2 will be used as
the common ancestor. The ancestor is very helpful in providing context for differences and for conflict
resolution.


File selection


To merge files, highlight a file from the main display of the versions program and select the Merge option
from the Utilities menu.  The Merge option is not enabled for branched versions or binary files.  A dialog
similar to the one below will appear.


While strictly speaking the order of the files does not matter, the merge algorithm will be better served if
the Merge file (we will refer to as File1) is thought to be merged into the 'Merge with' file (referred to as
File2), just as the file selection pull-down menus suggest.


The Check-in as Latest Trunk check box is enabled if the file is not currently checked out for edit, and
File 2 is selected from Razor. The Terminate Branch check box will be enabled if File 1 is selected from
Razor, the Check-in as Latest Trunk check box is selected, File 1 is a current branch (that is, not a
previously terminated branch), and the File 1 branch is not currently checked out for edit.


Difference display


The main merge window is divided into three major areas: the ancestor area, the difference area, and the
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merge result area. Each of these areas can be resized. Below is a sample display with the major areas
identified...


The ancestor area includes the browse buttons (for the original files and the ancestor file), a compare
button (to re-execute the compare if merging a file outside of Razor), and the merge button. The ancestor
file becomes the reference point for differences as well as resolving potential conflicts between files. The
ancestor file is the lowest common version between the two merge files or File2 if one or both of the
merge files is outside of Razor. 


Differences are displayed in the Difference area in a series of panes - one for each difference between
the two files and optionally the common text between the two.   For more information on this and other


display options, see "Controlling the merge view ."  The difference area is where most of your attention
will be concentrated. The important components are....
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In the difference area, a difference is visibly cued by its position, being left-oriented (change from File1),
right-oriented (change from File2), side-by-side (change from both File1 and File2) or the full pane (text
common to all three files). Each difference has one of these states (the state can be displayed by
selecting on the Ancestor button to display the message in the status area): 


 Text common to all files. (Display of common data can be controlled with the Hide common data option
under View.)


 Text has been modified or added to both files. 


 Text has been added to File1 or File2.


 Text has been deleted from File1 or File2.


 Text in all three files is different (referred to as a conflict). Display can be limited to just conflicts with
the Show conflicts option under View.


Interactive merging, a walk-through


After the comparison is done and the differences displayed, the interactive merging starts. The first thing
you will notice is the merge display is completed and a message is written to the status line with the
number of conflicts. In the simplest case, that is - no conflicts, you could probably select the Merge
button to copy the results to the merge output area, and then save the results either to a file, or check
the merge back in to Razor.


Let's walk through an example of merging the efforts of our two programmers mentioned earlier. In a
perfect world, the programmers did not modify the same sections of code and you want all of the
changes from both. In that case, go buy a lottery ticket because you've beaten the odds.


Now for the real world, while the objective of the two programmers was different, they editorialized and
managed to change the same section of code in different ways. This is called a conflict. The most
challenging task in merging files is to resolve conflicts (much as it is in life.) You select which panes get
included in the merge result by selecting the Include/exclude toggle button. By default, merge will pick
what it thinks is the best choice for the merge result. Say merge notices that text was added to File2
and the text did not exist in File1 or the ancestor, then it will decide to include the new text in the merge
result. If there is no clear "winner," such as when the text is different in all three files, merge will punt
and choose File2.
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NOTE: Merge will generally produce reasonable output if you pick two files that came from a
reasonable ancestor. It really helps if both files are managed by Razor, as you might expect. But
however good the algorithm is, merge is not a mind reader. Care must be taken to understand the
differences and how they should be merged to produce the final product. Don't just "merge and go!"


So how will various differences be displayed? Consider the following code snippet for the ancestor...


/* Extended regular expression matching and search library, version 0.12.
   (Implements POSIX draft P10003.2/D11.2, except for internationalization features.)


   Copyright (C) 1993 Free Software Foundation, Inc.


   This program is free software; you can redistribute it and/or modify
   it under the terms of the GNU General Public License as published by
   the Free Software Foundation; either version 2, or (at your option)
   any later version.


   This program is distributed in the hope that it will be useful,
   but WITHOUT ANY WARRANTY; without even the implied warranty of
   MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
   GNU General Public License for more details.


   You should have received a copy of the GNU General Public License
   along with this program; if not, write to the Free Software
   Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139, USA.  */


#include <string.h>
#ifndef bcmp
#define bcmp(s1, s2, n)memcmp ((s1), (s2), (n))
#endif
#ifndef bcopy
#define bcopy(s, d, n)memcpy ((d), (s), (n))
#endif
#ifndef bzero
#define bzero(s, n)memset ((s), 0, (n))
#endif


#define REGEX_MALLOC


/* AIX requires this to be the first thing in the file. */
//#if defined (_AIX) && !defined (REGEX_MALLOC)
//jeb  #pragma alloca
//#endif


#define _GNU_SOURCE


Here is a sample of some merge outputs and a short explanation. With each of these examples, the
difference pane and the highlighted ancestor section will be shown.
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Resolving conflicts
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I'm sure you've turned to this section looking for really inspiring words of wisdom on how to resolve
conflicts. Sorry. We can only tell you the mechanics within the merge interface to make the changes.
You have to do the hard part.
Interactive selection/edit of the merge result for each pane is controlled by the three edit control buttons
and one of two include pane toggle buttons shown below:


. 
The pencil button enables editing of the difference pane, and changes the background color to show that
it has been enabled. Normally difference panes are not editable. Text can be entered or pasted from
another source once editing is enabled. If you really blew it, you can undo edits with the Undo button.
This gives you the ability to make little tweaks, or to completely change the text that will be merged.


The Ancestor area highlights the related difference section in the ancestor. If there is no line in the
ancestor file, the single line prior to the difference section will be highlighted. 


The square and diamond toggle buttons (On the PC these buttons are shown as an option button and an


option checked button, respectively.)  enable or disable the difference pane's inclusion into the merged
output. By default, merge will always select a section for inclusion, even if conflicts exist. In the case of
conflicts, merge picks File2 but can certainly be overruled by toggling the button, or either pane can be
edited and selected. To make editing changes, select the square/diamond button to enable it, then edit
the pane. Once a change has been made, the background color will change to show that it has been
edited. The background color and other X resource settings for merge can be found in the X Resources
section.


Saving merged output


When you've got something you're happy with, select Merge and your merge selections will be copied to
the merge result area. Once you have something in the merge result, you have the option of saving the
output. Merge results can be written to a file, or checked directly back into Razor.


TIP: To have the merged result checked back into Razor, the Check-In as Latest Trunk check
box must have been checked when the files were selected. Also, File2 must be a Razor file - because
that is the file you are merging into, and cannot be checked out.


Controlling the merge view


If the amount of information is oppressive, you have several display options that effect how and how
much information is presented. These options are all controlled under the View menu.


•Each difference pane can be resized and subsequently reset with the Restore Diff Pane Height (^R)
option. 
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•You can hide/show the common sections of both files by selecting the Hide Common Data (^D) option
from the View menu. Select Show Common Data (^D) to show all data, common or differences.


•Since resolving conflicts is a key aspect of merging files, just conflicts can be displayed with the Show
Conflicts Only (^S) option. All differences can be displayed by then selecting the Show Differences/All
(^S) option.


6.7.2 Changing attributes of files


As defined by your local configuration of the versions program, files within Razor groups can have various
attributes associated with them. These attributes are set at the time the files are first introduced to the
system (See "Introducing new files"), but they can be changed later as the need arises. 


To change the properties associated with a file, select the file from the versions list. Selecting Edit file
props from the Utilities menu will bring up the following panel. Remember that the nature of the attributes
can differ dramatically from group to group.


The user can then use this form to change the nature of any of the attributes.


The top of this panel offers a special 'attribute'... control over the execute permissions of the file. Files
will be archived with the execute permission setting at the time they were introduced.


Archive engines such as SCCS and RCS have special keywords that can be included in source files and
expanded automatically upon check-out. These keywords include such things as the file name, version
identifier, date, etc. and are typically embedded in a comment or identifier string for informational
purposes. It is sometimes undesirable to have keywords expanded if they also have a different meaning
within the file. Archive engine keyword expansion can be enabled/disabled (This option is not selectable


for binary files.) from this form. 


The binary attribute of file.  See "Handling binary files ." is determined when it is introduced. The Binary
indicator may not be modified.


6.7.3 Promoting specific versions, file-by-file


The underlying meaning and philosophy associated with promoting files under control is a bit involved. A
full discussion of this is provided in the Configuration & Personalization section of this manual, under the
heading "File and thread STATEs ".  We'll limit this discussion to performing a promotion from the
GUI.


To do a promotion, the user would highlight one or more files from the main scrolling list of the versions
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program and select the Promote button. The following panel will appear.


The panel allows the user to promote a selected version of the file to one of the allowable state levels.
This promotion can be associated with one or more issues from the problem tracking system (as
discussed earlier), and can even have some supplementary text as well. Each time the Apply button is
selected on the panel, it will sequence to the next file that was chosen from the main display.


6.7.4 Promoting a selected group of files


Multiple files may be promoted at once via the Promote GUI. Files are promoted one blessing level to the
next highest blessing. 
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In the Versions GUI, select all of the files to be promoted. Multiple files are selected using the shift or
control key in conjunction with the mouse.


•Click Promote. The Promote GUI appears (see above).


•Click PromoteAll. The files are promoted to the next highest level.


NOTE: When using the Promote All option, files will always be promoted to the next Blessing
level. Files are NOT necessarily promoted according to the selected Blessing level in the Promote GUI.


6.7.5 Looking at files


There are a variety of mechanisms available through the versions program to examine not only the files
under control, but also various bits of information associated with these files.


Getting read-only copies


It's possible to obtain read-only copies of any files in the database by first highlighting the ones of
interest and then selecting the Checkout Readonly button on the main display.







Razor Manual104


© 1992-2009 Visible Systems Corporation, All rights reserved.


If a single file was chosen, then the user will be able to select a particular version of that file, as shown
above. If several were chosen from the main display, it is assumed that the latest version of each is
desired.


The user must fill out the "Checkout to" field on the panel to indicate the directory where a copy of the
file should be placed. As with many of the similar interfaces, this can be done by either typing directly
into the text area, or by using the "cd" button. In either case, once set, selecting the Ok button will
deliver readonly (Will include execute permission if the file was introduced with execute permission.) copies
of the indicated files.


Files that are included in one or more folders will be placed into subdirectories (referred to as folders
within the versions program) of the "Checkout to" destination. When the "Path is absolute" check-box is
selected, files will be placed directly into the Checkout to destination.


Browsing files


The contents of a text file can be displayed with the Browse function. Browsing causes a temporary
readonly copy of the file to be retrieved from the database and brought up in a simple text window for
display. Double-clicking on a file in the main display list will browse the latest version. Highlighting a file
in the main list and selecting Browse from the Utilities menu will display a version selection dialog
similar to the one below.
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To browse a particular version, highlight the version in the scrolling version list and select Ok, or simply
double-click the version.


The default behavior is to use a simple Motif style text pane for showing the contents of the file. Razor
allows you to override this behavior and bring up the file in any editor you wish. By setting the
environment parameter $RAZOR_EDITOR (Not supported by PC clients.) to point to a script (most likely in
each user's home directory), the script will be passed the full path to the temporary file ($1) containing
the contents of the file specified along with the proper name of the file ($2). The sample script,
$RAZOR_HOME/examples/razor_browse, will bring up the vi editor in an xterm window and set the title
bar to the name of the file. Note that the script must remove the file specified in $1 when the browse
session completes.


To print a file from the Browse GUI, simply click the Print button at the bottom of the window. 


Reviewing history


Nearly every user action against files in the Razor database is recorded. Of special interest are all the
comments that were made as the files were checked in and out.
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By highlighting a single file from the main display list and then selecting the Info option from the Utilities
menu, the above panel will appear. Within it is a full accounting of the Info and History files that are part
of the Razor database. To best appreciate and understand these files, you may want to review their
structure, as defined in Razor   File  Formats section, " Audit Information ," and "A History file ."


Seeing how versions/files differ


Every version of a file under the control of Razor is recorded in the Razor database. It is often handy to
be able to quickly and easily view the changes that occurred in a file between versions. By highlighting a
file from the main display of the versions program and selecting the Diff option from the Utilities menu, a
panel similar to the one below will appear.  Only text files can be Diffed.
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The Compare option allows you to control whether you will be comparing two different versions of the
same file, or whether the program will compare a file within the Razor database against an existing file in
your directory structure.  The PC GUI for selecting a file outside of Razor is different than that of the UNIX GUI.


 


If the With a file outside of Razor option is selected, a File button will appear next to Cancel and an un-
editable File text field will appear below the Compare option. Selecting the File button will display a file
chooser window allowing a file outside of Razor to be compared. The selected file name will be displayed
in the File field.


You can also control the nature of the output that the comparison will generate, as shown by the
Options selection above.


After identifying which files and versions will be compared, selecting the Apply button will result in a
display similar to the one above. A series of key symbols will appear between the two sides. If the
center column is empty, then those portions of the file are identical. A greater than or less than symbol
will be used to point to which side contains unique lines relative to the other. A vertical bar indicates that
the identified lines are similar, but appear to have been edited.


The output may be saved using the Save button. A dialog popup will appear to allow the user to enter a
directory path and filename.


For more information, or a better understanding of this option, we'd encourage you to refer to the main
pages for sdiff on a UNIX platform.
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6.7.6 Checking Files Out


Of course, the reason files are stored in Razor is to provide a controlled mechanism for access and
modification. Developers obtain writable copies of the files by selecting the ones of interest from the
main display of the versions program and selecting the Checkout for Edit button. Doing so will bring up
the following panel.


The user must first decide where the writable copy of the file is to be placed. The directory name can be
typed directly into the Check-out to field, or the cd button can be used. Using the latter method brings
up its own panel which allows the user to 'walk' to the desired destination by mouse interaction with
scrolling lists (reminiscent of the methods discussed for introducing files).


For files being checked out that are included in one or more folders in the Razor database, they will be
placed into the Check-out to location including the appropriate subdirectories. When the Path is
absolute check box is selected, files will be placed directly into the Check-out to destination.


The Clear button can be used to clear the title and description entries. Cancel cancels the check out
action and returns to the main display. Help is, well, help.


Filling in comments


There are two mechanisms for associating user comments with the check-out.


After specifying where the files should be placed, the user must enter a brief reason why he is checking
the files out. This Title field must be filled in with something for the check-out request to be processed.


Separately, the user has the option of entering a longer, more thorough set of comments in the
Description field. These notes may be of whatever length and purpose deemed necessary. They will be
stored in the Razor database, and can be recalled later as necessary to gain insight as to not only
which files the user checked out, but what the thinking was at the time.
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NOTE: Many version control systems allow comments only when the file is being checked back
in. Razor allows comments to be made both before and after changes are made to the files. The notes
made during check-out of files can address what the developer is hoping to accomplish. These notes are
shown during the check-in process, and may be modified to reflect what actually got done.


Associating issues to editing activity


In addition to the above means of commenting on a check-out effort, users may directly relate the
activity to one or more issues in the problem tracking system. In many ways, this makes more sense
than making comments directly on the check-in or check-out panels themselves.   Razor's "out-of-the-box"
stance is to make this type of association optional; at the sole discretion of the user. It is possible however to
force users to make the association, based on local rules. An example of how this would be done is in the "
Writing Your Own Shell Scripts "section.


This is very powerful. It allows you to use the problem tracking system as the heart of your
development process, allowing you to directly associate what you are doing against the stated reason of
why you're doing it. This can come back and help later as you pull together threads which define your
product releases!  (See "Defining threads by related issues ").


In order to do this type of association, you of course need to have both the issues and versions tools
running at the same time on your display against the same database. Given that, the first step is to
identify the relevant issues from the problem tracking system. Once done, there are two different ways to
perform the association.


The drag-and-drop method2.


2. This feature is not available in the PC Client.


Once one or more issues are selected on the main display of the issues program, a small icon will
appear to the right of the toolbar, just below the menu on the main display. Grabbing this icon with either
the Select or Extend mouse button allows you to drag it over to the small scrolling list on the check-in/
check-out panel. This icon only appears if you are using Razor's version control tool and have groups
defined in the database. Of course, if you never create a versions control group, then you will never see
this icon


You can repeat this maneuver as many times as necessary.


The copy-and-paste method


After selecting one or more issues from the main display of the issues program, the user may use the
menu button of the mouse to bring up a small list of options. Choosing Copy Issues will push the list
onto an internal clipboard area for later use.


228


124







Razor Manual110


© 1992-2009 Visible Systems Corporation, All rights reserved.


After the issues have been selected, the user then returns to the versions program and brings the cursor
over the small issues scroll area on the panel. Again, by using the menu button on the mouse, a short
list of options will appear. Selecting Paste Issues will drop the issue numbers into the scrolling list.


This Copy-Paste effort can be done as many times as necessary to get an accurate list. The menu
associated with the small issues list also allows the user to select and deselect all members of the list
as well as delete members from the list if necessary.


TIP: If the issues program is running on your display against the same database (which it
probably is), you can double click on any of the issue numbers in the scrolling list to view a copy of the
full issue for review and possible modification.


The steps outlined here for associating issues to a check-out activity are the same as those that can be
used wherever version control commentary is allowed. This includes checking a file back in, introducing
new files to the database, etc.


6.7.7 Changing your mind


Although the linear evolution of information in a file may be a nice goal, it is seldom obtainable in
practice. The straight check-in, check-out actions described above result in a flow similar to the one
diagrammed below.


In the following sections we will explore some variations to that flow.


Uncheck-out files


It is frequently the case that a person will check out one or more files for modification, and later decide
that more files were checked out than were really needed, or that the edits were not worth putting back
into the database. In this case, the affected files would need to be unchecked. Doing so frees the
permission lock on the files without incrementing the version number, or affecting the file archive.


To do this, the user simply selects the files checked out from the main display list and selects the
Uncheckout button. A small popup will appear.
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The user will have a choice that the file remain where it was, or have it replaced with a read-only copy of
what it looked like prior to the check-out. It is assumed for this action that the file has not been moved
from where it was checked out to. 


NOTE: Occasionally, access to a checked-out file is required by someone other than the original
user. Users defined in the RAZOR_ADMIN role (see "Definable roles ") have permission to check a file
back in or uncheck it. This provides a work-around when a key implementor left a file checked out and
went on vacation.


Reverting files


Occasionally, a situation may occur where modifications were made to a file, and you wish to back them
out. In effect, you'd like to revert to a prior version of a file and pretend that the edits never happened. The
Revert option from the Utilities menu allows you to do exactly that.


Rather than delete the intermediate versions and completely lose whatever engineering effort went into
them, Razor allows you to take an earlier version of a file and leap-frog it to the front of the evolutionary
line.
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6.7.8 Using custom commands and utilities


The versions program is intended to be used primarily for the controlled archival of different versions of
files. Over time however, Razor support has received requests to allow the program to have extended
capabilities, above and beyond that of normal CM functions. To facilitate this, the program allows each
user to make personal additions to the Scripts menu bar option.


NOTE: The Razor Administrator may wish to control which users may create/modify/execute
user-defined scripts. Out of the box, Razor DISABLES the ability for users to create/execute their own
scripts via the Scripts pulldown menu. This feature is controlled via the Access_list file, specifically the
USER_SCRIPTS access control, described in " Access Controls ."


Selecting the Create/Modify option from the Scripts menu will bring up the following panel. This screen
allows you to add, delete, modify, and execute commands to and from the Scripts menu itself. Note that
the Scripts menu will only be active and available if there are one or more files selected from the main
display list.
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On the panel, the Menu label field holds the text that will appear on the Scripts menu itself. The
Command field holds the command string that will be executed. It is expected that the command will be
run against whatever files have been highlighted on the main display, and there are two methods of
invocation, as discussed below.


Adding serial commands


If you'd like to run the desired command once for each file selected, enter the command exactly as you'd
type it at the command line. The only exception is that you should put the key characters '##' wherever
you'd like the file name to appear at the time of execution. This type of approach is often used to employ
a print button, as shown above.


The command will be run from the RAZOR_TMP directory, and a read-only copy of the latest version of
each file will be made available there on each iteration. A small popup window will appear, counting down
the number of times it has run against the selected list. Upon completion, a window will appear on the
display showing the output of the full run.


NOTE: The versions program will be suspended while the commands are being processed. You
will need to wait for the series to complete before doing anything else with the versions tool.


Adding batch commands


If one of the arguments to the command entered on the panel is "-list", then rather than invoking the
command once for each file selected, it will be run only once. An environment variable,
$RAZOR_FILE_LIST, will contain the names of all the files selected from the main display.


If the flag "-list_versions" is on the command line instead of just "-list", then each line of the file pointed
to by the environment variable will contain not only the filename, but also the latest version number as
well.


The flag "-supress_cmd_output" (NOTE spelling) can be used to disable bringing up a panel if the
command (e.g. a script) does not have any output.


NOTE: As with the serial approach, the command will be run from the RAZOR_TMP directory,
and the versions program itself will be suspended until the command completes . Unlike the serial
approach, the output of the command is not saved and sent to the display.


Running commands


If the $RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables/Commands file exists, then the
commands it defines will be listed in the Commands pull-down menu on the main display. Selecting from
the menu will simply invoke the command as defined in the Commands file. The result is presented to
the user in an output window. Refer to "Commands " for the format and usage of this file.


The list of items selected from the GUI is made available to the script via the environment variable 
$RAZOR_FILE_LIST.
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6.7.9 Running reports


The Reports menu bar option on the main display pulls down to a collection of locally defined reports.
Reports can be either database (accessible to everyone who has access to the database) or user
reports (accessible only to you). Your Razor Administrator controls who can create and run each of
these types of reports. For details on creating reports, refer to " Defining reports " section.


6.7.10 Controlling your view


Displaying modification dates


Although not mentioned earlier, you are allowed to customize the information displayed on the main
scrolling list. Through the View menu option, you can show the date that each file was last modified,
and/or the number of days that have elapsed since the check-in occurred.


By enabling the Days since last mod (^l) option from the View menu, the display will widen and add a
note of the number of days since the file was last modified. Similarly, you can choose the Modification
date (^m) option from the View menu and the main display will now include the exact date of the last
modification of the issue.


As with the UNIX command ls, dates occurring more than 6 months ago are shown as the date and year
of the modification. Dates less than 6 months ago will display the date and time of day that the edit
occurred.


The above menu and associated hot-keys also give the user the ability to quickly open up a selected
folder, close a folder, select all files within a folder, etc.


Filtering the display


The versions program allows you to have hundreds or perhaps thousands of files within a single Razor
group. This in turn can yield a particularly long and unfocused list being presented on the main display.
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It's possible to reduce and restrict the list to only those files which meet certain selection criteria.
Selecting the Display Filter option from the View menu (or using the ^F hot key) will bring up the
following control panel.


Perhaps the best way of becoming familiar with the concepts of filtering the display list is to simply
experiment with the above panel. Nonetheless, the following notes should help you understand some of
the basic themes.


By entering text in the Filename pattern field, you can restrict the list to only those files that follow a
particular naming convention. For example, entering the string "land*.c" will prune the list to include only
those ".c" files beginning with "land". The Options menu allows you to toggle between using normal UNIX
style wildcarding or regular expressions 


(See "Regular Expressions ") for matching. 


NOTE: File names must include the folder name in order to match.


The Availability section gives you the ability to restrict the list to only those files that are either checked
in, or out for edit. It even allows you to quickly prune the list down to only those files out for edit by a
particular user or list of users separated by spaces. Furthermore, you can apply the filters to either files
on the main trunk of their evolution, or those that have branched.


Filtering by time modified


If you're interested in only viewing files that have been edited during certain time periods, then you can
take advantage of the Modified range field. Whether or not this criteria is used for filtering of the list is
controlled by the Disable toggle on the right side of the display. Selecting the Modified range button will
bring up a special panel for entry of the desired date/time range.
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The two rows of controls are used to define the start and stop of the date/time range. You can either fill
in the values directly by selecting the various buttons or set relative dates by selecting one of the
shortcuts available on the menu bar ("From", "To").


Filtering by matched attributes


The bottom section of the filter panel allows you to restrict the list to only those files that match
particular attribute settings. The nature and meaning of the attributes are configured by your local
administration and will most likely differ from what's shown in the example.


Executing the filter


As restrictions are entered on the panel, the left footer will show a count of how many files within the
group match your interests. Selecting the Apply button will cause the matched files to be displayed on
the main list. It's possible to have the count updated either on a keystroke by keystroke basis, or only
after typing a tab or carriage return. This personal preference is set from the Match while typing option of
the Options menu item of the filter panel itself.


6.7.11 Setting personal preferences


Certain aspects of how the versions program behaves are configurable on a user by user basis. Each
user can set defaults on a database basis which control how the program will initialize, execute, and
react in specific circumstances. A panel which lets you control these aspects of the program can be
brought up via the Tool Properties option on the Edit menu.







Using Versions 117


© 1992-2009 Visible Systems Corporation, All rights reserved.


For each database, the user can specify:


 Warn on overwrite of writable files - This is selected to provide a warning if an attempt is made to
checkout a file on top of a file which is in a writeable status.


 Warn on overwrite of readonly files - This is selected if the user wants to make sure that the file being
overwritten is read-only indicating that no edits are currently being done.


 Autoload checkin directories - This requests that the checkout directory path be prefilled in the checkin
window.


 Hide thread groups allows the user to see (unchecked) or not see (checked) the thread groups in the
Groups menu.


 Hide issue groups allows the user to see (unchecked) or not see (checked) the issues groups names
in the Groups menu.


 Get files in Unix text format allows PC users to get files in Unix format.


 Group to use at startup allows the user to define the default startup group


Note: Only file control groups may be used as startup groups.. If no entry appears here, the versions
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program will come up showing the first group in the Razor database, as determined by an alphabetical
sort. 


 Startup directory allows the user to specify the default directory path to be used for checkout
operations associated with the specified group.


NOTE: The Versions Props GUI allows a startup group and a default checkout directory to be
specified for each group. Both Versions and Threads will honor these settings. The Treads tool has no
GUI to specify a default checkout directory for a given group. However, if the user displays Threads
groups within Versions they can edit the default directory for a Threads group.


See also...


• "Using Threads "


• "Checking files in and out "


• "Making additional file control groups "


• "File and thread STATEs "


• "Remote UNIX Client Applications "


• "Razor PC Applications "


• "Customizing the Attributes file "


• "Attaching scripts to buttons "
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7 Using Threads


The threads program is the final piece of the Razor trilogy. It provides a mechanism for defining which
unique combination of files and versions "belong together" for the sake of a release or product build. This
section discusses how to use the threads program from a user's perspective. 


To start the program from a shell prompt, simply enter...


# threads &


Command line arguments are also permitted to override certain environment variable settings or permit
access to remote databases:


-universe <universe_dir>
-group <group>
-remote


Note: See "Remote UNIX Client Applications ."


-rc <file name>2


2. Permits the specification of an X resource file


-no_color3


3. Use the default desktop colors instead of the Razor-defined colors


Themes and concepts


Within Razor, a "group" is an organizational model. The versions program allows you to define which
files belong within which groups. All files in the same group are assigned a similar set of attributes,
although the attribute collection may vary from group to group.


Although the versions program provides a nice vehicle for monitoring changes on a file by file basis, it's
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often necessary to monitor changes to your effort from a broader perspective. Your product at any point
in time is defined as the union of a unique combination of files, at a unique mix of their relative versions.


A thread can be thought of as a collection of specific files that have been grouped together for a special
reason. One reason to group files together into a thread is for release/build management. As new
releases of a product are developed, the files (implying specific versions of those files) are gathered
together, tested as a whole, and ultimately released as a whole. The exact state of each file, as they
relate to the thread, can be reconstructed. A thread is what forms the relationship among specific
versions of files. Files are no longer thought of as individual, autonomous entities, but rather as what the
combination becomes. An individual source file that performs mathematical calculations by itself is not
worth much until it is packaged within the context of a system.


If we imagine a simple group containing only four files, then we could diagram how each file has evolved
from version to version, as well as how threads would come into play.


Each row of the above diagram shows how a single file within the group evolves from version to version.
The vertical (blue) lines which flow behind the rows represent threads. Each thread indicates a
relationship of which file/version combinations belong together. For example, the left most thread on the
diagram brings together main.c:1.6, init.h:1.6, color.c:1.2, and static.h:1.9. The only difference between
the second and third threads on the diagram is that they reference different versions of the file color.c.


The meaning and utility of a thread is completely up to the user. Each thread may be given a unique
name, and may evolve over time. The diagram above may be represented as four different named
threads, or a single thread that has gone through several changes itself.


Often, each Razor group will have a thread which defines the file/version combinations constituting a
product shipment or release. This special thread evolves over time to reflect the contents of each
release. Separately, threads may be defined to remember which combinations were compiled for the
sake of lab testing, or to create a test mix of files for quick experiments. The scope and utility are
completely up to the user.
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7.1 Threads main display


As with the other Razor programs, the main display is dominated by a large scrolling list containing the
names of all the existing threads for the defined group.


Header/footer


The window header will contain the program name. The left footer of the display shows file statistics. The
right footer will normally display the version number of the release of Razor you are using (not as shown
above).


Menu bar


The menu bar contains the menus File, View, Utilities, Commands, and Groups. 


 File contains file-related commands such as New Thread and Exit.


 View contains a collection of view manipulation and selection commands, like modification dates and
filtering options.


 Utilities contains threads manipulation commands like compare, generate, and extract.


 Reports permits the creation/modification/execution of reports. The menu consists of database and
user reports. Reports can be run by selecting them from the menu.


 Commands (optional) contains site-specific commands. 


Note: See "Running commands " for more details.


 Groups contains a list of threads groups available for this database. Selecting a different group will
refresh the list.
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Main list


The scrolling list displays the filename of each thread contained within the indicated group. Each thread
is shown with its highest version number.


7.2 Browsing Threads from Versions GUI


The easiest way view to Browse a Thread or Project is through the Versions tool. 


1. In Versions, go to Edit -> Tool Properties and uncheck "Hide thread groups".  Click OK.


2. Go to Groups -> Threads -> <threads_group_name>.  Now your threads are displayed.


3. Highlight desired thread and go to Utilities -> Browse.


4. Select the version of the Thread to browse and then click OK.  The contents of the Thread appear in a
Browse GUI.


Note: This is also handy if you want to view an Issue through Versions as well. Simply uncheck the
"Hide issue groups" option.


7.3 Edit Thread display


Threads are created and edited with the Edit Thread display, shown below.


Header/footer


The window header will contain the thread name being edited. The left footer of the display shows file
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statistics of the thread.


Menu bar


The menu bar contains the menus File, View, Selections, and Utilities. 


 File contains file-related commands such as Import, Save/Save as, and Cancel.


 View contains a collection of view manipulation and selection commands, like folder open/close and
filtering options.


 Selections provides automatic methods of selecting files for the thread as well as automatic methods
for branched file inclusion.


 Utilities contains threads manipulation commands like compare, generate, and extract.


File/folder list


The scrolling list displays the file/folder names contained in the group, along with their current version, an
inclusion flag, and the version included in the thread.


7.4 Creating and editing threads


To create a new thread, select the New Thread option on the File menu of the main display (or take
advantage of the hot key, ^N). To edit an existing thread, use the mouse to double click over the thread
of interest. In either case, the Edit Thread panel will appear on the display (as shown above), overlapping
the main threads window.


Note that while a thread is being created or edited, the main window of the threads program becomes
inactive. You can only manipulate one thread at a time. Also, while editing an existing thread, all other
users will be locked from accessing that thread until the edit session is complete.


The Edit Threads window lists every file within the defined Razor group, much as the versions program
would. The information displayed however is slightly different. Not counting the glyphs which appear next
to the file names, there are four columns on the display.


The first column will contain a "+" if the file is included as part of the thread definition. If it is not to be
included in the thread, then this column will be blank, as is the case for the file "Notes" above. For files
that are part of the thread, the 3rd and 4th columns show the latest version of the file, and which version
is actually included in the thread. Refer to " Filtering the display for the main Threads GUI " for more
on how to limit the main display list.


There are several means of editing a thread definition, as detailed in the following sections.
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Importing an existing thread


It is possible to absorb an existing thread definition as the starting point for creating a new thread, or as
a means of picking up where another thread left off. Selecting the Import option from the (Edit Threads)
File menu will bring up the following panel.


A list of all the existing threads for the group appears in the upper left corner of the panel. As selections
are made from that list, the upper right window will update to show all of the possible versions of that
thread. As the selected thread/version changes, the Title and Description fields will update accordingly.
After choosing a thread/version combination, selecting the Ok button will update the current thread to the
same definition.


Importing a version of a thread does not completely overwrite the version being edited. For example, let's
say a file was not included in version 1.5 of a thread but was included in 1.6. Further more, someone
edits 1.6 and then imports 1.5, the thread (which will now be saved as 1.7) will include the file that was
excluded in 1.5. That being said, the best way to think of importing a thread is that it works as a mask
rather than an overwrite.


File by file decisions


As files are highlighted on the Edit Threads display list, a small popup will appear. It allows the user to
decide on a file by file basis whether it should be included in the present thread definition.
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If the indicated file is excluded from the thread, then the scrolling list is inoperative. Otherwise, it shows
all of the possible versions of the file that can be referenced. Modifications to this popup panel have
immediate effect on the definition of the thread and are reflected on the main list itself. This option
provides the user with the highest granularity control over what file/version combinations belong in the
thread.


Including the latest version of every file in a thread


Of perhaps greater utility than the file by file process described above, is the ability to make broad,
sweeping decisions as to what file/version combinations should be included as part of a thread definition.


The simplest case is where we want to define a thread that includes all known files at their most recent
version. Choosing the Blanket Selections  option from the (Edit Threads) Selections menu (or using
the ^B hot key) will bring up the following panel.


To select the latest versions of all files, we'd set the top selector to Included, and apply the decision to
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All Files. We would not restrict the action to any particular filetype or Blessing. All that would be
necessary to enact the choice is to select the Ok button at the bottom.


Blanket selections


Let's build upon the concept of making broad file/version selections for a thread. Blanket Selections has
some powerful capabilities to enhance file selection.


The interface is divided into three key areas. Working up from the bottom, we have...


1. A list of attributes relative to the files within this group. This will be somewhat similar in style and
intent to the filter panel which is used in the versions program. It allows the user to define the scope of
files to be included in the selection. If none of the options for an attribute are selected, then there is no
specified preference for that attribute, and it is a guaranteed match. For example, if we wanted to select
only the "Doc" files, then that's the only Filetype that would be highlighted.


2. The scope of the selection can be further refined with the Apply to option. This defines what files in the
group or thread the selection will be applied to (The selection is only applied to files listed in the display list.)
Files that are part of "closed" folders will NOT be effected by the blanket selection.


3. The top selector controls whether the files identified by the selection are to be included or excluded
from the thread. You can not perform both include and exclude actions with one blanket selection, so it
may take more than one selection to complete your thread update.


A few examples may clarify how this interface can best be used.


 Say we wanted a thread that included not the most recent version of each file, but instead the version
that had last been brought to the Tested state. Simply set the Blessing field to Tested.


 We can use multiple passes with the blanket selection process to produce some nicely tuned effects.
If we wanted to combine the Tested versions of most of the files with the latest version of the scripts,
then we would first perform the selection described above, and then restrict the scope to the Scripts and
set the Blessing to Active for a second pass.


Increasingly complex illustrations can be made. The point is that through a little forethought and a
combination of the preceding functions, it is possible to quickly pull together any thread definition you
choose.


Defining threads by related issues


If you've been diligent enough to stay with our documentation to this depth, then we'll reward you with
what is perhaps the greatest gem in the Razor crown. You can define which versions of which files go
into a thread by whether or not they were affected as a result of working on one or more issues.


This is important, and bears repeating... You can define which versions of which files go into a thread by
whether or not they were affected as a result of working on one or more issues.


From the (Edit Threads) Selections menu, choosing the Include based on issues option will bring up the
following panel.
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The panel basically feeds the user from the top down.


1. From the issues main display, the user selects which issues to have considered for affecting the
contents of a thread. The issues can be associated here by either the drag-n-drop or copy/paste
methods. See section "The drag-and-drop method " or "The copy-and-paste method ." Notice that the
issues can be included from any of the issues groups defined for the database.


2. The middle section of the panel allows you to specify which file actions warrant having the file included
in the thread. If file promotions are being considered, then the promotion level must be specified. You
can choose whatever combination of actions.  Actions are defined in Table , " Action " you wish. Actions
other than those below may be entered in the Others field.


-Check-in actions include BUMP, CHECK-IN, CHECK-POINT, MERGE-CHECK-IN and REVERT.


-Introduce actions include INTRODUCE and INTRODUCE_AND_EDIT.


-Promote actions include PROMOTE.


3. The list of file/version pairs from the above decisions will be automatically generated and displayed for
your review in the bottom pane. 


4. Selecting the Okay or Apply buttons on the bottom will perform the edits to the thread.


The drag-n-drop method is typically used for selecting a small number of issues, so we support an
alternative method. The Load button on the bottom of the panel lets you refer to an external file which
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specifies a full list of all issues to be included. This file has the form <issue#> <issues group>,
one per line.


Trunks vs. branches


No, this is not a misplaced section from a tree surgeon's manual. Trunks and branches are terms Razor
uses to describe the state of divergent modification paths a file can take. A trunk version of a file is one
that does not have branches (sounds simple enough). A branched version of a file is one that has a
separate modification path, based at one point on a trunk version. Trunk version numbers have two
numbers, e.g. 1.22; branch version numbers have four numbers, e.g. 1.22.2.3, where the first two
numbers of a branched version number are the trunk version it was branched from. "Parallel
development" has a discussion of trunk and branch versions.


By default, Razor will only allow one version of a file (trunk or branch) to be included in a thread.  Pre-


4.1e releases allowed multiple versions of a file (trunk and branches) to be included in a thread.  This
behavior is set via the Selections pulldown of the Edit Thread dialog. The choices for selection are "Allow
selection of one trunk OR branch" (the default) and "Allow selection of any trunk AND branch".


With some of the methods ( "Importing an existing thread" and "Blanket selections" above, and " Defining


threads by related issues ")     available for editing a thread, it is possible for multiple versions of a file
(including trunk and branches) to be "eligible" for inclusion. Based on the default selection, Razor will
choose the highest selected version of the file for inclusion in the thread. If the version selected is not the
desired version, the user may select the appropriate version of the trunk/branch via manual selection. (
Refer to "File by file decisions" above.)


For example, let's edit the thread 'thread_test', choosing "Include based on issues . Refer to "Defining
threads by related issues "


The issues to be included have been associated to changes made to a trunk file and two versions of its
branches as follows:


I...-502        apple           1.5
I...-499        apple@1.4.1     1.4.1.6
I...-505        apple@1.2.1     1.2.1.2


Razor would select version 1.5 of the file 'apple' for inclusion in the thread "thread_test" as shown below:


+       apple           1.5             1.5     
        apple@1.2.1     1.2.1.2         --.--
        apple@1.4.1     1.4.1.6         --.--   
        apple@1.6.1     1.6.1.2         --.--


This default behavior may be modified by selecting "Allow selections of any trunk AND branch" via the
Selections pulldown of the Edit Thread dialog. The default behavior of these selections as well as making
one of these selections insensitive can be handled via an X resource, refer to the "X Resources "
section.


Saving it back to the database


After all of the necessary edits are completed, the new definition must be saved back to the Razor
database. If this was an existing thread that has been modified, then selecting Save from the (Edit
Threads) File menu will bring up the following panel.
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As when checking a file back in from being edited, the user is required to enter a title line. A longer
description of the change can be entered, as well as associating the action to one or more issues from
the problem tracking system.


Note: To change the attribute values for a thread, you must run versions and select the appropriate threads
group. Refer to "Changing attributes of files " for more information. Also, see " Customizing the Attributes file


 for a description on how to change the attributes for ALL threads in this threads group.


When the thread definition is saved back into the database, its minor version number will automatically
be incremented (i.e. if it was at 1.5, it is saved as 1.6). By setting the Increment Release toggle on the
panel, the user can force the major release number of the thread to go to whatever is entered as the new
release number indicated.


Finally, selecting the Ok button on the panel will cause the new thread definition to be stored back into
the database.


If this is a new thread, the only possibility from the (Edit Threads) File menu is to Save As a new thread
name, and the following panel will appear.
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A thread name must be provided, as well as a Title for the effort. And, as above, a longer text description
may be provided and the action can be associated with one or more issues from the problem tracking
system.


Since this effort is in effect similar to introducing a new file into the versions program, you will also have
the opportunity to provide the initial settings for the attributes associated with the thread. In the example
above, the Thread_type is being set to Experimental.


Note: To change the attribute values for a thread, you must run versions and select the appropriate threads
group. Refer to "Changing attributes of files " for more information on this procedure. Also, see "
Customizing the Attributes file  for a description on how to change the attributes for ALL threads in this
threads group.


Selecting the Ok button at the bottom of the display will cause the new thread to be entered into the
database at version 1.1.


7.5 Extracting threads and generating thread scripts


Threads are defined and recorded to gather the indicated file/version combinations. The purpose may be
to define a set of files for a full compilation of source code or to simply record a "snapshot" of the
database at a given time.


If the file group for which the thread is being created contains branches, you may want to consider the
extraction results of the multiple version selection for trunks and branches. As described in " Trunks vs.
branches ,"the choices are "Allow selection of one trunk OR branch" (default) and "Allow selection of
any trunk AND branch".


101


196


124







Razor Manual132


© 1992-2009 Visible Systems Corporation, All rights reserved.


If a file included in a thread was chosen based on the selection "Allow selection of one trunk OR branch"
then the extracted version of the file will be the one indicated in the thread.


Based on the example outlined in "Trunks vs. branches ," the extracted version of file 'apple' would be
1.5 as indicated below:


+       apple           1.5             1.5     
        apple@1.2.1     1.2.1.2         --.--
        apple@1.4.1     1.4.1.6         --.--   
        apple@1.6.1     1.6.1.2         --.--


If files included in a thread were chosen based on the selection "Allow selection of any trunk AND
branch" then the extracted version of the file will be the LAST included version that appears in the thread.


+       apple           1.5             1.5
+       apple@1.2.1     1.2.1.2         1.2.1.2 
+       apple@1.4.1     1.4.1.6         1.4.1.6
        apple@1.6.1     1.6.1.2         --.--


In this case, version 1.5 of 'apple' will be extracted to the destination directory which will then be
overwritten with version 1.2.1.2 and finally overwritten with 1.4.1.6.


The threads program allows users to directly extract read-only copies of included files to a specified
location or to generate a shell script which when invoked will extract read-only copies of included files.


Both the Extract Thread and Generate Script options are available from the Utilities menu. This menu is
present on both the main display and the Edit Threads window.


If the Extract Thread option is selected, the following panel appears.
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The top left corner of the panel contains a list of all the threads for the indicated Razor group. As different
threads are highlighted on that list, the scrolling list in the top right of the panel will update to show
various versions of the thread. The Title and Description fields will also update as necessary to show
what was entered at the time of creation.


The Set output directory button allows the user to navigate to the directory where the files should be
placed. The directory will be populated according to the Thread_rules file described in the section
entitled "Thread  rules" below.


Alternatively, if Generate Script is selected from the Utilities menu, the following panel will appear.
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The Thread and Version lists are as described for the Extract Thread panel. The Title and Description
fields will also update as necessary to show what was entered at the time of creation.


After selecting which thread/version the user would like to generate a script for, the destination directory
for the thread script must be specified. This can be done by either typing it directly into the Output script
for field, or by using the Set output directory button (which brings up a nice interface of its own).


The script that is being generated will gather together the indicated files, but it needs to know where to
extract the thread to. The Extract thread to field on the panel serves this purpose. Whatever text is
entered there is what the script will use as the top of a directory tree. As such, it can be either an
absolute path, or it can work relative to where the user is when the script is executed. It may also take
advantage of shell environment variables (such as $HOME).


When the Ok button is selected at the bottom of the panel, a shell script will be generated with the
name rz_build<threadname>_v<version>. For example, in the screendump shown above, a script named
rz_build_Release_v1.2 will be placed in the directory /home/snuffy/ivory. When that script is executed, it
will use the directory /local/buildarea as the base for its activity.


Thread rules


All the files within a thread do not need to follow the defined file hierarchy. It is possible to have the files
distributed into a directory tree of your design and choosing. We don't recommend use of this approach
except in unusual situations.
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NOTE: In other words, your thread should emulate your file hierarchy.


The Thread_rules file in the Tables directory establishes the rule set for directing where each file in the
thread should be placed. The file itself is similar to a series of case statements which determine the
destination subdirectory name based on the attribute settings of each file. It is common to use folders for


organizing development projects while extracting and building into a single folder. A short series of examples
are perhaps the best means of illustrating how thread rules would be used.


• If you expect that all of the files within a group can simply end up at the base directory itself, then all
that's necessary is a thread rule which catches all cases as the default, as shown here.


default: .


If the group contains folders, then subdirectories corresponding to the folder names will be created under
the base directory. The individual files will be placed into these folders.


• If we expand on the above idea a little, we can envision a similar situation, except that "Doc" files
should be put in a subdirectory called "notes".


Filetype:
    case Doc: notes
default:     .


• It is also possible to use the settings of ONE_OF_MANY attributes as variables that are expanded
when the script is generated. If we wanted to implement a directory structure where source code was
scattered across one of several possible subdirectories, then we may choose to have configured the
group to have a ONE_OF_MANY attribute called "Subdir". We could then use rules such as the
following...


Filetype:


    case Header: #Subdir#
    case C:      #Subdir#
    case Doc:    notes
default:      .


NOTE: The Thread_rules file applies to both the Generate Script and Extract Thread buttons on
the Utility menu.


Changing how files are extracted


When new groups are created, a file called Thread_script_template.sh is placed in the Tables directory
for the related thread. This template contains the method for file extraction. When a thread script is
generated, this file is copied to the destination script name, and the actual commands to get the read-
only copies of the files are appended to the file.


The lines that are added to the script are of the form shown below:


get_file <filename> <version> <destination> <is_binary> <new_name>
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...where <filename> is the file that is being extracted, <version> is the extracted version of that file, and
<destination> is the location to put the extracted file. The parameter <is_binary>, can have a value of
either "0" or "1", with "1" meaning the file being extracted is a binary file ("0" means it's a text file).
Lastly, the parameter, <new_name>, will only be used if the thread needs to extract a file that had been
removed from the database since this version of the thread was created; the archived filename will have
to be renamed to the original name.


The actual definition of the get_file command is what is provided by the template. By changing the
template file, you can in effect change the natural behavior of what the generated script will do.


For example, using the default template, as the script runs it will overwrite any existing file that happens
to already be in the destination. You may opt to rewrite the script such that the get_file command will
overwrite the existing file only if it passes some tests (which are up to your discretion).


NOTE: Changing this file will only effect the behavior for extract's that create a script. It does not
effect the GUI thread extract.


Before changing the template, it is suggested that you first study and understand the one provided. It is
well commented, and should serve as a good example.


In addition to the general template provided (above), a second script is placed into the Tables directory at
the time the group is created. 


Thread_script_after_template.sh. The contents of this file are appended onto the end of the final script
being generated.


The sample automatically provided does nothing more than 'exit 0'. You are free to change the contents
to be whatever you wish. A common example is to have the script kick off a compilation or massive print
job after all of the files have been properly retrieved.


7.6 Running reports


The Reports menu bar option on the main display pulls down to a collection of locally defined reports.
Reports can be either database (accessible to everyone who has access to the database) or user
reports (accessible only to you). Your Razor Administrator controls who can create and run each of
these types of reports. For details on creating reports, refer to " Defining reports " section.


7.7 Running commands


If the $RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables/Commands (See "Commands " in the


Razor File Formats section for the format of this file.)  file exists, then the commands it defines will be listed
in the Commands pull-down menu on the main display. Selecting from the menu will simply invoke the
command as defined in the Commands file. The result is presented to the user in an output window. To
add a visual separator to the list, put the SEPARATOR tag on a line by itself in the Commands file.


The list of items selected from the GUI is made available to the script via the environment variable 
$RAZOR_FILE_LIST.
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7.8 Comparing threads


It is often important and useful to be able to see what differentiates one thread from another. Fortunately,
there is a simple means of doing just that. By selecting the Compare option from the main display's
Utilities menu, the following panel will appear.


Selecting the Compare button at the bottom of the panel runs the analysis.  Two different thread analysis
tools are available.


Using the mouse, the user identifies which thread/version is to be on the left, and which is to be on the
right. Selecting the Compare button at the bottom of the panel runs the analysis. The output lists all files
currently in the group along with each file version. The last column identifies the type of change as "No
change," "Included," or "Excluded." If desired, the results can also be saved to a file with the Save
button.


SDIFF-BASED THREAD COMPARISON


By default, the UNIX-based sdiff side-by-side difference utility is used to compare the selected threads. 
The output lists all files currently in the group along with each file version.  The last column identifies the
type of change as 'No change", "Included", or "Excluded".  If desired, the results can also be saved to a
file with the Save button.
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GUIFFY-BASED THREAD COMPARISON


In Razor v5.3+, the Guiffy (include link to http://guiffy.com/) tool can be used to compare the selected
threads.


Guiffy Threads Diff


The Guiffy tool highlights and color-codes thread differences.  The Guiffy GUI includes 'Next', 'Prev'
buttons to navigate through the threads.  The Guiffy preferences can also be tailored to highlight only
differences, omitting elements common to both threads.


Use of sdiff or Guiffy for thread comparison is dictated by the 'Use Guiffy Tools setting' in Versions (Edit -
> Tool Properties)


7.9 Projects - Threads of Threads


In many cases, a development effort is the result of bringing together several threads from several
different groups. Since the coordination and management of these threads can itself become
complicated, Razor allows you to generate a special thread of threads, called a project. These are
defined and stored under the special group named -PROJECT-, which appears as the last option under
the Groups pull down menu.


The project editor


To create a new project, you must first select -PROJECT- from the groups menu, and then choose the
New Project option from the File menu. To edit an existing project, simply double click the mouse over
one of the existing project names listed on the main display. In either case, the Project Edit panel will
appear, as shown below.
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There are three columns to the rows on the list. They indicate the thread name, which version of that
thread is part of the project definition, and which Razor group that thread relates to. (Note that you can
control whether the list is sorted by the names of the threads or the groups they refer to with options on
the View menu).


Defining the collection of threads


Modifications are made to the project definition through the options on the Edit menu, as shown below.
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There are three elements which combine to form entries in a project definition. The first is the Razor
group the thread relates to, and is selected from the Groups menu. Secondly, for the selected group, the
upper left corner of the panel shows all of the known threads. Third, for whichever thread is selected, the
scrolling list in the upper right shows all of the possible versions of the thread. As selections are made in
the two lists, the Title and Description fields are updated to show what commentary was entered at the
time of creation.


If the panel is up in "add" mode, then selecting the Apply button will allow more and more items to be
added to the list. If the panel is up in "edit" mode, then apply only changes the definition of the particular
thread of interest.


7.10 Browsing Projects from the Versions GUI


The easiest way view to Browse a Thread or Project is through the Versions tool. 


1. In Versions, go to Edit -> Tool Properties and uncheck "Hide thread groups".  Click OK.


2. Go to Groups -> Threads -> PROJECT.  Now your Projects are displayed.


3. Highlight desired Project and go to Utilities -> Browse.


4. Select the version of the Project to browse and then click OK.  The contents of the Project (the
Threads that it contains) appear in a Browse GUI.


Note: This is also handy if you want to view an Issue through Versions as well Simply uncheck the "Hide
issue groups" option.


7.11 Controlling your view


Razor provides you with a variety of options for controlling and organizing what is presented to you.


Date information


As shown earlier, the main display contains a scrolling list of the names of all the existing threads for
the defined group. It is occasionally useful to also show information relative to when the thread was last
modified.


By enabling the Days since last mod(^l) option from the View menu, the display will widen and add a
note of the number of days since the thread was last modified. Similarly, you can choose the
Modification date (^m) option from the View menu and the main display will now include the exact date of
the last modification. A sample threads display with both Modification date and Days since last
modification would be shown.


As with the UNIX command ls, dates occurring more than 6 months ago are shown as the date and year
of the modification. Dates less than 6 months ago will display the date and time of day that the edit
occurred.
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Filtering the display for the main Threads GUI


The threads program allows you to have a large number of threads within a single Razor group. This in
turn can yield a particularly long and unfocused list being presented on the display.


It's possible to reduce and restrict the list to only those threads which meet certain selection criteria.
Selecting the Display Filter option from the View menu (or using the ^F hot key) will bring up the Display
Filter GUI.
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Perhaps the best way of becoming familiar with the concepts of filtering the display list is to simply
experiment with the above panel. Nonetheless, the following notes should help you understand some of
the basic themes.


By entering text in the Name pattern field, you can restrict the list to only those threads that follow a
particular naming convention. For example, entering the string "Test*" will prune the list to include only
those threads beginning with "Test". The Options menu allows you to toggle between using normal UNIX
style wild carding or regular expressions for matching. See "Regular Expressions " for more on
matching.


As restrictions are entered on the panel, the left footer will show a count of how many files within the
group match your interests. Selecting the Apply button will cause the matched files to be displayed on
the main list. It's possible to have the count updated either on a keystroke by keystroke basis, or only
after typing a tab or carriage return. This personal preference is set from the Match while typing option of
the Options menu item.


Filtering the display for a single thread


In the Edit Thread GUI it is also possible to reduce and restrict the display only to those files which meet
certain selection criteria. Selecting the Display Filter option will bring up the Display filter GUI.


Like the Display Filter for the main Threads GUI there is a Name pattern field. See "Filtering the display
for the main Threads GUI" above for more details. You can also specify that only certain 'file types' or
files at certain 'blessings' are displayed.
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Displaying just the files included in a thread
The Threads program allows you to have a large number of files within a single Thread.  By default, the
Edit Thread GUI will display all files in the associated Versions group. The files included in the Tread
appear with a '+' in front of the file name. Using the Display Filter in the Edit Thread GUI, the view can be
changed to include only files in the thread.


To display only files included in the thread:


1. From the Threads main GUI, double-click the desired Thread. The Edit Thread GUI will be displayed.


2. Choose View --> Open All folders.  This ensures all files are now displayed.


3. Choose View, --> Display Filter.  The Display Filter GUI appears.


4. Select "Display only files included in this thread."


5. Click OK.  Only the files included in the thread are displayed.


See also...


• "Using Versions "


• "File and thread STATEs "


• "Remote UNIX Client Applications "


• "Razor PC Applications "


• "Customization & Personalization "


• "Attaching scripts to buttons "
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8 Command Line Functionality


The Razor program set was designed to remove developers and managers from the drudgery of
traditional command line methods, and replace it all with a simple and pleasant mouse driven interface.
None the less, there are many people who prefer command line interactions, and there are in fact a
number of instances where it actually provides distinct advantages (such as incorporating Razor
functionality in shell scripts).


This section discusses some of the command line options available to UNIX and Windows 2000/XP
users.


NOTE: X resources (as described in "X Resources ") that change the behavior of Razor clients
do NOT affect Razor command line functions.


The "razor" program


Rather than come up with numerous separate commands, each with differing expectations of what's
required on the command line, we've opted to create a single program which can be directed to perform
all sorts of tasks.
To get a full list of what the 'razor' program can do for you, type...


# razor help


Note that the information resulting from the above command may include more options than what is
described here. In case of conflict, refer to the information provided by the command itself. Below are
some tables summarizing the command options and a reference to the section containing more detailed
information.


In each of the following examples, there are some common themes which are best covered here. Items
contained between square brackets ([]) are optional. If not supplied, defaults will be used. The backslash
(\) is used below to continue the single-line command on multiple lines. Do not include the backslash
when entering commands.
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a. See "Administrative functions ."


a. See "Password functions ."
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a. Unless  otherwise noted,  see  " Bringing up issue forms by command line ." 
b. See  "Changing promotion level / state by command line ."
c. See "Deleting issues "
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a. Unless otherwise noted, see " Checking files  in and out ."
b. See "Branching a file ."
c. See "Comparing file attributes ."
d. See "Creating a folder ."
e. See  "Promoting files and threads ."
f. See "Renaming a file or folder ."
g. See "Deleting files ."
h. See "Deleting folders ."
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a. Unless otherwise noted, see " Working with threads ."
b. See "Deleting threads ."


See "Time related functions ."
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8.1 Administrative functions


Discovering which version of Razor you have


The quickest means for finding which version of Razor you are presently running is to type the following
command:


# razor version


The program will print out the version number, patch level, and release data of the product. File 
$RAZOR_HOME/VERSION contains similar information. Note that if you have any of the GUI's up, you
will also see the version number in the bottom right footer of the display. The patch level is not displayed
on the GUI, but can be determined via the Help menu's On Version option.


Determining Razor usage


Another common query is to discover where and how Razor is being utilized on your system. By
entering the command...


# razor info


you will see a full breakdown of where the license manager is running, where the various database
servers are running, against which databases, and an accounting of each Razor user.


To determine who is connected to the database...


# razor who


lists the user, the application (issues, versions, or threads), and the machine they are connected to.


And in case you forgot who you were, or were wondering if Razor really knew who you are, enter the
command...


# razor whoami


Displaying system id


In order for us to generate license keys for a customer site, we need to have the unique id for the
machine that will be running the license manager. A simpler route is to enter the following command...


# razor id


The output of the above command is what must be sent back to razor_license@visible.com to enable
generation of license keys.


Modifying/reviewing the license information


The Razor licensing information is held in the file $RAZOR_LICENSE_DIR/Licenses, which is a simple
ASCII file. Although it's possible to enter the license keys directly to that file with a text editor, it's often
preferable to employ the razor program for this task. By entering the command...


# razor license



mailto:razor_license@visible.com
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...you will be prompted to enter the hostid and 4 keys which make up the license file. If there are already
values in the file, they will be offered as defaults within brackets; hitting the return key will simply accept
the default values.
The primary advantage of using this programmatic method for entering the keys (as opposed to doing a
raw edit of the license file) is that the keys are immediately validated and deciphered, providing a full
description of what your licensing status is. If there were any typing mistakes on entry, you'll know it
immediately, instead of discovering the problem later as you try to invoke the license manager (
razor_lm).


To view the license information, enter...


# razor license_info


You have a 5 seat license Your license never expires Your service contract expires on 12/31/2003
IssueWeaver is enabled.


Your output will most likely be different, but it will describe what type of license you have, including the
number of seats, when your service expires, and any optional products enabled.


Note: Your Razor license NEVER expires, but having a current service contract entitles you to all
product upgrades for all platforms, as well access to our world-class support.


Starting and stopping the license manager


Once the Razor environment has been established for the associated database (by sourcing an rz_prep
file), start the license manager as a background task. Refer back to " Modes " for details on the
operating modes of the license manager and the commands to use to start it.


You have the ability to limit who can execute the " razor lm_down" command. The file LM_Access_list
contains the Razor operation RAZOR_LM_DOWN and a list of users/groups/roles that may perform that
operation. See "Access Controls "for details on controlling who can do what.


Starting and stopping a database server


Once you have already properly utilized one of the rz_prep files associated with a database the following
command will bring up the associated database server process.


# razor up


And, just as simply, to bring the related database server down again, use the command:


# razor down


When attempting to bring a database server down, you will be warned if there are already people actively
using the database. If that is indeed the case, you will be given the option of abandoning or continuing
with the database shutdown sequence. 


You have the ability to limit who can execute the "razor down" command through the Access_list file.
For this and other operations that can be controlled, see " Access Controls ."
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8.2 Password functions


To use the following functions, the associated access controls must be enabled (refer to " Access
Controls ) for the Razor Administrator.


Creating/Modifying password information


To add a new user...


razor add_user [<user>] [<group>] [<passwd>] [<0|1> force passwd change at next login (=1)] [<0-365>
days until passwd expires] [<0|1> lock user account (=1)]


If the password is entered interactively, it will not be displayed.  Passwords are limited to 8 characters
and user groups are limited to 16 characters.  Empty (null) passwords should have no entry in the
password field.
For remote users, forced password changes at the next login can be requested. An entry of '1' will force
the user to change password.


Password aging can also be requested for remote users. A number from 0 to 365 is entered to set the
number of days a user's account can go without changing a password.


Remote users accounts can be locked (=1) and unlocked (=0).


TIP: We strongly suggest you avoid using null passwords.


To change a user's password...


razor passwd <user>


You will be prompted for the existing password, the new password, and a verification.


To modify a user...


razor modify_user [<user>] [<group>] [<passwd>] [<0|1> force passwd change at next login (=1)] [<0-
365> number of days before the passwd expires] [<0|1> lock (1) or unlock (0) user account]


If the user name is not specified, you will be prompted for the user name. You may enter a "q" to exit. If
the user group is not supplied, the current user group will be indicated along with a prompt for the "new"
user group.  Entering a <return> will not modify the user group.


Password changes can be forced for remote users. A '1' in this field forces a password change at the
next logon for remote users. A '0' will not force the password change.


Password aging may also be indicated for remote users. A number from 0 to 365 indicates the
maximum number of days a user's account can go without changing its' password
Remote user accounts can be locked (1) and unlocked (0).


To remove a user...


razor remove_user [ <user> ]
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Below is a series of command line examples adding a user called "bob" with no password in the
"vegetable" user group, subsequently modifying the password to "tomato", and then deleting the entry for
user "bob".


# razor add_user bob vegetable ""
# razor passwd bob
Current Password: (max 8 chars) 
New Password: (max 8 chars) tomato
Confirm Password: tomato
# razor remove_user bob


To lockout a user...


# razor lockout_user [<user>] [<0|1>]


A zero will unlock the account; 1 will lock the account.


When a user's account is locked, that user will be unable to login remotely to Razor.  This includes all
UNIX/LINUX clients using the -remote option and all Windows clients.  If the account is locked, remote
users cannot log in to Issues, Versions, Threads.


To set password aging....


# razor passwd_aging [<user>] [<0-365>]


Set the maximum number of days (0 to 365)the remote user account can go without changing
passwords. When a user's password expires, that user will be unable to login remotely toRazor with the
current password.  This includes all UNIX/LINUX clients using the -remote option and all Windows
clients.  In other words, if the password expires, remote users will be unable to log in to Issues,
Versions, and Threads until their password is changed.


NOTE: The script rz_group_passwd_aging may also be used to set password aging for a group
instead of a particular user.  The script is located in $RAZOR_HOME/scripts. Usage:
rz_group_passwd_aging [<group>] [<0-365>]


Displaying password information


Password information, including user name and user group, can be displayed for a single user or for the
entire password file. At no time will the passwords be displayed.


To display the password information for a single user...


razor user_info <user>


A sample of the output would look like this.


# razor user_info dave
User: dave Group: razor_remote


To display the contents of the Razor password file...
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razor passwd_info


Below is an example.


# razor passwd_info
User: george     Group: razor
User: no_user         Group: razor
User: test              Group: test
User: kathy             Group: razor


8.3 Checking files in and out


Although Razor was designed in part to help avoid the drudgery of command line efforts in favor of a GUI,
it is often handy to use the command line for special tasks. For example, some people may want to
generate Emacs extensions which bring files in and out of the version control system. Another common
need is to write a shell script which would do some mass edit of files under control. For example, by
using the command line options, a script could check dozens of files out for edit, modify them all, and
put them back without requiring a human to click around with a mouse.


Getting a read-only copy of a file


# razor -c get -f <file> -g <group> [-v version] \
[[-d dir] [-o] | [-z]]


If the optional -o flag is present, it forces an overwrite of any files that may already be there. If it is not
present, and a file of the same name is already in the suggested directory, then the program will stop to
query whether you want to overwrite the existing file.


If the -d flag is present, then files will be placed in the specified directory. However, the folder hierarchy is
not reproduced as would otherwise be done. This has the same effect as selecting 'path is absolute'
when using the versions GUI.


To force output to stdout, use the optional -z flag.


Checking a file out for edit & checking it back in again


# razor -c co -f <file> -g <group> [-d <dir>]\
   [[-i <issue[:<issue group>]>] ...] [-p <file>] \
   -t <title> [-o]
# razor -c ci -f <file> -g <group> [-d <dir> \
???[[-i <issue[:<issue group>]>] ...] [-p <file>] \
???-t <title>


Note that the primary difference between these two commands is the option for the -c flag. The string
"co" is used to check the file out from version control, and the string "ci" is used to check the file back in
again. Checking in a file from the command line always takes the file. If a readonly copy is required or
the file is to be checked back out for edit, then an additional razor command must be executed. If a
readonly copy is required, the command "razor -c get" must be executed.


The -f flag specifies the file name to be checked out/in, including the appropriate directory path, e.g. lib/
os_funcs.c. If a branch is being checked out, separate the branch version (x.y.z) from the file name with
an at-sign (@), e.g. server/status.cpp@1.12.1
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In both cases, the -t flag is required. The quoted string which follows it is entered into the History file for
the effort as the title. It's an opportunity to note why the file is being operated on. Additionally, an
optional -p flag pair can be offered. If present, the contents of the named file are entered as the
description prose in the history file. This allows for a more robust commenting mechanism.


If the optional -o flag is present on the check-out command, it forces an overwrite of any files that may
already be in the specified directory. If the flag is not present and a file of the same name is already in
the suggested directory, then the program will stop to query whether you want to overwrite the existing
file.


If the -d flag is present, then files will be placed in the specified directory. However, the folder hierarchy is
not reproduced as would otherwise be done. This has the same effect as selecting 'path is absolute'
when using the versions GUI.


It is also possible to associate any number of issues to either of the above check-in/checkout activities.
To do so, simply put "-i <issue[:<issue group>]>" flag pairs onto the command line. The <issue> can be
in either its fully annotated form (i.e. I..1-234) or as a simple integer value. Use ":<issue group>" to
specify issues from other than the default issues group. You may have as many -i flag pairs as
necessary.


Introducing a new file


Just as you can check files out or in, you may also need to introduce new files into the database using
the command line interface. The following command will perform the file introduction:


# razor -c intro -f <file> -g <group> [-b] [-k] \
[-d folder] [-i <issue[:<issue group>]>]


The <file> and <group> parameters must be specified, with <file> being the path, absolute or relative, to
the file being introduced. You may use the flag, -b, to introduce this file as a binary file; if not present,
the file will be introduced as text. The file will be introduced into the database at the top-level of the
group, unless you specify the -d <folder> flag; that option will specify an alternate destination in the
database. 


The -k flag is used to set the file property to "disable keyword expansion" by your selected archiving
engine. You might set this if you're using SCCS as your file control archiving engine and you need to
disable SCCS Keyword expansion, to avoid having a format string in your source code, such as, "%H%
M%S" expanded to "07/24/98M%S" when you perform a check-out readonly operation or browse a file.
By default, keyword expansion is enabled for all files.


It is also possible to associate any number of issues to the above activity. To do so, simply put "-i <
issue[:<issue group>]>" flag pairs onto the command line. The <issue> can be in either its fully
annotated form (i.e. I..1-234) or as a simple integer value. Use ":<issue group>" to specify issues from
other than the default issues group. You may have as many -i flag pairs as necessary.


Un-checking a file


It is also possible to uncheck-out a file by command line. As with the commands above you need to
specify the filename and group that it came from.


# razor -c un_co -f <file> -g <group>
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Only the person who checked the file out to begin with, or those listed in the RAZOR_ADMIN role (See "


Roles ,") are allowed to un-check it. Also note that the writable copy of the file that was obtained
during the original check-out effort will remain available; it is not affected by this operation.
 


Creating a folder


There may be an occasion when it is necessary to create a folder in a file control group, possibly as
preparation for a command line file introduction or the injection of existing SCCS/RCS archives. You may
perform this operation with the command:


# razor -c new_folder -f <folder> -g <group>


where <folder> is the name of the new folder, or the folder path and new folder name, when creating a
sub-folder.


Renaming a file or folder


Files or folders can be renamed within a file control group with the command:


# razor -c rename -f <file> -g <group> -n <new_name>


where <file> can be either a file or folder. If renaming to a folder, the folder path in <new_name> must be
an existing location in <group>. Just as in the versions GUI, this command cannot rename a file that is
currently checked-out for edit, a branch, or a trunk file with one or more branches. If renaming a folder,
there cannot be any files checked-out for edit within the folder or any of its sub-folders. Also, this
command cannot be used to rename issues, threads or projects.


Incrementing the major version of a file


When making major releases, some users like to be able to bump the major version number of all files.
The easiest way to do this may be via a script. The Razor command line interface supports this via the
following command:


# razor -c bump -f <file> -g <group> -t <title> \
[-r <new major>] [-i <issue[:<issue group>]>]


This operation will be treated as a file check-in and will execute any check-in before or after scripts that
may be configured in the Actions file. The RAZOR_ACTION environment variable available to these
scripts will be set to BUMP_BEFORE and BUMP_AFTER.


Note: See "Writing Your Own Shell Scripts " section. The major version can be set as well as
associating the bump action to an issue.


It is also possible to associate any number of issues to the above activity. To do so, simply put "-i <
issue[:<issue group>]>" flag pairs onto the command line. The < issue> can be in either its fully
annotated form (i.e. I..1-234) or as a simple integer value. Use ":<issue group>" to specify issues from
other than the default issues group. You may have as many -i flag pairs as necessary.


Obtaining a full text copy of an issue


# razor -c get_issue -f <issue> [-v version] [-d dir] \
[-g <issue group>] [-z] [-o]
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Issues are represented on disk as ASCII files which are managed by an archival engine to provide full
change histories for the information on the form. It is possible to get a read only copy of this raw data for
any incarnation of the issue form.


If the optional -v flag is not specified, then the program will get the most recent incarnation of the issue
information. If the optional -d flag is provided, the output will be placed in the indicated directory,
otherwise it will appear in the directory where the command was executed. The optional -o flag will force
an overwrite of any pre-existing files. Use the -g option to retrieve issues from other than the default
issues group.


To force output to stdout, use the optional -z flag.


Branching a file


You may branch a file from the command line with the following command, 


# razor -c branch -f <file> -g <group> -t <title> \
[-v <version>] [-p <file>] [-i <issue[:<group>]>]


The current version of the file will be branched unless the optional -v flag is used, e.g. -v x.y, to branch
version x.y of <file> that is currently at version, x.zz. A title is required to describe the branch action. A
more lengthy description may be added with the -p option for the recorded history. And finally, an issue
can be associated with this action with the optional -i option.


It is also possible to associate any number of issues to the above activity. To do so, simply put "-i <
issue[:<issue group>]>" flag pairs onto the command line. The <issue> can be in either its fully
annotated form (i.e. I..1-234) or as a simple integer value. Use ":<issue group>" to specify issues from
other than the default issues group. You may have as many -i flag pairs as necessary.


Comparing file attributes


There might be an instance where you have a need to compare the attributes of different Info files,
possibly in scripts you've written where you wish to check changes in different versions of the same
issue. You can perform a comparison of attributes or the state attribute values for different Info files by
running the command


# razor compare <file1> <file2> \
<ATTRIBUTE | STATE <Attributes file>>
        
where <file1> and <file2> are the Info files to be compared (paths to the files may be either absolute or
relative). You must specify which parameters you wish compared; either the ATTRIBUTE(s) or simply
the STATE attribute values. If comparing the STATE attribute values, you must include the path to the
Attributes file for the group. The output from this command will be directed to your terminal (or stdout).


8.4 Changing promotion level/state by command line


Promoting files and threads


There are occasionally situations where users may wish to promote a version of a file to a different
blessing. The following command will do that...
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# razor -c promote -f <file> -v <ver> -s <state> \
-g <group> [[-i <issue>[:<issue group]>] ...]


<state> is the new state you want to promote to. Threads may also be promoted via the command line.
The only difference between file promotions and thread promotions is that the group name must have
"##Threads" appended to its name.


It is also possible to associate any number of issues to the above activity. To do so, simply put "-i <
issue[:<issue group>]>" flag pairs onto the command line. The < issue> can be in either its fully
annotated form (i.e. I..1-234) or as a simple integer value. Use ":<issue group>" to specify issues from
other than the default issues group. You may have as many -i flag pairs as necessary.


Promoting issue states


Similarly, it is possible to advance an issue to a different state via command line...


# razor -c promote_issue -f <issue> -s <state> \
-g <issue group>


<state> is the new state you want to promote to. The normal rules governing permissions and
notifications will be enforced by the program.


This operation will be treated as a modify and will execute any modify before or after scripts that may be
configured in the Actions file. The RAZOR_ACTION environment variable available to these scripts will be
set to PROMOTE_BEFORE and PROMOTE_AFTER.


Note: See "Writing Your Own Shell Scripts ."


8.5 Bringing up issue forms by command line


There are certain situations where in you may want to have a script or 3rd party package direct the
issues program to either display an existing issue, or bring up an empty issue form such that a new
issue can be entered into the system. The issues GUI must be running on the machine where the
command line interface will be executed and must be subscribed to the same issues group that the
command is for. To pop up an issue form, you would use either of the following commands
respectively...


# razor popup_issue <issue[<:issue group>]>


# razor new_issue


The ability to pop up either prior or new issue forms provides an excellent integration point for connecting
Razor with existing methods and procedures at your site.


8.6 Modifying Issue Attributes


There are occasionally situations where it may be necessary to modify the contents of an Issue attribute
via the command-line, Issues create.apply after script, or Issues modify.apply after script.
The following command will allow you to edit attributes within a specific Issue:


# razor -c modify_issue -f <IssueNumber> -g <IssueGroup> -a <AttributeName>:
<AttributeValue>
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For TIME_STAMP attributes, you must use same format as specified in the Issue group's Attribute file. 


For TEXT_PANE attributes, you must specify the attribute value as the full-path to the file to replace
(Writeable TEXT_PANEs) or append to (AppendOnly TEXT_PANEs). This will either replace the contents
or append to the current text pane contents.


For ONE_OF_MANY attributes, you must specify one attribute value.


For X_OF_MANY attributes, you must specify attribute value(s) as a comma-delimited list (without
embedded spaces). 


For CHECK_BOX attributes, the valid attributes are: 0,1.


For TEXT_FIELD attributes, specify the text strings with embedded spaces using double-quotes.


NOTE: This command does NOT support modification of the STATE or the LABEL attributes.  The
STATE attribute type may be modified via the 'promote_issue' command.  The LABEL attribute is not
associated with a single issue.  Rather, it is applied to all issues within a given Issue control group.  The
LABEL attribute should be modified directly through the Attributes file for that particular Issue control
group.


8.7 Removing things from the database


PHILOSOPHY NOTE: These delete functions are not included in the GUI because they are
considered destructive. A simple misplaced click could destroy hours of work. Razor's philosophy is, if
you really want to delete something you should have to work a little harder.


NOTE: If the name of the object being removed from the database contains spaces (in either the
file or folder names), you MUST enclose it in quotes.


NOTE: ALL before scripts will be executed prior to removing files/folders.  If any before script fails,
the operation will be terminated and no files/folders will be removed.


Deleting files


It's possible to completely remove files from the version control aspect of Razor. 


# razor -c rm -f <file> -g <group> \
[-i <issue[<:issue group>]>]
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NOTE: Deleting files does not destroy existing threads that reference those files.


Deleting folders


It's also possible to remove folders (including all files contained in the specified folder) from Razor using
the following:


# razor -c rm_folder -f <folder> -g <group> \
[-i <issue[<:issue group>]>]


A list of the files contained in the folder will be listed for confirmation.


Deleting threads


Since a "thread" is a text file under control of a specially named group, we are able to delete it from the
database with only a slight variation of the command used for deleting files. For example, if we wish to
delete the 'Beta' thread from the 'apple' group, we could use the following command...


# razor -c rm -f Beta -g apple##Threads


NOTE: The named files/threads are not actually being deleted from the file system. They are
instead simply being hidden. This is done as a safety measure, and allows your Razor administrator to
actually retrieve it later if need be.


Deleting issues


Issues are ASCII files under version control, just as any other file. They are merely members of a special
razor group ++ISSUES++[.<issue group>]. Knowing this, it is possible to remove them from the
database using the same command line syntax as removing a file (above). A more comfortable
alternative however is to use the following command...


# razor -c rm_issue -f \
<issue[<:issue group>]> [-g <issue group>]


Note that the <issue> can be specified in its fully annotated form (I..1-234) or simply as a normal integer
value (1234). Use the -g option to specify an issues group other than the default.


TIP: Rather than delete issues outright, some sites prefer to keep them around for quite some
time. To prevent old ones from cluttering up their displays, they add an 'Obsolete' check box to the issue
form and then just filter out the ones they don't have a pressing need to see. This also makes future
deletion more orderly; they can filter to see only the Obsolete ones, sort them by the date of last
modification, and draw up their hit list.
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8.8 Working with Threads


Creating a thread


You may find it necessary to create a thread non-interactively (that is, without using the threads GUI) at
times. The following command line will perform this operation...


# razor -c new_thread -f <name> -g <group> [-n <list>] \
[-i <issue[<:issue group>]>] [-m]


The new thread will include the files and file versions specified in the <list> file. If the optional -n <list>
flag is not used, Razor will expect the list file to be in your current directory with the same name as the
new thread. The format of the <list> file must be a single line entry for each file to be included in the
thread. It is not necessary to have an entry for excluded files, but you may, if you wish, for
completeness. As it is, excluded entries in the <list> file are simply ignored, since this is the initial
instance of the thread. Each line must have 3 fields separated by 1 or more TAB characters, and be in
the form,


< + | - >  <file>  <version>


where '+' indicates inclusion, '-' exclusion and <file> is the filename, with folder path, if appropriate; and
<version> is the version of the file to be used in this thread.


You may use the -i <issue> flag to associate an issue with this operation. However, don't confuse this
flag with the selection option to "Include [files] based on issues". The "new_thread" command only
includes files for the thread based on the entries of the <list> file; there are no blanket, filtered, or
associated-issue flags from the command line to select files for the thread. The -m flag, if present, will
allow multiple versions of a branched file (trunk/branch) to be included in the new thread.


Note: See "Trunks vs. branches " for more details.


Generating thread scripts


The threads program offers a nice mechanism for generating a shell script which will gather the
appropriate files together for the sake of a product build or release. Occasionally, it may be handy to
generate this script directly from the command line (or more likely, from a controlling script). The
following command line will do this for you...


# razor -c thread -f <name> -g <group> [-t <dir>] \
[-v <ver>] [-d <dir>] [-o]


When using this command, the -f and -g flag pairs are required, and they note the name (file) of the
desired thread and its related group respectively. Unless specified otherwise with the -t flag, the files will
be gathered into the user's $HOME directory. The optional -v flag specifies which version of the named
thread will be utilized for the making of the script; the default action is to use the most recent version of
the named thread. The script itself will be placed in the current working directory, unless indicated
otherwise by the optional -d flag. And, as with other razor commands, the optional -o flag will force the
overwrite of any pre-existing script.


(In order for the above command and its various flags to make sense, you must already be familiar and
comfortable with what threads are and how they are used.)
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Duplicating a thread


To fit into some processes, occasionally it is convenient to be able to duplicate a thread via the
command line. The syntax for this operation is as follows:


# razor -c dup -f <name> -g <group> -n <new name> \
-t <title> [-i <issue[:<issue group>]>]


This operation will be treated as a thread creation and will execute any create before and create after
script configured in the Actions file. The RAZOR_ACTION environment variable available to these scripts
will be set to DUP_BEFORE and DUP_AFTER.


Note: See the section entitled " Customization & Personalization ."


Modifying a project / thread


It is possible to modify a project or thread through the command line interface. A file must exist with the
same name as the thread identifying the additions/subtractions. This file (or use -n to specify an
alternate file) contains a list of the additions/subtractions in the form:


# razor -c modify -f <name> -g <group> -t <title> \
[-v <ver>] [-p <file>] \
[-n <list> [-i <issue[:<issue group>]>]]


You must specify the <name> of the thread or project that will be modified, and the <group> (a thread or
project group). You must also provide a thread title with -t <title>, a quoted text string containing a brief
description of this operation that is recorded in the database. Additional comments of this specific
operation may be added to the database by using the -p <file> flag; whatever text, or "prose", contained
in <file> will be recorded in the history of the thread or project.


The thread or project will be modified by the entries in the <list> or change file. If the optional -n <list>
flag is not used, Razor will expect the file to be in your current working directory with the same name as
the thread or project to be modified. The <list> file contains a single line entry for each change that will
be made. The format of this file varies for threads and projects; a thread change contains 3 fields while a
project <list> file contains 4 fields. The list file must be in the following formats:


< + | - > <file> <version>


... and for projects 4 fields of the form:


< + | - > <thread> <group> <version>


where '+' indicates inclusion, '-' exclusion.
Use the -v option to modify the specified version. If no version is specified, the latest version will be
modified. You may also use the -i <issue> flag to associate an issue with this operation. However, don't
confuse this flag with the selection option to "Include [files] based on issues". The "modify" command
updates the thread or project based on entries in the -n file. There are no blanket, filtered, or associated-
issue flags from the command line to select files for the thread. The -m flag, if present, will allow multiple
versions of a branched file (trunk/branch) to be included in the modified thread. 


Note: See "Trunks vs. branches " for more details.


183


124







Razor Manual164


© 1992-2009 Visible Systems Corporation, All rights reserved.


Comparing two versions of a thread


From the command line, Razor can compare different versions of a thread, or compare two different
threads. The result of the compare will go to stdout, but can be redirected, as needed. To perform a
thread compare, run the following command... 


# razor -c thread_compare -f <name1> [-f <name2>] \
[-v <v1>] [-v <v2>]


One thread file name ("-f <name1>" parameter) is required, as is the group name. If the optional second
file name parameter is included in the command, the compare will be performed on two different
threads. 


If an optional version parameter ("-v") is used, it will be associated with the first name parameter. The
second optional version parameter will be associated with the second name parameter (if used) or the
second version of the thread for the comparison. When no version parameter is specified, the latest
version of the thread will be used.


8.9 Formatting text


Formatting text?


Yes, formatting text. There are a number of situations within the Razor flow of events where it is handy to
be able to judiciously add carriage returns to otherwise long, run-on sequences of characters. We opted
to implement a very simple text formatter, modeled after the 'fmt' program available with Sun's flavor of
UNIX.
The command line syntax for this function is...


# razor fmt [-width] [<filename>]


The program will read text from its standard input, or from the optionally supplied filename, and print to
its standard output. This is a simple text formatter which fills and joins lines to produce output lines of
(up to) the number of characters specified in the -width option. The default width is 80. Blank lines are
preserved in the output, as is the spacing between words.


8.10 Running batch reports


Reports can be generated in batch mode via the Razor command line. This is frequently helpful to be
able to generate reports periodically that produce say HTML files that are placed on a Web server for a
project team to view.
The command line syntax for this function is...


# razor -c report -g <group> -f <report name> [ -l <d | u> ]
[ -z ]


The program will execute the specified report and generate the result to standard output (if the -z flag is
used) or to a file with the same name as the report, with a ".rpt" extension.
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8.11 Time related functions


Internally, the razor programs hold time values as integers, and this is often reflected in how they appear
in the History and Info files. Refer to "Razor File Formats " for a description.


In order to make the parsing and manipulation of these files by shell scripts easier, we have provided a
few convenience functions.


A  UNIX/Windows 2000, XP platforms only.


See also...


• "Writing Your Own Shell Scripts "


• "Using Issues "


• "Using Versions "


• "Using Threads "
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9 Remote Command Line


The Razor remote command-line interface (CLI) allows a subset of the razor 'local' command-line
functionality to be executed on a machine other than the Razor server host. The Razor remote CLI is
supports UNIX clients, Windows clients, UNIX-based Razor servers, and Windows-based Razor servers. 


The remote CLI currently requires ssh, i.e. secure shell, for use in executing commands on the remote
Razor server host machine.  The remote CLI currently requires 'scp', i.e. secure copy, for use in
uploading/downloading files to/from the remote Razor server.


Rather than requiring the user to specify ssh-related and scp-related arguments on the command-line for
each operation, the CLI makes use of 'remote database connection profiles'.


A given profile caches all of the information necessary to execute Razor commands remotely for a given
Razor DB.  A user may create multiple profiles for working with multiple Razor DBs.  A particular profile
could be referenced on the remote CLI to indicate the applicable Razor DB.  In the absence of a
specified profile, the default profile,
$HOME/.defaultRmtRzConnProfile.xml is used.  It should be noted that the default profile can only
reference a *single* Razor database.


Here's how a profile could be created for use by an Apple OS X client to run the Razor command-line
remotely on a Linux-based Razor server.


razorRemote -c make_profile -conn /usr/bin/ssh -port 22 -copy /usr/bin/scp -host Glsclinux 
    -prep /usr/local/razoradm/razor_db/db1/rz_prep.sh -tmp /home/brian/tmp/cli


NOTE:  As no '-f' option was specified the profile is saved as $HOME/.defaultRmtRzConnProfile


NOTE:  The scp, ssh commands specify the command for execution on the CLIENT


NOTE:  The 'prep' option specifies the filename of the Razor DB prep file on the remote server


NOTE:  The 'tmp' option specifies the tmp directory on the REMOTE server


Let's dump the profile created in the previous example:


razorRemote -c view_profile


profile: [/Users/brian/.defaultRmtRzConnProfile.xml] conn: [/usr/bin/ssh] connOptions: [] xfer: [/usr/bin/
scp] xferOptions: [] user: [brian] host: [glsclinux] licenseDir: [/usr/local/razoradm/Razor_lm] razorHome:
[/usr/local/razoradm/Razor] userHome: [/Users/brian] prep: [/usr/local/razoradm/razor_db/db1/rz_prep.
sh] rmtTmpDir: [/usr/local/rztmp/remote]] JVM: [1.5.0_07-87] OS: [Mac OS X;10.4.9;ppc]


Usage:
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    razorRemote -c  make_profile -conn <connMethod> [-connOpts <options>]
                                 -copy <copyMethod> [-copyOpts <options>] -host <hostname> [-user
<username>]
                                 -prep <prepFile> -tmp <tmpDir> -razorHome <RemotePath> -licenseDir
<RemotePath>
                                 [-f <profile>] [-dbgLevel <level>]
    razorRemote -c  view_profile [-f <profile>] [-dbgLevel <level>] 


  Options:
       -c
               make_profile - Create default or named remote Razor DB connection profile for use with
                              subsequent remote command-line operations.  
               view_profile - View contents of default or specified remote Razor DB connection profile


       -conn      Connection method to be used to connect to remote Razor DB host.  E.g. 'ssh'
       -connOpts  Connection method optional parameters
       -copy      Copy method used to upload/download files to/from remote DB.  E.g. 'scp'
       -copyOpts  Copy method optional parameters
       -host      Remote Razor DB hostname.  Remote Razor command-line will execute 'local' razor
                  commands on this host
       -user      Username for Razor operations
       -prep      Specifies rz_prep filename for specific remote Razor DB to be used.


NOTE:  If the login shell being used by the remote user is Bourne-shell based the Bourne-shell based
'rz_prep.sh' prep file should be utilized.  Otherwise, if a csh-based shell is used the csh-based 'rz_prep'
prep file should be utilized.


- Hide quoted text -
       -tmp       Specifies temporary, working directory located on remote host
       -razorHome Specifies RAZOR_HOME on remote host
       -licenseDir Specifies RAZOR_LICENSE_DIR on remote host
       -f         Remote Razor DB connection profile filename.  If no filename is specified, the default
                  profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel  Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


    razorRemote -admin id                     - Display license id information
    razorRemote -admin license_info           - View license information
    razorRemote -admin version                - Display the current version information


    razorRemote -admin info                   - Displays connections to all db servers
    razorRemote -admin who                    - Display current connections to db server


File operations:
  razorRemote -c ci         -f <file> -g <group> [-d dir] -t <title> [-i <issue[<:issue group>]>[,<issue[<:
issue group>]]] [-p <file>] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c co         -f <file> -g <group> [-d dir] -t <title> [-o] [-i <issue[<:issue group>]>[,<issue[<:
issue group>]]] [-p <file>] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c un_co      -f <file> -g <group> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c intro      -f <file> -g <group> [-b] [-k] [-d folder] [-i <issue[<:issue group>]>[,<issue[<:
issue group>]]] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c branch     -f <file> -g <group> [-v version] -t <title> [-i <issue[<:issue group>]>[,<issue
[<:issue group>]]] [-p <file>] [-profile <file>] [-dbgLevel <level>]
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  razorRemote -c terminate  -f <file> -g <group> -v <version> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c get        -f <file> -g <group> [-v version] [[-d dir] [-o] | [-z]] [-profile <file>] [-dbgLevel
<level>]
  razorRemote -c get_issue  -f <issue> [-v version] [-g <issue group>] [[-d dir] [-o] | [-z]] [-profile <file>] [-
dbgLevel <level>]
  razorRemote -c new_folder -f <folder> -g <group> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c rename     -f <name> -g <group> -n <new_name> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c rm         -f <file> -g <group> [-i <issue[<:issue group>]>] [-q] [-profile <file>] [-dbgLevel
<level>]
  razorRemote -c rm_folder  -f <folder> -g <group> [-i <issue[<:issue group>]>] [-q] [-profile <file>] [-
dbgLevel <level>]
  razorRemote -c rm_issue   -f <issue> [-g <issue group>] [-q] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c modify_issue  -f <issue> [-g <issue group>] -a <attribute name:attribute value> [-profile
<file>] [-dbgLevel <level>]
  razorRemote -c promote    -f <file> -v <version> -s <state> -g <group> [-i <issue[<:issue group>]>[,
<issue[<:issue group>]]] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c promote_issue   -f <issue> -s <state> [-g <issue group>] [-profile <file>] [-dbgLevel
<level>]
  razorRemote -c dup        -f <thread> -n <new name> -g <group> -t <title> [-i <issue[<:issue group>]>]
[-profile <file>] [-dbgLevel <level>]
  razorRemote -c bump       -f <file> -g <group> -t <title> [-r <new major>] [-i <issue[<:issue group>]>[,
<issue[<:issue group>]]] [-profile <file>] [-dbgLevel <level>]
 
  Options:
       -c
               ci         - Check the specified <file> in.
               co          - Check the specified <file> out.
               un_co      - Un-check out the specified <file>.
               intro      - Introduce the specified <file>
               branch     - Branch the specified <file>
               terminate   - Terminate branch specified by <version> of <file>
               get         - Get a read only copy of the specified <file>.
               get_issue  - Get a read only copy of the specified Issue.
               new_folder  - Create a folder.
               rename  - Rename a file or folder.
               rm         - Remove the specified file.
               rm_folder   - Remove the specified folder and all of its files.
               rm_issue    - Remove the specified Issue.
               modify_issue   - Modify the specified Issue.
               promote     - Promote the file to the specified state.
               promote_issue - Promote the issue to the specified state.
               dup         - Duplicate the contents of the specified thread.
               bump        - Bump the major version of the specified file.
                            
The default is to increment the major version by one unless -r <new major> is specified.


       -a     Attribute name, value pair
               For TIME_STAMP attributes must use same format as specified
               in Attributes file.
               For TEXT_PANE attributes must specify attribute value as file
               to replace (Writeable TEXT_PANEs) or append to (AppendOnly
               TEXT_PANEs) current text pane contents.
       -b      Use binary archival.
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       -d      Optional directory to put/get file.  If none specified, use
               current directory.  For file introduction this name will
               represent the folder to introduce the file to.
       -f      Name of file on which to perform operation.
       -g      Name of group to which file belongs.  For issues commands,
               the <issue group> is the name of the group which appears
               in the issues Group pulldown.  For the main issues group,
               no group name should be entered.
       -i      An issue to relate to the operation.  More than one -i <issue>
               may appear on a line.  If the issue is in the default
               issue group, no <issue group> should be specified.  For other
               issue groups, the issue number must be followed by 
                       :<issue group>
               where <issue group> is the name that appears in the Group
               pulldown of issues.
       -k      Set file property such that keyword expansion is disabled.
       -n      New name.
       -o      Force overwrite of existing files.
       -p      File containing description text (prose).
       -q      No interactive query.  Do not ask user to confirm operation
       -r      Major revision number.
       -s      The state used for promotion.
       -t      Title for operation.
       -v      Version.
       -z      For get and get_issue operations, send output to stdout
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


9.1 Creating Thread Scripts


    razorRemote -c thread -f <file> -g <group> [-t top dir] [-v version] [-d dir] [-o]  [-profile <file>] [-dbgLevel
<level>]


    Options:
       -c thread -Generate a thread script.
       -d              -Optional directory to write script to.  If none is specified, current directory will be used.
       -f               -Name of thread to generate script from.
       -g              -Name of group to which thread belongs.
       -t              -Optional top level directory to populate in script. If none specified, $HOME will be used.
       -v              -Optional version of thread to generate script from.  If none specified, latest version will
be used.
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'
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9.2 Comparing Two Versions of a Thread or Two Different Threads


    razorRemote -c thread_compare -f <thread> [-f <thread>] -g <group> [-v <v1>] [-v <v2>] [-profile <file>]
[-dbgLevel <level>]


    Options:
       -f              -Name of thread to compare.  If two thread names are specified, the specified version of
each thread
                        will be used.
       -g             -Name of group to which thread belongs.
       -v              -Version to compare.  If one version is specified.
                        the latest version will be used.
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


9.3 Creating a Thread


    razorRemote -c new_thread -f <name> -g <group> [-n <file>] [-i <issue[<:issue group>]>] [-m] [-profile
<file>] [-dbgLevel <level>]


    Options:
       -c new_thread   -Create a thread.
       -f              -Name of new thread.
                        For threads, file contains 3 fields of:
                           < + | - >  <file>  <version>
                        where '+' indicates inclusion, '-' exclusion.
       -g             -Name of group to which thread belongs.
       -i              -An issue to relate this operation to.  See the '-i' description above for more details.
       -m            -Allow multiple versions of a file (trunk/branch) to be included in the thread .
       -n             -Alternate name of list file.  <name> is the default,
                        file should be in the format described for -f
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default 
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


9.4 Thread Editing and Project Editing


    razorRemote -c modify -f <name> -g <group> -t <title> [-v <ver>] [-p <file>] [-n <file>] [-i <issue[<:
issue group>]>] [-m] [-profile <file>] [-dbgLevel <level>]


    Options:
       -c modify   -Modify a thread or project.
       -f               -Name of thread or project to edit.
                        For threads, file contains 3 fields of:
                           < + | - >  <file>  <version>
                        For projects, file contains 4 fields of:







Razor Manual172


© 1992-2009 Visible Systems Corporation, All rights reserved.


                           < + | - >  <thread>  <group>  <version>
                        where '+' indicates inclusion, '-' exclusion.
       -g              -Name of group to which thread belongs or ++PROJECT++.
       -n              -Alternate name of change file.  <name> is the default
       -p              -File containing description text (prose).
       -v              -Modify the specified version.  If no version is
                        specified, the latest version will be modified.
       -t              -Title for the modification
       -i              -An issue to relate this operation to.  See the '-i' description above for more details.
       -m              -Allow multiple versions of a file (trunk/branch) to be included in the thread .
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


9.5 Report Functions


razorRemote -c report -f <name> -g <group> [-l <u | d>] [-profile <file>] [-dbgLevel <level>]


Options:


       -c report     -Run a report.


       -g              -Name of group to which the report belongs.


       -f               -Name of report.


       -l               -Specifies report locale (user or database).


       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used


       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or
'ERROR'


9.6 REMOTE COMMAND SAMPLE USAGE


% razorRemote -admin info


The license manager is running on GlscLinux.localdomain, pid = 4894


Remote Clients are using Local and Razor Password files


Connections: 


Database '/usr/local/razoradm/razor_db/db1/RAZOR_UNIVERSE',
is active on GlscLinux.localdomain, rz_server pid = 4944


1 -    brian is running Issues   on machine GlscLinux.localdomain, pid = 5551
2 -    brian is running Versions on machine GlscLinux.localdomain, pid = 5553


----


Database '/usr/local/razoradm/razor_db/demo/RAZOR_UNIVERSE',
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is active on GlscLinux.localdomain, rz_server pid = 5604
          
1 -    brian is running Versions on machine GlscLinux.localdomain, pid = 5613


There are 3 applications connected.


% razorRemote -admin who


Connections: 


brian is running Issues   on machine GlscLinux.localdomain.
brian is running Versions on machine GlscLinux.localdomain.


% razorRemote -c co -f ByteArrayPool.java -g db1_grp1 -d . -t "Adding RCS tags to header" -i I...-..5
0 [main] ERROR com.visible.cli.rmt.RazorRemote  - Remote command [/usr/bin/ssh   brian@glsclinux 
source /usr/local/razoradm/razor_db/db1/rz_prep.sh ;  RAZOR_LICENSE_DIR=/usr/local/razoradm/
Razor_lm ; export RAZOR_LICENSE_DIR ; RAZOR_HOME=/usr/local/razoradm/Razor ; export
RAZOR_HOME ; /usr/local/razoradm/Razor/bin/razor -c co -f ByteArrayPool.java -g db1_grp1 -d /usr/
local/rztmp/remote -t "Adding RCS tags to header"  -o  -i I...-..5 ] failed with status of [1] stdout [] stderr
[Overwrite flag [-o] required]
 
% razorRemote -c co -f ByteArrayPool.java -g db1_grp1 -d . -t "Adding RCS tags to header" -i I...-..5 -o


% razorRemote -c ci -f ByteArrayPool.java -g db1_grp1 -d . -t "Adding RCS tags to header" -i I...-..5
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10 Razor Special Features


In addition to the primary GUI's of the issues, versions, and threads programs, Razor also allows for a
great deal of tangential power. This is possible primarily because of the underlying structure of the
database. By having an ASCII based system, Razor is able to offer extended functionality through the
judicious use of shell scripts and e-mail.


Please note that we also offer an HTML (WWW) interface to the issues database. This product, called
IssueWeaver, is purchased separately. If you'd like to learn more about this, please contact us at
razor_sales@visible.com or download the manual from our Web site at www.razor.visible.com.


NOTE: Razor 2003 / 2000 / XP Server does not yet support e-mail entry of issues, database
synchronization, or e-mail query (remote access via e-mail).


Special features include...


· E-mail entry of issues
· Global tracking of issues
· Remote access by e-mail


10.1 Email Entry of Issues


Perhaps one of the most popular special features of Razor is the ability to submit new issues via e-mail.
This allows customers and service personnel to enter new problem reports directly into the system from
remote locations (or other machines at the same facility) without requiring access to a full network
connection or GUI.


NOTE: You must have Razor installed on the same platform as your mail server.


NOTE: E-mail entry of issues is done as the Razor user 'daemon'.  For a given issues group, the
permissions file:$RAZOR_UNIVERSE_DIR/DOMAIN_01/<IssueGroupName/Tables/Permissions
identifies the state transitions that are allowed for each user.  By default all users, I.E. "*", are allowed to
transition an issue from <InitialState> to <InitialState>.  If this table is updated to incorporate specific
users and/or roles, you need to ensure that the user 'daemon' is still allowed to transition issues from
<InitialState> to <InitialState>.  Likewise, you should ensure that $RAZOR_UNIVERSE_DIR/Tables/
Access_list or $RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables/Access_list includes user
'daemon' in the 'ISSUE_CREATE' entry.


Installation and set up


When a database is created, special shell scripts are generated:


$RAZOR_UNIVERSE_DIR/Scripts/rz_mail_issue_catcher
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Note: To turn off automatic success notification, the rz_mail_issue_catcher script must be modified to
set NOTIFY_ON_SUCCESS to 0.


$RAZOR_UNIVERSE_DIR/Scripts/rz_mail_issue_catcher.<issue group>


There will be a unique copy of this script for each database on your system as well as for each issue
group. An <issue group> name is the name that appears in the Group pull-down in issues (i.e. the issue
group name for ++ISSUES++.Test is simply Test). All that's necessary to take advantage of e-mail
submission of issues is to establish an e-mail alias at your site which will send the incoming message
off to the appropriate script for processing. Someone with superuser access will need to do the following
steps:


1. Define a user at your site as being the Razor administrator. Modify the /etc/aliases file on the
machine which processes the e-mail for your network by adding the following line: 


razor-admin: <username>


The <username> entry is a comma separated list of one or more userid's that will be notified if there are
problems.


2. Define the e-mail alias which will be used for the submission of issues. Enter this as another entry in
the /etc/aliases file. Mail sent to this alias will be piped directly into the above named script.


Note: The idea of configuring e-mail to go directly into a shell script is also explored later in this manual. See "


Scripts which receive and process e-mail ."  For example, if the alias you wish to use is "problem", and
the related database resides at /home/razoradm/razor_db, then you would add the following line:


problem: "| /home/razoradm/razor_db/RAZOR_UNIVERSE/Scripts/rz_mail_issue_catcher"


3. As superuser, run the newaliases program to record the changes to the file. There may also be some
additional steps to properly enable these modifications through NIS at your site. Your local sys-admin
people should be well versed on the necessary steps.


Once the above steps are complete, e-mail entry of new issues will be enabled. The script will take the
subject line of the message and enter that as the first TEXT_FIELD entry of the attribute section
(typically the title line). All of the remaining attributes on the form will take on their default values. The
body of the message will be entered in the first of the two text panes at the bottom of the form. 


Upon completion, the initial STATE will be related to the e-mail address of whoever submitted the issue.
E-mail will also be sent back to that person indicating the issue number that the entry was assigned.


Setting initial attribute values on e-mail submission


A simple text e-mail message sent to the defined address yields a very limited input mechanism. Only
the subject line and first text pane are utilized. If the e-mail message is properly formatted however, it is
possible to have direct control over the other attributes at the top of the form.


The e-mail message may contain a set of attribute/value pairs which will be parsed and used upon
receipt of the message. There should be only one setting made per line, and the collection of settings
must begin with the single keyword 'SET' and terminate with the single keyword 'BODY'. There should be
1 or more tabs separating the attribute name from the proposed value on each line.


The spelling and capitalization of the attribute labels, as well as the proposed values, must appear


228
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exactly as defined in the Attributes file for the database. When providing a value for a TIMESTAMP
attribute, it must be formatted exactly as called out in the Attributes file. Below is a sample e-mail
message, as it would affect our default attribute collection.


SET
Title           This is the preferred title
Priority        Low
Impact          Minimal
Projection      10/24/2003
Scope           Code, Library
Responsibility  Testing


BODY


And here's the text which will end up in the first of
the two text panes at the bottom of the form...


Since the formatting of the e-mail message is rather precise, and requires detailed knowledge about the
options available in the related Attributes file, it is best suited for use with automated processes such as
formatting scripts, programs, or intermediate interfaces.


Filling the second text pane on e-mail submission


In addition to the above functionality, it is possible to have some of the incoming e-mail message placed
in the first text pane, and some of it in the second text pane.
If present in the message, everything below the following line...


#=#=#=#=#=#=#=#=#=# --- SOLUTION --- #=#=#=#=#=#=#=#=#=#


will appear in the second text pane on the issue form. Please note that the separator line must appear 
exactly as shown. As with setting attribute values on e-mail submission, this functionality is best suited
for use with automated processes such as formatting scripts, etc. 


Modifying e-mail entry behavior


The rz_mail_issue_catcher script which does most of the e-mail processing is normally more than
adequate for most sites. You are not, however, required to use it, and may substitute one of your own
design in its place. This would allow you to perhaps preprocess the incoming messages and set various
attributes based on where the mail originated, lock out entry from certain sites or individuals, or change
its default response back to the originator.


We would recommend that rather than edit the script we provide, you copy it to a new name and refer to
your script in the /etc/aliases file. This will greatly reduce confusion if there are difficulties. Visible
Systems is, of course, not obliged to provide service for problems with anything but their own products.
As a general rule however, we'll do what we can to help.


Licensing considerations


The e-mail interface used to submit issues acts just like another issues user if you have purchased 5,
(or fewer), seats. Once you have more than 5 seats, e-mail submission acts like a parallel application
which means that you can have x simultaneous issues users and x simultaneous e-mail submittals.







Razor Manual178


© 1992-2009 Visible Systems Corporation, All rights reserved.


In other words, if you purchase 5 seats of Razor, and there are 5 copies of the issues program running
when an e-mail submission is being made, then it will be refused. All of the issues license tokens will
have been taken. If you purchased 6, (or more), seats of Razor, and that same number of issues
programs are in use, concurrent e-mail submissions will proceed with no problem.


10.2 Global tracking of issues


Another extremely powerful and popular extension of the issues program is the ability to run
synchronized problem tracking databases across multiple sites. 


How it works


Before trying to install and use the global tracking capability of Razor, it may be useful to introduce
some terminology and understand the underlying mechanisms.


One location is defined to be the primary database site (sometimes called the master site). This is
where the main copy of the problem tracking database is housed. All other locations are considered
secondary (or slave) sites; they work off mirrored copies of the primary database. You may have one or
more secondary databases.


When an issue is created or changed at the primary site, the Razor programs form an e-mail message
which is sent to a unique address at each of the secondary sites. Upon receipt of the message,
programs at the secondary sites parse the message and modify the affected issue.


A slightly more involved flow occurs when an issue is created or modified at one of the secondary sites.
In this situation, no changes are immediately made to the database at that site. Instead, scripts at that
site generate a specially formatted e-mail message and send it to a unique address at the primary site.
Upon receipt, the Razor programs parse the message and enact the requested change to the issue in
the primary database. From that point, the flow is similar to the above case; the primary server
generates an e-mail message back to all of the secondary sites.


Installation and set up


Installation of remote database synchronization is very straightforward; nearly all of the details are
managed by the running of a single script; rz_install_remotes (To create gloabl tracking of issues for other


than the default group, invoke the script with the group name, e.g. rz_install_remotes ++ISSUES++.
<group>.) Below is a sample running of that script, as it would appear when run from the primary site.


# rz_install_remotes


This script will install/update your remote database synchronization for the issues program. One site will
control the main database and all other sites will receive updates from the main database.


Will this location have the main database? [y] y


The database synchronization is handled via email. You must define an email address at both sites to receive
updates. If you have already run this script at the other site, respond with the email address you defined at that
time.


Local email address to be defined by this site? db_primary


Remote email address to be defined by the other site? db_secondary@slave.site
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Installing remote database synchronization...


Please have your System Administrator add this line to the /etc/aliases file or NIS table:


db_primary: "|/local/RAZOR_UNIVERSE/DOMAIN_01/++ISSUES++/Scripts/issue_catcher"


If you have not yet run this script at the other site, please do so now.


Additional remote sites may be entered in the file:


 /home/RAZOR_UNIVERSE/DOMAIN_01/++ISSUES++/Tables/Slave_sites


After running the script at the primary site, you will need to make the edits suggested in the output to
the appropriate /etc/aliases files at each site. The information above is simply for the sake of an
example. You will need to honor the information presented by your local execution of the script.


After having set up the primary site, the same script would be run at the secondary site(s), again
honoring the suggested edits to the /etc/aliases file. Once completed, the synchronization of remote
databases will be in effect.


Things to be aware of


It is important to recognize that when a user makes a change to an issue at a secondary site, it will not
appear in their local database until the e-mail leaves that site to go to the primary, gets processed there,
and returns in a related message. The amount of latency between the origination of a change and its
manifestation in the local database will be a function of the underlying e-mail connectivity.


With this flow of events, there is an opportunity for a collision of efforts. It is possible for two people to
attempt simultaneous edits to the same issue at different sites. If/when this happens, the first change
that is received by the primary database server is the one that has precedence. The second change is
rejected. There will be no data loss, however, as the originator of the second change will receive a
message by return e-mail, explaining what the problem was. Users then have the option of re-entering
the modification.


The Permissions files (which control who may bring about state changes to issues) have
local jurisdiction. In other words, users at the primary site are forced to honor the local
permissions. Users at the secondary site must honor the local permissions.


10.3 Remote access by e-mail


The final special feature discussed in this section is not really unique to Razor per se but is actually just
an extension of UNIX that can be implemented independently. It allows a site to arrange for incoming e-
mail messages to be parsed and run as a series of UNIX commands, with the output being sent back to
the originator of the message.


What we have done, however, is put together a series of scripts and methods which make the setup of
this capability fairly straightforward. The mechanisms also provide for a modest level of security. The
original intention was to provide a means of letting people at remote sites do queries on the Razor
database through simple e-mail messages, but the scope can actually be much greater than that.


How it works
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After the system has been put in place, the following sequence describes what happens when e-mail
has been received.


1. The script which catches the e-mail (rz_query) does some initialization steps, basically setting itself
up to point to the proper Razor database.


2. The incoming e-mail message is caught by the script and the full contents are stored in a temporary
file. The "From" and "Subject" lines of the message are noted.


3. A brief e-mail message is sent to the local Razor administrator, letting her know that this type of
activity is going on.


4. A lookup occurs to see if the originating e-mail address has been equated with a local user account. If
not, then e-mail is sent back indicating that the person was not properly registered to perform this
activity, and nothing else happens.


5. If the external address properly equates to a trusted userid the e-mail message (saved from above) is
passed to rz_mail_catcher 


(If you have customized this script, it should exist in the database directory called Scripts.), found in the Razor
installations script directory, for processing.


NOTE: It is expected that if you plan to implement this feature you will be first curious about and
ultimately comfortable with specific details on how it is all implemented. We encourage you to examine
all of the relevant scripts; they are fairly well commented, and we welcome your feedback.


6. Installation and set up


The first step in configuring your site for this functionality is to establish two e-mail aliases for your
system. Have someone with superuser access add the following lines to your /etc/aliases file...


razor-query: "|<fullpath to RAZOR_UNIVERSE>/Scripts/rz_query"
razor-admin: <local razor administrator>


... where the text within the brackets are expanded out as necessary. At a minimum, you will need to
run the newaliases program to make the new aliases fully functional.


Each user that wishes to take advantage of this capability needs to run the script rz_mail_signup,
supplying it with the expected e-mail address to be writing in from on the command line. This script
sends a request to the razor-admin address (established above), asking that an entry be made in the
trusted_users file. To get the latest copy of rz_query, users should run $RAZOR_HOME/scripts/
rz_install_email_query.


Upon receipt of the e-mail'd request, it is up to the discretion of the razor administrator whether or not
the user should be granted this level of access. The message details how to edit the file
$RAZOR_LICENSE_DIR/trusted_users. As a courtesy, the administrator should e-mail back the
resolution status of the request.


Controlling access


If at any point someone needs to be removed from the list of trusted users, it can be done through a
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simple edit of the $RAZOR_LICENSE_DIR/trusted_users file. The syntax of the file is fairly
straightforward, but you can still refer to "trusted_users ."


E-mail commands


Once you have followed the steps to this point, you will want to add one of the following commands to
the body of the e-mail message:


get a read-only copy of a file
RAZOR_GROUP=<group>
razor_get <filename>
check-out a file
RAZOR_GROUP=<group>
razor_co <filename>


check-in a file
RAZOR_GROUP=<group>
razor_ci <filename>
<include the body of the file to be checked in>
RAZOR_FILE_END


Note: Razor does not support the capability to attach files when using rz_query since the various
mailtools handle attachments in a slightly different manner.
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11 Razor Customization & Personalization


One of the greatest assets of Razor is its versatility. Through a simple collection of ASCII files, you have
the ability to configure the tool to function and assist your efforts in a myriad of ways. 


Razor's default settings allow you to use the product very nicely "out of the box". You are free to accept
the defaults as is, use them as a starting point for your own efforts, or abandon them completely in favor
of your own unique and specific needs. One place to look for examples is in the $RAZOR_HOME/
examples directory. This directory contains a collection of files/scripts that do all kinds of useful utilities.
There is a README file that lists each of the files and a brief description and usage.


· Containers: databases, groups, and folders


· Basics: defining the terminology


· Customizing attributes
· Controls


11.1 Containers: databases, groups, and folders


Razor provides significant flexibility on organizing, processing, and viewing your data. It is not for us to
say how you should organize your data. We offer this brief discussion of the three basic types of
"containers" employed by Razor as food for thought when you are configuring your database. The three
containers of information within Razor are: databases, groups, and folders. Here is a picture to get us
started...


Databases


A database is a collection  (We intentionally leave the term "collection" undefined. You can define it


appropriately for your application. of information related by a common theme. There is no association, in
the Razor sense, from one database to another. Company projects or products would typically be
maintained in separate databases. Each database generally has a team of people, like a project or
product team, accessing it.


Note: People can access more than one database, but information is not shared between them. Keep in
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mind that there is a separate Razor server for each database, so databases are brought up, managed,
accessed, and brought down independently.


Here are some considerations with respect to separating data into different databases:


 Databases are easy to create.


 There is minimal overhead to have multiple databases.


 The smaller the database, the less time it will take for the server to come up.


 For databases, controls (e.g. access lists, user roles, etc.) are implemented at the database level.
There are no Razor-level database controls that span databases.


 Databases are "owned" by a single user. That user is the only one who requires read/write access to
the database. All client database access is performed by the database server.


Groups


A group is a "narrower" collection, contained within a database. There are issues groups and file control
groups. File control groups support versions (on a file-by-file basis) and threads  (a specific version of
each file for a product or project release). Each group has unique and distinct attributes. Groups can
have their own set of controls, or can be controlled at the database level.  3. See "Themes and concepts


" for a discussion on threads.


Issues groups are used to track virtually any information that has a status which changes over time.
Issues from one group can not easily be related to issues in another group. Issues can be related to
activity within any of the file control groups. For example, issues containing product change requests
can be related to file change history for that product as well as related documentation. 


File control groups are independent of each other but operations on files can be related to issues.
Projects exist within a project group and are composed of threads from one or more thread groups.
There is one and only one project group per database, but there is a thread group for every file control
group in the database.


To discuss relationships among groups consider an organization that has three different divisions:
Development, Support, and Sales. Examples of groups could be:


Note that the use of some issues groups may overlap with the different organizations. There might be a
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separate file control group for each product of a family of products, e.g. Word Processor, Spread Sheet,
Presentation Manager. Conversely, these products might be included in a single file control group if there
is a lot of commonality between them.


Let's see how issues groups can be used to relate activity to file control groups with the above simple
example. On the issues side, the development team conduct regular peer reviews during the course of
the design and implementation. Development test logs are initially generated by developers and then
verified by the support team. All three groups contribute to issues relating to the products development -
with sales suggesting feature requests received from customers, support identifying problems, and
development inputting both enhancements and problem reports. Sales staff take customer orders for
products. Action items from meetings can be tracked across the development and sales teams. 


Each division has responsibility for various file control groups - some shared responsibility and some
sole responsibility. Development is solely responsible for the source code of their product. Developers
may generate their own test data that is then used or augmented by support. Support may also, with
inputs from the development team, be responsible for product documentation - both hard copy and Web-
based information. Sales contributes to Web pages as a marketing function, but also maintain their own
sales literature.
Here are some considerations with respect to separating data into different groups:


 Groups are easy to create.


 There is no overhead for multiple groups.


 Each group has a different set of attributes.


 Groups can override controls implemented at the database level.


 Switching between groups provides a completely new view of the data.


Folders


Folders are the simplest collection. They contain files and are a way of grouping related files. Only file
control groups can contain folders. With few exceptions, the folder hierarchy you use in Razor will mirror
the directory layout on disk.


Here are some considerations with respect to separating data into different folders:


 Folders are easy to create, and can be done without restarting the database server.


 Folders only apply to file control groups.


 There is no overhead for folders.


 Folders organize logically related files, e.g. libraries.


 Folders can be moved or renamed.


 File names, including their containing folders, must be unique in Razor.


 Folders can contain files and other folders.
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 Folder hierarchies are honored when files are extracted with the versions and threads tools (but can be
overridden).


11.2 Basics: defining the terminology


The Attributes file


One of the most important configuration files for the Razor tool suite is Attributes. There is a copy of this
file within the Tables sub-directory for issues, each of the defined file groups, each of their associated
thread groups, as well as the project group.


Note: It may be helpful to examine how the Razor database directory structure is organized by
referring to the text and diagrams in "Razor Directory Layouts ."


The full syntax for the Attributes file is provided later in this manual. This nicely commented file is
generated during the creation of a new database or group. You are encouraged to refer to these
comments for specific details on how to edit the file itself. Below is an example of the out-of-the-box
issues Attributes file.


NOTE: While Razor comes pretty-well equipped out-of-the-box, the configuration files are intended
only to be a starting point. You are encouraged to customize these files to meet your specific
requirement.


# 
# Standard RAZOR data file rules apply.  Empty lines and those beginning
# with a hash ('#') are ignored.  These may be sprinkled liberally
# throughout the file.
# 
# All other lines must contain at least three (3) TAB SEPARATED fields.
# If there are fewer than 3 fields, the program errors out.  Some attribute
# types allow/require a 4th TAB SEPARATED field.  The first field denotes
# the type of attribute item, and it must be one of the following...
# 
#    CHECK_BOX
#    TEXT_FIELD
#    ONE_OF_MANY
#    ONE_OF_MANY_STACK
#    X_OF_MANY
#    TIME_STAMP  (issues only)
#    LABEL
#    STATE
#    ONE_OF_MANY_LIST
#    X_OF_MANY_LIST
#    TEXT_PANE
# 
# The second field is the label you want associated with the item.  Since
# this is a tab delimited file, it is possible for the label to contain
# embedded spaces, however, we STRONGLY discourage this.  The RAZOR programs
# will append a colon (':') to the text when displaying it on screen.
# 
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# The third field is required, but the syntax differs for each of the
# possible attribute types.  Please refer to the documentation for
# details.
# 
# For ONE_OF_MANY, ONE_OF_MANY_STACK, X_OF_MANY,
ONE_OF_MANY_LIST and
# X_OF_MANY_LIST an optional 4th field defines the number of rows to
# display the Attributes.
# 
# The TEXT_PANE attribute is used to label the two scrolling text areas
# at the bottom of the issue form.  The attribute name MUST be of the
# format 'TEXTn' where 'n' is 1 for the first text area, 2 for the second.
# The third field in the TEXT_PANE definition will be the string used to
# label the text area.
#
# For the TIME_STAMP, the third field is the time format and may be in a
# form as specified in the man pages for gmtime or ctime.  An example of
# a time format would be the string %D.  This would display the date in
# the format MM/DD/YY.
# 
# The fourth field of the TIME_STAMP attribute is a comma separated list
# of flags of the following format:
# 
#I=<nn>-Defines an increment in days to be added to the
# current date.
#P=[Y|N]-Defines if this field should automatically be
# loaded when a new Issue is created.  The default
# is N.
#R=[Y|N]-Defines if entry of the field is required.  The
# default is N.
#U=[Y|N]-Defines if the field should automatically be
# updated when an Issue is transitioned to the
# modify state.  The default is N.
#W=[Y|N]-Defines if the field is writable.  The default
# is Y.
# 
# NOTE:  For the issues program, the first field MUST be a TEXT_FIELD.
# This text field is shown on the main display as the title for the
# issue.
# 
# CHANGING ATTRIBUTES:  After you have created some issues, you may
# find that you would like to change or add attributes.  To ADD an
# attribute or add a value (including a state) to an existing attribute, 
# take the database server down ("razor down") and edit this file.  
# To RENAME or REMOVE an existing attribute and/or an attribute value
# (including a state), take the database server down and use one of
# the following scripts that may be found in $RAZOR_HOME/scripts:
#
#rz_rename_attr, rz_rename_attr_val 
#rz_remove_attr, rz_remove_attr_val
#
# These scripts will update the Attributes file and the existing
# database.  Refer to the manual for details.
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#
#
TEXT_FIELDTitle50
ONE_OF_MANYPriority---, Low, Medium, High, Urgent
ONE_OF_MANYImpact---, Minimal, Medium, Severe


STATEStateSubmitted, No-Action, Active, Completed, Closed


TIME_STAMPProjection%m/%d/%YI=7,P=Y


X_OF_MANYScopeCode, Systems, Documentation, Library, Marketing, Testing


CHECK_BOXApprovedNo


X_OF_MANYResponsibilityEngineering, Testing, Management


TEXT_PANETEXT1Description of Problem


TEXT_PANETEXT2Actions Taken


Since an understanding of attributes serves as a cornerstone to all three programs in the Razor tool set
and since the syntax and nature of the controlling file is the same, it is discussed first.


Attribute types defined


Below is a summary of the primary attribute types, how they may be used, and how they end up
appearing on your display. In the hope of clarity, the typographic convention " " is used to denote
the tab character. You are actually allowed to use as many tabs as you wish to separate the fields in
order to make the file look more columnar.


NOTE: Although the syntax and mechanisms of Razor allow it, we strongly discourage the use of
punctuation characters in either the attribute labels or possible values; these tend to confuse or
complicate efforts to parse the resulting ASCII database files with UNIX utilities such as awk or perl.  


The syntax also allows for spaces to be used in attribute labels (but not the values), however, we, again,
discourage their use. Instead of spaces, we would recommend using either the underscore character (as
in "Due_by"), or Hungarian Notation (as in "DueBy"). Choose attribute labels and values much as you
would choose variable names in a program.


IMPORTANT: Before modifying an Attributes file, be sure to bring down the database server.
Restart the server for the changes to take effect.


CHECK_BOX


A CHECK_BOX is conceptually an X_OF_MANY which offers only one option. That single option can
then either be selected or not selected. The syntax for specifying this attribute type is as follows:


CHECK_BOX <label_name>
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Note:  label_name throughout this section refers to a label given to the attribute. This name should not
contain any special characters (like commas, quotes, etc). The label name is the way the attribute is
referred to in various Razor commands and controls. <default_value>


The <default_value> should be set to '0' (zero) if you'd like the CHECK_BOX to be initially un-set, and
'1' (one) if you'd like its default to be selected. An example is shown below:
CHECK_BOX Obsolete 0


The decision of when to use a CHECK_BOX instead of one of the other attribute types (such as a
ONE_OF_MANY offering 'Yes' and 'No') is up to whomever configures your Razor installation. 


LABEL (issues only)


A LABEL is purely read-only information presented on the issues form. Users cannot interact with it or
modify it in any way. The syntax is as follows...


LABEL <label_name> <text>


In this case, the <label_name> does not actually get displayed to the user. The <label_name> for a
LABEL attribute does, however, come in handy when customizing the colors of the various attributes on
the issue form. See "X Resources ."  Instead, it is the <text> field which is put on the display, as in
the following example:


LABEL QA ** Values below here are for QA only **


This attribute type is often employed simply to provide a visual break between different sections of a
large attribute collection.


ONE_OF_MANY
ONE_OF_MANY_LIST
ONE_OF_MANY_STACK


These three attributes serve the same function but differ in the way the values are presented to the user.
The intent is to force the selection of a single value from a limited list (Up to 1024 items.) of options.
These attributes are often used to select a priority for an associated issue or to denote the type of file
being entered into the versions program. Since the definition is the same for either, we'll just show the
syntax for 


ONE_OF_MANY...


ONE_OF_MANY <label_name> <value_list>[ <num>]


Here, the <value_list> is a comma-separated list of values that you want offered to the user. Values in
the value list can either be a text string (with no embedded spaces) or a file specification of the form "file:
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<filename>". <filename>, located in the groups Tables directory, can be any combination of comma,
space, or newline-delimited entries. Let's say that the file fruit_trees, in the Tables directory, contained
the following:


Apple
Pear
Cherry


... and a ONE_OF_MANY definition of a tree was found in the Attributes file as:


ONE_OF_MANY Tree Oak, Elm, file:fruit_trees, Fur, Pine


...then the full list of values would be:


Oak, Elm, Apple, Pear, Cherry, Fur, Pine


Although there are practical limits on the number of values presented (you normally don't want the user
to choose from a huge list), there are none directly imposed by the program. 


If present, the optional <num> field gives you some control over how the options on the list are
displayed. If present for a ONE_OF_MANY, it dictates how many rows the options will be spread over. If
present for a ONE_OF_MANY_STACK, it determines how many entries per column will be used. If
present for a ONE_OF_MANY_LIST, it determines how many lines will be visible.


Below are three examples of how ONE_OF_MANYs may be used.


ONE_OF_MANY Filetype C,C++,Ada,Header,Script,Doc


If the above sample were instead entered as a ONE_OF_MANY_STACK, it would appear as follows:


Furthermore, if the sample were entered as a ONE_OF_MANY_LIST, it would appear as follows:
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The default setting on initial use is that the first option in the list is selected. For the sake of sorting, the
items in the front of the list are considered lesser in value than those at the end. This is independent of
what the words may mean to you.


TIP: You may want to take advantage of knowing that the first element of a ONE_OF_MANY
style attribute is the default setting when you are designing an issues form. If all new issues are to be
assigned a 'Low' priority, then have your options work from low to high. Many sites opt to have the first
choice on the list be something offbeat and visually distinct, such as '---', to distinguish whether the value
was consciously set to one of the values, or left at the default.


STATE


A STATE attribute is a special purpose ONE_OF_MANY. If employed, there can be only one STATE
attribute defined within the same Attributes file. The syntax is basically the same as that of a
ONE_OF_MANY, as shown below:


STATE <label_name> <value_list>


The <value_list> is a comma separated list of possible state names. Unlike a ONE_OF_MANY,
however, you do not have the option of controlling the number of rows used during the display of this type
of attribute.
Although the syntax for defining the STATE attribute is the same, the "state" of an issues form is
completely different in meaning and intent from the "state" of files or threads under control of Razor. For
a more detailed examination of how and why you would use the STATE attribute refer to either "Issue
STATEs  (permissions)," or "File and thread STATEs ."


TEXT_FIELD


A TEXT_FIELD is a single line of unrestricted text. Common usage is most likely as the initial entry on
an issues form. As entered in the Attributes file, it consists of 3 tab separated fields...


TEXT_FIELD <label_name> <length> (The length the field as it appears on the issue form
may appear to be longer or shorter than the defined length. The number of characters entered is limited
to the defined length. The field will be scrollable if necessary.)


Where <label> is what will appear on the display and <length> is the maximum number of characters
that can be entered into the field. Below is a sample TEXT_FIELD and the display that would result from
it...


TEXT_FIELD Title 50


203 210
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These attributes are naturally empty at creation time. The above example sets a limit of 50 characters.
Your setting may be set larger or smaller depending on the specific need for the information to be held in
the field.


NOTE: For issues, the first TEXT_FIELD.entry MUST be non-blank when submitted, either as
entered by the user or by pre-load or e-mail submission. Issues requires at least one TEXT_FIELD
attribute. The first TEXT_FIELD is shown as the title on the issues main display.


TEXT_PANE (issues only)


The TEXT_PANE attribute is used to label the two scrolling text areas at the bottom of the issue form.
The attribute name MUST be of the format 'TEXTn' where 'n' is 1 for the first text area, 2 for the second.
The definition consists of three fields...


TEXT_PANE <TEXTn> <label_name>


The third field in the TEXT_PANE definition will be the string used to label the text area. Two text panes,
TEXT1 labeled 'Problem' and TEXT2 labelled 'Solution' are shown below.


The contents of these two text panes can be prefilled from the contents of the files Problem_template
and Solution_template. Details of the use of these files is discussed in " Pre-loading information into the
text panes ."


TIME_STAMP (issues only)


A TIME_STAMP is a special purpose text field which offers a very controlled but versatile input
mechanism. As such, its syntax is a bit more complex than most of the other attribute types, as shown
below:
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TIME_STAMP <label_name> <format> <flags>


As with all the other attribute types, the <label> field is simply used as an identifier on the display and in
the database. 


The <format> field controls not only what information is displayed and entered on the attribute but also
exactly how it appears. An example of a format field would be the string "%D" which yields a date entry
of the form "04/01/95".  Razor will properly handle two-digit years, but the %Y format (four-digit year) is
encouraged. For a full listing of the types of format strings allowed, you'll need to refer to the man pages
for strftime on a UNIX system.   Although not specifically stated in the man pages for strftime, there
must be white space or at least one non-alphanumeric character such as "/" between any two
conversion characters (i.e. %m/%d/%Y %H:%M).  Refer to the man pages for details. Below are some
examples illustrating the variety of options.


For example, to generate the second example in the above listing, make the following entry in the
Attributes file:


TIME_STAMP Brief %e-%b-%Y


A TIME_STAMP attribute is reminiscent of a TEXT_FIELD, and the user can directly type into it. You'll
notice that the <label_name> field becomes a button on the issue form. Selecting it brings up a separate
panel which is used for the actual entry of the date/time value. Input to the field is nicely controlled, yet
remains flexible for the user.
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The Time menu option offers a variety of courtesy mechanisms for setting the field to specific dates
(Today, One week from now, Four weeks ago, etc.). The special options of Min and Max time set the
field to the most distant and future times possible.


The Clear button at the bottom of the popup clears the data on the field and dismisses the popup.


The optional <flags> field for timestamps is a comma separated list of additional controls over how the
TIME_STAMP itself behaves. Possible entries are detailed in the following table:


Note that there can be no spaces on either side of the '=' sign for any of the flags, but that more than
one flag can be specified for a TIME_STAMP. For example, the following flag combination indicates that
the attribute should be pre-loaded with a date one week from today, whenever the issue is created or
modified, and the user is not allowed to change it.


P=Y,I=7,U=Y,W=N


Razor allows you to "spell out" the flag names if you wish, which may make the meaning of the flags
clearer, as in the following...


Preload=Yes,Increment=7,Update=Yes,Writable=No


NOTE: It is possible to create conflicting flag combinations. For example, you could require entry
in the field, but not have it be pre-loaded or writable by the user. Please don't do this; you won't like
yourself in the morning.


All of this functionality and control combine to make the TIME_STAMP attribute one of the more powerful
fields on the issues form. Through it, you can set up fields for noting the discovery date of a problem
(which may be different from the date the issue was submitted), reminder dates for notifying the
originator of the status of the issue... whatever.


X_OF_MANY
X_OF_MANY_LIST


X_OF_MANY and X_OF_MANY_LIST offer the ability to choose zero or more options from a fixed list
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(Up to 1024 items.). The syntax for this type of attribute is nearly identical to that of a ONE_OF_MANY
and is as follows:


X_OF_MANY <label_name> <value_list> [ <num>]


Here, the <value_list> is a comma-separated list of values that you want offered to the user. Values in
the value list can be either a text string (with no embedded spaces) or a file specification of the form "file:
<filename>". <filename>, located in the groups Tables directory, can be any combination of comma,
space, or newline-delimited entries. Let's say that the file unix_platforms, in the Tables directory,
contained the following:


Sun
HP
SGI
RS6000


... and a X_OF_MANY definition of platform was found in the Attributes file as:
X_OF_MANY Platform file:unix_platforms,Macintosh,Intel


...then the full list of values would be:


Sun, HP, SGI, RS6000, Macintosh, Intel


Although there are practical limits on the number of values presented (you normally don't want the user
to choose from a huge list), there are none directly imposed by the program. If present, the optional
<num> field serves to control how many rows will be used to display the list to the user. Below is an
example:


X_OF_MANY Platform Sun,HP,SGI,RS6000,Other


If the above sample were instead entered as an X_OF_MANY_LIST, it would appear as follows:


The default setting for an X_OF_MANYs is that none of the options are set. You are allowed to filter on
X_OF_MANYs settings but you cannot use them for sorting. To select a value in a X_OF_MANY_LIST
attribute, use the Select button. To select additional attributes, use CTRL-Select. Refer to " Scrolling list
behavior " for a review of list selection methods.24
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11.3 Customizing the Attributes File


To avoid problems in your database, you should follow certain steps when making changes to the
Attributes file to insure that all appropriate files in the database are properly updated with your changes.
Perform any of the following steps WITH THE DATABASE SERVER DOWN! 


1. Bringing the server down


Refer to "Stopping the database server " for details.


2. Adding new attributes/values


If adding something new to the Attributes file, that is, adding an entirely new attribute with values, or
adding a NEW value to an existing attribute, you simply use any text editor, edit the Attributes file,
$RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables/Attributes, and add all new changes.
Remember the "format" for each line in the Attributes file; there are 3 or more fields, separated by tabs
(no leading or trailing "spaces"), and if a value list is used, the values must be comma separated. All
new additions to the Attributes file can be made in one edit session.


NOTE: If a new value is being added to the STATE attribute, you should also edit the Bitmaps file
and include the new value. For your issues Attributes file, you must also edit the Permissions file and
include the value as well.


3. Changing an existing attribute


If modifying an attribute that currently exists in the database, that is, you need to remove an attribute or
one of its values, or you wish to rename the attribute name or a value in its list, you must update all
references in the database for that name or value (and there may be more than one reference). To insure
that all locations in the database are properly updated with your modification, we have provided the
following scripts to do all of the work:


rz_remove_attr <group> <attr name>
rz_remove_attr_val <group> <attr name> <attr value>
rz_rename_attr <group> <Old name> <New name>
rz_rename_attr_val <group> <attr name> <Old value> <New value>


You can see the convention used in these scripts. If the script name ends in _val, you're going to modify
an attribute value; otherwise, you're going to modify an attribute name. You must always provide the
<group>, so the correct Attributes file will be modified (whether it's in an issues, file control or threads
group), the <attr name> of the attribute to be modified, and if appropriate, the attribute value.


NOTE: By using these scripts, ALL points in the database will be properly updated; this means
the Attributes file, Permissions and Bitmaps files (if appropriate) and the Info files.


NOTE: If you rename or remove attributes and/or attribute values and are using IssueWeaver,
remember that you may also have to update the rules files to reflect the changes.
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NOTE: If you are renaming LABEL and TEXT_PANE attribute values, the <Old value> is ignored,
relieving you from having to type the old value exactly, spaces and all. It won't matter what is entered for
<Old Value>. This also holds true for the LABEL attribute value.


4. Restarting the server


Lastly, once all the necessary scripts have been run and new additions made, restart the database
server. See "Starting the database server ."


11.4 Controls


Razor permits user access to be controlled globally. Access can be controlled at the License Manger
level, and for Databases, at the RAZOR_UNIVERSE level and/or the group level.


Access Controls


Access settings for the License Manager are controlled by the LM_Access_list in the Razor_lm
directory. For databases, these settings are controlled by the Access_list file. The database Access_list
file can be placed in the RAZOR_UNIVERSE/Tables directory to control access for the entire database.
The Access_list can also be placed in RAZOR_UNIVERSE/DOMAIN_01/<group>/Tables to control
access for an individual group. Settings at the universe level may be overridden at the group level.


The format of the entries for both these files are: 


<operation> <who>


<operation> is any one of the operations listed in the table below and <who> is any combination of
username, group name and role


 username is any valid user account.  


NOTE: Depending upon the License manager mode ("Modes ") the user names are defined via
the local or Razor password file.


 group name is any valid user group


NOTE: Depending upon the License manager mode ("Modes ") the group names are defined
via the local or Razor password file.


 role is any role defined in the file Roles


NOTE: Although UNIX platforms support the subscription of one user to multiple groups, the
Access_list will validate users based on the primary group.


Operations may appear multiple times; with the <who> list being concatenated. In the definition of
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<who>, group name must be preceded by the plus ("+") symbol and role must be preceded by the
percent ("%") symbol.


LM_Access_list


This file controls who can bring the License Manager down, add users, modify users, remove users, set
password aging, and lock/unlock user accounts.


Database Access List (Access_list)


This file controls who can perform various functions in Issues, Versions, and Threads. The format of the
entries are: 


<operation> <who>
.
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a. Will control the availability of the Promote functionality ONLY IF the Promoters files does not exist.
b. Removes a file in the context of file control, as well as threads and issues (since they are all just files
to Razor)
c. Refers to terminating a branched file
d. Controls switching between databases







Razor Manual200


© 1992-2009 Visible Systems Corporation, All rights reserved.


e. Enabling USER_REPORTS enables both modifying as well as viewing user reports


Definable roles


It's often easier to think and define access to things in terms of roles, rather than as a list of specific
users. You can handle this in one of two different ways with Razor.


The first way is simply to have your System Administrator lay things out for you by judicious use of user
groups. Then, instead of having only a comma separated list of users in the Permissions file (see "
Permissions (issues only) ," you can give access to users by including a '+' in front of the user group
name.


Another way is to take advantage of the Roles file. Noting this directly from the comments within the
template for this file...


#
# This file defines Roles for use in the Permissions table for both
# user state transition permissions or email notification definition.
# Note that for email notification, group identifiers will be ignored
# if they are included in the role definition.
#
# The format of this file is role name (no spaces allowed in names)
# followed by one or more identifiers separated by spaces or commas.
# The identifiers may be any collection of user id, group id and
# other role id.  When referencing a group id, the group name must
# be preceded by a '+' character.  A role must be preceded by a '%'.
# When referencing other roles, the role must have been previously
# defined in the file.
#
# If the file $RAZOR_UNIVERSE_DIR/Tables/Roles exists, the defined
# roles will apply for all groups in the database.  If the file
# $RAZOR_UNIVERSE/DOMAIN_01/<group>/Tables/Roles exists, it will 
# take precedence over the $RAZOR_UNIVERSE_DIR/Tables/Roles file.
#
# EXAMPLES:
#
# "Razor Administrator/special user" role:
# The identifiers associated with RAZOR_ADMIN will be allowed to
# check-in or uncheck-out files that have been checked out by any
# other user.
RAZOR_ADMINnobody
#
# Define a role CM whose users are mark, joel, deb and anyone in the
# cmteam Unix group:
#CMmark, joel, deb, +cmteam
# 
# Define a role SW whose members are ivory, filmer and pedone as well
# as all members of the CM role:
#SWivory, filmer, pedone, %CM
#
# Define a role that has a large number of members:
#LEADjones, smith, brown, martin
#LEADphil, fred, steve, jane
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#LEADdonna, mary
#
# These lists will be concatenated as follows:
#LEAD = jones, smith, brown, martin, phil, fred, steve, jane, donna, mary
#


NOTE: A role called RAZOR_ADMIN can be defined that has 'special' privileges. Users in
RAZOR_ADMIN are allowed to check another person's file back in or uncheck another person's
checked-out file.


Options


Each line consists of the following fields...


<option> <value>


An Options file may be added to the Tables directory of a file control group and/or to the Tables directory
of the database. This file can be used to gain more control over the individual tool, such as the version
check-in process. The options at the group level take precedence over those defined at the database
level. Options and the associated value must be tab separated


The Options file consists of lines containing option/value pairs. Currently supported options are:
FileCheckIn or IssueText<n>.


FileCheckIn


The option FileCheckIn supports the following three possible values:


 AllowNoChange


This is the default state and will force check-in's to work in the same manner as in previous releases.
The file will ALWAYS be checked in regardless of whether or not it has changed.


 


 WarnIfNoChange


Upon check-in if it is detected that the file has not changed since it was checked out, the user will be
given the option to either continue or stop the check-in of the unchanged file. The user is presented with
three choices:


-Continue - check in the unchanged file and proceed to the next file in the list
-Skip - do not check in the unchanged file and proceed to the next file in the list
-Halt - terminate the check-in process


 MustChange -


Check-in of unchanged files will not be allowed.


Upon completion of the check-in process through the GUI, the user will be notified if unchanged files
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were not checked in. The user will be given the option of viewing the list of files that were not checked-in.


The default state for the command line interface is to NOT check in unchanged files when the option
FileCheckIn is set to WarnIfNoChange. The user will be prompted to enter "Yes" if the unchanged file
should be checked-in.


NOTE: Unchanged files will remain in the checked-out state until the user performs an uncheck-
out (or check-in, if allowed). 


IssueText<n>


Options for controlling the modes of accessing the text areas on an issue form. Only one setting is valid
per text area. The option IssueText supports the following three possible values: 


 Writable (default)


users may enter data anywhere in the specified text area.
 Readonly


users may only view the specified text area.
 AppendOnly


users may only append data in the specified text area.


makeBackupOnRemoveAttach


Option specifying the behavior when an issue's file attachment(s) is removed. 


 TRUE


Each time a file attachment is removed by the users, a backup copy of the file attachment will be
created by Razor. TRUE is the default. The backup copy will be named:


$RAZOR_UNIVERSE_DIR/DOMAIN_01/<issue group>/Attachments/<issue name>/rz.<timestamp>.
Aattachment name>


 FALSE


When a file attachment is removed by the user a backup copy of the file attachment is NOT made.


copyFileAttachForIssuesBeforeScripts


Option specifying the behavior when the 'Before' scripts associated with the issue_create.apply and
issue_modify.apply buttons are executed. 


 TRUE 


Temporary copies of all file attachments being added will be made available for use by the before script.


 FALSE







Razor Customization & Personalization 203


© 1992-2009 Visible Systems Corporation, All rights reserved.


Only a proposed change log listing the file attachments being added and/or removed will be made
available for use by the before scripts. This is the default.


11.5 Configuring the Issues Program


Razor provides an out-of-the-box, basic, Attributes file. This Attributes file is intended to be a starting
point for your customization efforts. Even after you've customized your Attributes files and have
functioning databases, your needs may change for the values or names of attributes currently in use. 
ALL changes to the Attributes file should be left to the responsibility of your Razor Administrator.


Conditional attributes (sensitivity)


It's possible to configure Razor to directly disallow changes to specific attributes, based on the setting of
other attributes (ONE_OF_MANY style) on the issue form. Better still, this conditional insensitivity can
be made to specific users or roles (Definable roles  .) The file which controls all of this is...


$RAZOR_UNIVERSE_DIR/DOMAIN_01/<issue group>/Tables/Insensitive


This file defines which fields should be made insensitive (grayed out) when the attribute/value/who fields
match. Within the file, fields are TAB separated and are defined as:


<attribute> <value> <who> <insensitive>


The <who> field can be any combination of users, user groups and roles. User group entries (under UNIX
or Windows 2000/XP) must be preceded by a '+' and role names by a '%'. To match users who are not a
member of an entry, precede the entry with the not symbol '!'.


Example 1: 


When the field 'Level' is set to 'Active' we want the 'Priority' field to be inactive for all users:


Level Active * Priority


Example 2:


When the 'Impact' field is 'Medium' make 'Projection' inactive for all users:


Impact Medium * Projection


Example 3:


When the 'Approved' toggle button is set, make 'Responsibility' inactive for users barney, wilma and
members of the 'jetson' group:


Approved 1 barney, wilma, +jetson Responsibility


Example 4:


When the 'Priority' field is set to 'High', make 'Impact' inactive for all users not in the CM role:
Priority High !%CM Impact
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OPINION: Power corrupts. Absolute power corrupts absolutely. An overzealous approach to
customizing and modifying everything that is modifiable should be avoided, at least until you become
comfortable with the essentials. We encourage you to balance your enthusiasm with a level of self-
restraint.


Issue STATEs (permissions)


As noted earlier, a STATE attribute is a special purpose ONE_OF_MANY. Within the context of the
issues program, it is used to represent the process flow or lifecycle of an issue. Issue STATEs allow you
to...


•note the present status of an issue.


•record who brought the issue to the present status and when that transition occurred.


•define a state flow and permission system.


•set up an automatic e-mail notification list for state changes.


For the sake of discussion, let's examine the simple 5 state model diagramed below. Although the
relative merits and shortcomings of this example could be hotly debated, it will serve well for the purpose
of illustration.


The arrows on the diagram indicate the acceptable and anticipated transitions in the status of an issue.
All new issues enter the system in the Submitted state and (hopefully) end up in either the Closed or
No-Action states. In this example, some amount of cycling between the Submitted, Active, and
Completed states is allowed but once an issue reaches either of the terminal states, no more
modifications are possible. As you can see on the chart, a Closed to Closed transition is allowed,
meaning that modification of the issue contents are allowed, but it cannot return to a prior state.
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To define the names and basic order of the states, you would need a single line in the file
$RAZOR_UNIVERSE_DIR/DOMAIN_01/<issue group>/Tables/Attributes, such as the one below...


STATE State Submitted,No-Action,Active,Completed,Closed


The next step is to define the various state transitions in the Permissions file, which is found in the same
directory. With a text editor, you must spell out all the possible transitions. With a 5 state model, there
are 25 different paths which must be clearly spelled out. (Even when a person makes a simple edit to an
issue without directly changing its state, it is treated by Razor as if a state change occurred, with the
transition path going to and from the present state.)


Each line in the file is used to denote which userid's.


NOTE: Userids include Roles (denoted by %) and Groups (denoted by +). are allowed to make
the indicated transition. There are three required fields on each lkne. witj tabs serving as the field
separators. The first two fields indicate the initial and destination states respectively, spelled and
capitalized exactly as they appear in the Attributes file. 


The third field indicates who is allowed to bring the issue through that particular change. An asterisk is
used to allow all userids equal ability to perform a particular state transition. If a particular path is not to
be allowed, then the keyword "nobody" should be used. When only a specific set of known userids are
allowed, then they should form a comma separated list. You can also take advantage of user groups and
defined roles.


TIP: A handy script is available in $RAZOR_HOME/examples called build_default_permissions. It
creates a new Permissions file (in the database) based on the current STATE settings. 


Continuing with our example above, we would have a Permissions file with the following entries...


Submitted Submitted *
No-Action Submitted nobody
Active    Submitted *
Completed Submitted *
Closed    Submitted nobody


Submitted No-Action *
No-Action No-Action *
Active    No-Action *
Completed No-Action *
Closed    No-Action nobody


Submitted Active    *
No-Action Active    nobody
Active    Active    *
Completed Active    *
Closed    Active    nobody


Submitted Completed *
No-Action Completed nobody
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Active    Completed *
Completed Completed *
Closed    Completed nobody


Submitted Closed    nobody
No-Action Closed    nobody
Active    Closed    nobody
Completed Closed    *
Closed    Closed    *


It should be noted that the above definitions are basically a line by line description of what is shown in
the matrix in Customization & Personalization "section.  Also notice that in this example, if a
particular state transition is allowed, then all users on the system have been granted the permission
equally. To change this, you need only change the third field on the affected line.


For example, if you wanted only Norm, Cliff, or the Admin group to be capable of bringing an issue to the
Closed state (or of editing it after it was in the Closed state), then you would oodify the related lines to
read...


Completed  Closed  norm,cliff, +Admin
Closed     Closed  norm,cliff, +Admin


NOTE: The default stance of the issues program is to allow anybody to do any state transition. If
a particular issue state transition is not directly spelled out in the Permissions file, then it is assumed to
be allowed. It is often clearer to note it directly in the file rather than leave this as an unspoken
convention.


Controlling the issues state string


The issues program automatically records and displays the user id and timestamp of state transitions.
Users can supplement the time stamp and user id which appears on an issue form STATE transition by
creating a script named: 


$RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Scripts/rz_state_string


When invoked, the script receives the following parameters:


$1 = Date string
$2 = User id


The first line of output from this script will be appended to the standard state information. This may be
handy for including the phone number of the individual directly onto the issue form itself.


E-mail notification on state changes


It is often the case that you would want certain individuals automatically notified when particular issue
state transitions occur. The Permissions file supports an optional 4th field on each line which is a
comma separated list of users to notify of the state change. Entries in this list can be any combination
of e-mail addresses, Razor roles1


1. Groups defined in a role will be ignored by e-mail notification. See Definable roles "" for details on
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roles. (prefixed by %), and attribute fields (prefixed by $RAZOR_ATTR_name) that consist of e-mail
addresses and/or roles.


Expanding on our example above, if you wanted Carla and the Admin role to be notified whenever an
issue went directly from the Submitted to the Completed state (skipping over the Active state), then you
would modify that particular transition line in the Permissions file to read...


Submitted  Completed  *  carla@xyz.com, %Admin


The e-mail message which will be sent is a full text representation of all information contained in the
resultant issue form.


NOTE: It is possible to e-mail information directly to a program or script. This would allow you to
have some state changes send information to a script which makes programmatic decisions on who
should be notified rather than always sending the information to the same users. For more information,
see Scripts which receive and process e-mail ."


NOTE: Razor supports e-mail notification of State Changes on Windows 2003 Server, 2000 & XP
Servers. This functionality requires the use of Outlook or Outlook Express. Please see " E-mail
Functionality in Windows 2003 Server, 2000 & XP " for more details.


Associating glyphs to attributes


As noted earlier in the manual, it is possible to associate glyphs to the settings of an issue's STATE or
the various ONE_OF_MANY style attributes on an issues form. These glyphs would appear on the left
side of the main scrolling display of issues, providing quick visual insight to the nature of the issue.


To define the glyph usage, you need to edit the file $RAZOR_UNIVERSE_DIR/DOMAIN_01/<issue
group>/Tables/Bitmaps directory. Each line defines a relationship between an attribute value and a
glyph. Three tab separated fields are required, as shown below:


<label ><value ><glyph_file_name>


For example, if your Attributes provided for noting the relative priority of an issue as follows...


ONE_OF_MAN YPriorit y---, Low, Medium, High, Urgent


Then you could have glyphs showing from 1-4 dots, depending on the relative priority the issue had been
assigned. The corresponding lines in the Bitmaps file would read...


Priority  Low    $RAZOR_HOME/glyphs/dots_1.xbm
Priority  Medium  $RAZOR_HOME/glyphs/dots_2.xbm
Priority  High   $RAZOR_HOME/glyphs/dots_3.xbm
Priority  Urgent  $RAZOR_HOME/glyphs/dots_4.xbm


If a specific attribute setting is not directly called out in the file, then no glyph will be assigned to that
setting and the space will be left blank (as for the '---' setting in our example). 


Pre-loading information into the text panes
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Typically, the first of the two text panes is used to record a statement of the problem at hand. The
second pane is often used as an engineering notebook; a place for recording notes and comments as
the task is addressed and brought to resolution. You are not bound in any way by these conventions,
however, and are free to use the two text panes in whatever manner you see fit.


It is possible to pre-load the two text panes at the bottom of the issue form when new issues are
created. Through this approach, your intended utilization of the text panes is self-documenting. These
panes may contain essay questions, delimiters, instructions, or whatever else you deem necessary.


The text to be pre-loaded should be included in the files Problem_template (text pane 1) and
Solution_template (text pane 2) which are located in the <issue group>/Tables subdirectory.


Controlling form layout


Sometimes it might be nice to "tighten up" the issues form beyond what Razor produces by default. For
example, you might want to place two attributes on the same line of your issues form. There is a very
useful script in $RAZOR_HOME/examples called attr_to_xy. To run it, enter...


attr_to_xy  [-g <issue group>] [<outfile>]


It will generate X/Y positioning for attributes in the input issues group. If <outfile> is specified, output will
go to this file, otherwise, stdout will receive the output. Once the X/Y positions are generated, they can
be tweaked as necessary. Remember to incorporate the X/Y positions into your Xdefaults or Wdefaults
files1


1. For more information on X default settings recognized by Razor clients, see "X resources / Razor
databases ."  You must rerun the Razor program for these changes to take effective.


Below is an example of how to run this script, with its output going to stdout:


# $RAZOR_HOME/examples/attr_to_xy


Starting X position [10]:  
Starting Y position [10]:  
Y offset [40]:  


! X/Y positions for "Title"
Issues.IssueForm*TitleLabel.x: 10
Issues.IssueForm*TitleLabel.y: 10
!Issues.IssueForm*TitleLabel.background: gray95
!Issues.IssueForm*TitleLabel.foreground: black


! X/Y positions for "Priority"
Issues.IssueForm*PriorityLabel.x: 10
Issues.IssueForm*PriorityLabel.y: 50
!Issues.IssueForm*PriorityLabel.background: gray95
!Issues.IssueForm*PriorityLabel.foreground: black


! X/Y positions for "Impact"
Issues.IssueForm*ImpactLabel.x: 10
Issues.IssueForm*ImpactLabel.y: 90
!Issues.IssueForm*ImpactLabel.background: gray95
!Issues.IssueForm*ImpactLabel.foreground: black
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! X/Y positions for "State"
Issues.IssueForm*StateLabel.x: 10
Issues.IssueForm*StateLabel.y: 130
!Issues.IssueForm*StateLabel.background: gray95
!Issues.IssueForm*StateLabel.foreground: black


! X/Y positions for "Due_by"
Issues.IssueForm*Due_byLabel.x: 10
Issues.IssueForm*Due_byLabel.y: 170
!Issues.IssueForm*Due_byLabel.background: gray95
!Issues.IssueForm*Due_byLabel.foreground: black


! X/Y positions for "Okay"
Issues.IssueForm*OkayLabel.x: 10
Issues.IssueForm*OkayLabel.y: 210
!Issues.IssueForm*OkayLabel.background: gray95
!Issues.IssueForm*OkayLabel.foreground: black


! X/Y positions for "Scope"
Issues.IssueForm*ScopeLabel.x: 10
Issues.IssueForm*ScopeLabel.y: 250
!Issues.IssueForm*ScopeLabel.background: gray95
!Issues.IssueForm*ScopeLabel.foreground: black


! X/Y positions for "Product"
Issues.IssueForm*ProductLabel.x: 10
Issues.IssueForm*ProductLabel.y: 330
!Issues.IssueForm*ProductLabel.background: gray95
!Issues.IssueForm*ProductLabel.foreground: black
!Issues.IssueForm*Product.width: 120


Place these and other Xdefault commands in the file $RAZOR_UNIVERSE_DIR/Xdefaults to control X
settings globally.


Colors


Colors may be used to convey certain themes or messages to your users. Colors of both attribute labels
and values can be controlled through X defaults. Let's say you had a ONE_OF_MANY attribute named
Priority with values: ---, Low, Medium, High, Urgent. The following X defaults will set the foreground color
of the label to Brown and the attribute value foreground color depending upon the value:


Issues*PriorityLabel*foreground: Brown
Issues*Priority*---*foreground: Orange
Issues*Priority*Low*foreground: Red
Issues*Priority*Medium*foreground: Blue
Issues*Priority*High*foreground: Green
Issues*Priority*Urgent*foreground: Orange


See "X Resources " for a detailed description of the X resources available for customization.275
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TIP: Don't go crazy with colors. Sometimes too many colors can become confusing for your
users, difficult for you to maintain, and look downright ugly. Use colors sparingly and where they
enhance the overall presentation.


General suggestions


If you're starting fresh, we'd encourage you to begin with a minimalistic approach. Design your issues
form with as few attributes as necessary to accomplish what you truly need. This is often achieved
through some simple modifications to the default arrangement supplied as part of the Razor release. As
time progresses and your experience with the environment grows, add other attributes and conventions
as needs dictate.  See Customizing the Attributes file ."


Similarly, don't start off with lots of attached actions to enforce rules. This is for two reasons. The first is
that by waiting a little, you may avoid the need to change and edit scripts to accommodate changes in
the way the attributes are laid out. The second is that you may discover that a programmatic policing of
people's actions may not be necessary after all.


11.6 File and Thread Attributes


File and thread STATEs


As a development effort proceeds, the various files involved will go through numerous modifications. It is
often handy as well as necessary that you have the ability to assign various levels of trust to particular
versions of each file. The most recently edited form may not be the most highly tested or trusted. This is
accomplished through the use of a STATE attribute.


Although defined in the Attributes file much like a ONE_OF_MANY, these special attributes are used as
historical markers, rather than indicators of the present status of a file under control. The STATE
attribute is best described by example.


In the following flow, we'll assume that a Razor group has been configured to provide four distinct levels
of blessings for the files under control. These would appear in the related Attributes file as follows...


STATE State Active, Compiled, Tested, Released


The Active state is the lowest level of trust and it implies that the related version of the file is in a
dynamic state. The Compiled state implies that the related version can pass through the compiler
without any problems and that it conforms to various in-house coding standards. If a version is Tested,
then it has successfully completed a series of quality control measures. Finally, if a version of a file has
been promoted to the Released state, then it has actually been incorporated into a product release.  


Please note that the states discussed here are purely for illustration only. You may opt to incorporate a much
more sophisticated scheme, or none at all.


In the following diagrams, the squares represent a file that is being modified over time, with each check-
in yielding a higher version number for the file. The various states can be thought of as placards which
travel on a wire over the history of changes occurring to the file under control.
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In this scenario, our developer (Latka) reaches a nice break point in his efforts and now has a version of
the file which he believes compiles nicely and meets all of the necessary coding standards. He is able to
promote the latest version of the file to the Compiled state and is free to continue on with other work. As
he does this, he notifies his friend Louie in SQA that the file is ready for testing.


NOTE: The actual mechanics of promoting a file are discussed elsewhere. See "Promoting
specific versions file-by-file." 


Since Louie is able to easily obtain a read-only copy of any file at any version, Latka is indeed free to
proceed with his development efforts. His ongoing modifications to the file will not affect Louie's tests.


After some time, Louie may flag version 1.3 of the file as being tested. Independently, Latka may well
have moved on and identified a subsequent version as being Compiled, while he has progressed further
on with yet more edits.
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Since the various state placards are left associated with unique file version numbers, there is no danger
in having the developers proceed with their work. In fact, taking advantage of this paradigm, developers
become much more likely to occasionally checkpoint their efforts into the archival system, allowing
users to welcome and rely on the system rather than avoid it.


Defining who may promote files/threads


Razor allows you to easily restrict who may perform the promotion of various versions of files and
threads from one state to another. Only those users defined in the database/file control group (i.e.
versions group or threads group) Tables/Promoters [See "Promoters (versions & threads only) ." ] are
allowed to do promotions (i.e., a list of userid's, user groups, and or defined roles). The syntax of the file
requires that each userid be called out on its own line. To limit promotion to Jerry, George, and Elaine;
the Promoters file would look like...


jerry
george
elaine


The default is to allow all users to promote files, denoted by an asterisk ("*") on a line by itself.


NOTE: The Promoters file is superseded by the Access_list file but is left for backward
compatibility. Users should switch to Access_list, described in the "Custotmization & Personalization


" section, as subsequent versions of Razor may not support Promoters.


Associating glyphs to file attributes


As noted earlier in the manual, it is possible to associate glyphs to represent the settings of the various
ONE_OF_MANY attributes related to a file or thread under control. These glyphs will appear on the left
side of the main scrolling display of the versions program, providing quick visual insight to the nature of
the file.


To define the glyph usage, you need to edit the file $RAZOR_UNIVERSE_DIR/DOMAIN_01/<file control
group>/Tables/ Bitmaps. Each line defines a relationship between an attribute value and a glyph. Three
tab separated fields are needed for this, as shown below:
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<label> <value> <glyph_file_name>


For example, if you defined an attribute in the Attributes file which indicated which library the related
source code belonged to...


ONE_OF_MANY Lib ---, GUI, Math, Comm, Dev


...then you could have glyphs hinting of the relationship. The corresponding lines in the Bitmaps file
would read...


Lib  GUI   $RAZOR_HOME/glyphs/star_0.xbm
Lib  Math  $RAZOR_HOME/glyphs/symbol_hash.xbm
Lib  Com   $RAZOR_HOME/glyphs/symbol_bang2.xbm
Lib  Dev   $RAZOR_HOME/glyphs/weather_sun.xbm


11.7 Report Generation


Razor contains an integrated Report Generator. The Report Generator provides a way to filter a Razor
database and output selected attributes in a variety of formats. Reports can be generated for example to:


 display a status summary of issues and their state,


 bar chart a file control group by file type,


 pie chart issues by status.


Reports are made up of a filter definition, a format definition, a report title, a report description, and an
output file name. Format and filter definitions can be independently saved and combined together to
produce reports tailored to your requirements. Reports can be output in one of the following formats:


 File - used primarily to export data to an ASCII file to be imported into another application such as
Excel or Access,


 HTML - tabular reports viewed by a Web browser,


 Pie chart - graphic pie charts that show data as a percentage of a total data set viewed by a Java-
capable Web browser, and


 Bar chart - graphic bar charts that show numeric data (count, sum, min, max, avg) viewed by a Java-
capable Web browser.


Access controls may have been created by your Razor administrator to limit your ability to run or modify
reports. Reports are categorized by "locale" as either database or user. User reports are only seen and
executed by you. They are conceptually similar to stored filters. Database reports are available to all
users. Subject to the access controls established by your Razor administrator, you can store format,
filter, and report definitions as either database (available to all users of that database) or user (only
available to you).


Running reports


Reports are run by selecting them from the Reports pull-down menu of each Razor tool (issues,
versions, or threads).  Running a report causes the saved report definition to be read and executed
against the currently selected group.  Reports are unique to Razor group since they specify the
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attributes to be output. Therefore a different list of reports will appear for each group.


Reports that require a Web browser to be viewed are HTML, Pie chart, and Bar chart. The default
browser is Firefox, but can be changed by setting the environment variable RAZOR_BROWSER. For File
reports, the standard Razor file browser is used to view the report, unless the environment variable
RAZOR_EDITOR is set.


Defining reports 


Reports can be defined at the database level (seen by everyone for that database) and at the user level.
(seen only by you). As mentioned before, the Razor adminstrator can limit the creation of reports at
either the database or user level.


To define a report or modify an existing one, select Create/Modify definitions... from the Reports menu. A
Report definition form similar to the one below is displayed.


The form consists of a window header/footer, a menu bar, a report definition area, and function buttons. 


Header/footer


The window header will contain the currently selected report definition name. It may also contain the
locale. The left footer of the display gives an explanation the last command, e.g. saving report definitions.


Menu bar
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The menu bar contains the menus File, Edit, and Help.


 File contains the file-related commands Open, Save, Save As, Preview, Delete and Close..


 Edit consists of Edit Format and Filter definitions and New Format and Filter definitions.


 Help contains information on Report Definition.


Report definition


 Title is the title for the report (this replaces the report title meta tag RAZOR_REPORT_TITLE1 in the
format file.)


NOTE: Refer to "Report meta tags " for further details on meta tags.


 Description is an optional description of what the report will produce.


 Format is a list of saved report formats.


 Filter is a list of saved report filters.


Function buttons


 Preview will display the results of the currently active/selected format and filter.


NOTE: If a format or filter form are active, they will take precedence over the current filter/format
selections on the Report Definition form.


 Save saves the selections in the currently selected report definition.


 Save as displays a Save as dialog like the one below. Allows the selections to be saved to the
specified definition name. The report locale, either database or user, can be specified as well via the
locale radio button.


 Cancel dismisses the Report Definition form.


Note: The Report Definition form can not be dismissed while a Format or Filter form are active.


213
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The main components of a report are the format definition and the filter definition. Formats determine how
the report is to be produced/viewed. Filters determine which attributes are to be output, their order, the
criterion for selecting records, and the output sort order.


 Report definitions can be deleted by selecting the Delete database definitions... or Delete user
definitions... from the File menu. A Delete Report Definitions form is displayed. Click the report definition
to delete and select Delete.


Defining report formats


To define a report format, select Format <selected format>... or New Format from the Edit menu of the
Report Definition form.  A Report Format form will be displayed.
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The Format form has the same basic organization as the Report Definition form.


Header/footer


The window header will contain the currently selected report format name. It may also contain the locale.
The left footer of the display gives an explanation the last command, e.g. saving report format.


Menu bar


The menu bar contains the menus File, Options, and Help...


 File contains the file-related commands such as Open, Save Save As, Delete and Close


 Options contains various report format options.


 Help provides a dscription of the Report Format window.


Report formats area


The report formats area contains various text fields that are used to construct the report. These text
fields are grouped under the categories delimitors, adornments, and date formats.


 Delimitors are text strings
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NOTE: Any text entry can contain Razor meta tags. Refer to "Report meta tags" below for a list of
meta tags. to be output for each of record, below (or attribute), item (for X_OF_MANY attributes), and
value (i.e. a double quote character can be used to contain each individual attribute).  Selecting a report
format from the Options menu will prefill defaults for the delimitors.


 Adornments are text strings to be output around the report.


 Date formats specifies the output date format for all TIME_STAMP attributes. The date format is also
useful for grouping date attributes. A convenience menu is provided that will prefill the date format string
(e.g. selecting "December" from the date format menu will prefill %B in the date format text field which
can be used to group a TIME_STAMP attribute by month).


 Chart size specifies the pie or bar chart size in pixels. This can be used to control the chart size for
inclusion into reports and presentations.


To define a report format, first select a format from the Output format option of the Options menu.
Selecting an output form will prefill the rest of the form with appropriate defaults. Other options that can
be selected include:


 Output format - defines the report format.


-File - is an ASCII file, typically to export data to another application (e.g. Microsoft Access).
-HTML - is an HTML file, viewed with a Web browser.
-Pie Chart - is a pie chart, where each entry consists of a percentage of a pie (with all entries equalling
100% of the pie).


-Bar Chart - is a bar chart, where each entry is represented as a bar whose height is its numeric value.


 Output numeric values for MANYs - for attributes like X_OF_MANY or ONE_OF_MANY, instead of
outputting the values as text, this option will output numbers. This option is useful when outputting data
for import into a spreadsheet program.


 Attribute names as 1st line - this option is useful for File formats when the data is being exported to a
spreadsheet or database program, or for HTML format for column headers.


 Generate sequence #s - generates a unique number for each record output. Useful when exporting to a
database program that requires unique keys for importing records.


 Summarize attributes by - summarizes the output data. Summaries include:


-Count - for the attribute specified, counts the number of records that contain each unique attribute value,
e.g. if an attribute State has the possible values "Submitted", "No-action", "Working", "Closed"; count
will count the number of records that have each of the possible state values


-Sum - totals the value of each records attribute.


NOTE: Sum is only appropriate for attributes that contain numbers (integers) or when outputting
numeric values for MANYs.
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-Min/Max/Avg - self explanatory


-Total - outputs an additional line at the end of the output summarizing the number records output out of
the total number of records.


-Avg STATE transition - produces a special report that shows the average time to transition from state to
state


NOTE: At least one of the numeric summaries (count, sum, min, max, and/or avg) are required for
Pie chart and Bar chart.


Report meta tags


Each of the above text fields may contain meta tags. These meta tags will be replaced with the
appropriate text when the report is generated. This allows generic report formats to be defined that are
independant of such things as the date/time they were generated. Meta tags are referenced as 
<<meta_tag_name>>, where meta_tag_name is one of the following:


For example, if the report title "Razor Status Summary" was entered for a report, and the report format
title string was "<<RAZOR_REPORT_TITLE>> generated on <<TODAY>>", it would generate something
like "Razor Status Summary generated on 1/12/2000".


Defining report filters


To define a report filter, select Filter definitions... from the Edit menu of the Report Definition form.  A
Report Filter form will be displayed.
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Header/footer


The window header will contain the currently selected report filter name. It may also contain the locale.
The left footer of the display gives an explanation the last command, e.g. saving report filter.


Menu bar


The menu bar contains the menus File, View, and Help.


 File contains the file-related commands such as Open, Save, Save As, Delete, Close and Help.
 View contains various report filter view options.
 Help provides a description of the Report Filter window.


Report filter area


The report filter area consists of three elements, attribute selection/ordering, additional filter sort criteria,
and filter/sort options. The filter/sort options should look familiar to you. It looks similar to the filter form,
containing a Sort order menu and filter criteria for each attribute. The sort order only effects the output of
records for File and HTML formats.


More about filter options
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Two convenience options are available on the View pull down menu: include all attributes and exclude all
attributes. These can be handy if the number of attributes is large and many of the attributes are to be
included or excluded.


The Select From list in the attribute selection / ordering portion of the report filter contains all attributes
for the group, as well as some additional file/issue-related report information. The non-attribute fields are
denoted with "--". The Output Order list determines which attributes are to be output and their order.
Non-attribute report information include:


-Issue/file name - for issues, it is the issue number; for versions and threads, it is the file name
-Last modified - the date the file was last modified


For versions and threads:


-Latest version- indicates the current file version
-Checked out - indicates whether the file is checked out
-Owner - the name of the user who checked out the file
-Reason - the reason the file was checked out
-Related issues - any issues that might have been associated with the check out


 Additional filter/sort criteria - a list of filter/sort criteria effecting how database objects are matched and
sorted for display.


Match criteria:


-Case insensitive - when filtering text fields, ignore case (issues only)
-Use RegEx in filename pattern - interprets filename as a UNIX regular expression (versions and threads
only)
-Invert sort order - sort the output in descending order (the default is ascending) (issues only)
-Sort by modification date - sort by the date the object was last modified (issues only)


Some report examples


Now that you know how to define reports, let's walk through defining some useful "starter" reports. We
will define the following reports:


 An ASCII file that can be imported into MS Excel.


 An issue summary report.


 A pie chart showing the percentage of issues at a certain status.


 A bar chart from versions showing counts of files by file type.


Excel export


Sometimes it is useful to export Razor data to a third-party application like MS Excel. To create an
export report definition:


1. Start issues.
2. Select Create/Modify ... from the Reports menu. A Report Definition form will appear.
3. Select New Format and then File... from the Edit menu. A Report Format form will appear. 
4. Enter a double quote in the Value delimitor field.
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5. If it is not selected, select Attribute names as 1st line from the Options menu. Unselect all other
options.
6. Select Save as... and a Save Report Format form will appear.
7. Enter Excel export and select Ok.
8. Select Cancel on the Report Format form. The form will disappear.
9. Select New Filter... from the Edit menu. A Report Filter form will appear.
10. Include all attributes from the View menu.
11. Select Save as... and a Save Report Filter form will appear.
12. Enter all and select Ok.
13. Select Cancel on the Report Filter form. The form will disappear.
14. Select Save As on the Report Definition form. Enter export_text in the Output File Name field on the
Save Report Definition window. (This will make the report definition 'export_text' available from the
Reports menu on the main Issues screen.)
15. Select "Excel export" in the Format list and "all" in the Filter list.
16. Select Preview on the Report Definition form. A file preview dialog will appear with the contents of the
data.


This file can then be imported into Excel using the Microsoft's Import Wizard.


Issue summary report


A report can be quickly generated to summarize issue information.


1. Start issues.
2. Select "Create/Modify" ... from the Reports menu. A Report Definition form will appear.
3. Select "HTML" from the Formats list.
4. Select "New Filter" from the Edit menu. A Report Filter form will appear.
5. Select "Include all attributes" from the View menu.
6. In the bottom section of the Report Filter screen, Select Sort 1st for the State attribute.
7. Select Save as... and a Save Report Filter form will appear.
8. Enter summary in the name field select Ok.
9. Select "Cancel" on the Report Filter form. The form will disappear.
10. If desired, enter Title and Description in the Report Definition screen.







Razor Customization & Personalization 223


© 1992-2009 Visible Systems Corporation, All rights reserved.


11. Select "html" in the Format list and "summary" in the Filter list.
12. Select 'Save As ...' and enter summary.html in the Output File Name field of the Report Definition
screen.
13. Select OK.
14. Select Preview on the Report Definition form. A Web browser will appear with a table containing the
selected information...


Percentage of issues at a certain state


A report can be generated to summarize issues at a given state.


1. Start issues.
2. Select "Create/Modify" from the Reports menu. A Report Definition form will appear.
3. Select "Pie chart" from the Formats list.
4. Select "New Filter" from the Edit menu. A Report Filter form will appear.
5. Select "Clear all attributes" from the View menu. 
6. In the 'Select from' pane, double-click the State attribute and note that it appears in the 'Output order"
pane.
7. Select Save as... and a Save Report Filter form will appear.
8. Enter state and select Ok.
9. Select Cancel on the Report Filter form. The form will disappear.
10. Back in the Report Definition screen, enter a Title and Description and make sure "pie chart" is
selected from the formats list and "state" is selected from the filters list.
11. Select 'Save As.." and enter state.html in the Name field for the Report Definition and click OK.
12. Note that the new report definition name now appends the Report Definition screen title.
13. Make sure a Web browser is running.
14. Select Preview on the Report Definition form. A Web browser will appear with a pie chart
summarizing the percentage of issues at each state.
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Count of files by file type


A report can be generated to count files by type.


1. Start versions.
2. Select "Create/Modify..." from the Reports menu. A Report Definition form will appear.
3. Select "Bar chart" from the Formats list.
4. Select "New Filter" from the Edit menu. A Report Filter form will appear.
5. Select "Clear all attributes" from the View menu. Double-click the "Filetype" attribute.
6. Select Save as... and a Save Report Filter form will appear.
7. Enter file type and select Ok.
8. Select Cancel on the Report Filter form. The form will disappear.
9. Back in the Report Definition screen, enter a Title and Description and make sure "bar chart" is
selected from the formats list and "file type" is selected from the filters list.
10. Select "Save As.." and enter filetype.html in the Name field for the Report Definition and click OK.
11. Note that the new report definition name now appends the Report Definition screen title.
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12. Make sure a Web browser is running.
13. Select Preview on the Report Definition form. A Web browser will appear with a barchart
summarizing the percentage of issues of each file type.


11.8 Miscellanea


Printing customization


Destination of the printed output is controlled by the user's print command, which is configurable via the
Print Setup... option of the File pulldown menu.


The defined command will receive the contents of the information to print on stdin.  For example, to send
output to the printer queue named 'eng' a user would define their print command as "lpr -Peng".


E-mail composition script


Sending e-mail to us via the e-mail dialog is controlled via Xdefaults settings. Refer to "E-mail back to
Support " for details.275
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Changing the compression engine


To change Razor's compression engine, create the script $RAZOR_UNIVERSE_DIR/Scripts/compress.
The script MUST return 0 on success or 2 if the compress worked but made the file bigger. All output
MUST go to stdout.


Custom help files


It is possible to customize the Razor help files for each separate database. To do this, perform the
following steps:


1. Create a help directory for each database and then copy the $RAZOR_HOME/help files to the new
directory.


2. Add the variable RAZOR_HELP_DIR to the rz_prep and rz_prep.sh file for each appropriate database.
This variable should point to the directory that contains a 'help' directory with your customized help files.


3. Modify these files to suite your requirements.


General suggestions


As with the issues program, we generally encourage people to start with a minimalist approach. Keep
the list of attributes down to only those that would be truly handy for people to filter on. For example, if
your file naming convention already indicates which sub-system the file relates to then there is little need
to define a similar attribute.


By and large, with the exception of STATEs, most attributes are set at the time a file is introduced into
the system and seldom change after that. They then serve as convenient mechanisms for filtering the
display and doing blanket inclusion/exclusion efforts with the threads program.


The assignment of attributes to files should be illustrative and useful, not simply clerical and
bureaucratic.


See also...


• Changing your mind
• X Resources
• The entire section on Scripts !
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12 Writing Your Own Shell Scripts


One of the key factors in the design of Razor is its utilization of simple ASCII files as the underlying
database (as opposed to a relational/SQL database). By staying "close to UNIX," users can more easily
tap into the wealth of existing tools and skill sets on the market rather than learning and relying on yet
another 3rd party system.


Before being able to write effective and useful scripts, it is of course, important to have a working
familiarity with how the Razor database is organized. A detailed discussion of the directory structure and
database file syntax is provided in the Appendices of this manual for your reference.


NOTE: Typically when writing scripts, temporary files are created or need to be created. Ensure
that you refer to the Razor-defined RAZOR_TMP environment variable in your scripts for all references to
temporary directories.


Razor comes with some excellent examples "out of the box". Look in the directory $RAZOR_HOME/
examples for some examples, sample scripts, pearls of wisdom, etc. A README file in this directory
contains a list of all of the example files and a short description of their usage. With each new release of
Razor, the examples are updated and enhanced, so it makes this a rich source of examples.


This section discusses several points that will help you understand and write shell scripts which can
expand the functionality of the Razor tool suite. 


Using rz_utils
The file rz_utils is a collection of Bourne/Korn shell subroutines which greatly simplifies the task of
interacting with the Razor database. It virtually eliminates the need for you to directly parse the various
directories and info files, providing a wide variety of functions.


To use rz_utils, your Bourne/Korn shell script will need to "dot" in the file. For example...
#!/bin/sh
. $RAZOR_HOME/scripts/rz_utils
#...continue on from here...


rz_utils does not depend upon any external parameters being set. Once "dotted", you'll be able to take
advantage of the functions described below, much as you would a normal UNIX program. 


display_issues_from_list <list> [<sig file>]


Dump out the contents of a list of issues. The input file which contains the list must have entries of the
form:
<issue group>|<issue number>
        
An optional second parameter may be passed which is the name of a file containing a signature block
which should be appended to the output of each issue.


find_state <info file>


Get the highest state value.


find_state_ver <state name> <info file>
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Find the version/text for the specified state.


find_transition INFO NEW_INFO


Find the transition from the current state to the new state.


folder_name <name>


Returns the top-level folder name for the given path.


get_activity [-d <delim>] [-p <state>] [-a <action>[...]] <activity file>


Build a list of files that have been related to this issue. This list will contain the highest version of each
file.


get_db_field <field name> <info file>


Obtain the value of a database field entry (such as LATEST_VERSION).


get_field [-d <delim>] <attr name> <info file>


Get an attribute value for a given field. If the <delim> is defined, field values will be separated by that
delimiter. Otherwise, field values will be space separated.


get_raw_field <field name> <info file>


Get a field without tweaking it like get_field() does. This is useful for getting the value of a TEXT_FIELD.


get_time_field <field name> <info file>


Get the integer time value for a time stamp.


get_time_string <field name> <info file>


Get the time string value for a time stamp.


issues_at_state <state name>


Dump out a list of issues at the selected state.


sort_thread_commands  <unsorted thread commands>


Sort a list of threads commands of the form 
+ file2 2.5
+ file1 1.7
+ file1 1.6.1
+ file2 2.4


so that for each distinct file name, only one line appears, and the version number is the max of all the
version numbers for that file. 
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NOTE: Note that version numbers cannot be sorted properly with "sort".


state_info <state name> <info file>


Shortcut for file_state_ver().


Using rz_html_utils


The file rz_html_utils is a collection of Bourne/Korn shell subroutines which provide a neat way of
encapsulating HTML formatting for shell scripts.


To use rz_html_utils, just as in using rz_utils, your Bourne/Korn shell script will need to "dot" in the file.
For example...


#!/bin/sh
. $RAZOR_HOME/scripts/rz_html_utils
#...continue on from here...


In contrast to rz_toolbox, rz_html_utils does not depend upon any external parameters being set. Once
"dotted", you'll be able to take advantage of the functions described below, much as you would a normal
UNIX program. 


init_html <title> [<background color>]


Initialize the HTML. This should generally be done first and only once.


end_html


End of HTML. This should be done last.


row_heading <heading string>


Define a row heading.


new_row


Start a new row in a table.


end_row


End a row in a table.


fill_cell <title> <val> <span> <align>


Fill a cell in a table. All four parameters should be specified. The title will appear in bold text. If the title
should be omitted, an empty string must be specified. The <val> will follow the title. The <span>
specifies how many cells to span. If missing the default is 1. The <align> parameter specifies how the
contents of the cell should be aligned. The default is left.


init_table <caption> <border width>
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Initialize a table. This should be done once per table.


end_table


End an HTML table. There should be one of these for each init_table.


insert_text_block <file>


Insert the text contained in the file.


main_heading <heading> [<alignment>]


Create a main heading. This function should be called after init_html. An optional alignment value can be
set to control placement of the heading. The options are left, center or right. The default value is right.


list_heading


^cf0 Add a heading.


create_anchor <name> <title> <file>


Create an anchor for a file.


line


Insert a line break.


start_pre


Start a preformatted paragraph.


end_pre


End a preformatted paragraph.


font <size> (+1, +2, etc...)


Set Font size and characteristics.


Using rz_toolbox


The file rz_toolbox is a collection of Bourne/Korn shell subroutines, similar to those previous discussed
in rz_utils, which provide a higher level of granularity in interacting with the Razor database. These
routines are generally less efficient than the corresponding rz_utils functions, but do provide a more
detailed level of granularity.


rz_toolbox is a collection of Bourne/Korn shell subroutines which greatly simplifies the task of interacting
with the Razor database. It virtually eliminates the need for you to directly parse the various directories
and info files, providing a wide variety of functions.


You are in no way restricted or confined to use rz_toolbox; you are always free to parse the database
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yourself. In fact, if you have a specific set of things you are looking to accomplish and are adept at
writing scripts, you may be able to write a very precise and efficient script on your own. Also, since
rz_toolbox is a Bourne/Korn shell tool, you will not have the option of taking advantage of it if you are
using the C shell (or TCL, or Perl, etc.).


To use rz_toolbox, your Bourne/Korn shell script will need to "dot" in the file. This is analogous to a
#include in C programming, or using the source command in the C shell. For example, a typical script
may begin as follows...


#!/bin/sh
. $RAZOR_HOME/scripts/rz_toolbox
#...continue on from here...


In order to take advantage of any of the rz_toolbox functions, the environment variables RAZOR_HOME
and RAZOR_UNIVERSE_DIR must be set. This may already have been handled by previous reference to
the appropriate rz_prep file, or they could directly be set through in-line reference in the script itself.


Once properly set, you'll be able to take advantage of the functions described below, much as you would
a normal UNIX program. The descriptions are broken out into three broad categories. The code samples
are shown assuming that the lead in shown above has already occurred.


Utility routines


razor_groups


This function sets the environment variable RAZOR_GROUPS to contain a space separated list of all the
groups within the indicated RAZOR_UNIVERSE_DIR.


The following code sample will do a simple loop, printing out the names of all the known groups.


#!/bin/sh
. $RAZOR_HOME/scripts/rz_toolbox
razor_groups
for g in $RAZOR_GROUPS ; do
    echo "Group name = $g"
done


razor_files [-o]


This function generates a space separated list of all the files under control within a single Razor group.
With the -o option, the list is sent to standard out, otherwise the environment variable RAZOR_FILES is
set to the list. The environment variable RAZOR_GROUP must be set to indicate the group of interest
prior to calling the function. 


Optionally, you can set the environment variable RAZOR_PATTERN to hold a UNIX wildcard expression.
If set, it will be used to filter specific files.


The following code sample will print out the names of all files within the "fruit" group which have the
characters "xy" in their names.


#!/bin/sh
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. $RAZOR_HOME/scripts/rz_toolbox
RAZOR_GROUP=fruit
RAZOR_PATTERN='*xy*'
razor_files
for f in $RAZOR_FILES ; do
    echo "---- $f"
done


TIP: Remember that issues in the problem tracking system are also stored as separate files. The
default issues group is named "++ISSUES++". Additional issues groups are named "++ISSUES++.
<issue_group>". Knowing this, you can set the RAZOR_GROUP accordingly and use the above function
to traverse issues!


razor_folders [-o]


This function generates a space-separated list of all folders within the current group. With the -o option,
the list is sent to standard out, otherwise the environment variable $RAZOR_FOLDERS is set to the list.
The environment variable RAZOR_GROUP must be set to indicate the current group prior to calling the
function. Optionally, you can set the environment variable $RAZOR_PATTERN to hold a UNIX wild card
expression. If set, it will be used to filter specific folders.


razor_issue_num


This is a simple courtesy function which will take a single integer argument and reshape it into a Razor
style issue number. The output is placed in the environment variable $RAZOR_ISSUE_NUM for
subsequent use. For example, the lines...


razor_issue_num 1234
echo $RAZOR_ISSUE_NUM


... will output the string "I..1-234".


NOTE: The prefix defined in the file $RAZOR_UNIVERSE_DIR/DOMAIN_01/<issue group>/
Tables/Prefix will be honored.


check_server_down


This function tells you whether the database specified by environment variable $RAZOR_UNIVERSE_DIR
is being served. A return of 0 indicates the database is being served, 1 means it isn't.


Parsing for attributes


razor_learn <filename>


If the environment variable $RAZOR_GROUP is set to the name of the group you are interested in, this
function will take the filename supplied by the single argument and parse the related Info file. The end
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result will be a large collection of new and specially named environment variables which tell everything
there is to know about the file in question. 


The function returns all of its information through a collection of environment variables which can
subsequently be queried by the script. The following table describes the variables which will always be
generated.


The razor_learn function will yield all of the environment variables described below regardless of the
nature of the corresponding Attributes file in use. Additionally, a collection of group-specific variables will
be created with names that correspond with the various attribute labels. 
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For example, if there were attributes with the labels "Filetype" and "Library", then the razor_learn
function would generate the environment variables "RAZOR_Filetype" and "RAZOR_Library" to hold their
values. Other than the "RAZOR_" prefix, the spelling and capitalization of the labels will remain the
same. Space and punctuation within the label name itself will of course be translated to underscores.


TIP: An example showing the usage of razor_learn, as well as some of the other functions defined
in the rz_toolbox, may be found in the script $RAZOR_HOME/examples/sample_toolbox_usage.


The exit status of the razor_learn function returns a 0 if there were no problems. Otherwise, error
messages will be sent to the standard output, and you will be returned a non-zero exit status, which can
be sensed by the "$?" environment variable.
The razor_learn function is perhaps the most powerful in the collection supplied by rz_toolbox. In many
cases you can write a few lines of shell script which can be used to extract the specific information you
are looking for in a much more efficient manner.
For example, if the only information you need is the setting of the 'Author' ONE_OF_MANY, then the
following lines of shell script will run much more quickly than the razor_learn function...


INFO_FILE=$RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Info/filename
AUTHOR='awk '/ATTR.*Author/ {print $3}' $INFO_FILE'


The decision as to whether or not you should use razor_learn, or code something yourself will be based
on balancing your need for shell code efficiency against your available time and comfort level for writing
scripts.


razor_learn_file <filename>
This is a special purpose subset of the razor_learn function described above. Rather than parsing just
the file found in the Info directory of the indicated $RAZOR_GROUP, it will parse any similarly shaped
file, as identified by the argument to the function.
It is expected that this function will be used most often to interpret information that has not yet been fully
recorded in the database. 


TIP: The issues program creates a copy of the issue form as a simple disk file, (in the format of
an Info file), and offers it to apply.before scripts as the first argument on the command line. This allows
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the script to examine the information on the form prior to it being passed to the database server.


razor_attr_val <attribute_label>
This function will set environment variable $RAZOR_ATTR_VAL to the value of the specified attribute
label. This function should be called after invoking razor_learn so $RAZOR_ATTR and $RAZOR_<attr
name> are properly defined.


razor_versions
This function fills the environment variable $RAZOR_VERSIONS with a space separated list of all the
version numbers for the file most recently examined with the razor_learn function. This functionality was
separated from razor_learn in the interest of efficiency.


Filtering by script


Just as the filter panel of the GUI's allow you to prune the main display list to a specific set of files, it is
possible to achieve the same effect through functions in the rz_toolbox. 


razor_load_filter <filter_file>


This function is meant to read in the filename specified as the single argument. Each line of the file
should contain a single attribute name, a tab, and a list of acceptable values. The resulting collection
represents a filter which may be applied against files in the database.


razor_filter_match


Given that a proper filter has been loaded (above), this function compares the most recently razor_learn'd
file and returns a 1 if it matches all of the selection criteria.


For example, if we wanted to print all of the files in the apple group which were written by Ken and were
for the HP platform, then we could use the following script.


#!/bin/sh
#
# Source in the toolbox, set the group, and get a list of
# all the files in it
#
. $RAZOR_HOME/scripts/rz_toolbox
RAZOR_GROUP=apple
razor_files
# 
# Create a temporary filter file definition, load it in,
# then delete the file
#
FF=/tmp/ff.$$
cat >$FF <<-EOF1-
Author    Ken
Platfor m  HP
-EOF1-
razor_load_filter $FF
rm -f $FF
#
# Now spin in a loop for all the files and print the ones
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# that match what we're looking for
#
for x in $RAZOR_FILES ; do


    razor_learn $x
    razor_filter_match
    if [ $? -eq 1 ] ; then


        lpr $x
    fi
done


The above example is perhaps overkill for such a simple task, but it does serve to illustrate how several
of the themes discussed in the rz_toolbox may be used together to achieve a reasonably sophisticated
solution.


Using the system_setup script


Razor is designed to run on a wide variety of platforms. To accommodate the variations in different UNIX
dialects as well as Windows 2000/XP, most of the supplied scripts will source in the system_setup
script from the $RAZOR_HOME/scripts directory. It does a quick determination of which kind of system
it is running on, and then sets up a number of shell variables which are later used instead of straight
UNIX-style commands.


For example, some variations of the echo command support the outputting of lines without a carriage
return. On other systems however, its necessary to use the printf command. The system_setup script
defines a shell variable called _ECHO_N_ which breaks out to "echo -n" on some systems, and "/usr/
bin/printf" on others. Through this, a shell script can be written that will run equally well on all systems.
. $RAZOR_HOME/scripts/system_setup
$_ECHO_N_ "Que pasa? "


The system_setup script is automatically sourced in if you've referenced the rz_toolbox. You are, of
course, free to review it and use it on its own if you work in a heterogeneous network and face the same
challenge.


Customizing printouts of issues


The Print button in the upper right corner of an issues form invokes the shell script rz_issue_print.  By
creating your own copy of rz_issue_print, and placing it earlier in your search path, you can override the
default output format.


The default rz_issue_print script supplied as part of the Razor release resides in the $RAZOR_HOME/
scripts directory. It is accompanied by a file rz_issue_print.awk which it expects to reside in the same
directory. To utilize your own version of the script, it is suggested that you copy both of these files to the
$RAZOR_UNIVERSE_DIR/Scripts directory. Since the rz_prep files automatically place this directory
earlier in your search path, it will find and use this copy in preference to what comes with the release.
As supplied, the script parses the issue form into a very basic structure and sends it to the requesting
client as simple ASCII.  If you are content with the organization of the data on the printout then no
modifications are necessary.


Note: Refer to "Printing customization " for details on controlling the printed output destination.183
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If you wish to generate your own output format, overhaul the script and its associated awk program as
you see fit. The comments at the top of the existing file should be able to guide you fairly well as to what
arguments are supplied to the script on invocation. Please bear in mind however that the script named
rz_issue_print is also utilized as one of the default options on the Reports menu. 


Writing report scripts for issues


By making simple edits to the Reports file in the <issue group>/Tables directory of the database, it is
possible to define a set of report scripts which can be run directly from the menu bar of the issues
program. The file syntax is quite straight forward. Each line of the file contains at least two tab separated
fields. The first is the label which will appear on the menu bar, and the second is the script which will be
run. An optional third field controls how the issues program will call out to the report script, as defined
below. A line consisting only of the tag SEPARATOR will cause a visual separator to appear on the pull-
down menu.


To invoke a report script, the user first uses the filter and sort panel to arrive at the collection of issues of
interest. Once the list is filtered, the user must highlight the issues of interest. One method is to use the
Select all issues option from the menu mouse button. The report is run against only the issues selected,
and will be passed in the order displayed (not the order in which they were selected by the mouse).


The standard output of the report script is captured and displayed in a text panel upon completion. The
user has the option of reviewing, dismissing, printing, or saving it to a file. Note that if the file does not
produce any output, then the program will not pop up a text panel.


For historical reasons, the issues program supports two mechanisms for calling out to attached report
scripts, the batch method and the serial method.


The batch method


This is the preferred method for writing and calling out to report scripts. To utilize it, the related line in the
Reports file must have a third tab separated field which contains the string "name", as shown in the
example below.


Priority Matrix   rz_issue_tally   name


When invoked, the script will be passed only two arguments. The first argument will be the name of a
temporary file which contains a list of all the selected issues. The issue numbers will each be on their
own line. The second argument will be the process id of the calling issues program. This will match the
environment variable RAZOR_PID, which is also available.


It is expected that the report script will cycle through the issues indicated by the file ($1), gather
information and send it to its standard output.


Properly written, a report script can also be invoked directly from the command line. The top section of
the rz_issue_tally script in $RAZOR_HOME/scripts has an example of how this can be accomplished. It
examines the arguments supplied on the command line and decides where to get the list of files. If there
are no arguments, it works off all the issues in the database. If the second argument equals the value of
RAZOR_PID, then it works off the file mentioned in the first argument. Failing either of those tests, it
simply accepts all the arguments on the command line as the list of issues of interest.
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if [ "$1" = "" ] ; then
    LIST='ls'
elif [ $# = "2" -a "$2" = "$RAZOR_PID" ] ; then
    LIST='cat $1'
else
    LIST=$*
fi


The serial method


The serial method for invoking report scripts is supported mainly for historical reasons. 
To use the serial approach, there should be only 2 fields on the line in the Reports file; the 3rd "name"
field is not used. In this situation, the script will be called once for every file identified from the main list
of issues.


The script will be given 4 arguments on its command line for each invocation. The first is the issue
number itself. The second field is the archive version number of the most recent form of the issue in the
database. The third argument is the process id of the calling issues program.


In the Reports file, if the third field is "env", the report script will be invoked once for each selected item
(just as it is when nothing appears in field 3). Instead of extracting a copy of the issue, the user's
environment will be set as per the environment variable table shown in "Issues form values as
environment variables ."


The fourth argument is a flag indicating where in the sequence of issues this invocation is. For the first
call in a series of selected issues, the fourth argument is RZ_START. For the last call, the argument is
set to RZ_END. If there was only one issue selected, then the flag is set to RZ_START_END. All
intermediate calls have the fourth argument set to an empty string.


Prior to each call to the script, a read only copy of the full issue is extracted from the database and put
into the RAZOR_TMP directory. Its filename will be the concatenation of the issue number, a number
sign ("#"), and the process id passed in as the third argument (e.g. $RAZOR_TMP/I...-500#16231).


As with the batch method, all output from the script is captured, but this time it is gathered over the
series of invocations. These are then formed into a single long message which is displayed in a text
panel upon completion of the whole event.


TIP: During the processing of issues in the serial method, a small notice will appear on the
display, offering a count down of the issues as they are passed along to the report script. Dismissing
this window will cause the issues program to abbreviate the list and terminate the report process.


Automatic printing of reports


Normally, report output is printed by selecting the Print button from the report output window.  However,
it is possible to force automatic printing and bypass display of the output by specifying the "print" option
in the Reports file.  This typically would be combined with the "name" option as shown in the sample
below.


Summarize issu erz_issue_summariz ename, print
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Any reports that are configured with the print option will appear in the Reports pulldown menu with an
asterisk (*) appended to the report label signifying that auto-printing is enabled.


Issues form values as environment variables


When creating or modifying issues, the values on the issue form will be output to the script's
environment as environment variables. The table below lists these environment variables.


E-mail addresses specified in the Permissions file will expand environment parameters that appear
there. This allows e-mail to be sent directly to addresses that appear in fields on the form. For example,
if the file Responsibility contains e-mail addresses, the entry $RAZOR_ATTR_Responsibility in the
Permissions file will send e-mail to those shown in that field.


Note: See Issue STATEs  "(permissions)." 


Attaching scripts to buttons


Perhaps the single greatest opportunity for customization of Razor lies in the ability to attach shell
scripts to run both before and after many of the actions. Scripts which run before Razor performs an
action have the ability to veto the pending action by returning a non-zero exit code.


Versions & threads


There are dozens of unique locations where scripts can be attached to the actions of the versions and
threads operations. These extensions are enabled by editing the Actions file in the related Tables
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directory. Each line in the file represents a different button on the related interface to which scripts can
be attached.


The following two tables show not only where scripts can be attached, but also what arguments will be
passed to the scripts when they are executed.


Buttons for the file operations


Buttons for threads operations
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In the tables above, the first argument supplied to the script is always the name of the file or thread
itself. The second argument is the affected version number of the related file or thread. Note that in some
cases, the before and after scripts will be provided different version numbers. Specifically, in the versions
program, the checkin.apply before script is told the original version number, and the after script is told
the version number of what the check-in effort produced.


The third and fourth arguments to the scripts are optional, and vary in purpose. In the above table,
"fullpath" indicates that $3 is the full path name to where the file is coming from or going to. The term
"dirname" is simply the directory part of "fullpath".


Both the introduce and check-in operations of the versions program provide the related after script a
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fourth argument. This flag indicates whether or not an imbedded operation took place, i.e.,
 


0 - files were taken during the operation
1 - readonly copies of the files were left behind
2 - the files were immediately checked back out again


Note that for cases 1 and 2 above, the associated before and after scripts for the check-out readonly or
check-out operation are also performed. For example, if someone introduced a file and arranged such
that a readonly copy be left behind, the following sequence of scripts will be executed...


introduce.apply before script
readonly.apply before script
readonly.apply after script


introduce.apply after script


NOTE: In this special flow of events, the nested 'before' script would no longer have its normal
ability to veto the action.


For the uncheck-out operation, the attached scripts are passed the version number that the file would
have gone to, if the edits had been completed by a check-in. Also note that the uncheck-out operation
allows the user the option of leaving readonly copies of the files behind. If this is chosen, then the related
readonly.apply scripts will be run, and the 3rd argument to the uncheck-out after script will have the
directory the readonly copy was placed into (otherwise $3 would be "N/A").


Programming tip: If an introduce.apply script returns the special non-zero exit value of 99, the
versions program will skip the file being introduced and not generate an error message/dialog. This could
be very useful in cases where directories are being introduced. For example, it may be desirable to skip
all compressed files, object files and executables.


In addition to the information available to the scripts via the command line, they are also provided a
number of shell environment variables, as outlined below:
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The <operation> part of the setting of RAZOR_ACTION is based on both which program was involved,
and the action the user selected, as shown below...


 For the versions program, <operation> could be: BRANCH, BUMP, CHECKIN, CHECKOUT, DUP,
INTRODUCE, PROMOTE, PROPS, READONLY, REMOVE, RENAME, SAVE, or UNCHECKOUT.


 For the threads program, <operation> could be DOUBLE_CLICK, EXTRACT_FILE,
EXTRACT_THREAD, EXTRACT_PROJECT, THREAD_CREATE, THREAD_MODIFY,
PROJECT_CREATE, or PROJECT_MODIFY.


 For the issues program, <operation> could be either ISSUE_CREATE or ISSUE_MODIFY.
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 For command line, <operation> is set to BRANCH, BUMP, DUP, INTRODUCE, PROMOTE, SAVE,
REMOVE, CHECKOUT, CHECKIN, UNCHECKOUT, READONLY


Whether or not a before or after script takes advantage of all this information is a completely different
story.
Let's look at a quick example to illustrate some of the above concepts. Suppose that the user dick was
a junior engineer, and was not to be given the same level of trust or latitude as the rest of the engineers.
Specifically, when checking out a file for edit, he must associate the activity with one or more issues in
the database. The following script, when attached as a checkout.apply before action, will do the
necessary screening.


#!/bin/sh
if [ $USER = "dick" -a "$RAZOR_ISSUES" = "" ] ; then
     echo "Sorry Dick... Please associate this action "
     echo "with one or more issues from the Razor database."
     exit 1
else
     exit 0
fi


Execution order for attached scripts


It should be remembered that if multiple files are being acted upon, the attached scripts will be executed
for each file selected. In other words, if the user is checking out 3 files for edit in one operation, the
related before and after scripts will be invoked 3 times each; once for each file. For example, if a user
were checking out the three files "apple", "grape", and "peach", then (if attached) the following sequence
would occur...


-      run before.apply script for apple
<Razor would process apple, and update database>
run after.apply script for apple
-      run before.apply script for grape
<Razor would process grape, and update database>
run after.apply script for grape
-      run before.apply script for peach
<Razor would process peach, and update database>
run after.apply script for peach


This pattern of 'run before script - do processing - run after script' holds true for all of the multi-file
operations with one exception; introducing files. In this case, if we were introducing the files "barney",
"fred", and "wilma", then the sequence would be...


-      run before.apply script for barney
run before.apply script for fred
run before.apply script for wilma
-      <Razor would process barney, fred, and wilma, and update database>
-      run after.apply script for barney
run after.apply script for fred
run after.apply script for wilma


Issues


As with the versions and threads programs, scripts can be attached to run both before and after edits are
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done to the issues database.
The same on-screen form is used for both the creation and modification of issue information. It's
occasionally useful though to treat the two events differently. The arguments supplied to the scripts are
shown in the following table.


For a discussion of the preload entry, see the section " Pre-loading an issues form ."


Buttons for issues operations


The filename points to a readonly copy of an ASCII file containing all of the information on the issue form.
The file resides in RAZOR_TMP, and will have a name that is the concatenation of the issue number and
the process id of the issues program itself. Please note that this file has been generated and provided to
the scripts for information only. Any changes made to the file by the script are ignored.


The second argument provided to the issue_create.apply and issue_modify.apply scripts is a space
separated list of e-mail addresses that will be notified. This list comes straight from the related state
change in the Permissions file, and is again provided for the sake of completeness.


Also, as outlined in the table above, scripts attached to buttons in the Razor program are provided a
number of environment variables which give extra information.


As with scripts attached to buttons in the versions or threads programs, the before script has the ability
to veto the pending razor operation by returning a non-zero return code. For example, if we wish to
prevent the user 'joe' from creating an issue with the Priority field set to High, we could attach the
following script as the create.apply before action.


NOTE: The user is able to specify via the Options file (see "copy
FileAttachForIssuesBeforeScripts ") the behavior of the issues before scripts regarding issues file
attachments.


#!/bin/sh
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N='egrep -c "ATTR.*Priority.*High" $1'
if [ $N -gt 0 -a "$USER" = "joe" ] ; then
    echo "Sorry, but you're not allowed to set"
    echo "an issue to be high priority."
    exit 1
else
    exit 0
fi


If Joe were to try and create such an issue, the output from the script will be captured and shown to him.


Informing the user from attached scripts


Simple notification - Razor_notice file


The examples in the prior section show how to attach scripts to both the versions and issues program
which have the potential of vetoing a user action. In such cases, when a veto occurs (by a before script
returning a non-zero exit status), all the standard output from the script is saved, and eventually shown
to the user through a window such as the one below.


Note: And no... the little sailor is not sticking his tongue out at you; he's smiling. You can learn more about
Occam the Icon by reading through the list of common questions and answers .


It's occasionally preferable to have the message back to the user appear in a nicer format. To
accomplish this, instead of having the text caught as the standard output of the script, it should be
written out to a specific temporary file. The filename itself is the concatenation of the Razor temporary
directory ($RAZOR_TMP), the string "/Razor_notice.", the $RAZOR_PID and the exit status the script
will be returning. If this file is present, the contents will be caught by the program and placed in a notice.


For example, working with the script in the prior section, if we replaced the echo statements as follows...


NOTICE_FILE=$RAZOR_TMP/Razor_notice.$RAZOR_PID.1
echo "Sorry, but you're not allowed to set" >> $NOTICE_FILE
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echo "an issue to be high priority."        >> $NOTICE_FILE


... then the display presented to the user will have a much more concise appearance.


As a general rule, this method for instructing the user is preferred. There are situations, however, where
you may prefer to use the default behavior, such as when the instructions and comments back to the
user are particularly long and detailed.


Interactive notification - rz_notice (local, UNIX only)


There may be occasions within scripts that it is desirable to ask the user something, get the answer,
and make an intelligent decision based on the response. The program rz_notice will display an X
window, with configurable text, buttons, location, window title, and more. Usage is...


rz_notice [-center] [-button <name>[:<return code>]] \
[-field <name>] [-default <name>] [-text <string>] \
[-file <file>] [-title <string>]


where


•-center centers the window on the screen


•-button creates a button named <name>•-field creates a named text input area named <name>
•-text creates a text string


•-file includes the contents of <file>


•-title sets the window title to <string>


Field values entered are sent to standard out in the form:


<field name>="<value>"


So this...
rz_notice -center \
-title "Razor notice" \
-text "Enter the value for:" -field "Due_date" \
-button "Set":11 -button "Unknown":22


would display this...
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and assuming the user entered "1/1/2004" and clicked "Set" would generate this...


Due_date="1/1/2004"


NOTE: The good news is this cool rz_notice can really enhance your scripts with interactive
inputs from your users. The bad news is it is only available for UNIX, non-remote clients.


Pre-loading an issues form


New issue forms naturally provide default values for each of the attributes. This means that a fresh form
has empty TEXT_FIELDS, nothing selected on the X_OF_MANY's, and the first item selected for the
ONE_OF_MANY attributes. It's possible, however, to have new issue forms come up with a
programmable set of defaults.


There is a line in the Actions file which permits the attachment of a pre-load script. The initial setting of
the line is as follows...


preload   n/a   n/a


To enable issue form preloading, replace the first "n/a" in the line above with the name of a script which
is to be run. You must either enter the full pathname to the script, or be sure that the script is on the
search path for whomever would be running the programs. (A good location for such scripts would be in
the $RAZOR_UNIVERSE_DIR/Scripts directory, which is automatically placed on the search path by the
rz_prep file.)


In order to set the default values for the issue form, the preload script should make a series of single line
entries in the file $RAZOR_PRELOAD (which is an environment variable available to the script). Each
line must have the label for the desired attribute, a tab, and the desired setting for each value you wish to
establish.


An example preload script is shown below. It preloads the priority of a new issue to be High if the boss
is creating it.


#!/bin/sh
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if [ "$USER" = "boss" ]
then
    echo "Priority   High" > $RAZOR_PRELOAD
fi


Much more sophisticated arrangements can also be established. For example, a single preload script
could look for a $HOME/bin/razor-preload script for each user. If present, it would run this instead of its
own code. This would allow each person custom initializations.


Scripts which receive and process e-mail


Razor encourages the use of an often overlooked capability on UNIX systems; the ability to send e-mail
directly into a program or script (as opposed to sending it to a specific user). The mechanics for doing
this are fairly straightforward, and allow for a great deal of flexibility and power.


To best understand how this works, we'll explore it in the context of an example. 


The issues program allows for specific e-mail addresses to receive a message on certain state
transitions, as defined in the Permissions file . 


NOTE: For details on this, see Issue STATEs  (permissions). 


Suppose, however, that rather than always sending e-mail to a fixed address, we wanted to notify the
originator of an issue when the issue is Closed. A common approach is to use the Permissions file, but
instead of having the issues program send e-mail to a user account, it sends the message directly into a
shell script which decides the best route for further e-mailings.


The first step is to write the script itself, a variation of which is shown below. (A more fully commented
form of the script can be found in the Razor release in the file 


$RAZOR_HOME/examples/notify_on_closure.)
#! /bin/sh


FULLTEXT=/tmp/$$.1
cat > $FULLTEXT


. /local/razor_db/rz_prep.sh


. $RAZOR_HOME/scripts/rz_toolbox


INUM='egrep 'Issue.*has been mod' $FULLTEXT | cut '-d ' -f3'


RAZOR_GROUP=++ISSUES++
razor_learn $INUM


INFO_FILE=$RAZOR_UNIVERSE_DIR/DOMAIN_01/++ISSUES++/Info/$INUM


ORIGINATOR='nawk '/STATE.*Submit/ {print $4}' $INFO_FILE'
      WHEN='nawk '/STATE.*Submit/ {print $3}' $INFO_FILE'


mail -s "$INUM has been closed" $ORIGINATOR << -EOF1-
FYI... Issue number $INUM, (which you originated on $WHEN)
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has been closed out.
       Title: $RAZOR_Title
    Priority: $RAZOR_Priority
-EOF1-


exit 0


In brief, the script is performing the following steps...


1. It first captures whatever is coming in on standard input out to a temporary file. This is the body of the
e-mail sent as a result of the state transition of the issue.


2. The script then sources in the appropriate rz_prep.sh file, and follows that by referencing the
rz_toolbox (discussed earlier (See "Using rz_toolbox ")).


3. Next, it extracts the issue number from the body of the e-mail message, and uses that as an
argument to the razor_learn function.


4. The info file for the issue is quickly parsed to discover who originated the issue, and when it entered
the system.


5. An e-mail message is composed and sent back to the originator.


The second step is to make the appropriate modifications to the Permissions file. Fortunately, the format
of the file is fairly straightforward.  All we need to do is add a fourth field to the lines controlling the
permissions of who can bring the issue to the closed state. Examples of the related lines are shown
below...


Note: See Issue STATEs  (permissions). 


...
Submitted   Closed   *       closure
No-Action   Closed   *       closure
Active     Closed   *       closure
Completed   Closed   *       closure
Closed     Closed   nobody
...


Now, whenever an issue is transitioned into the Closed state, an e-mail message will automatically be
generated and sent to 'closure'.
The final step in accomplishing this is to make an appropriate entry in the /etc/aliases file for your site.
You must establish an e-mail address which pipes the message directly into the script. In the example
below, we've named the alias to be the same as the script name itself in the hopes of reducing
confusion, so the line in /etc/aliases would look like...


closure: "|/local/razor_db/RAZOR_UNIVERSE_DIR/Scripts/closure"


Note that the above edits require superuser assistance, and it will most likely need to be followed by the
running of newaliases and/or other programs to fully enable the address for your network.


NOTE: Razor supports e-mail notification of State Changes on Windows 2003 Server, 2000 & XP


228


203







Razor Manual252


© 1992-2009 Visible Systems Corporation, All rights reserved.


Servers. This functionality requires the use of Outlook or Outlook Express. Please see " E-mail
Functionality in Windows 2003 Server, 2000 & XP " for more details.


Debugging suggestions


Much of the activity associated with scripts attached to buttons happens behind the scenes, and, as a
result, the normal attack of populating the script with debugging output is not effective. There are a
couple of alternatives possible.


One approach is to have the shell script send e-mail messages out to a particular user account.
Although this works, it employs a circuitous route to the data you are looking to gather. You also have to
put up with a certain amount of system delay, and must deal with the chance that the messages will not
be received in the same order they were sent.


An alternative is to have the scripts append their output to a debugging file in a known location. If you
use this approach, you must remember to insure that the file has full read/write permissions.


A third option is to deliberately stall the script in action and send the output directly to the screen. The
sample script $RAZOR_HOME/examples/spill will do exactly this. It captures a variety of data into a
temporary file, and then invokes an xterm running vi on the file. This has the added advantage of
suspending the related Razor program while you are examining the output; the program will not continue
until you exit the vi editor.


NOTE: The spill script mentioned above is provided for illustrative purposes only. It is expected that
you will be able to take the methods and themes presented in it and expand upon them for your own
needs.
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13 Razor Directory Layouts


· Where the release is stored
· How a database lays out
· Where is the license stored


13.1 Where the release is stored


$RAZOR_HOME


Where the release is stored


Below is a diagram of the directory structure below $RAZOR_HOME. It is shown exactly as it would
appear after having run the script rz_install.


                /--- Razor_iw_lib1  -------+-- default 
                |                        \-- glyphs 
                |                  
                |-- bin 
                |-- doc                 
                |                 
                |-- examples -------------- small_glyphs 
                |                 


   razoradm -------+-- glyphs                 
                |-- help 
                |-- lib --------------------nls --------- local_im_tbl
                |-- sample_db 
                |-- scripts
                |                 
                |                       /-- Demo -----+-- Code_development
                |                       |                 
                |                       |-- Issues_tables_templates 
                \-- templates ----------+-- Threads_tables_templates
                                        |-- Tables 
                                        \-- Versions_tables_templates


1. Razor_iw_lib relates to IssueWeaver, which is purchased and documented separately.


We do not encourage making any modifications to the files or directory structure provided via the release
procedure. Doing so would complicate your efforts as you migrate from one version of Razor to the next,
as well as virtually eliminating the chance that our support team will be able to assist you if things go
wrong. Please do not edit or change anything under this release area.


Relative to the $RAZOR_HOME directory...


./bin
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./scripts


This is where the Razor executables and related shell scripts reside respectively. Both of these
directories are placed on a user's search path via the appropriate rz_prep files.


./doc


This area serves as a repository for Razor documents such as the Razor manual. View file
$RAZOR_HOME/README.manual for information on how to obtain the Razor documents.


./examples


Various sample scripts and Xdefaults files are stored here. These are provided for instructive purposes
only. They are typically heavily commented, and are intended to serve as launching points for your own
efforts at customizing the tool.View the file examples/README for a description of the various scripts
found in this directory.


./glyphs


./examples/small_glyphs


The glyphs directory contains a robust collection of *.xbm files. These are intended to be used as glyphs
attached to the main display of versions or issues. In our case, these were created with Sun's iconedit
program. You are free to use either these, or ones of your own design. The small_glyphs collection was
generated and donated by a customer. They are typically 12x13 pixels while a 'normal' glyph is 16 by
16.


NOTE: To see what glyphs are included with the Razor release, see Glyphs; supplied & exposed!


NOTE: To learn the mechanics of attaching them to the displays, see Associating glyphs to
attributes .


./help


This is where all the text for the help displays are stored.


./lib


The most notable entry in this directory is a XKeysymDB file. 


./sample_db


Customized issue and file control groups.  These customized groups may be added to a database via
the Razor Admin tool available on Windows 2003 Server/2000/XP or via the script
rz_add_customized_group on UNIX platforms.
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./templates, et al


As the name would imply, this directory holds template forms of the various files that come into play
when a database or group is being created.


13.2 How a database lays out


$RAZOR_UNIVERSE_DIR


How a database lays out


When a database is created, you supply an empty directory for the rz_new_database script to populate.
Directly into that directory the script will create the two rz_prep files, as well as a directory named
RAZOR_UNIVERSE. 


Below is a diagram of what will appear under the originally supplied directory. Note that the sourcing of
the rz_prep file (or dotting in the rz_prep.sh file by Bourne and Korn shell users) provides users with an
environment variable named $RAZOR_UNIVERSE_DIR, which leads directly into the
RAZOR_UNIVERSE directory itself.


                   /-- DB_Compatibility1


                   |
                   +-- Custom
                   |
                   |                   /-- ++ISSUES++
                   |                   |-- ++ISSUES++.Documentation
                   |                   |-- ++PROJECT++
                   |                   |-- Doc
                   |                   |-- Doc##Threads
                   |                   |-- Include
                   |                   |-- Include##Threads
                   +-- DOMAIN_01 ------+-- Lib
                   |                   |-- Lib##Threads
                   |                   |-- Server
                   |                   |-- Server##Threads
                   |                   |-- Spy
                   |                   |-- Spy##Threads
                   |                   |-- StarGuide
                   |                   \-- StarGuide##Threads
                   | 
                   |                       /-- Database
                   +-- Report_definitions -\-- definitions.<user>
                   | 
                   +-- Scripts
                   |
   RAZOR_UNIVERSE--+-- Tables
                   |
                   +-- Weaver
                   |
                   |                   /-- AIX
                   |                   |-- DIGITAL_UNIX
                   |                   |-- HPUX
                   |                   |-- IRIX
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                   |                   |-- IRIX64
                   |                   |-- Linux
                   +-- bin ------------+-- SCO
                   |                   |-- SUNOS4
                   |                   |-- SUNOS5
                   |                   |-- SUNOS5.x86
                   |                   \-- Windows
                   |
                   |                   /-- Issues_tables_templates
                   |                   |-- Tables
                   +-- templates ------+-- Threads_tables_templates
                   |                   \-- Versions_tables_templates
                   |


          rz_prep--+ 
                           |
     rz_prep.sh--\


1. This is a Razor file contains database compatibility information for upgrades.


If we look inside the $RAZOR_UNIVERSE_DIR, we'll see a few files which relate to the starting of a
database server. These files are described elsewhere. (See "Administration files .")


Also under the $RAZOR_UNIVERSE_DIR are various subdirectories, described below.


Custom


The Custom directory is where you should put scripts that are attached to various buttons. Instead of
modifying any of the supplied scripts in-place i.e. $RAZOR_HOME/examples), you are encouraged to
copy them into this directory for modification.


Report_definitions


The Report_definitions directory contains user and database-related report definitions. The file Database
contains database locale definitions. User definitions are stored in files named definitions.<user>.


Scripts


The Scripts directory contains Razor scripts specific to this database.


Tables


The Tables directory can contain files that are global to an entire database. For example,


-placing a Roles file in the $RAZOR_UNIVERSE_DIR/Tables directory enables a single control point for
all role definitions in that database. Note: See " Definable roles ."


-adding an Access_list2  file   to $RAZOR_UNIVERSE_DIR/Tables allows global access control of all
groups under that database. See "Access Controls ."
                         
-creating an Options3 file in $RAZOR_UNIVERSE_DIR/Tables permits control of file check-ins for all
groups in the database.  Note: See "Options ."


Weaver
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This directory is used by IssueWeaver to store temporary files and user filter/sort files.


templates


The templates directory contains templates for issues text panes, etc.


bin


Note: See "Handling mixed environments ."


The bin directory contains operating system-specific rz_db_exec executables to permit heterogeneous
networks to be served.


DOMAIN_01


The DOMAIN_01 directory is the top of a directory tree which actually holds the database itself. Under
this is a subdirectory for each of the various groups under control. The names as shown above are
simply examples; your directory names will of course differ. In fact, if you are using Razor only for the
problem tracking aspect of the tool, you will only have the ++ISSUES++ subdirectory. The ++ISSUES++
group is the default issues group. Additional issues groups may be added at any time.


Note 1: The directory is numbered (01) in anticipation of future releases which will provide more options
for organizational layout. See the related question within thte "Common Questions and Answers "
section, which provides a little more information. 


Note 2: For each file control group (Doc, Include... in the example above) there is a corresponding
Threads subdirectory (Doc##Threads, Include##Threads...). Also, the ++PROJECTS++ directory is
where all the project definition files are stored.
If we examine the structure under the DOMAIN_01 directory in more detail, we'll see a layout as shown
below.


                                    |                   /-- Delete
                                    |-- Archive --------+-- RZ_VCS
                                    |                   \-- SCCS
                                    |-- Attachments
                /-- ++ISSUES++ -----+-- History
                |                   |-- Info
                |                   |-- Latest
                |                   |-- Scripts
                |                   |-- Tables
                |                   \-- Updates
                |
                |                                       /-- Delete
                |                   /-- Archive --------+-- RZ_VCS
                |                   |                   \-- SCCS
                |                   | 
                |-- ++PROJECT++ ----|-- History
                |                   |-- Info
                |                   |-- Scripts
                |                   \-- Tables
                |
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. --------------+
                |                                       /-- BINARY
                |                   /-- Archive --------+-- Delete
                |                   |                   |-- RZ_VCS
                |                   |                   \-- SCCS
                |-- Doc ------------+
                |                   |-- History
                |                   |-- Info
                |                   |-- Scripts
                |                   \-- Tables
                |
                |                                       /-- Delete
                |                   /-- Archive --------+-- RZ_VCS
                |                   |                   \-- SCCS
                |                   |
                |-- Doc##Threads ---+-- History
                |                   |-- Info
                |                   |-- scripts
                |                   \-- Tables
(etc., etc., etc...)


Each directory under DOMAIN_01 will have a similar set of subdirectories, as described below.


Archive


Each group will have a Delete, RZ_VCS, and SCCS subdirectory. Depending upon the archival engine
selected for that group, either the RZ_VCS (for RCS) or SCCS subdirectory will be populated.


Info


This subdirectory contains a single easily parsed ASCII file representing the attribute information for the
named file, as well as a variety of supportive information. There will be a one to one relationship between
files under control, and files here. For issues, the files will be a fully annotated form of the issue number
(i.e. I..1-234).


History


This directory holds files which chronicle the changes which occur to files and issues under control. As
with Info files, there will be a one to one relationship between what is here and files/issues under control.


Scripts


At the time of creation, populated with rz_mail_issue_catcher and rz_query.1
1. For each issues group, the file rz_mail_issue_catcher.<group> is created. It is made available as a
highly localized bin for customer generated scripts. Any razor-supplied scripts that you would like to
customize should be placed here - as they get executed before the distributed scripts.


Tables


This directory contains all of the configuration files which determine how that particular Razor group
presents itself. In particular, this is where the Attributes file resides.
Issues group directories have a number of subdirectories that are unique to its special functionality.
These are described briefly below.
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Activity


Files in this directory store the relationship between various issues and the development activity which
was associated with them.


Attachments


If any of the issues in the associated database have attachments, this directory consists of a directory
or set of directories named <issue name> each which contain the following:


-RzAttachManifest - A text file listing all associated file attachments. Includes filename, username
associated with introduction, timestamp for introduction.
-RzAttachHistory - A text file logging all remove, add operations performed. Each entry includes
operation type, file attachment filename, user, timestamp, directory introduced from (ADD only) or name
of optional backup file (REMOVE only).
-<attachment 1> - Issue file attachment(s) added by user
-rz.<timestamp>.<attachment> - Represents backup file created when a user removed the attachment.


Latest


This directory contains two files for each of the issues in the database. Files with a '.1' suffix hold the
latest representation of the text stored in the statement of problem text areas. Files with a '.2' suffix hold
the text for the statement of solution text area.


Updates


This is a work directory which the Razor programs use while handling e-mail synchronization of
databases.


13.3 Where the license is stored


$RAZOR_LICENSE_DIR
Where the license is stored


Below is a diagram of the directory structure below $RAZOR_LICENSE_DIR. It is:


/-- Databases
|-- License.conf
|-- License_status


  Razor_lm -------+-- Licenses
|-- LM_Access_list
|-- rz_passwd
\-- trusted_users


Relative to the $RAZOR_LICENSE_DIR directory...


Databases


This file supports the change database capability of issues.


License.conf
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This file is used to configure the Razor License manager program.


License_status


This file contains status information for the Razor License manager program while it is running. It will not
appear if the license manager is not active.


Licenses


This file contains the license key information for Razor. It can be updated via the razor license
command.


LM_Access_list


This file controls who can bring the License Manager down, add users, modify users, remove users, set
password aging and lock/unlock user accounts.


rz_passwd


This binary file contains the razor remote user name/password information. It can NOT be edited
manually. It may only be updated via the Razor command line password functions.


trusted_users


This file is associated with the e-mail entry of issues.
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14 Razor File Formats


This appendix is meant as a single reference location defining the syntax of each of the various Razor
files. For a detailed discussion of the utility of the files, or how/why you would be interested in them, you
will need to refer to the appropriate location in the main body of the manual.


In the hope of clarity, the typographic convention " " is used to denote the tab character. When it
appears in the following definitions, you are actually able to use as many tabs as necessary. This is
often handy to give the resultant file a columnar appearance.


14.1 Administration Files


$RAZOR_UNIVERSE_DIR


Report_definitions/Database


This file contains database locale report definitions for all tools. It can contain format, filter, and report
definitions that are available to all users. It is updated by each of the tools via the Create/modify
definitions menu item, and should not be edited manually.


Report_definitions/definitions.user


This file contains user locale report definitions for all tools. It can contain format, filter, and report
definitions that are unique to the named user. It is updated by each of the tools via the Create/modify
definitions menu item, and should not be edited manually.


DB_Compatibility


This file contains information used internally by Razor to determine database compatibility and should
not be modified.


rz_startup


This is a shell script generated at the time the database was created, and is used as a controlled vehicle
for starting the related database server. It is this script which gets invoked by the command 'razor up'. 


Server_status


This file is generated by the Razor database server, and specifies the following four pieces of
information...


SERVER_HOST_IP:    <host IP address>
SERVER_HOSTNAME:   <hostname>
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RAZOR_PORT_NUMBER:  <port number>
RAZOR_KID_NUMBER:  <port number>


Wdefaults


This file, if present, will be referenced by the various Razor/PC client applications to control resources
about how the GUI's will appear and act. It is often generated by copying the $RAZOR_HOME/
examples/Wdefaults.sample file and making edits as necessary. Only a subset of the X resources
honored by the Motif clients are honored by the PC clients. Refer to the appendix " X Resources " for
information on which specific resources are honored by the PC clients.


Xdefaults


This file, if present, will be referenced by the various Razor programs to control various resources about
how the GUI's will appear and act. It is often generated by copying the $RAZOR_HOME/examples/
Xdefaults.sample file and making edits as necessary. Refer to the appendix "X Resources " for
information on specific resources.


$RAZOR_LICENSE_DIR


Databases (issues only)


This file supports the change database capability of issues. The file format is:


<database_name>  <database_path>


...where database_name is the name which will appear on the issues Database pull-down menu and
database_path is the fullpath of the database directory (including RAZOR_UNIVERSE). The
database_path must match the information displayed when the command "razor info" is entered.


License.conf


This file controls the modes of the license manager.  To enable the particular control, add the entry in
the License.conf file. Configuration controls are:


DEBUG : Force the license manager to run in debug mode.


LOCAL PASSWORD_FILE: Force the license manager to use the local password file.


RAZOR PASSWORD_FILE: Default mode for the license manager


LOCAL_AND_RAZOR_PASSWORD_FILE: Force the license manager to use the local password file.  If
the userid is not in the local password file, the license manager will use the Razor password file for user
validation.


License_status


This file is written by the Razor license manager program (razor_lm). It contains information about which
host is running the license manager, and which port is being used. The first three lines of the file contain
the following information...


LICENSE_HOST_IP:   <hostIP address>
LICENSE_HOSTNAME:  <hostname>
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RAZOR_PORT_NUMBER:  <port number>


This will be followed by some comment lines noting when the license server was last invoked.


Licenses


This file contains the license keys which control how many simultaneous users of Razor are allowed at a
site. The first line of the file contains either the 8-digit hexadecimal number representing the hostid of the
machine which will be running the license manager for the site, or the single word "DEMO".


The second line contains a sequence of 8 digit hexadecimal numbers provided by Visible Systems. The
alphanumeric portion of the hex numbers can be in either upper or lower case.
Everything following the first two lines are ignored by the Razor programs. They are, therefore, available
for comments by the users, and are often used to spell out the customer ID, how many licenses were
purchased, and what the various expiration dates are.


NOTE: A customer ID number was issued when you received your license keys. Use this ID number
when corresponding with Visible Systems.


LM_Access_list


The LM_Access_list (for the License Manager) controls who may bring the License Manager down, add
users, modify users, remove users, set password aging, and lock/unlock user accounts. This file may be
used to provide global access. The format of the entries are:
<operation> --------------> <who>


See "Access Controls " for a complete description of controlling user access.


rz_passwd


This file is managed by the Razor license manager program (razor_lm). It contains information
concerning user names, passwords, and groups for Razor remote clients. It is a binary file that can NOT
be edited. Its contents can be modified with the appropriate razor password commands.


Note: See "Password functions ."


trusted_users


This file is associated with the database access feature described in " E-mail entry of issues ". The
Razor Administrator will be notified by e-mail to "razor-admin" when a user signs up for this feature. It is
at the discretion of the Administrator to add the e-mail entry to this file, identifying the user's e-mail
address that will be used in database queries and the local user id associated with the e-mail address.


The format of an entry in this file is 


<e-mail address> [...<e-mail address>...] <local name>


where one or more e-mail addresses may be included in an entry with the last field being the local host
user id associated with the addresses.
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14.2 Database Files


This section is intended only to provide the basic syntax of the named files, not to provide an in depth
understanding of each of the fields.


An Activity file (issues only)


This file contains a list of all file operations which have been related to a particular issue. The format of
the entries in this file are (on a single line):


<action> <who> <version> <state> <date> <group>
<filename> <file id>


The contents of this file are never parsed and are displayed to the user in an "as is" form.


A History file


The History file contains a record of all activities which have occurred on each file in the database. One
History file exists for each file within a group. The file is named the same as the file it represents. 


Like the Info files, the History files are in human readable, easily parsed, ASCII format. This is intended
to make the generation of site specific, custom report and metrics scripts a very straightforward process.


The format of each entry in a History file is:


<action> <who did it> <version> <state> <date>
##TITLE: <Your title. This may not appear for every action.>
##NOTES: <Contents vary. May not appear for every action.> 
# <description when applicable>
# <.....>
##ISSUE:  <issue number>  <issue group>


The action field can take on any of the following:
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Audit Information


Sometimes for reasons of security, record keeping, etc., detailed information on file checkins and
checkouts is needed. An Audit entry has been added to the History File for this purpose.


The Audit entry is written to the Razor History file each time a user does a check-in or check-out. The
format is as follows:


##AUDIT <user> <date, time> <version> <state> <action> <absolute path>


An example of how it appears in an actual History file is included below:


CHECK-OUT deb 1.1 Active 2002/11/18,15:23:05
##TITLE: test
##NOTES: CHECKED OUT TO: /home/deb/SAMPLES
##AUDIT: deb 2002/11/18,15:23:05 1.1 Active CHECKED OUT TO: /home/deb/SAMPLES
##ISSUE: I...-..1 ++ISSUES++


CHECK-IN deb 1.2 Active 2002/11/18,15:23:17
##TITLE: test
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##NOTES: CHECKED IN FROM: /home/deb/SAMPLES
##AUDIT: deb 2002/11/18,15:23:17 1.2 Active CHECKED IN FROM: /home/deb/SAMPLES/file1.txt
##ISSUE: I...-..1 ++ISSUES++


An Info file


The Info files contain the latest status and attribute information for each file within a particular group. The
files are named the same as the files they represent in the database.
The status format is defined as:
<field> <value>


The field/value pair definitions follow. The format of the value(s) which follow the field name are shown in
parenthesis.:


-LATEST_VERSION - (character string) Specifies the file's latest version
-LAST_MODIFIED - (integer  character string) Date of last modification. The date is in two values.
The first is as an integer which is output by the time() function and the second is in a more human
readable format: YYYY/MM/DD,HH:MM:SS.
-TIME_CHECKED_IN- (integer character string) Time of last check-in. This field has two values.
The first is as an integer which is output by the time() function and the second is in a more human
readable format: YYYY/MM/DD,HH:MM:SS.
-CHECK_SUM - (integer) For Razor internal use.
-FILE_ID - (integer) File identification number for files under file control; value is zero for issues, threads
and projects.
-IS_A_BRANCH - (0/1) When set, indicates if the file is a branch file.
-IS_TERMINATED - (0/1) Indicates the file has been terminated.
-CHECKED_OUT - (0/1) Indicates if the file is currently checked out.
-BINARY - (0/1) Indicates if the file is a binary (non-ASCII) file.
-OWNER - (character string) This field indicates who has the file checked out. This field will only exist if
the CHECK_OUT field value is a 1.
-NUM_BRANCHES - Indicates the number of branches from this file.
-NUM_STATES - (integer) Indicates the number of states associated with the file.
-STATE - (character string character string) Indicates the state and the version of the file which
achieved that state. There will be NUM_STATES entries of this field.
-EXPAND_KEYWORDS - (0/1) Indicates that archive engine keywords can be expanded.


For each attribute assigned to the file, entries of the form:


ATTRIBUTE <attribute label> <attribute value(s)>


The attribute values will depend on the type of attribute they represent. Below is a list of the attribute
types and the attribute values that may appear. Note that the STATE attribute is not represented
because it is a special case handled in the status portion of the Info file.
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A Latest file (issues only)


This file is a copy of all current text contained in the issue form text panes.


The filename is the issue number with the extension, .x, where "x" is a digit that identifies the number of
the text pane, with 1 being the first text pane, and 2 being the second pane.


14.3 Configuration Files


Most of these files apply to all Razor programs (unless specifically identified). Unless otherwise noted,
each of the following configuration files supports the presence of internal comments, denoted by having a
'#' (hash) as the first character on the line. Blank lines are ignored, and may be used to provide nice
visual breakage. We actively encourage the use of comments in whatever files you edit.
Some of these files are located at the universe level, and others at the group level. Files located at the
universe level will exist in the directory...


$RAZOR_UNIVERSE_DIR/Tables


...and group-related files are found in the directory...


$RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables


Where appropriate, environment variables (such as $RAZOR_HOME) and the '~' (tilde) may be used to
identify directories and/or file names.
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Each line of the file is terminated with a carriage return, and is independent of how the local screen wrap
may be presenting the text to you.


14.4 Universal-level Files


Files located at the universe level will exist in the directory...


$RAZOR_UNIVERSE_DIR/Tables


Files at the universe level may also appear at the group level. Files at the group level will take
precedence.


Access_list


Access_list controls who may perform operations within the Razor tools. This file may be used to
provide global access. The format of the entries are:


<operation> <who>


See "Access Controls " for a complete description of controlling user access.


Options


Each line consists of the following fields...


<option> <value>


This file can be used to gain more control over the version check-in process and the appearance of text
panes. See "Options " for details. Changes take effect on the next invocation of the related tool.


Roles


This allows administrators to define role names and reference these role names in the Permissions file
by prefixing the role name with a '%'. Role definitions can be any combination of user id, group id
(preceded by a '+') or other roles (preceded by a '%'); Role definitions in the Permissions file may be
used for either the state transition 'who' or the e-mail column. For e-mail, group names defined for the
role will be ignored.
If you have a large number of users to define for a role you can use two or more lines. example:


CM     mark, joel, deb, +cmteam
CM     kathy, john,  george, al


Razor will concatenate both lists so that CM will contain mark, joel, deb, +cmteam, kathy, john, george,
al


NOTE: A role called RAZOR_ADMIN can be defined that has 'special' privileges. Users in
RAZOR_ADMIN are allowed to check another person's file back in or uncheck another person's
checked-out file.


197


183







Razor File Formats 271


© 1992-2009 Visible Systems Corporation, All rights reserved.


14.5 Group-level Files


Files located at the group level will exist in the directory...


$RAZOR_UNIVERSE_DIR/DOMAIN_01/<group>/Tables


Files at the group level, if the same as files found at the universe-level, will take precedence. Group-level
files may include all of those files listed previously under the universe-level files, as well as the following:


Actions


Each line consists of the following fields...


<label> <before script> <after script>


The <before script> and <after script> may contain either the name of the script to be executed or the
string "n/a" if no script is applicable. To avoid ambiguities, it is recommended that the fullpath to the
script be specified. Environment parameters and the use of special symbols such as "~" are allowed.
Changes to the Actions file are honored on the next invocation of the related issues, versions, or threads
program.


Attributes


The Attributes file is the mechanism used to control the layout of forms. A full description of this file is
provided within the section "Containers:  databases, groups, and folders ."


Changes to attributes require that the related Razor database server be stopped, then restarted. Note
also that changes to this file may have repercussions, requiring coordinated edits to other Razor
configuration files, or scripts you may have written.


NOTE: See "Customizing the Attributes file .


Bitmaps


Each line consists of the following fields...


<label> <value> <bitmap_file>


The <bitmap file> can be specified using environment parameters and/or special symbols such as "~".
Changes to the Bitmaps file are honored on the next invocation of the issues, versions, or threads
program.


Commands 


Each line consists of the following fields...


<label> <command>


The <command> can be specified using environment parameters and/or special symbols such as "~". A
separator line can be inserted with a line containing the word "SEPARATOR".
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The script is passed the name of a file containing the list of items selected from the GUI. The file will be
empty if no items were selected. Changes to the Commands file are honored on the next invocation of
the issues, versions, or threads program. 


Insensitive (issues only)


Each line consists of the following fields...


<attribute> <value> <who> <insensitive>


Each line specifies which field should be made insensitive, (grayed out), when the
<attribute><value><who> value matches. The <who> field can be any combination of users, user
groups, and roles. User group entries (UNIX and Windows 2000/XP) must be preceded by a '+' and role
names by a '%'. To match users who are not a member of an entry, precede the entry with an '!', (the
'not' symbol). Changes to the Insensitive file are honored on the next invocation of issues.


NOTE: Text Panes can not be made insensitive. The insensitive functionality works in conjunction
with attribute state values. The Text Pane attribute does not have a state value. NOTE: The Insensitive
option is not available in IssueWeaver.


Permissions (issues only)


Each line consists of the following fields...


<state1> <state2> <userid_list>[ <addr_list>]


Changes to the Permissions file take effect on the next invocation of the issues program.


Prefix (issues only)


This file contains a single line with an alphabetic character in the first position. The character is used in
the issue name of subsequently created issues. As an example, if the Prefix file contains the character
'X' and then issue 35 is created, the issue will appear in the main display list as 'X...-.35'. It is a nice way
to visually differentiate between various issues groups.


Problem_template, Solution_template (issues only)


These are free format text files. Whatever you place in these files (including Razor style comments and
blank lines) will be used to pre-load the text sections of new issues.


Changes to the problem or solution template files take effect on the next invocation of the issues
program.


Promoters (versions & threads only)


Aside from comments, each line consists of either a single userid, a user group (preceded by a '+'), or a
defined role (preceded by a '%'). These should be in lower case. Changes to the Promoters file take
effect on the next invocation of the related versions or threads program.


NOTE: The Promoters file is superseded by the Access_list file but is left for backward
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compatibility. Users should switch to Access_list, described within this section, as subsequent versions
of Razor may not support Promoters. If the Promoters file however does exist, it will override the
PROMOTE option in the Access_list file.


Reports (issues only)


Each line consists of the following tab-separated fields...


<label> <script_name> [  options ]


Label is the report label that will appear in the Reports pull-down menu. Script_name is the script used
to generate the report. Options consist of a comma-separated list of any combination of the following:
name, print. If the field options contains the string "name", the first argument passed to the script will be
the name of a temporary file containing the list of selected issues.  If options contains the string "print",
the output of the script will be automatically printed as defined via the user's print command.


NOTE: Refer to "Writing report scripts for issues " (Batch method). 


NOTE: Refer to "Printing issues ."


A separator line can be inserted with a line containing the word "SEPARATOR".
Changes to the Reports file take effect on the next invocation of the issues program.


Vcs


This file contains a single word and tells Razor which archive engine is being used for the group, e.g.
SCCS or RCS. DO NOT EDIT THIS FILE! It is created and maintained by Razor.


14.6 Personal Files


$HOME/.razor-init


This file should not be edited by the user. It contains filter initialization and setup information. This file is
written by selecting the Save Setup option of the File menu on the issues, versions and threads
programs filter dialog.
Razor users' view filters are stored in the file $HOME/.razor-init.<user name>. If $RAZOR_USER is
undefined for a given user, Razor will use the $HOME/.razor-init file.


$HOME/.razor_login


This file contains Razor universe directory, user name, and host ID information entered to remote client
prompts. This file is written automatically whenever a remote client login dialog is entered.


$HOME/.razorrc


This file should not be edited by the user.  It contains customization information for the versions and
threads tools.  This file is written by the Tool Properties  item of the Edit menu selection on the version
program's main window.
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15 X Resources


X resources are a powerful and robust mechanism for having intimate control over the appearance (and
often the functionality) of an X program. Many elements of the Razor GUI can be tuned to your specific
needs or preferences. PC clients honor a subset of X resources described in this appendix. Resource
settings destined for the PC clients must be set in file Wdefaults in the $RAZOR_UNIVERSE_DIR
directory. Specify the resource setting in the same manner as for a true X client.


NOTE: X resources that change the behavior of Razor clients do NOT affect Razor command line
functions.


It is far beyond the scope of this manual and our customer support service to train you on all the
possibilities available via X resources. This appendix however discusses some resources unique to
Razor and its various programs that you may find handy.


15.1 X resource/Razor databases


When each of the various Razor programs begin running, they take on certain defaults for their
appearance and behavior. The true run-time settings for the various X resources are determined by the
following conceptual flow.


NOTE: For a full understanding of how resources work, and the concept of widget hierarchies and
inheritance, you will need to consult The Motif Programming Manual and The Motif Reference Manual
from O'Reilly Associates. 


1.All the various interfaces initialize with hard-coded, factory-defined settings for color, fonts, and so on.


2.X resources are utilized as acquired from the 'normal' places, including (but not limited to) $HOME/.
Xdefaults, files in the app_defaults directory, command line control via the "-xrm" argument, etc.


3.If present, the programs read in and use the settings from the file Xdefaults, which would be found in
the related $RAZOR_UNIVERSE_DIR directory.
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15.2 The Xdefault.sample File


To help your efforts at tailoring Razor's X resources, a heavily commented example file is included as
part of the Razor release. The file...


$RAZOR_HOME/examples/Xdefaults.sample


... may be copied and referenced as necessary to form your own set of Xdefaults.


The tables that follow detail a subset of the many options discussed in the sample file. They represent
some of the more useful resources, and are grouped to highlight various themes. For a full and accurate
description, we encourage you to refer to the file itself. 


In the tables, the left column is the resource specification, the center column shows the default resource
value, and the right column indicates whether or not the resource is honored by the PC clients. Those
resources honored by the PC clients will be marked with a 'w' and are contained in the file Wdefaults
located in the $RAZOR_UNIVERSE_DIR directory.


General foreground colors and background colors


The following sets the foreground and background for the issues, versions and threads interfaces.
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A table exists which lists all sorts of colors by name, and relates them to the various intensity levels.


On Sun's running OpenWindows, consult the file $OPENWINHOME/lib/rgb.txt
and on other UNIX systems, consult the file /usr/lib/X11/rgb.txt.


Fonts for Razor GUI's


General GUI Fonts
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Report GUI fonts


Widths and heights
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General GUI widths and GUI heights


Report GUI widths and GUI heights
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Initial filter and display options


It's possible to set the initial value for various display and filter toggles. The values shown in the following
table are the programmatic defaults, where a value of '0' means off, and '1' means on. (You can also use
the strings 'True' and 'False,' if you prefer.).
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Special control over text widgets


Many users prefer that text (and text field) widgets behave in a manner other than the default provided by
Motif. What follows is a set of examples of some things that can be set and how this would be done.
The action functions shown are pretty much self-explanatory. Try them out and pick the ones you like.
The examples are shown for the issues program, but can be applied to versions, threads or any other
interface. Removing the leading 'Issues' from the translation definition will cause the definitions to take
effect for all text widgets, not just those used by Razor.


It can prove extremely useful to be able to take the output of a command and insert it into a text or text
field widget. If text is selected, the text will be replaced by the output of the command. Razor provides
this capability through the razor-cmd() action. 


What follows are several convenient settings for the Text widget along with an example of how to define
the F2 key to place the current date into the widget. Also shown is an example of how to define the F3
key to execute 'fmt' on the selected text.
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The Xdefaults.sample file included with the Razor release also documents a fairly complete collection of
bindings which allow text widgets to closely emulate the behavior of Emacs. Please refer directly to the
above file if this interests you.


Window titles and icon labels


It's occasionally handy to set these to something a bit more descriptive, especially when you may have
multiple databases running at your site.


Diff window rows/columns


If control over the number of rows/columns the diff utility is required, use the following resources.


15.3 Issues Miscellanea


The work area on the issue form which contains the configurable attributes is defined as FormWorkArea.
Its height is set and may be changed to meet user preference. The number of rows used by the two text
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panes at the bottom of the issue form may also be defined. To configure the issue form for an issues
group other than the default issues group, append the issue group name to 'IssueForm' in the resource
specification. For example, setting issue form height for issue group 'dev' could be done with resource
setting 'Issues*IssueFormdev*TextForm1.height:400'.


NOTE: that the overall initial width of the issue form is controlled by the amount of space required
to display 80 characters in the two text widgets. To increase or decrease the initial width, you need to
specify a different font for that area.
The text panes on the issues text will automatically scroll to the bottom when a form is displayed. This
behavior can be overridden.


Scrolling and word-wrapping can also be controlled in the two text areas.


The ability to relate issues to file operations can be disabled by not having any file groups or via an X
resource setting.


When populating an issue form with widgets, the issues program will start 10 pixels from the top of the
form, with a gap of 10 pixels between the widgets. The default behavior is to have all labels be fixed width
based on the longest label. Some users may prefer to modify these values to provide a tighter or looser
appearance.


Left to its own, the issues program will strive to keep an accurate list of issues on the display. Each
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time the database server receives a change, it notifies all of the other running issues programs, and each
in turn will update its display. It is possible to prevent this from happening while you are actively editing
an issue. 


Users who wish to change the length of the STATE name string to accommodate long (or short) STATE
names when they are displayed on the issue form, can do so through the setting of an X resource.


If using multiple issues groups, the default issues group shown in the Group pulldown is shown as -
Issues-. Some users may prefer to modify this value to provide a different appearance. This setting does
NOT force a default issue group. It is just a way to "name" the default group (++ISSUES++).


Users of the text editor vi are accustomed to hitting the <ESC> key while entering text. Unfortunately,
the default action of that key in Razor programs is to dismiss the window. Its possible to override that
behavior in the issues program by setting the following resource...


The number of columns used to display groups in the issues groups pulldown is defined as follows: a
value of 0 means the program will compute the number of columns automatically, while a non-zero value
will be honored as defined.


You may control the double-click interval time for the issues main list. The interval is in milliseconds.


The legal values are: NO_LINE, SINGLE_LINE, DOUBLE_LINE, SINGLE_DASHED_LINE,
SHADOW_ETCHED_IN, SHADOW_ETCHED_OUT
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A visual separator may be added in the pull-down lists for Commands and Reports using the following
resource.
The legal values are: NO_LINE, SINGLE_LINE, DOUBLE_LINE, SINGLE_DASHED_LINE,
SHADOW_ETCHED_IN, SHADOW_ETCHED_OUT


NOTE: As mentioned earlier in this appendix, the definitive reference point in learning about which
X resources are supported is the Xdefaults.sample file included with the release. We strongly suggest
that you browse through it if you are interested in having fine granularity control over how the Razor
programs work.


TID BIT: There is a very useful script in $RAZOR_HOME/examples called attr_to_xy. Usage:
attr_to_xy  [-g <issue group>] [<outfile>]. It will generate X/Y positioning for attributes on an issue form.
If <outfile> is specified, output will go to this file, otherwise, stdout will receive the output. The results
can then be incorporated into either the Xdefaults or Wdefaults files.


15.4 Versions Miscellanea


The number of characters to use when displaying file names in versions can be controlled by...


Binary introductions can be controlled with...


a. Razor's PC Client will only allow Binary or Auto-detect to be selected, you must have one selected -
unlike the UNIX client. By default Auto-detect is set to true in the Wdefaults file.


When files are introduced, you can have Razor expand keywords automatically by setting:
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The check-in dialog allows users to specify the action to take on files which are being checked in. The
choices are "Take the files", "Leave a read-only copy", and "Check files back out for edit". The default
selection can be controlled through one of the following X resources. Remember that only one of them
can be set to True.


You can control the output path for versions as being absolute or relative.


There's even an X resource which forces the immediate deletion of the backup files (...filename) which
are created during the check-in and introduction operations. This option does not effect command line
check-ins or introductions - they always make a backup.


You can control whether the check-in title information will be the same for all files or what was originally
entered for each file at check-out...


The number of columns used to display groups in the Versions groups pulldown is defined as the
following, (a value of 0 indicates program computed, non-zero will be honored as defined).


You may control the double-click interval time for the versions main list. The interval is in milliseconds.
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You may control the behavior of the Versions diff output with the following three resources. You should
set only one of these values to True.


If control over the number of rows/columns the diff utility is required, use the following resources.


Versions merge colors can be controlled with the following resources.
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Merge fonts...


Merge pane sizes...


The Commands text pane scrolling and word-wrap attributes can be controlled as follows.


15.5 Threads Miscellanea


The number of characters to use when displaying file names in threads can be controlled by...


The following controls the minimum/starting height of the center area of the paned window:


The following controls whether the inclusion of files may be based only on issue relationships:
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The following controls whether changes can be made after file inclusion has been changed via the issue
selection dialog:


The number of columns used to display groups in the threads groups pulldown is defined as follows: a
value of 0 means the program will compute it automatically, while a non-zero value will be honored as
defined.


You may control the double-click interval time for the threads main list. The interval is in milliseconds.


If control over the number of rows/columns the diff utility is required, use the following resources.


The following controls the initial setting for thread file selection criteria for branched files, as set in the
Edit Threads Selections pulldown.


The following controls the sensitivity setting (whether or not the option can be selected) for thread file
selection of branched files.  Changing the value to 0 makes the option not selectable.


The Commands text pane scrolling and word-wrap attributes can be controlled as follows.


15.6 Email Back to Support


When composing email to be sent to Visible Systems, the default text which appears in the To: Cc: and
Subject: fields can be set to something other than the defaults.
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15.7 Occam the Icon


As strange as it may seem, some users have asked how to hide our friend (and mascot) Occam from
the various dialogs which employ his likeness. If set to false, a logo will appear in his place.
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16 Regular Expressions (Razor pattern matching)


Most people are already familiar with the concept of using wildcards for filename expansion. Regular
expressions serve a similar purpose, but have the potential of being much more sophisticated,
complicated, and powerful.


It is beyond the scope or intent of this document to provide a full description of how to use regular
expressions. A detailed discussion is often available in the UNIX man pages for ed, and the O'Reilly
book UNIX in a Nutshell has a very nice section devoted to them. Razor's pattern matching technique is
the same as that supported for ed. Since the filter panels of Razor do allow you to enter regular
expressions, we offer here a quick table of some of the more familiar meta-characters.


To help complete the picture, we offer the following quick set of examples. They are by no means
complete, but some of our new users have found this to be a good starting point.
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17 Razor PC Applications


This section describes how to install and run the Razor/PC client applications "issues", "versions", and
"threads" as well as how to install and run the Razor/SCC interface to popular Windows Integrated
Development Environments (IDE). You should already have read "Installation/General Administration "
before proceeding.


17.1 PC Client Applications


System requirements


The PC Client targets Windows 2003, 2000, XP operating systems.  Also required prior to running a PC
client is that the Razor server be installed on a Windows 2003 Server, Windows 2000, Windows XP or a
UNIX platform which is network accessible from the client's PC. 


Obtaining a copy of the software


You may obtain the software from www.razor.visible.com.


Installing the software


After retrieving the Razor/PC distribution to a WIN32 machine, simply run the self-extracting executable.
You may also install RazorSCC at this time (refer to "Installing the software" seectionn for details on
installing RazorSCC).


The WIN32 machine must be able to resolve the hostname of the Razor license manager if using the
hostname instead of IP address when starting up. If the PC is not setup for name service (DNS), add
entries to the local host table for the license manager host.


If you are upgrading, it is not necessary to uninstall the current installation of RazorPC for versions 4.1e
and higher.  If upgrading from a Razor release prior to 4.1e, it is necessary to first uninstall RazorPC.  In
Windows, you should uninstall by executing 'Add/Remove Programs' from the Control Panel. It is very
important that all windows applications be terminated before un-installing.


Starting Razor


Razor can be started via the Start button in the bottom left corner of the screen.  Choose Start -->
Programs --> Razor PC, and then choose Issues, Versions, or Threads.


You may also choose the "razor" option (from Start, Programs, RazorPC) to open a new Razor desktop.
 Then choose Application from the main menu, and the necessary Application choice: Issues, Versions,
or Threads.
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Logging in


The first two dialogs presented to the user running a remote client involve "logging in".


The first dialog requests server information.  Specifically, the user is required to provide information
necessary to connect with the Razor license manager and Razor database server on the network.


The second dialog requests user information.  This user/password information is dependent upon the
Razor license manager mode.  The possible user authentication modes are to use the Razor password
file, the local password file or a combination of both.  Refer to "Starting the license manager " of the
manual for details.  The Razor administrator will be able to provide the mode so that you can determine
the correct user/password information to enter.


Users may modify their Razor password at any time.


It may be necessary to contact your local Razor administrator for some of this information. A more
detailed explanation of each field on the two dialogs follows:
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UniverseDir


The UniverseDir field must contain the fully expanded path to a Razor database (The setting of
$RAZOR_UNIVERSE_DIR as defined in the rz_prep file.),  up to and including RAZOR_UNIVERSE. This
path should end with RAZOR_UNIVERSE, (without a trailing '/' or '\').


NOTE: Either the UNIX or the PC path style may be used for the <database>/RAZOR_UNIVERSE
path in the Issues/Versions/Threads log-in screen. Examples: UNIX path //D/Visible/Razor/DB/
RAZOR_UNIVERSE PC path D:\Visible\Razor\DB\RAZOR_UNIVERSE


Port


The Port field must contain the port of the License manager. The installation default is 16151. This port
may be verified by viewing file $RAZOR_LICENSE_DIR/License_status.


Host


The Host field must contain the host of the License manager. This may be given in either hostname
format or IP address format. If entered as a hostname, the PC must be able to resolve the name.


Local Host


A field containing the IP address(es) for this client session. This list will be enabled if there is more than
one IP address by which the machine identifies itself (as in the case of a local network vs. a PPP dial-up
IP address).


UserID/Password
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Razor requires the user to enter a valid user id and password before allowing access to a Razor
database. The user id and password must be a valid entry in the Razor password file.


Change password (This option is insensitive whenever the license manager is running with the local
password file.)


Check this if the remote password is to be changed. If so, enter the new password into the two
password fields and click OK.


New password


The new password to change for the specified user ID.


Verify


Is the same password as in the new password field. If this does not match the New password field, the
password will not be changed.


Getting help


If you are having difficulties getting connected, check the Help pull-down menu. There are some handy
tips for trouble-shooting problems.


Logging off


When you have completed use of the PC client application, select Exit from the File menu pulldown. 
This action will release the license token in use. 
For users who do not have a permanent network connection, the PC client offers a disconnect function. 
Disconnecting


NOTE: Disconnecting does reduce the reconnect time with the server, as it only has to transmit
the changes since the last connect. does NOT immediately release the license token.


Upon disconnect, a Reconnect button appears, like the screen shown below..
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Clicking Reconnect will attempt to reconnect to the server using the same database and login
information as previously entered.


17.2 Integration with Windows IDEs


This section describes what RazorSCC is, how it is installed, and how it can be used.  The file control
features provided by RazorSCC are described in "Using Versions ."


Introduction


RazorSCC is a "link" or "interface" between a Razor database and a supporting application. This "link"
enables your application to utilize the file control features of Razor directly from within the supporting
application!


Your "supporting" application is most likely an Integrated Development Environment (IDE), that is, an
application that incorporates a variety of software development tools within one program (an editor,
compiler, linker, debugger, etc.).  With RazorSCC, you've just added "Source Code Control" or "Version
Control" to that suite of tools! 


RazorSCC implements the Microsoft Source Code Control API (SCC API) Specification.  This
specification defines a method for Source Code Control Providers, like RazorSCC, to interact with an
IDE.  For RazorSCC to "link" to your IDE, the IDE itself must also have implemented the Microsoft SCC
API.  You'll need to refer to your IDE's documentation to determine whether or not it supports this
interface.


TIP: Check your application's documentation for such topics as "Source code control", "Version
control", "SCC", "VC", to determine if it supports the Microsoft SCC API spec. If you are unsure, simply
install RazorSCC and run your application. Check the menu-bar buttons (such as "Project", "Tools", or
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"Options") or select a Project file and click the right mouse button, looking for source code control
selections.  If you find menu selections, such as "Add to Source Control", "Check Out", "Source
Control" (or something similar), then you know your IDE can use RazorSCC.


System requirements


RazorSCC runs on Windows 2003/2000/XP platforms only. It will connect to any existing Razor
database installation (Windows 2003 Server/2000/XP or UNIX). Since RazorSCC will run as a PC
Remote Client, each user must have an appropriate password file entry or user account, as described in
"Remote client password ."


License requirements


Your current Razor License allows you to run RazorSCC!  There are no license modifications or updates
needed to get running (unless, of course, you wish to increase the number of licenses you currently
have, and our sales staff be glad to help you with that!).


A Razor token (for Versions) will be used when you run your IDE and login to a Razor database (see
"Running RazorSCC" below).


If you wish to run your IDE without using RazorSCC, simply click Cancel when the Razor Login dialog
appears and no Razor token will be assigned to the IDE session.


Obtaining a copy of the software


RazorSCC is included as a software component in both the 2000/XP Server and the RazorPC (First


release of this program is Razor version 4.2.) installation programs.  You may obtain a copy of either
installation program by following the steps described in "Obtaining a copy of the software ."


Installing the software


Running either installation program gives you the option to select RazorSCC for installation.  Simply
select RazorSCC. 


The software will be copied to the designated location and the appropriate PC system updates will be
made.


NOTE: PC system modifications must be made to run RazorSCC.  Therefore, the installation
program MUST initially be run on EACH PC that will run RazorSCC.


NOTE: RazorSCC may be installed separate and exclusive of RazorPC and Razor 2000/XP
Server.  It does not require either to run but does require a Razor server running somewhere.


Upgrading the software


RazorSCC must be upgraded when your Razor Installation is upgraded.  The version of RazorSCC must
match the version of your Razor installation to work properly.
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NOTE: To determine the version of RazorSCC running for a PC, click RazorSCC from the Start
menu and run the RazorSCC Information Utility.  The "Version" entry in the RazorSCC Installation
Information window is what you're looking for.


The actual upgrade procedure is to simply obtain the latest copy of the installation program (either the
Razor Server or RazorPC program), and run the program, being sure to select RazorSCC as a software
component to be installed (upgraded), and choosing the correct location for the software installation.


Running RazorSCC


NOTE: How your IDE presents and performs the source code control features through RazorSCC
might vary from the descriptions below. As mentioned previously, your IDE must implement the
Microsoft SCC API Specification in order for you to use RazorSCC. Although the SCC API defines
specific procedures for the source code control providers, like RazorSCC, and procedures for the IDEs to
interact; there are no specifics defining how the IDE interacts with you, the user.  How you select file
control features may vary from IDE to IDE.  There may be pop-up menus or menu bar pull-downs to
make your selections; labels on the menu items might say one thing for one IDE and something different
for another. If any questions exist concerning how to "initiate" a file control function, and it's not obvious
from the IDE or this manual, please refer to the IDE documentation for assistance."


Once RazorSCC has been installed, simply run your IDE to automatically load and use RazorSCC! Prior
to actually using any file control features from your IDE, you will be prompted to log-in to the Razor
database that contains the project files. Refer to " Logging in ," for details regarding this procedure. 


How you select the file control features may vary from IDE to IDE. Please check your IDE
documentation for specifics regarding how to do this. Most likely, you will click a menu item after
selecting a file (or bunch of files) from the project file list or after clicking a menu bar button (such as
"Project" or "Tools"). 


The IDE menu items may (or may not) appear as listed below and will let you perform the correlating
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Razor action:


You may re-sync Razor database information with IDE displayed or listed information by clicking
"Refresh Status".   Razor database information will automatically be updated for the selected files prior
to performing any RazorSCC file control function.


Once you select a file control option in the IDE,a dialog will most likely be displayed, listing the selected
files and additional options that might be chosen for the action.  After making any additional choices and
clicking, "OK", RazorSCC will perform the appropriate Razor database changes. Clicking "Cancel" from
the dialog will, as it states, cancel the action before any Razor modifications are made. 


NOTE: Any controls applied by your Razor Administrator on the database or Razor group, such
as "Before" Action scripts ("Attaching scripts to buttons "), Access List or Options file settings ("
Controls ") will be checked by RazorSCC after the "OK" button is clicked.


Razor-specific features
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Razor provides some file control features that may be considered "specific" to Razor, that is, applicable
to Razor only.  An example of such a feature would be associating issues to file actions 
(see, "Associating issues to editing activity "). 


For certain file control actions, the IDE dialog may have an "Advanced" button shown.  If displayed, this
button allows users to select options or features "specific" to Razor.  If appropriate, you should click this
button to make the necessary selections and entries.  Advanced feature selections must be made
before the "OK" button is clicked.


Some Razor functions will not be available from your IDE through RazorSCC; this is just the nature of
the beast.  If you need to perform a Razor file control function, such as Promote, you must run a Razor
client to do this.


Mapping Files Into Razor


Files in an IDE Project may exist in various locations. This approach may work fine for the IDE, however,
for Source Code Control systems, like RazorSCC, the files in the project must somehow be mapped
between the project and the source code database.


When putting IDE work files under RazorSCC control, the IDE will most likely prompt the user to specify
a Project Working Directory. The location entered defines where the IDE files exist. RazorSCC requires
all project files be located at this location or in sub-folders of this location. When an IDE file is added
(that is, Introduced) to Razor, the file's location in the Razor database will be it's relative location in the
Project Working Directory. For example, IDE working files located at the Project Working Directory level
will be located at the top-level of the Razor Group, and IDE working files located in sub-folders of the
Working Directory will be located in a matching folder structure in the Razor Group.


Mapping files between your IDE project and Razor is very important, so you can see how necessary it is
to define a proper Working Directory. RazorSCC will use the defined Working Directory to add or get files
to and from the database. This works great for your IDE work files, that is, your source code, definition
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files, documentation, etc. 


Some IDE's may handle IDE-specific files differently than the working files when it comes to putting the
files under source code control and designating a "working" directory. In particular, the IDE Project file
(for example, in Visual C++, the .dsp file) or the IDE Workspace file (if the IDE uses one) might always
be considered a top-level file by the IDE. The IDE might not prompt the user to designate a working
directory when adding the file to Razor; it might simply assume the path to the file as the working
directory. When the IDE makes an "assumption" for the working directory, it "forces" the location of the
file in the Razor database. If you will be placing IDE Project or Workspace files under Razor control and
this is a concern, please check your IDE documentation to determine how these files will be handled.
This might be a little difficult to find in documentation, so a second approach might be to simply try it!
(with a "test" project in a "test" Razor database or group). If this still is a concern for you, you can avoid
this situation by creating Projects and Sub-Projects at the same level as your Workspace file...the
mapping from your IDE to the Razor database will keep the IDE-specific files all at the top-level of the
Razor Group."


NOTE: The IDE retains the path to the Project Working Directory. If you need to change this
location (or wish to find out if it's even possible to change this location), please refer to your IDE
Documentation.


RazorSCC Information 


Once you've installed RazorSCC on your PC, you'll notice an addition to your Start Menu.  What you'll
find is a selection for "RazorSCC" with an option to run the "Razor Information Utility".  Because of the
nature of RazorSCC, it might be rather involved to collect information about the local installation.


Running this utility will display a window that contains useful information, such as the version of
RazorSCC, the location of the software, host computer particulars, and so on.  The purpose of this utility
is to provide information only.


More Information...


• "Installation and General Administration "


• "Using Issues "


• "Using Versions "


• "Using Threads "
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18 Remote UNIX Client Applicatitons


This section describes how to install and run the remote Razor client applications "issues", "versions",
and "threads". You should already have read "Installation and General Administration ."


18.1 New topic


To run Razor clients remotely, you simply need the client executables for your client machine (NOT the
server machine, since it may be different) and the following:


 The proper version of X11...


-If you're on a Sun using SunOS 4.1.x, you need at least X11R4 (which is pretty much a given already)


-If you're on a Sun with Solaris 2.x, you need X11R5 (which is standard with Solaris).


-All other platforms need X11R5 or better.


 For X Terminals, more than 4 Mb of RAM installed on the machine.


NOTE: Remote clients will NOT connect to pre-4.1d databases. Pre-4.1d commands such as
issues -remote will execute with no errors but will still connect to the local database server.


18.2 Obtaining a of the Software


You may obtain the software from our Web at www.razor.visible.com. Please refer to "Obtaining a copy
of the software" in the Installation and General Administration  section for specifics on how to do this.
It is necessary to retrieve only the release for your client architecture, NOT for the architecture the server
is running on; which may be different. If the client architecture is the same as your server architecture,
you don't have to get anything.


18.3 Installing the Software


Making a remote distribution


A script has been provided to create a remote distribution for your client machine. The script 
r z _ c r e a t e _ r e m o t e _ d i s t r i b u t i o n will create a remote client distribution for subsequent
installation on the client machine. The script must be run from the Razor distribution directory of the
client machine architecture. It generates a compressed tar file that can then be copied to the client
machine and extracted.


Let's say that you are on a Solaris machine and want to generate a distribution for your remote clients
running SunOS. As mentioned previously, you must first obtain the SunOS distribution of Razor - since
that is the target client machine architecture. You must extract the SunOS distribution and then run the 
r z _ c r e a t e _ r e m o t e _ d i s t r i b u t i o n script. Below is an example of extracting the SunOS release
into / t m p and making the remote distribution.   If the client and server architecture are the same, then cd to
the Razor installation directory (ie. $RAZOR_HOME) and then run r z _ c r e a t e _ r e m o t e _ d i s t r i b u t i o n.


NOTE: This script can (and probably should) be run without the environment variable
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RAZOR_HOME set. You must run this script from the Razor distribution root directory for the target
client machine since the script access files relative to this top-level directory.


SPECIAL NOTE: Due to differences in the tar tool implementation on certain platforms,
specifically DEC, SCO, and SunOS; a tar file can not be created on a SunOS platform destined for
either a DEC or SCO platform. Conversely, a tar file can not be created on either a DEC or SCO platform
and extracted on a SunOS platform.


# cd /tmp
# zcat Razor.tar.Z | tar xf -
# cd Razor_<version>
# . / s c r i p t s / r z _ c r e a t e _ r e m o t e _ d i s t r i b u t i o n


This script will generate a compressed tar file and place it in the
HOME directory [/home/razoradm].  If this is acceptable, press enter,
o t h e r w i s e
enter the full path where you would like this file to be installed.
Where should I install the output tar file [/home/razoradm]? / t m p


The binaries being extracted are for Version 4.1d, SUNOS.  
Is this correct [y]? y


Please wait, generating compressed tar file...


a  Razor_<ver>/VERSION 1K
a Razor_<ver>/bin/issues 2489K
a Razor_<ver>/bin/threads 2570K
a Razor_<ver>/bin/versions 3236K
a Razor_<ver>/lib/ 0K
a Razor_<ver>/lib/XKeysymDB 4K
a Razor_<ver>/lib/nls/ 0K
a Razor_<ver>/lib/nls/C 4K
a Razor_<ver>/lib/nls/ja_JP.jis7 3K
a Razor_<ver>/lib/nls/ja_JP.jis8 3K
a Razor_<ver>/lib/nls/ja_JP.mscode 6K
a Razor_<ver>/lib/nls/ja_JP.ujis 4K
a Razor_<ver>/lib/nls/ja_JP.pjis 3K
a Razor_<ver>/lib/nls/ko_KR.euc 4K
a Razor_<ver>/lib/nls/lt_LN.bit7 2K
a Razor_<ver>/lib/nls/lt_LN.bit8 4K
a Razor_<ver>/lib/nls/wr_WR.ct 3K
a Razor_<ver>/lib/nls/zh_CN.ugb 4K
a Razor_<ver>/lib/nls/zh_TW.big5 9K
a Razor_<ver>/lib/nls/nls.dir 2K
a Razor_<ver>/lib/nls/nls.alias 1K
a Razor_<ver>/lib/nls/local_im_tbl/ 0K
a Razor_<ver>/lib/nls/local_im_tbl/lt_LN.bit7 5K
a Razor_<ver>/lib/nls/local_im_tbl/lt_LN.bit8 5K
a Razor_<ver>/lib/nls/README 1K


Operation complete. The output file is located in /tmp/razor_remote_<ver>.
S U N O S . t a r . Z .


You may transfer this file to the target platform (e.g. ftp)
and install it.


Installation instructions for the remote target machine are in /tmp/
r e m o t e _ c l i e n t s . i n f o
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If the client architecture is different than the server architecture, then the client distribution is no longer
needed and can be deleted with the command...
# rm -rf *


Installation guidelines


You need to decide where the release should reside. If you are using a personal workstation, you may
install the release right under your home directory. The specific installation instructions were generated
by the r z _ c r e a t e _ r e m o t e _ d i s t r i b u t i o n script detailed in the previous section. Below is an
example of the remote client installation instructions.


Installation on remote target machine.


Transfer the file /tmp/razor_remote_<ver>.SUNOS.tar.Z to the target
machine, e.g. via ftp, in a global accessible directory, or wherever you
install 3rd party software.


Uncompress and untar /home/razoradm/razor_remote_<ver>.SUNOS.tar.Z:
  # zcat /home/razoradm/razor_remote_<ver>.SUNOS.tar.Z | tar xvf -


If desired, create a link to this Razor release directory:
  # ln -s <full path to Razor release dir> Razor


Define the environment variable RAZOR_HOME
  C shell:
  # setenv RAZOR_HOME <full path to Razor release dir>


  Bourne/Korn shell:
  # RAZOR_HOME=<full path to Razor release dir>
  # export RAZOR_HOME


Add the bin directory to your path:
  C shell:
  # set path = ($path $RAZOR_HOME/bin)


  Bourne/Korn shell:
  # PATH=$PATH:$RAZOR_HOME/bin
  # export PATH


You may add these to your .login or .profile file.


NOTE: You will NOT have to create a database or install a license manager on your machine
since the database you are accessing is on a remote machine.


NOTE: You must have a user entry in the Razor password file.


18.4 Starting the Remote Client


To start a remote client. The RAZOR_HOME and search path (e.g. PATH) environment variables should
already be set at this point., simply enter the command at the UNIX prompt with the -remote option. For
example, to start the versions tool remotely, enter...
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# versions -remote &


Any other command line options recognized by the client may be added as well (such as -group and -
universe).


Logging in


The first two dialogs presented to the user upon running a remote client involve logging in. The first dialog
requests server information. Specifically, the user is required to provide information necessary to connect
with the Razor license manager and desired Razor database server on the remote UNIX network. The
second dialog requests user information. Remote Razor client applications require each user have an
entry in the Razor password file defining the user name, group, and password.  See related sections
"Password file entries" and  "Remote guest account" in the Installation and General Administration ,
and "Password functions "for additional information concerning Razor's password feature.


NOTE: A history of previous logins is maintained (see "$HOME/.razor_login" on " Razor File
Formats "). It may be necessary to contact your local Razor administrator for some of this
information. A more detailed explanation of each field on the two dialogs follows:


Universe Dir


The UniverseDir field must contain the fully expanded path to a Razor database.
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NOTE: Look at the setting of $RAZOR_UNIVERSE_DIR as defined in the rz_prep file on the
server machine. (up to and including RAZOR_UNIVERSE). This path should end with
RAZOR_UNIVERSE, (without a trailing '/' or '\').


NOTE: Either the UNIX or the PC path style may be used for the <database>/RAZOR_UNIVERSE
path in the Issues/Versions/Threads log-in screen. Examples: UNIX path //D/Visible/Razor/DB/
RAZOR_UNIVERSE PC path D:\Visible\Raazor\DB\RAZOR_UNIVERSE


Port


The Port field must contain the UNIX port of the License manager. The installation default is 16151. This
port may be verified by viewing file $RAZOR_LICENSE_DIR/License_status on the server machine.


NOTE: If the value of RAZOR_PORT_NUMBER in the License_status file is different than 16151,
then enter the value listed in the file.


Host


The Host field must contain the UNIX host of the License manager. This may be given in either hostname
format or IP address format. If entered as a hostname, the remote machine must be able to resolve the
name.


UserID/Password


Razor requires the user to enter a valid user id and password before allowing access to a Razor
database. Remote Razor client applications require each user have an entry in the Razor password file
defining the user name, group, and password.


Change password (This option is insensitive whenever the license manager is running with the local
password file.)


Check this if the remote password is to be changed. If so, enter the new password into the two
password fields and click OK.


New password


The new password to change for the specified user ID.


Verify


Is the same password as in the new password field. If this does not match the New password field, the
password will not be changed.
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18.5 Temporary Disconnecting


For all intents and purposes, remote clients will function as local clients do. There are however some
subtle distinctions.


First, connected remote clients will have an additional File menu option called Disconnect, as shown
below:


In cases like a dial-up connection, remote clients can disconnect from the server and release the
connection. Disconnecting does NOT release a license token. Upon disconnect, a Reconnect button will
appear, as shown in the picture below. Clicking Reconnect will attempt  to reconnect to the server using
the same database and login information as previously entered.


NOTE: We say attempt because it is possible that the server was taken down since
disconnecting. If so, the remote client will display a message that the server is not available. 


18.6 More Information


• "Installation and General Administration "


• "Using Issues "


• "Using Versions "
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• "Using Threads "54
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19 Razor Administration via Razor Admin


The Windows 2000/XP version of Razor provides two interfaces available in administering your
installation; the "traditional" UNIX scripts or the Razor Admin tool. If you are a prior Razor UNIX
administrator and are comfortable with the scripts, you can stick with that administration method. You
should read through "Razor administration via scripts" below as it contains differences unique to
Windows 2000/XP under the POSIX subsystem.


The rest of this section describes how to administer Razor using the Razor Admin tool. From this one
tool, you can update your Razor license keys, create databases and groups, bring the license manager
and database server up and down, and monitor users and connections.


Starting Razor Admin


To start the Razor Admin tool, select Start --> Programs --> Razor --> Razor Admin and you will see a
window similar to the one shown below:


The main display


The main display of the Razor Admin tool consists of a window header/footer, a menu bar, a database
control area, and a license manager control area.


Menu bar


The menu bar contains the menus Database, License Manager, Syslog Manager, View, and Help.
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 Database contains the database-related commands New, New Demo, Select, New Group, Editor,
Connections, Start, Stop, and Exit.


-New Group consists of the pullright menus Issues and File.


 License Manager consists of license manager-related commands such as Start, Stop, Connections,
Configuration, Access list, Razor ID, Keys, Info, Version, and Remote Users.


 Syslog Manager consists of Syslog control functions such as Start, Stop, Clear, and Email.


 View contains window controls to show/hide the Status Bar, Output Log, and Syslog.


 Help consists of About, On Application and On Version and Readme.


-Readme has a pull right menu containing README document choices.


Footer bar


The footer bar contains tool tips, current time, and Razor version.


Database control


The Database status section includes a database selection area, a mode selection area and numeric
indications by tool (i.e. issues, versions and threads) of the total number of connected clients. The
information displayed in the mode selection area and the clients area is dependent on the selected
database. Until a database has been selected, the mode selection button is not available.


License manager control


The License Manager status section includes a mode selection area and numeric indications by tool of
the total number of connected clients. The mode selection area consists of a button which indicates the
selectable mode and a status text field indicating the current mode. If the license manager is not
currently running, the mode button will indicate "Start" and the mode status field will indicate "Stopped".
Selecting "Start" will start the license manager.  Once successfully started, the mode button will
indicate "Stop" and the status text field will display Running.


Installing license keys


In order for Razor to run, you must now obtain and install some license keys. Demo keys may be
obtained automatically via our Web site at: http://www.visible.com/Download/Razor/demo_keys.htm.
Demo keys will permit you approximately three weeks to evaluate Razor. If you have problems or do not
have access to the Internet, contact us either via e-mail at "razor_licenses@visible.com" or by phone at
(315) 363-8000.


 Select Razor ID from the License Manager menu. A pop-up window will appear, like the one below,
with the Razor ID information required by us in order to generate license keys.



http://www.visible.com/Download/Razor/demo_keys.htm
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 Send the full output of this command to 'razor_licenses@visible.com' requesting license keys. If you
are demoing Razor, you can generate your own temporary license keys via our Web site at http://www.
visible.com/Download/Razor/demo_keys.htm.


 Once you receive the license keys from us, select Keys from the License Manager menu. You will see
a License Keys dialog like the one that follows. Take care to enter the keys correctly and with the
correct case. If you are installing demo keys, enter DEMO in the ID field. Click OK to enter the new
keys.


For first time installations: If you have not installed the License Keys, the Invalid/Missing License Keys
message like the one in the next figure will appear when you start the Razor Admin tool. Additionally,
the License Keys dialog box will appear. 



mailto:razor_licenses@visible.com

http://www.visible.com/Download/Razor/demo_keys.htm

http://www.visible.com/Download/Razor/demo_keys.htm
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Creating Razor Databases


 To create a database, select New from the Database menu. A New Database dialog will be shown.  A
demo database may be installed by selecting New Demo from the Database pulldown menu. Select the Help
button on the New Demo Database dialog for details.
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Select the location of the database by using the Database Location button. This will bring up an Explorer
dialog that will allow you to choose the path where the database will reside - which MUST be an NTFS
file system. The Database location presented in the New Database GUI should be in a form similar to D:
\Visible\<database_name>


 Enter a database name (no spaces or funny characters please (Characters like ', ", <, >, !, ?, $, &, etc,
etc.).


 If you also wish the database to be used for file control, enter a File Group name (A Razor group
should not be confused with a UNIX group: they are different beasts. See "Databases, groups, and
attributes " and "Containers: databases, groups, and folders " (again, no spaces or funny
characters please)).


 Enter EXACTLY the SAME User name and Password which were used to login into your computer.
Confirm the password.


NOTE: Only members of the Admin group may use the Razor Admin tool.


 When you have completed these entries, click OK to create the database.


Within the limits of system resources any number of databases may be created on the Razor host.


Starting Razor


Starting the license manager


 Start the "Razor License Manager" service by selecting the "Start" button in the License Manager
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control or select Start from the License Manager menu.
 When the License Manager has been started, you will see "Running - 0 databases connected" in the


status message field.
The default license manager configuration is to use the Razor password file ("Razor passwords" above). 
The license manager may also be run against the local password file or a combination of the local and
Razor password files.  To change the license manager configuration:


1. Terminate the "Razor License Manager" service.


2. Modify the $RAZOR_LICENSE_DIR/License.conf file to enable the use of the local password file.


3. Modify the "Razor License Manager" service to run as an Administrator instead of as the "System"
account.


4. Start the "Razor License Manager" service.


5. Start the "Razor Inetd" service.


Note: If you wish the "Inetd" service to start automatically upon reboot, use "automatic" instead of
"manual"  via the  2000/XP Service panel.


Starting a database


If you have not yet created a database, refer to "Creating Razor Databases" above.


 Click "Select" in the Database control area or select Select from the Database pull-down menu. A
Select Database dialog will be displayed similar to the one below.


 Select the appropriate database. It's name will be highlighted.


 Click OK. The selected database name will appear in the name field in the Database control area.


 Click the "Start" button to the left of the selected database name or select Start from the Database
menu. 


NOTE: To automatically start the Razor license manager at boot time, refer to "Starting the
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programs" below, specifically on how to start the database service via the Shortcut to Services.


Razor passwords


Razor passwords can be created and maintained from the Razor Admin tool. Additional information
relating to Razor passwords can be found in "Remote client password " and "Password functions ."


Configuring the LM_Access_list to add users


Before you can add users, you need to make sure the LM_Access_list is configured with the proper
permissions. If the LM_Access_list is not configured correctly for this function, the Remote Users choice
in the License Manager menu will be unavailable.


To configure the LM_Access_list:


1. Logged in as Administrator on the server machine, choose Start -->Programs --> Razor --> Razor
Admin to display the Admin GUI.


2. Select License Manager --> Access list.


3. Scroll down the file and change the following areas: (Note: The asterisk can be replaced with specific
users, groups and/or roles.)


-Change ADD_USER from nobody to *


-Change MODIFY_USER from nobody to *


-Change REMOVE_USER from nobody to *


4. To set password aging or lock user accounts: (Note: The asterisk can be replaced with specific users,
groups and/or roles.


-Change SET_PASSW_AGING from nobody to *


-Change LOCKOUT_USER from nobody to *


5. Click OK, and save your changes.


6. Now, if necessary, start the license manager and choose License Manager --> Remote Users. 


7. In the Remote Users GUI, choose the appropriate action. For more details, see "Managing Razor
Passwords and Users" below.


Managing Razor Passwords and Users


To manage Razor passwords and users, select Remote Users from the License Manger menu. A
Remote Users dialog will be displayed like the one below. Of course your display will be empty if you
have not created any users and passwords yet.
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NOTE: The Remote Users menu item will only be enabled under the following conditions: the
License Manager is running, a database is selected in the Database Control, you are logged in as
Administrator, and Administrator is authorized to perform password file updates via the LM_
A c c e s s _ l i s t file.


Adding a user


To add a new user, click the ADD button in the Remote Users GUI. A User dialog will appear.
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To add a new user, specify a user name, a group name and a password. Additionally, options may be
set for locking the account, password aging and forced password change on next login.


 Account is locked


Selecting the 'Account is locked' option will lock a user's account. Deselecting the option will unlock the
account. Users with locked accounts will not be able to connect to Issues, Versions and Threads.


 Password Aging


'Password Aging' enables setting the maximum days a user's account can go without a password
change. The default for this field is 'Always Valid' meaning that the password will never expire. 


To activate aging for the account, select the desired number of days (1-365) from the drop down list. 
If a user attempts to access an account with an expired password, a 'Must change password' dialog will
appear with the following message: 'The password for this account <user_name> ) has expired. You will
not be allowed to continue unless you change your password." The user must select the 'Change
password' option and enter a new password before continuing with the login.


 Force a password change at next login


This option forces users to change the password the next time they log into Issues, Versions, or
threads. A 'Must change password' dialog will appear with the following message: 'The password for this
account <user_name> ) has expired. You will not be allowed to continue unless you change your
password." The user must select the 'Change password' option and enter a new password before
continuing with the login.


Modifying and deleting users


To modify an existing user entry, single click the name in the Remote Users list and click MODIFY. The
User information dialog will be displayed. Make the appropriate changes and click OK.


To delete a user entry, single click on the name in the Remote Users list and click DELETE. A
confirmation message will appear, allowing you to confirm the user entry deletion.


Creating new groups


Additional issues or file control groups can be added at any time after Razor is installed.


NOTE: The database server must be down before a new group can be added. The New Group
menu choices for "Issues" and "File" will be inactive when the database server is up. To bring the
database server down, simply click the Stop button next to the selected database server name.


To create a new group, select New Group from the Database menu and select either Issues or File. A
sample New Issues Group dialog is shown.







Razor Administration via Razor Admin 323


© 1992-2009 Visible Systems Corporation, All rights reserved.


Select the group type from the drop-down menu. Group types are defined by the Razor installation and
additional group types may be added with new releases. Currently, the issues groups include:


 Default - default issues group created when a Razor database is created.


 Action_items - action items related to process-oriented meetings.


 Bug_tracking - issues relating to software problem tracking.


 Customer_tracking - a customer contact database.


 Music - tjat's right, this just gives you an idea that Razor can be used to track just about anything.


 Peer_Review - generally associated with tracking ISO or other CM-standard review mechanism.


 Support_Helpdesk - a help-desk tracking/follow-up database.


 ToDo - Dorothy's little dog or what you still have to accomplish.


File control groups include:


 Default - default file control group that is created when a group name is entered in the File Group field
of the New Database dialog (See "Creating Razor Databases" above.)


 Code_development - a software-oriented version control group.


 Document_management - oriented towards tracking document changes as opposed to software.


 Web_development - similar to Code development, where the files relate to Web pages.


Enter whatever name you would like to use to identify this group in the Group Name field. It is
recommended that you not use spaces or special characters in the name. This name will also be used
to identify this group in Razor scripts and functions. If you are creating a new issues group (as shown on
the above dialog), you have the option of selecting a Prefix which is appended to the issue number. The
default prefix is "I". You may enter any of the 26 letters of the alphabet (A-Z). There is no restriction on
using the same letter for multiple issues groups. Click OK to add this group to the selected database. A
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Razor Admin Tool dialog will popup giving the user the option to edit the group.


Selecting Yes for group edit will pop up the Attributes dialog box. From this dialog. attributes can be
added, deleted and modified. For more information select the Help button on the Attributes dialog or refer
to the Razor Manual. An example of an Attributes dialog follows.


Further customization of this or any group may be performed by selecting Editor from the Database
menu.


Administering databases


Configuring databases
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Razor database configuration files can be edited by selecting Editor from the Database menu. The Razor
Table Editor dialog displays a list of the universe level configuration files and the issues and file control
(versions and threads) groups included in the senected database. Each group that contains configuration
files will be designated with a plus/minus sign ("+" or "-") before the name. Selecting the plus sign will
expand that group's list of configuration files. The Razor Table Editor might look something like:


Here is a summary of the features associated with the Razor Table Editor dialog:


 Selecting Access List will popup the Access List dialog.  The Access List contains the supported
access controls.  Who can perform which Razor operations is defined via the access controls.  For
information regarding this file, select the Help button on the Access List dialog or refer to the Razor
manual ("Access Controls "). A sample Access List dialog is show below:197
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 Selecting Roles will popup the Roles dialog.  Roles may be defined to further refine access controls. 
For information regarding this file, select the Help button on the Roles dialog or refer to the Razor manual
("Definable roles "). A Roles dialog on a populated Ro les file might look something like:197
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-Selecting a particular role entry will display a Modify Role dialog, like the one below:


 Selecting the "+" preceding Issues will expand to show the issues groups.  The default issues group
(the one created with the creation of a new database) always appears as "++ISSUES++".  Additional
issues groups will appear with the name entered in the Group Name field of the New Issues Group
dialog.


-Selecting the "+" preceding "++ISSUES++" (or any other issues group) will expand to show the
configuration files for this group.  Any files that are preceded with "*" are not editable by the current
user. 


-Selecting Attributes will popup the Attributes dialog.  Attributes are used to define and configure the
selected group.  For more information regarding this file, select the Help button on the Attributes dialog
or refer to the Razor manual ("The Attributes file "). An example of an Attributes dialog is shown
below:


186







Razor Manual328


© 1992-2009 Visible Systems Corporation, All rights reserved.


/Selecting a particular Attribute will display an Attribute Edit dialog.  For example, you might see the
following for the attribute named Scope:
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-The dialog will contain configuration information that is unique to its type. For example, the State
attribute contains the additional tabs Permissions and Bitmaps. Here is an example of the State
Attribute dialog.
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-Selecting the Bitmaps tab will redisplay the State Attribute dialog, shown below:
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-Likewise, selecting the Permissions tab will display a dialog like the one below:


NOTE: As you can see, each of the items shown under the groups edit tree are edited in a
similar manner. If you get stuck, each dialog has a Help button with an extensive help information.
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20 Glyphs Supplied with Razor


Glyphs; supplied & exposed!


Shown below are all of the glyphs presently included as part of the Razor release. You are of course free
to draw your own. The 'bitmap' program included with most X installations works well for this. Enjoy!
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Drawing your own glyph bitmaps


You are free to draw and use your own monochrome bitmaps.  


1. Create a directory in an easy to access and logical location.


# cd $RAZOR_UNIVERSE_DIR
# mkdir glyphs


2. Go to that directory and invoke your favorite bitmap editor program. (You're free to use whatever
program you prefer.)


# cd glyphs
# bitmap foo.xbm 16x16 &


3. Modify the Bi tmaps file to honor your efforts.
4. Restart the related issues, versions, or threads program.


If you discover that you've generated some dandy little images, feel free to forward them along to us for
inclusion in future releases.
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21 Instructions for Razor SCC


Installation instructions for RazorSCC, a Razor integration with Windows IDEs to provide source
code control from a supporting application 


Razor Integration with Windows IDEs - RazorSCC README file contents


Introduction - System requirements - Installation - Upgrades - Running RazorSCC - Razor 


Information Utility Introduction


RazorSCC is a "link" or "interface" between a Razor database and a supporting application. This
"link" enables your application to utilize the file control features of Razor directly from within the
application. Your "supporting" application is most likely going to be an Integrated Development
Environment (IDE), that is, an application that incorporates a variety of software development tools
within one program (an editor, compiler, linker, debugger, etc.). RazorSCC adds "Source Code
Control" to the suite of available tools. RazorSCC implements the Microsoft Source Code Control
API (SCC API) Specification. This specification defines a method for Source Code Control
Providers, like RazorSCC, to interact with an IDE. For RazorSCC to "link" to your IDE, the IDE
itself must also have implemented the Microsoft SCC API. You'll need to refer to your IDE's
documentation to determine whether or not it supports this interface. 


System requirements


RazorSCC runs on Windows 2000, XP, 2003 platforms only. It will connect to any existing Razor
database installation (Windows/2003 or UNIX). Since RazorSCC will run as a PC Remote Client,
each user must have an appropriate password file entry or user account, as described in the Razor
Manual, Appendix E, "Logging in". A current Razor License allows you to run RazorSCC. There
are no additional license modifications or updates needed to get running. A Razor token (for
Versions) will be used when you run your IDE and login to a Razor database (see "Running
RazorSCC"). If you wish to run your IDE without using RazorSCC, simply click Cancel when the
Razor Login dialog appears and no Razor token will be assigned to the IDE session. 


Installation


RazorSCC is included as a software component in both the 2003 Server and the RazorPC
installation programs. You may obtain a copy of either installation program by following the steps
described in the Razor Manual, Appendix G, "Obtaining a copy of the software", or by visiting the
Visible Systems Web site, 
http://www.visible.com/Download/Razor/razor_download.htm


Running either installation program gives you the option to select RazorSCC for installation. Simply
select RazorSCC. The software will be copied to the designated location and the appropriate PC
system modifications will be made. Since PC system modifications are required (in accordance with
the Microsoft SCC API Specification), RazorSCC must initially be installed on EACH PC that it will



http://www.visible.com/Download/Razor/razor_download.htm
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run on. 


Upgrades


RazorSCC must be upgraded when your Razor Installation is upgraded. The version of RazorSCC
must match the version of your Razor installation to work properly. The actual upgrade procedure is
to simply obtain the latest copy of the installation program (either the Razor 2003 Server or
RazorPC program), and run the program, being sure to select RazorSCC as a software component
to be installed (upgraded), and choosing the correct location for the software installation. 


Running RazorSCC


Once RazorSCC has been installed, simply run your IDE to automatically load and use RazorSCC.
Prior to actually using any file control features from your IDE, you will be prompted to log-in to the
Razor database that contains the project files. Please refer to the README.RazorPC, "Login
instructions" section, or the Razor Manual, Appendix E, "Logging in", for a detailed description of
this procedure. How you select the file control features may vary from IDE to IDE. Please check
your IDE documentation for specifics regarding how to do this. Most likely, you will click a menu
item after selecting a file (or bunch of files) from the project file list or after clicking a menu bar
button (such as "Project" or "Tools"). Once you select a file control option in the IDE, a dialog will
most likely be displayed, listing the selected files and additional options that might be chosen for the
action. After making any additional choices and clicking, "OK", RazorSCC will perform the
appropriate Razor database changes. Clicking "Cancel" from the dialog will, as it states, cancel the
action before any Razor modifications are made. 


Razor Information Utility


Once you've installed RazorSCC on your PC, you'll notice an addition to your Start Menu. There
will now be a selection for "RazorSCC" with options to run the "Razor Information Utility" and to
view this README file. Selecting "Razor Information Utility" displays a window that contains
information about this PCs RazorSCC installation. You will find the version of RazorSCC, location
of the software, host computer particulars, etc. The purpose of this utility is to provide information
only. 
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22 Razor API


A detailed approach for interfacing the activity stored by Razor with third party tools.


OVERVIEW 
 
The Razor tool suite includes the following primary components: 


 Versions.  A file version control system. 
 Threads.  A build or release management tool. 
 Issues.  A problem tracking tool. 


 
The Razor tools may be used collectively as a tool suite or independently.  The tools share a common
database.  The database is composed of one or more issues groups, one or more file-control groups,
and a project group.  File and thread groups are linked, with a single project group existing for all file/
thread pairs in the database.  Issues can be related to version control and thread activity, or can be
used in a standalone fashion. Therefore, it is envisioned that one approach for interfacing the activity
stored by Razor with third party tools would be to utilize the issue control groups for "defect" tracking;
version control groups for "versioning" and threads control groups for "release" or "baseline". 
 
Based upon this approach, the proposed API provides four categories of commands: 
 


1. Utility commands related to collection of activity for Versions and Threads. 
2. Versions and Threads activity collection commands 
3. Utility commands related to collection of activity for Issues 
4. Issues activity collection commands. 


 


This would mean that for a client-sever architecture the integration would need to take place on the
same host or server where the Razor database resides. The client and server would exchange text
commands and results over standard socket interface.   
 
UTILITY COMMANDS FOR COLLECTION OF VERSIONS AND THREADS
ACTIVITY 
 
rz_isRUD –rud <RUDirPath> 
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
Purpose:  Function validates path to specified database. 
Returns:  On success, the valid path is returned.  Otherwise, an error message is returned. 
 
rz_getFileControlGroups –rud <RUDPath>  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
Purpose:  Obtains list of all file control groups associated with the Razor database. 
Returns: Comma-delimited list of Razor file control groups for the specified Razor database. 
 
rz_isFileControlGroup –rud <RUDPath>  –g <GroupName> 
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName  Name of Razor file control group to be validated. 
Purpose:  Provides a means of validating a given string as the name of a current Razor file control
group. 
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Returns:  True/False 
 
rz_getAttributes –rud <RUDPath>  –g <GroupName>  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Name of Razor file control group. 
Purpose:  Razor attributes can be customized down to the group level.  Function serves as an
accessor obtaining the name and type of each attribute being used for the specified database. 
Returns:  A comma-delimited list of attribute name/type-value pairs.  E.g. Blessing/STATE, Filetype/
ONE_OF_MANY. 
 
 
rz_getAttributeValues –rud <RUDPath>  –g <GroupName> -a
<AttributeName> [-echo] [-verbose] 
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName  Name of Razor file control group. 
AttributeName  - Name of valid attribute for specified group. 
Purpose:  Obtains list of permissible attribute values for an attribute of type CHECK_BOX,
ONE_OF_MANY, ONE_OF_MANY_STACK, X_OF_MANY, STATE, ONE_OF_MANY_LIST,
X_OF_MANY_LIST. 
Returns:  On success returns a comma-delimited list of attribute values. 
 
 
rz_isValidAttributeName –rud <RUDPath>  –g <GroupName> -a
<AttributeName> [-echo] [-verbose]  
RUDPath  The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Name of Razor file control group. 
AttributeName  - Name of attribute to be validated. 
Purpose:  Provides a means of validating given attribute for specified Razor group. 
Returns:  TBD 
 
 
rz_isValidAttributeValue –rud <RUDPath>  –g <GroupName> -a
<AttributeName>:<AttributeValue>  [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Name of Razor file control group. 
AttributeName: AttributeValue  - Name of attribute name-value pair to be validated. 
Purpose:  Provides a means of validating given attribute name-value pair for specified Razor group. 
Returns:  TBD 
 
 
VERSIONS AND THREADS ACTIVITY COLLECTION COMMANDS  
 
rz_getTotalFiles –rud <RUDPath>  [–g <GroupName>] [-ts
<SinceTimestamp>] [-tu <UntilTimestamp>] [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Optional Razor file control group for the query.   
SinceTimestamp, UntilTimestamp – Optional timestamp(s) used to window the query.
Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Obtains total number of files  
Returns:  Total number of files. 
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rz_getTotalSubfolders –rud <RUDPath>  [–p <AuxPath>]  [–g
<GroupName>] [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
AuxPath – Optional auxiliary path from which subfolders are to be located.  Path should be specified
relative to the RUDPath.  Cannot utilize both the "-p" and "-g" options within the same query. 
GroupName – Optional Razor file control group for the query.  Cannot utilize both the "-p" and "-g"
options within the same query. 
Purpose:  Identifies subfolders within Razor database, directory, and/or group. 
Returns:  Total number of subfolders 
 
 
rz_getFilesByAttrVal –rud <RUDPath>  –g <GroupName> -a
<AttributeName>:<AttributeValue> [-ts <SinceTimestamp>] [-tu
<UntilTimestamp>] [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Razor file control group for the query.   
AttributeName: AttributeValue  - Name of attribute name-value pair for the query. 
SinceTimestamp, UntilTimestamp – Optional timestamp(s) used to window the query.
Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Provides a count for the number of files under source code control with a matching
attribute value. 
Returns:  TBD 
 
 
rz_getAddedFiles –rud <RUDPath>  [–g <GroupName>] [-a
<AttributeName>:<AttributeValue>] -ts <SinceTimestamp> [-tu
<UntilTimestamp>] [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Optional Razor file control group for the query.   
AttributeName: AttributeValue  - Optional attribute name-value pair for the query. 
SinceTimestamp, UntilTimestamp – Timestamp(s) used to window the query.
Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Provides a count for the number of files added to source code control within the specified
period. 
 
 
 
 
 
Returns:  TBD 
 
 
rz_getChangedFiles –rud <RUDPath>  [–g <GroupName>] [-a
<AttributeName>:<AttributeValue>] -ts <SinceTimestamp> [-tu
<UntilTimestamp>] [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Optional Razor file control group for the query.   
AttributeName: AttributeValue  - Optional attribute name-value pair for the query. 
SinceTimestamp, UntilTimestamp – Timestamp(s) used to window the query.
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Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Provides a count for the number of files under source code control that were changed
within the specified period. 
Returns:  TBD 
 
rz_getUnchangedFiles –rud <RUDPath>  [–g <GroupName>] [-a
<AttributeName>:<AttributeValue>] -ts <SinceTimestamp> [-tu
<UntilTimestamp>] [-echo] [-verbose]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Optional Razor file control group for the query.   
AttributeName: AttributeValue  - Optional attribute name-value pair for the query. 
SinceTimestamp, UntilTimestamp – Timestamp(s) used to window the query.
Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Provides a count for the number of files under source code control that were not changed
within the specified period. 
Returns:  TBD 
 
rz_getFileSummary –rud <RUDPath>  [–g <GroupName>] [-an
<AttrNameList>] -ts <SinceTimestamp> [-tu <UntilTimestamp>] [-echo]
 
RUDPath  The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Optional Razor file control group for the query.   
AttrNameList  - Optional list of additional attributes to be included in the file details. 
SinceTimestamp, UntilTimestamp – Timestamp(s) used to window the query.
Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Provides a detailed file summary.  Minimally, each summary includes: file name, number of
revisions over specified time period, and current version ID. 
Returns:  TBD 
 
rz_getChangeSummary –rud <RUDPath>  [–g <GroupName>] [-an
<AttrNameList>] -ts <SinceTimestamp> [-tu <UntilTimestamp>] [-echo]
 
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
GroupName – Optional Razor file control group for the query.   
AttrNameList  - Optional list of additional attributes to be included in the file details. 
SinceTimestamp, UntilTimestamp – Timestamp(s) used to window the query.
Timestamps are to be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Provides a detailed summary for files changed over the specified time period.  Minimally,
each summary includes: file name, number of revisions over specified time period, user-name and
comments for each revision. 
 
 
 
 
 
Returns:  TBD 
 
rz_getUserActivity –rud <RUDPath>  [-u <UserList>] [–g <GroupName>] [-an
<AttrNameList>] -ts <SinceTimestamp> [-tu <UntilTimestamp>] [-echo]  
RUDPath – The Razor universe directory (RUD) path locating a particular Razor database. 
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UserList – Optional (comma-delimited) list of users for which activity is desired. 
GroupName – Optional Razor file control group for the query.   
AttrNameList  - Optional list of additional attributes to be included in the file details. 
SinceTimestamp, UntilTimestamp – Timestamp(s) used to window the query.  Timestamps are to
be formatted as follows:  yy/mm/dd,hh:mm:ss. 
Purpose:  Summarizes the changes made by each user over the specified time period.  Minimally,
summary includes user-name and number of changes.  User summary may be expanded to include: 
files introduced/modified, TBD. 
Returns:  TBD 
 
UTILITY COMMANDS FOR COLLECTION OF ISSUES ACTIVITY 
 
TBD 
 
CM METRICS COLLECTION 
 
TBD 
 
SAMPLE USAGE 
 
Assume that the Razor database is configured as follows: 


 Single issue control group (ICG1)  
 Two file control groups (FCG1, FCG2) 
 The FileType attribute has been defined for all file control groups.  The permissible attribute


values are:  C++, Java, Docs 
 The Blessing (i.e. state level) attribute has been defined for all file control groups.  The


permissible attribute values are:  Active, Reviewed, Tested, Integrated. 
 Razor database is located in /home/brianm/db1/RAZOR_UNIVERSE 


 


Q. How do I obtain a list of the available file control groups for a particular DB? 


A.  Issuing command "rz_getFileControlGroups –rud /home/brianm/db1/
RAZOR_UNIVERSE" returns "FCG1, FCG2" 
 
Q.  How do I obtain the attributes associated with the FCG2 file control group? 


A.  Issuing command "rz_getAttributes –rud /home/brianm/db1/RAZOR_UNIVERSE
–g FCG2" returns 
"FileType,Blessing". 
 
Q.  How can I determine the different status/state/blessing levels associated with a file under version
control within the FCG1 group? 


A.  Issuing command "rz_getAttributeValues –rud /home/brianm/db1/
RAZOR_UNIVERSE –g FCG1 -a Blessing" returns 
"Active,Reviewed,Tested,Integrated" 
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Q.  How can I determine how many files are in the entire Razor DB in May 20001? 


A.  Issuing command "rz_getTotalFiles –rud /home/brianm/db1/RAZOR_UNIVERSE
-ts 01/05/01:00:00:00 -tu 01/05/31:23:59:59" returns "7". 
 
Q.  What effect does the verbose option (-verbose) have on my queries?   


A.  Repeating the previous example.  Issuing command "rz_getTotalFiles –rud /home/
brianm/db1/RAZOR_UNIVERSE -ts 01/05/01:00:00:00 -tu
01/05/31:23:59:59 –verbose" returns 
./DOMAIN_01/FCG1/inc/myTypes.h 
./DOMAIN_01/FCG1/inc/moreTypes.h 
./DOMAIN_01/FCG1/src/main.cc 
./DOMAIN_01/FCG2/inc/otherTypes.h 
./DOMAIN_01/FCG2/src/other.cc 
./DOMAIN_01/FCG2/src/more.cc 
./DOMAIN_01/FCG2/doc/readme.txt 
TOTAL:  7 
 
Q.  How do I obtain the number of subfolders for the file control groups? 


A.  Issuing command "rz_getTotalSubfolders –rud /home/brianm/db1/
RAZOR_UNIVERSE" yields: "5".  Issuing command "rz_getTotalSubfolders –
rud /home/brianm/db1/RAZOR_UNIVERSE -verbose" yields: 
./DOMAIN_01/FCG1/inc 
./DOMAIN_01/FCG1/src 
./DOMAIN_01/FCG2/inc 
./DOMAIN_01/FCG2/src 
./DOMAIN_01/FCG2/doc 
TOTAL:  5 
 
Q.  How do I obtain the number of header files currently in the "Reviewed" state from FCG1?  Issuing
command "rz_getFilesByAttrVal –rud /home/brianm/db1/RAZOR_UNIVERSE –g
FCG1 -a FileType:C++,Blessing:Reviewed" returns "2".  Issuing command "
rz_getFilesByAttrVal –rud /home/brianm/db1/RAZOR_UNIVERSE –g FCG1 -a
FileType:C++,Blessing:Reviewed –verbose " returns: 
./DOMAIN_01/FCG1/inc/moreTypes.h 
./DOMAIN_01/FCG1/src/main.cc 
TOTAL 2 
 
 ??????????????
????????????
?????????????????????????????????????????????????????????????????????????????
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23 Multiple NIC's and IP Address


Razor has the ability to work on servers and clients that have multiple Network Interface Cards (NIC's)
and Internet Protocol (IP) addresses.  For this functionality to be enabled, the server and/or the clients
must be properly configured and multihomed.  You may need to check with your Sys Admin regarding
this.


23.1 Servers with Multiple IP Addresses


Question: 


I have a multihomed server. It has one IP address for communicating with subnet A and a second IP
address for communicating with subnet B.  How do I configure a Razor License Manager and/or Razor
Database Manager to work with clients on both the A and B subnets?


Answer:  


When a Razor (License Manager and/or Database Manager) server is run on a multihomed machine,
Razor will detect the presence of multiple network interfaces (via gethostbyname() ).  The server status
file will contain a comma-separated list of IP addresses associated with each of the server's available
network interfaces.  


Thus, a multihomed Razor License Manager with IP addresses 3.11.4.1 and 3.11.5.1 would format the
"LICENSE_HOST_IP" entry in the RAZOR_LICENSE_DIR/License_status file as follows:


LICENSE_HOST_IP:    3.11.4.1,3.11.5.1


A multihomed Razor Database Manager with IP addresses 3.11.4.1 and 3.11.5.1 would format the
"SERVER_HOST_IP" entry in the$RAZOR_UNIVERSE_DIR/Server_status file as follows:


SERVER_HOST_IP:     3.11.4.1,3.11.5.1


A Razor (Versions, Threads, Issues) client will attempt to connect to the Razor server via each of the IP
addresses published in the server status file. It will try to establish a connection using the first value
specified in the comma-separated list.  If unsuccessful it will try using the next IP address. 


Using values from the current example, a Razor client would attempt to communicate to the Razor
License Manager and Database via 3.11.4.1.  If unsuccessful, the client would attempt to communicate
via 3.11.5.1.


By default, the order of the IP addresses stored in the server status file is dictated by gethostbyname(). 
New environment variables 'RAZOR_ALT_LM_SERVER_IP_ADDRS' and
'RAZOR_ALT_DB_SERVER_IP_ADDRS' provide a means of specifying the explicit order of IP addresses
that the Razor servers use when listening for new connections.
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Using values from the current example, the Razor License Manager and Database could be configured
so that Razor clients attempt to first connect on 3.11.5.1 and if unsuccessful 3.11.4.1 as follows:


#!/bin/sh
setenv RAZOR_ALT_LM_SERVER_IP_ADDRS "3.11.5.1,3.11.4.1"
setenv RAZOR_ALT_DB_SERVER_IP_ADDRS "3.11.5.1,3.11.4.1"
   
#!/bin/sh
RAZOR_ALT_LM_SERVER_IP_ADDRS="3.11.5.1,3.11.4.1"
RAZOR_ALT_DB_SERVER_IP_ADDRS="3.11.5.1,3.11.4.1"
export RAZOR_ALT_LM_SERVER_IP_ADDRS
export RAZOR_ALT_DB_SERVER_IP_ADDRS 


23.2 Clients with Multiple IP Addresses


Question: 


I need to run Razor (Issues, Versions, Threads) clients on a multihomed client.  The client machine has
network interface cards (NICs) for a 192.168.1.* Ethernet subnet as well as a faster 192.168.2.* ATM
subnet.  When communicating with the Razor License Manager and Database servers (mulithomed on
192.168.1.1, 192.168.2.1), I would like to utilize the faster interface corresponding to the 192.168.2.*
ATM subnet. How can I specify the use of a particular IP address by the multihomed Razor client?


Answer: 


The answer depends upon whether the Razor client is considered to be a 'local' or 'remote' client.


Remote clients include all Windows clients as well as any non-Windows platforms running the Issues/
Versions/Threads applications using the '-remote' command-line switch.


23.3 Remote Razor Clients


A remote Razor client will be presented with a login window in which the user is required to enter the: 


•Path to the Razor database


•License Manager IP  address or name


•License Manager port number


•Local Host IP address or name.


NOTE: For a client that has been multihomed properly, the login window will provide a list of
available client IP addresses in the 'Local Host' portion of the login window: E.g. 192.168.1.100,
192.168.2.100.  If you're unable to multihome the client properly, only a subset of available client IP
addresses will be listed.  A new environment variable RAZOR_ALT_CLIENT_IP_ADDR can be utilized to
specify the proper IP if it is not listed.  (See 'LOCAL RAZOR CLIENTS' section below).


Razor clients seeking to communicate via the faster 192.168.2.* ATM subnet should select an IP
address (192.168.2.1) for the Razor License Manager associated with the faster 192.168.2.* subnet. 
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The Razor client should also specify its 'Local Host' using its IP address (192.168.2.100) that
corresponds to the faster ATM subnet.


23.4 Local Razor Clients


Local Razor clients are not presented with a login window for specifying connection parameters for
themselves and the Razor servers.  By default, the local IP address used by the client to communicate
with the Razor License Manager and Database Manager servers is determined by gethostbyname().  For
a multihomed Razor client, gethostbyname() returns a list of IP addresses associated with the client. 
The Razor client will utilize the first IP address in the list when communicating with the Razor servers. 


In some cases the first IP address will be inappropriate.  (E.g. the Razor server has a single NIC
associated with subnet B.  The client's first IP address is associated with subnet A).  The default
selection can be overridden via environment variable 'RAZOR_ALT_CLIENT_IP_ADDR'.


For example, if it is desired that the client use 192.168.1.102, the client should specify


#!/bin/csh
setenv RAZOR_ALT_CLIENT_IP_ADDR "192.168.1.102"


or


#!/bin/sh
RAZOR_ALT_CLIENT_IP_ADDR="192.168.1.102"
export RAZOR_ALT_CLIENT_IP_ADDR







Part


XXIV


Razor ®







Windows 2003/2000/XP Server 351


© 1992-2009 Visible Systems Corporation, All rights reserved.


24 Windows 2003/2000/XP Server


This section describes how to install, run and administer the 2003/2000/XP Server. You should already
have read "Installation and General Administration " before proceeding. For those already familiar with
Razor in the UNIX environment, Razor server on Windows 2003 Server/2000/XP (2003/2000/XP Server)
will look quite familiar.


TIP: While old-time Razor UNIX users will be familiar with the command line administration
scripts, Windows users will more than likely enjoy the GUI Razor Admin tool. Many of the Razor
administrative functions can be performed with the Razor Admin tool, which is located in the Razor
program group. Once Razor is installed, skip right to "Registering License Keys" below for details on
using the Razor Admin tool.


2003/2000/XP Server supports all of the Razor remote clients which are PC clients, UNIX remote clients,
and IssueWeaver.


For specific details on installing IssueWeaver under 2003/2000/XP, refer to the Installation section in the


IssueWeaver Users Manual..


NOTE: The Razor install for Windows comes packaged with RCS. You will not need to install
RCS separately.


NOTE: In order to send e-mail via the 2003, 2000 or XP server, SMTP must be set up. E-mail
functionality requires the use of Outlook or Outlook Express. Please see "E-mail Functionality in
Windows 2003 Server, 2000 & XP" below for more details. Contact your System Administrator for
specific setup details for your site.


LIMITATIONS: 2003/2000/XP Server does not support database synchronization, e-mail issue
submittal and e-mail query (remote access via e-mail).


For the curious, the 2003/2000/XP Server license manager and database servers are installed as
2003/2000/XP Services. Starting and stopping these applications is as simple as starting or stopping the
service via the 2003/2000/XP Services panel or can be administered using the GUI Razor Admin tool.


28
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24.1 System Requirements


To run 2003/2000/XP Server you need the following:


 Networked Windows 2003 or Windows 2000 and SP4.


 Any user with administrative privilege. 


NOTE: Installation as well as all of the administration of Windows 2003 Server/2000/XP Server
must be done via the Administrator account.


 NTFS disk partition with enough free disk space for installation.


 NTFS disk partition(s) with enough free space to create and maintain the desired Razor databases.


24.2 Before You Get Started


General comments


IMPORTANT NOTE: All Razor administration MUST be performed via the Razor program group
utilizing the various programs items. Don't mix modes and slip into Windows to do things.


The majority of work will be done with either the GUI Razor Admin tool, or one of the provided shells. If
you choose to administer Razor using a shell, it is recommended that the "Razor csh" be used since
that is the assumed environment for all examples. 


NOTE: This shell is available from the Razor group via the Start menu or from the Razor program
group folder. 
The shells are POSIX compliant versions of the c shell and the korn shell and, therefore, require POSIX
compliant shell syntax. Of particular importance is the syntax used to represent drive letters, namely /
dev/fs/<drive_letter>/.


For example, the / t m p directory of drive D: is known as / / D / t m p. Referring to "/" simply means the top
level of the current drive. When providing a fullpath (i.e. when creating a new Razor database), it is
important to include the drive letter, otherwise, the path will be relative to current drive rather than a
fullpath. ALWAYS use upper case when providing the drive letter. 


The system wide environment parameters, RAZOR_HOME and RAZOR_LICENSE_DIR, are established
during installation. Parameter RAZOR_HOME points to the location of the Razor binaries, scripts, help
files, etc. Parameter RAZOR_LICENSE_DIR points to the directory containing the license file, etc. The
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other important environment parameter is RAZOR_UNIVERSE_DIR. This parameter points to one of any
number of databases. These environment variables are used internally by the various Razor binaries and
scripts.


Starting one of the shells is as simple as double-clicking over the appropriate shortcut in the Razor
program group or selecting one via the Start menu (Start->Programs->Razor...).


The Razor program group


Once the installation process is complete, the following program items will be available:


-Razor Admin
-Razor csh (c shell) 
-Razor ksh (korn shell) 
-ReadMeFile
-Shortcut to Services (Shortcut to 2000/XP Services panel)


Razor Admin is a GUI interface to Razor's administrative functions, such as starting and stopping the
license manager and database server. 


The Razor csh and Razor ksh each start the requested Unix-like shell. These shells (windows) provide
the PC user with a unix-like (POSIX) window that accepts Unix commands. These are POSIX-compliant
versions of the c shell and the korn shell. Much of the administration of Razor will be done from either
the Razor Admin tool or one of these shells. 


Program item "Shortcut to Services" is provided as another convenience to the Razor administrator and
does nothing more than popup the 2000/XP Services panel.


24.3 Obtaining a Copy of Razor


You may obtain the software by visiting our website at: www.razor.visible.com.


24.4 Installing Razor on Windows


•Download the appropriate copy of Razor. 


NOTE: Windows 9x can only be used as clients for RazorPC. The Databases and the server must
be installed on Windows 2003 Server/2000/XP.


•You must meet the following requirements when installing Razor server:


-The drive that will contain Razor MUST be NTFS partitioned.


-You MUST install as Administrator and not just a member of the Administrative group.


-Administrator must have a password.


-You MUST have a NIC card and be connected to a network.


•After downloading, check your system for the presence of a POSIX subsystem by going into the CMD
prompt (Start->Run, type in "cmd" and press enter). At the prompt, type in "posix" and hit enter. If



http://www.razor.visible.com





Razor Manual354


© 1992-2009 Visible Systems Corporation, All rights reserved.


POSIX is present you should get output saying "posix: command missing". This means that POSIX is
present and not disabled.


•The machine where Razor will be installed must have a NIC card and be connected to a network. To
verify this, run "ipconfig" at the cmd prompt. Your output should be the Ethernet adapter number, your IP
address, subnet mask, and your default gateway.


•Once you have installed Razor by double-clicking on the Razor.exe and choosing the appropriate
parameters, reboot the machine and log in as Administrator and not just a member of the Administrative
group.  This is very important.


•Through Windows Explorer, navigate to your Visible directory and find a file called "service.ini".  Open
the file and verify that it contains the names of three services:  Razor License Manager, Razor Syslog
Manager, and Razor Inetd.  If it does, your installation procedure was successful!


NOTE: If you attempted to uninstall a previous installation and were not successful, please
contact Razor_Support@visible.com for the proper uninstall instructions.


24.5 Database Creation - An Overview


It is recommended that a common repository (folder) be created that will contain all Razor databases.
Although databases may be located on any NTFS partition and do not have to belong to a general
repository, it is recommended that a common repository be created. The recommended repository
location is <Razor>/ razor_db, where <Razor> is the location of the Windows 2003 Server/2000/XP
Server installation such as / / D / V i s i b l e. 


Once the repository is created the individual database folders should be created. The names used as the
database folders are up to the Administrator. For example, databases DB1, DB2 and DB3 might be
represented as... 


/ / D / V i s i b l e / r a z o r _ d b / D B 1,
/ / D / V i s i b l e / r a z o r _ d b / D B 2, and
/ / D / V i s i b l e / r a z o r _ d b / D B 3.


It is up to the Administrator to manually create a given database folder. The database creation process
permits the database location to be specified. Here the database folder would be entered as a fullpath
such as / / D / V i s i b l e / r a z o r _ d b / D B 1. 


Since 2000/XP does not support the concept of setuid/setgid, another mechanism is required to insure
the server runs as the database owner. This is handled by installing the database server as an 2000/XP
service to run as the owner (installer) of the database. During database creation the installer's password
is entered. The database server is then registered as a service to run as the installer. Starting the
database server is done via the Services Control Panel or via Razor Admin. If, for example, you created
database / / D / V i s i b l e / r a z o r _ d b / D B 3, you would find the service named RazorDB_DB3. 


For first time installations, if you have not created a database, a pop-up will appear when you start the
Razor Admin Tool instructing you to do so.


NOTE: Either the UNIX or the PC path style may be used for the <database>/RAZOR_UNIVERSE
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path in the Issues/Versions/Threads log-in screen. Examples: 


UNIX path //D/Visible/Razor/DB/RAZOR_UNIVERSE 


PC path D:\Visible\Razor\DB\RAZOR_UNIVERSE


To create a database using the Razor Admin Tool,


 Select Database --> New


 The Database location presented in the New Database GUI should be in a form similar to D:\Visible
\<database_name>


 Enter the database name.


 For File Group name enter the name for the file versions control group if you plan to use the Versions
tool.


 For User, enter EXACTLY the SAME ID as the login ID you used to log onto your computer.


 For Password, enter EXACTLY the SAME as the password used to log onto your computer.


 Confirm the password.


24.6 Registering License Keys


You can only use license keys for the machine they were requested for. If you try installing them on a
different machine, the keys will not work. All demo users must enter DEMO for their Razor ID when
entering their license keys.


Installing Registered License Keys


License keys for registered licenses are installed as follows:


 Start the Razor Admin GUI (Start/Programs/Razor/Razor Admin).


 Select Keys from the License Manager pull down menu. 


 In "License Keys" GUI, enter your four license keys. Make sure your Razor ID appears in the ID field.
To obtain your Razor ID, select Razor ID from the Nicense Oanager pull down menu. The Razor ID is the
8 character identifier at the end of line 2 of the Razor ID screen.


Installing Demo License Keys


License keys for DEMO licenses are installed as follows:


Start the Razor Admin GUI (Start/Programs/Razor/Razor Admin).


 Select Keys from the License Manager pull down menu.


 In "License Keys" GUI, enter your four license keys. Enter the word DEMO in the ID field.
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24.7 Administrator Account Password Changes


Razor's License Manager and Database Services must have the same password as the Administrator
logon password. If the password changes on the Administrator logon, Razor will prompt the user to
change the password for the License Manager service.


The Update Service dialog box will appear when the following two conditions are met:


1. There has been a password change for the Administrator logon.


2. The license manager is started after that password change.


Updating the License Manager service password


The License Manager Service password can be updated using the following procedure. An alternative is
to follow the "Updating the Database Service Password" procedure substituting License Manager Service
for Database Service.


1. Enter the new logon password in the Update Service Password dialog box and click OK.


2. The 'Restart Service' dialog box will appear. Click 'Yes'. The License Manager will now restart.


Updating the Database Service Password


Razor databases must have the same password as the Administrator logon password and the License
Manager password. To update a Database Service password:


1. Choose Start --> Programs --> Razor --> Shortcut to Services


2. Find the database name in the list and double-click on it. For example, for the database 'customers'
find the entry RazorDB_customers.


3. In the resulting Service dialog box, click the 'This account' button in the Logon As portion of the
screen.


4. Change the Password entry and the Confirm Password entry to match the Administrator account
logon password. Remember that passwords are case sensitive.
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5. Start the Database from the Razor Admin GUI or the Services Window.


6. Repeat steps above steps for additional databases.


NOTE: Passwords for other Razor services such as Razor Inetd and Razor Syslog Manager may
need changing. Use the procedure outlined above in "Updating the Database Service Password."


24.8 Troubleshooting the License Manager


If the license manager does not start...


 Go to your Services menu and locate the service called Razor License Manager. Double click on it,
choose the Log On tab, and check the box that says "This Account." 


 Click on the small browse button to the right of the checkbox and find the Administrator account. 


 Choose the account and input the password for Administrator twice. 


 Click OK and try to start the service.


NOTE: In the event that the License Manager does not start, it should give you a specific reason.
Please reference the Troubleshooting guide.  If you have further questions, please contact 
Razor_Support@visible.com.


If the service does not start...


 Go to a Razor Csh prompt (Start->Programs->Razor->Razor csh) and wait for the prompt.


 Change directories (cd) to the Visible directory and input "razor_lm up". 


 If this starts the License Manager, it means that the services did not properly register with Windows. 


24.9 Connecting to a Database


An error that users sometimes see when first using Razor is "The Host/Port you are trying to connect to
does not appear to be running the RAZOR license server program. Please contact your RAZOR
Administrator."


Incorrect path statements usually cause this type of error. In the Razor Admin GUI, the path should be
formatted as such...


D:\Visible\Razor\<database>\RAZOR_UNIVERSE


In the above example, note the use of backslashes and a capital drive letter.


In the Issues/Versions/Threads log in screen on the Razor Desktop, the path should look like this...


//D/Visible/Razor/<database>/RAZOR_UNIVERSE
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or


D:\Visible\Razor\<database>\RAZOR_UNIVERSE


24.10 Additional Resources


Razor Online FAQ


We recommend reviewing our online Razor FAQs. You'll find that they answer some of Razor users'
more common questions. The address is http://www.visible.com/Products/Razor/FAQs.htm


Razor Manuals


The Razor Reference Manual is available on our website at:
http://www.visible.com/Products/documentation.htm


or


http://www.visible.com/Download/downloads.htm


Razor Technical Support


If you have any questions at any time during the installation process, please contact Razor support at:


Razor_support@visible.com


Phone:  800-6-VISIBLE


Razor technical support is available Monday through Friday, 8am - 5pm EST. 


24.11 Upgrading Razor PC Client/Server Installations


Upgrading Razor PC Server Installation


It is not necessary to uninstall the existing Razor PC server installation. To upgrade, perform the
following:


 Terminate all Windows applications and reboot the machine.


 Login as the PC's Administrator using the Administrator's password.


 Stop the database server(s) and license manager via the Razor Admin tool.


 If the Syslog manager, license manager and any of the database servers are setup to start
automatically at "boot", change the "Startup Type" to "Manual" via the Services panel.


 Start (double click) the Razor PC server installation program.


 When prompted, choose to upgrade your installation. This process should take only a few minutes



http://www.visible.com/Products/Razor/FAQs.htm

http://www.visible.com/Products/documentation.htm

http://www.visible.com/Download/downloads.htm

mailto:Razor_support@visible.com
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 You may run into a permission problem if:


-1. You did not originally install Razor as "Administrator"


-2. Administrator's password was changed since your last install/upgrade


-3. You did not upgrade as Administrator.


To solve these problems the ownership of the Razor services will have to change. Do so by logging in as
"Administrator" on the Razor server, opening the Services panel, and changing the logon information so
that the user and password are EXACTLY what is used when a user logs in as Administrator.


 Reboot the 2000/XP workstation.


 Login as Administrator.


 Start the Razor license manager and database server(s) as desired.


 Set the service "Startup Type" of the Syslog manager, Razor license manager and any of the database
servers to "Automatic", if so desired.


Upgrading Razor PC Client Installation


 Terminate all Windows applications and reboot the machine.


 Login to whichever account owns Razor.


 Start (double click) the Razor PC client installation program.


 When prompted, choose to upgrade your installation. This process should take only a few minutes


 When the upgrade is complete, reboot the machine. Razor is now ready to use (this is assuming that
the server is upgraded also and that the license manager and the required database server(s) are
running).


24.12 Managing Razor Passwords and Users


To manage Razor passwords and users, select Remote Users from the License Manger menu. A
Remote Users dialog will be displayed like the one below. Of course your display will be empty if you
have not created any users and passwords yet.
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NOTE: The Remote Users menu item will only be enabled under the following conditions: the
License Manager is running, a database is selected in the Database Control, you are logged in as
Administrator, and Administrator is authorized to perform password file updates via the LM_
A c c e s s _ l i s t file.


Adding a user


To add a new user, click the ADD button in the Remote Users GUI. A User dialog will appear.
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To add a new user, specify a user name, a group name and a password. Additionally, options may be
set for locking the account, password aging and forced password change on next login.


•Account is locked
Selecting the 'Account is locked' option will lock a user's account. Deselecting the option will unlock the
account. Users with locked accounts will not be able to connect to Issues, Versions and Threads.


•Password Aging
'Password Aging' enables setting the maximum days a user's account can go without a password
change. The default for this field is 'Always Valid' meaning that the password will never expire. 
To activate aging for the account, select the desired number of days (1-365) from the drop down list. 
If a user attempts to access an account with an expired password, a 'Must change password' dialog will
appear with the following message: 'The password for this account <user_name> ) has expired. You will
not be allowed to continue unless you change your password." The user must select the 'Change
password' option and enter a new password before continuing with the login.
•Force a password change at next login


This option forces users to change the password the next time they log into Issues, Versions, or
threads. A 'Must change password' dialog will appear with the following message: 'The password for this
account <user_name> ) has expired. You will not be allowed to continue unless you change your
password." The user must select the 'Change password' option and enter a new password before
continuing with the login.


Modifying and deleting users
To modify an existing user entry, single click the name in the Remote Users list and click MODIFY. The
User information dialog will be displayed. Make the appropriate changes and click OK.


To delete a user entry, single click on the name in the Remote Users list and click DELETE. A
confirmation message will appear, allowing you to confirm the user entry deletion.


Creating new groups


Additional issues or file control groups can be added at any time after Razor is installed.
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NOTE: The database server must be down before a new group can be added. The New Group
menu choices for "Issues" and "File" will be inactive when the database server is up. To bring the
database server down, simply click the Stop button next to the selected database server name.


To create a new group, select New Group from the Database menu and select either Issues or File. A
sample New Issues Group dialog is shown.


Select the group type from the drop-down menu. Group types are defined by the Razor installation and
additional group types may be added with new releases. Currently, the issues groups include:


•Default - default issues group created when a Razor database is created.
•Action_items - action items related to process-oriented meetings.
•Bug_tracking - issues relating to software problem tracking.
•Customer_tracking - a customer contact database.
•Music - tjat's right, this just gives you an idea that Razor can be used to track just about anything.
•Peer_Review - generally associated with tracking ISO or other CM-standard review mechanism.
•Support_Helpdesk - a help-desk tracking/follow-up database.
•ToDo - Dorothy's little dog or what you still have to accomplish.
File control groups include:
•Default - default file control group that is created when a group name is entered in the File Group field of
the New Database dialog (See "Creating Razor Databases" above.)
•Code_development - a software-oriented version control group.
•Document_management - oriented towards tracking document changes as opposed to software.
•Web_development - similar to Code development, where the files relate to Web pages.


Enter whatever name you would like to use to identify this group in the Group Name field. It is
recommended that you not use spaces or special characters in the name. This name will also be used
to identify this group in Razor scripts and functions. If you are creating a new issues group (as shown on
the above dialog), you have the option of selecting a Prefix which is appended to the issue number. The
default prefix is "I". You may enter any of the 26 letters of the alphabet (A-Z). There is no restriction on
using the same letter for multiple issues groups. Click OK to add this group to the selected database. A
Razor Admin Tool dialog will popup giving the user the option to edit the group.
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Selecting Yes for group edit will pop up the Attributes dialog box. From this dialog. attributes can be
added, deleted and modified. For more information select the Help button on the Attributes dialog or refer
to the Razor Manual. An example of an Attributes dialog follows.


Further customization of this or any group may be performed by selecting Editor from the Database
menu.


Administering databases


Configuring databases
Razor database configuration files can be edited by selecting Editor from the Database menu. The Razor
Table Editor dialog displays a list of the universe level configuration files and the issues and file control
(versions and threads) groups included in the senected database. Each group that contains configuration
files will be designated with a plus/minus sign ("+" or "-") before the name. Selecting the plus sign will
expand that group's list of configuration files. The Razor Table Editor might look something like:
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Here is a summary of the features associated with the Razor Table Editor dialog:


•Selecting Access List will popup the Access List dialog.  The Access List contains the supported
access controls.  Who can perform which Razor operations is defined via the access controls.  For
information regarding this file, select the Help button on the Access List dialog or refer to the Razor
manual ("Access Controls "). A sample Access List dialog is show below:197
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•Selecting Roles will popup the Roles dialog.  Roles may be defined to further refine access controls. 
For information regarding this file, select the Help button on the Roles dialog or refer to the Razor manual
("Definable roles "). A Roles dialog on a populated Ro les file might look something like:197
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-Selecting a particular role entry will display a Modify Role dialog, like the one below:


•Selecting the "+" preceding Issues will expand to show the issues groups.  The default issues group
(the one created with the creation of a new database) always appears as "++ISSUES++".  Additional
issues groups will appear with the name entered in the Group Name field of the New Issues Group
dialog.


-Selecting the "+" preceding "++ISSUES++" (or any other issues group) will expand to show
the configuration files for this group.  Any files that are preceded with "*" are not editable by the
current user. 
-Selecting Attributes will popup the Attributes dialog.  Attributes are used to define and
configure the selected group.  For more information regarding this file, select the Help button on
the Attributes dialog or refer to the Razor manual ("The Attributes file "). An example of an
Attributes dialog is shown below:


186
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/Selecting a particular Attribute will display an Attribute Edit dialog.  For example, you
might see the following for the attribute named Scope:


-The dialog will contain configuration information that is unique to its type. For example, the
State attribute contains the additional tabs Permissions and Bitmaps. Here is an example of
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the State Attribute dialog.


-Selecting the Bitmaps tab will redisplay the State Attribute dialog, shown below:
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-Likewise, selecting the Permissions tab will display a dialog like the one below:


NOTE: As you can see, each of the items shown under the groups edit tree are edited in a similar
manner. If you get stuck, each dialog has a Help button with an extensive help information.


24.13 Configuring the LM_Access_list to Add Users


Before you can add users, you need to make sure the LM_Access_list is configured with the proper
permissions. If the LM_Access_list is not configured correctly for this function, the Remote Users choice
in the License Manager menu will be unavailable.


To configure the LM_Access_list:


1.Logged in as Administrator on the server machine, choose Start -->Programs --> Razor --> Razor
Admin to display the Admin GUI.
2.Select License Manager --> Access list.
3.Scroll down the file and change the following areas: (Note: The asterisk can be replaced with
specific users, groups and/or roles.)


-Change ADD_USER from nobody to *
-Change MODIFY_USER from nobody to *
-Change REMOVE_USER from nobody to *


4.To set password aging or lock user accounts: (Note: The asterisk can be replaced with specific
users, groups and/or roles.


-Change SET_PASSW_AGING from nobody to *
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-Change LOCKOUT_USER from nobody to *
5.Click OK, and save your changes.
6.Now, if necessary, start the license manager and choose License Manager --> Remote Users. 
7.In the Remote Users GUI, choose the appropriate action. For more details, see "Managing Razor
Passwords and Users" below.


24.14 Razor Administration Via Scripts


If you are a prior Razor UNIX administrator and are comfortable with the scripts, you can stick with that
administration method. You still should read through this section as it contains differences unique to
Windows 2000/XP under the POSIX subsystem.


24.14.1 Installing License Keys


In order for Razor to run, you must now obtain and install some license keys. Demo keys may be
obtained automatically via our Web site at http://www.visible.com/Download/Razor/demo_keys.htm.
Demo keys will permit you approximately three weeks to evaluate Razor. If you have problems or do not
have access to the Internet, contact us either via e-mail at "razor_licenses@visible.com" or by phone at
(315) 363-8000.
Permanent keys are obtained directly from us. To get the keys, you will need to provide the Razor
identification for the machine that will be hosting the Razor license manager. Follow the steps below to
provide us with the appropriate information required for licensing your machine.  New installations will
automatically be provided with the required license information via Notepad. This information should be copied
to an e-mail which should be sent to 'razor_licenses@visible.com'.


•Start a "Razor csh" by choosing Start --> Programs --> Razor --> Razor csh. All subsequent
instructions requiring command line interaction should be done from this csh window.
•Run the following command to get host information required for your license keys.


% $RAZOR_HOME/bin/razor id


•Send the result of this command to 'razor_licenses@visible.com' requesting license keys. If you
are demoing Razor, you can generate your own temporary license keys via our Web site at http://
www.visible.com/Download/Razor/demo_keys.htm.
•Once you receive the license keys from us, run the following command. Take care to enter the
keys correctly and with the correct case.


% $RAZOR_HOME/bin/razor license


24.14.2 Starting the Programs


Starting the license manager


•Run "Shortcut to Services" by choosing Start --> Programs --> Razor --> Shortcut to Services.
•Select "Razor License Manager"
•Start the "Razor License Manager" service by right clicking on it. Then choose "Start" from the
shortcut menu.
The default license manager configuration is to use the Razor password file ("Razor passwords"
above).  The license manager may also be run against the local password file or a combination of
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the local and Razor password files.  To change the license manager configuration:


1.Terminate the "Razor License Manager" service.
2.Modify the $RAZOR_LICENSE_DIR/License.conf file to enable the use of the local password
file.
3.Modify the "Razor License Manager" service to run as an Administrator instead of as the
"System" account.
4.Start the "Razor License Manager" service.
5.Start the "Razor Inetd" service.


Note: If you wish the "Inetd" service to start automatically upon reboot, use "automatic" instead of "manual"  via
the 2000/XP Service panel.


NOTE: To automatically start the Razor license manager at boot time, change the startup option
from "manual" to "automatic" in the Services Panel.


Starting the Razor Syslog Manager


•Run "Shortcut to Services" by choosing Start --> Programs --> Razor --> Shortcut to Services.
•Select "Razor Syslog Manager".
•Start the "Razor Syslog Manager" service by right clicking on it and then choosing Start from the
shortcut menu. 


24.14.3 Database Creation


Running rz_new_database
To create a database, invoke the script rz_new_database from within a "Razor csh" as follows,
responding to the prompts accordingly... 


% $RAZOR_HOME/scr ip ts / rz_new_database


Within the limits of system resources any number of databases may be created on the Razor host.


Sample database creation


In the example below, a database called "Starguide" will be created in / / D / V i s i b l e / r a z o r _ d b.


1.Start a "Razor csh" by choosing Start --> Programs --> Razor --> Razor csh. All subsequent
instructions requiring command line interaction should be done from this window.
2.Follow the rz_new_database script as follows:


% cd $RAZOR_HOME
% cd ..
% mkdir razor_db
% mkdir razor_db/Starguide
% r z _ n e w _ d a t a b a s e


Checking your configuration...


The Razor database contains all of the files related to the Razor programs.
It is accessed by all users of these programs.


We offer a pre-configured DEMO database that highlights some of the Razor
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f u n c t i o n a l i t y .


Would you like to install it? [n] 


Where should I install your Razor database? r a z o r _ d b / S t a r g u i d e


Note: The script will look at your present configuration and ask some simple questions. Except under very
unusual circumstances, you should accept the defaults you are offered as shown in the square brackets "[]".


Creating the default issues group (++ISSUES++)...


Additional issues groups may be created later by executing the script
' r z _ a d d _ i s s u e s _ + g r o u p ' .


Will you be using this database for file version control
and/or build management? [y]  


Razor groups are created to contain related information for teams (groups)
of users.  To start with, you must define at least one Razor group. 
Additional groups may be added later by executing the script
' r z _ a d d _ g r o u p ' .


What is the name of your first group: D e v e l


Note: A Razor group should not be confused with a UNIX group: they are different beasts. See " Databases,
groups, and attributes " and "Containers: databases, groups, and folders ."


The group 'Devel' has been successfully added to the Razor database.


The PROJECT group has been added to the Razor database.  The PROJECT group is
used by the threads tool to manage a collection of related threads (a thread of threads). See " Projects: Thread
of threads ."


The database server for this database will now be installed as an 2000/XP
service.  This requires your password.


Please take care that you enter your password correctly and remember that
case matters.


Password for user [Administrator] : x y z


Installation complete. Additional setup information is in the file:


/ / D / V i s i b l e / r a z o r _ d b / S t a r g u i d e / R A Z O R _ U N I V E R S E / r z _ n e w _ d a t a b a s e . i n f o


Would you like to display it now? [y] n


24.14.4 Starting the Database Server


To start the database server service, perform the following:


•Run "Shortcut to Services" by choosing Start --> Programs --> Razor --> Shortcut to Services.
•Select "RazorDB_<database>", where <database> is the name of the database you wish to start. 
•Start the database service by right clicking on it and then choosing Start from the shortcut menu.
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NOTE: To automatically start the database server at boot time, change the startup option from
"manual" to "automatic"


24.14.5 Razor Passwords


Refer to "Remote client password " and "Password functions " for details on creating and
maintaining Razor passwords.


24.14.6 Administering Databases


Database administration includes direct maintenance (editing) of various configuration files within the
database hierarchy. These files are, and must remain, in POSIX text format. The Razor shells provide
the vi editor but Razor administrators are free to use any editor of their liking as long as the file, once
edited, remains in POSIX text format. Use of the vi editor is strongly encouraged since that editor
maintains the correct text file format.


NOTE: Either the UNIX or the PC path style may be used for the <database>/RAZOR_UNIVERSE
path in the Issues/Versions/Threads log-in screen. Examples: UNIX path //D/Visible/Razor/DB/
RAZOR_UNIVERSE PC path D:\Visible\Razor\DB\RAZOR_UNIVERSE


24.15 Email Functionality in Windows 2003 Server, 2000, & XP


Limited e-mail functionality is available for Windows 2003 Server, 2000 & XP servers. The script,
rz_sendmail_nt, allows you to send e-mail on State change and e-mail to razor_support@visible.com. E-
mail functionality in Windows requires that either Outlook or Outlook Express be set up as the default
mail client on the database server. It also requires setting up an e-mail account for the user running the
database service.


The rz_sendmail_nt script works in conjunction only with Outlook or Outlook Express. Razor will use the
e-mail account of the user running the database service. To verify which log on name is running the
service for the database, open the Services Window (Start -> Programs -> Razor -> Shortcut to
Services). Right click the necessary database and choose Properties. When the Properties dialog box
appears, click the Log On tab. You may then need assistance from your SysAdmin or Mail Admin to set
up the mail account for this Log On (user) name.


To send e-mail on State changes, specify the e-mail address for the intended recipient(s) in the e-mail
field in the Permissions file. To change the Permissions file, bring up the Razor Admin tool (Start ->
Programs -> Razor -> Razor Admin). When the Admin Tool appears, select your database (making sure
it is not running) and then open the Editor (Database -> Editor). From the tree view, expand the Issues
group that you would like to send e-mail on state changes from. Then open the corresponding Attributes
file by double-clicking on Attributes. When the Attributes GUI appears, highlight the State field and click
Modify. This will open a GUI with five tabs. Select the Permissions tab (fifth tab).  Click the necessary
State, and then click Modify.  In the Permission Settings GUI, specify the e-mail addresses for the
intended recipient(s).


You can also make direct modifications to the Permissions file from 'vi'.  You can run 'vi' from a csh
terminal (Start -> Programs -> Razor -> Razor csh).  For more information on setting this up, see " E-
mail notification on state changes ."
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NOTE: In Outlook and Outlook Express, you will need to click the Send/Recv button, or the e-mail
that Razor generates will remain in the Outbox.


24.16 More Information


• "Installation and General Administration "
• "Using Issues " 
• "Using Versions "
• "Using Threads "
 Installing IssueWeaver in the IssueWeaver manual.
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25 Environment variables


Environment variables come into play in various ways relative to Razor.


$PROJECTDIR


A variable used by SCCS to define the database archive. It is cleared by Razor so as not to confuse
Razor operations.


$RAZOR_ACTION


Set to indicate why the script was called, and is formatted as either <operation>_BEFORE or
<operation>_AFTER 
(e.g. PROMOTE_BEFORE). See "RAZOR_ATTR_FILE " for related information.


$RAZOR_ATTR_FILE


For file introduction, this file permits overriding attributes selected by the user.


$RAZOR_CMD_LINE


Set by the razor program so that a script may sense where the origin of execution is.


$RAZOR_BROWSER


Determines the browser Razor tools will use to view HTML-based reports. The default if not defined is
Firefox.


$RAZOR_DOMAIN


Always set to DOMAIN_01.


$RAZOR_EDITOR


On UNIX systems (This feature is not supported on remote clients (UNIX or PC). , defines a script to be
executed when browsing a file. This script can then invoke the editor of choice. See the example script
$RAZOR_HOME/examples/razor_browse for implementation details.)


$RAZOR_FILE


The file name.


$RAZOR_FILE_LIST


The list of selected items passed to a script invoked from the Commands menu.


$RAZOR_GROUP


The group name.
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$RAZOR_HELP_DIR


The parameter RAZOR_HELP_DIR points to a directory which will have the 'help' directory and all of its
supporting files. If it is not set, the default help files in $RAZOR_HOME are used. Refer to "Custom help
files " for details of how to incorporate custom help files.


$RAZOR_HOME


Defines the location of the Razor distribution.


$RAZOR_INCREMENT_RELEASE


This parameter is available to the check-in before/after scripts and is set to 1 if a user is trying to
increment the major release


$RAZOR_INFO_FILE


This parameter indicates the name of the temporary file containing attribute information in the form of an
Info file. Since the database is not fully updated until after the AFTER script, those who want to obtain
information about the introduction will need to pass this filename to the rz_toolbox function
razor_learn_file, or parse this file themselves for the required information.


$RAZOR_ISSUES


If the related activity was associated with one or more issues, this environment variable will contain a
space separated collection of the issue numbers.


$RAZOR_LICENSE_DIR


Defines the location of the Razor license and status information.


$RAZOR_LM_PORT


Overrides the default socket port the Razor license manager tries to connect to. The default port number
is 16151 if RAZOR_LM_PORT is not defined. When connecting, the license manager tries several port
numbers until a free port is found.


$RAZOR_PID


The process id of the application.


$RAZOR_PORT


Overrides the default socket port the Razor server tries to connect to. The default port number is 16152 if
RAZOR_PORT is not defined. When connecting, the server tries several port numbers until a free port is
found.


$RAZOR_TITLE


Where appropriate, this will be set to the text entered by the user for check-in, check-out, branch and
revert functions.
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$RAZOR_TMP


Users may change where temporary files are stored by setting this environment variable.  The default
location used when this variable is not set is "/tmp". This environment variable may be set via the files
rz_prep and rz_prep.sh for each Razor database.


NOTE: Make sure the directory pointed to by RAZOR_TMP is writable by everyone and has at
least enough space to hold two times the size of the largest file to be introduced.


$RAZOR_UNIVERSE_DIR


Defines the directory which contains the Razor database. Once all of the Razor environment parameters
have been set, changing this value and restarting one of the Razor tools will allow users to change from
one database to another.


$RAZOR_USER


The user who is currently logged on to Razor. This is useful to use in attached scripts.
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26 Common Questions and Answers


General


Q. How do I delete a database on UNIX?


First of all, make sure the database is not running. Second, remove the database folder including the
RAZOR_UNIVERSE, subdirectory and everything underneath that. The database has now been
removed. 


Q. How do I delete a database on Windows?


First of all make sure the database is not running.  The next step is to remove the database folder
including the RAZOR_UNIVERSE sub-directory and everything else underneath.  Next, using the
TextPad editor, update the C:\Visible\Razor\db_aliases file and remove the "source" line that references
that particular database.  Finally, using the Windows Registry Editor (start -> run -> regedit), delete the
database service named RazorDB_<dbname>.  You can now reboot the Windows server and the
database has been deleted.


Q. What editor do you recommend I use on a Windows server?


We recommend the TextPad editor since it does not alter the structure of non-Windows text files.  You
can download a copy from http://www.textpad.com


Q. Is there a difference between UNIX/Linux and Windows text files?


Yes.  Windows text files have a carriage-return and line-feed at the end of each line.  UNIX/Linux text
files only have a line-feed at the end of each line.


Q. Do Razor clients run on PCs with dual displays?


Yes, so long as the two displays have the same screen resolution.


Q. What is the best organization for my database?


We may be good, but we can't do everything for you. You have to decide what is the best organization
for your data given your unique requirements. Razor will handle pretty much any organization you desire.
To give you a good foundation to build on, we suggest that you study the section " Containers:
databases, groups, and folders ." This section discusses these three important data organization
methods and provides some things to consider when layout your database.


Q. What are all the kids for?


The kid_of_xxx processes are used to assist issues, versions, threads, and the database server for low-
level operations. Don't worry, some day they will grow up and leave home.


Q. What are these '...' or '.RZ_BACKUP' files I keep finding in my directories?


During operations for which the versions tool must check-in or introduce a file, a backup copy is made
first. This file is named '...<filename>' (under UNIX) or '<filename>.RZ_BACKUP' (under Windows) and is
copied simply as a safety mechanism. Users may, at their discretion, remove these files at anytime.
The rz_cleanup UNIX script may be used to delete ones that have reached a certain age. Users may
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also prevent the creation of these files in the first place if they so desire, (See " Versions.makeBackup
".)


Q. Who's the sailor?


At various points in the flow of the programs, users may notice a small glyph appear for short periods.
This was originally used purely as a debugging aid while developing the tool. It signals when
asynchronous database updates are being received by the programs from the Razor server (rz_server).
As time went by, it was decided to draw it as a sailor, in recognition of the fact that version 1 of the tool
suite was used on a Navy project.


The glyph was un-named until the history of William of Occam was investigated. Since then, he became
'Occam the icon', or 'Bill' for short. We decided we'd leave him in the program until people complained.
See "Occam the Icon " for details on how to dispense with our mascot.


Q. Some of my 'tabs' are now spaces in some of the Tables files; how did that happen?


Some editors, most notably Emacs, are often configured to insert spaces into the file you are editing
each time you hit the tab key. Disable this feature and try again.


Q. Whenever users have problems they select the "Send e-mail to support" button. I don't want
our problems going to Visible if we can handle them here. How can I change this?


There are X resources that can be set to control where mail goes. Look at "E-mail back to Support .".


Q. What happens when my service contract runs out?


First, the sky darkens and you'll notice a mist coming down from the mountains in the east... But
seriously, you will no longer have access to our fine support staff or product updates. Oh, and by the
way, your Razor tools will continue to work. You will be contacted by our license department for an
opportunity to renew your service contract before it expires.


Q. What's the proper pronunciation for 'glyph'?


According to the dictionary we have here in the office, it should rhyme with 'cliff', as in the word
'hieroglyphic'. It does not rhyme with 'wife'.


Q. I edited all the files I think I'm supposed to, 
but the issues form (versions attributes / threads attributes) did not change; why not?


After modifying files in the Tables directory, you must restart the database server. Did you remember to
bring the database server down before making the changes? Take a look at "Customizing the Attributes
file " for details.


Q. Whenever I start an application in the background nothing happens and I get a message
'Stopped (tty output)'


Check your tty setting using the command 'stty' If the 'tostop' flag is set, clear it using the command:
stty -tostop


Q. How do I customize Razor to ...


You came to the right place. If you are using the 2000/XP server release of Razor, you can use the
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Razor Admin tool to customize your database.  Refer to " Razor Administration via Razor Admin " for
details. 
Additionally, take a look at the examples directory in $RAZOR_HOME. This directory contains all sort of
scripts and files that we have collected and/or developed over the years. Many of these might even be
useful to you. Peruse the README file which contains a quick description of the use of each file. Take a
look here when you get a new release of Razor for updates and new goodies.


Q. Which archive engine should I pick?


Razor currently supports either SCCS or RCS (Razor uses RCS version 5.7 or higher. . The simple answer
is to pick the archive engine you have available on your system.  For example, Linux only has RCS


available. If you have a choice, it becomes a matter of preference. This discussion is not intended to
argue the merits of either archival system, just to present some things to consider:


NOTE: We recommend that the RCS database format be used . This offers a more portable
upgrade path and is the only engine available on Windows. Linux distributions offer RCS and not SCCS.


NOTE: If RCS is chosen as the archival engine, it must be RCS Version 5.7 or higher.


 SCCS is widely available many commercial UNIX platforms.


 RCS is freely available on most Linux platforms.


 There is a GNU clone version of SCCS available on Linux called CSSC.


 RCS stores its revisions by holding a copy of the latest version and storing backward deltas. SCCS
uses a "merged delta" method. Since RCS stores the latest version in full, it is faster in retrieving the
latest version.


 All RCS activity takes place within a single RCS file.


 If you are missing the sccs or rcs tools, or the SCCS or RCS file is corrupt and the tools don't work on
it, you can still retrieve the latest version in RCS. Not true with SCCS.


 RCS supports more and varied keyword expansion capabilities.


 The fact that SCCS uses prefixes (s.file.c) means that the make tool can't treat them in an ordinary
manner, and special rules (involving '~' characters) must be used in order for the make tool to work with
SCCS.


 Once you select an archival engine within Razor, YOU CANNOT CHANGE IT TO THE OTHER!
However, each database/group can employ a different archival engine, selectable at creation time via
rz_add_group and rz_add_issues_group.


Q. How is the archive engine configured in Razor?


When you create a database or group, you are prompted for the archival engine. The archive engine
method is then stored in a file called Vcs in the Tables directory each group and used by Razor as its
access method.
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Q. I run issues both locally and remotely. How can I easily remember the commands to run
issues remotely?


We suggest creating an alias in your shell's startup resource file. For example, in the C shell you would
add the following line to your .cshrc file to create an alias for remote issues:
alias rissues issues -remote


Q. Can I replace Razor's compression engine with my own?


Yes. Refer to "Changing the compression engine ."


Database-related


Q. How do I remove a Razor group, once I don't want it anymore?


This is fairly easy, but must be done from the command line with the database down. (Before doing this
though, you should really be familiar with how a Razor database is represented on disk.
In brief, you would bring the database down, then go to where the directories for the group exists, delete
them, then bring the database back up. For example, if you no longer want the apple group...


# razor down
# cd $RAZOR_UNIVERSE_DIR/DOMAIN_01
# rm -fr apple
# rm -fr apple##Threads
# cd
# razor up


Q. I am a little concerned about the performance of your ASCII based database. What are the
practical upper limits for a database, in terms of number of users, number of files, database
size, (lines of code), and number of issues?


Good question. The ASCII database is used only as a flushing mechanism. It is loaded, (read), by our
database server daemon, (rz_server), at startup and then held in memory to improve performance. As
updates are made, information is written back to the database files. All client applications which are
connected to the database server receive the information that the server has in memory. So the only
performance hit is at startup time, and not with each operation.


Q. How many Tarzan movies did Johnny Weismueller star in?


How did that get in there? Well, actually it was 16!


Q. How can I share information, scripts, templates, etc. amongst multiple databases? For
example, I want a master list of all issues/projects regardless of the database the source may
be stored in, a person would enter an issue which would be reviewed and assigned to a
database depending on the topic/resolution -- can one database act as the master for others?


When you create a new database, you can copy your master templates into the Tables directory for the
issues, versions and threads groups. When the database is brought on-line it will have your
characteristics already built in. Common scripts should be placed into a general area which is on each
users search path. You can even setup your templates to refer to the fullpath to your scripts so that no
ambiguity is possible.


Q. I notice that there's a DOMAIN_01 directory. Why is the number there, and how can I exploit
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it?


The simple answer is that there is one and only one domain. It was numbered in early anticipation of
product growth along these lines, but that has not yet occurred.


Q. How do I access multiple databases?


Each database has its own rz_prep file (and corresponding rz_prep.sh). You may set up aliases in your .
cshrc file to source the appropriate rz_prep file.


Q. How do I set up a single database to be accessed via multiple operating systems?


NOTE: Refer to "Handling mixed environments " for details on setting up multiple
operating systems.
The key is to make the rz_prep and rz_prep.sh files smart. Look at the files $RAZOR_HOME/examples/
rz_prep.smart and $RAZOR_HOME/examples/rz_prep.sh.smart to see how they can be set up.


IMPORTANT NOTE: These two files must be kept in sync!.


NOTE: You should run the script $RAZOR_HOME/scripts/rz_support_os to add the appropriate
rz_db_exec script to $RAZOR_UNIVERSE_DIR/bin.


Server-related


Q. How are file permissions handled?


Since the Archive directory is controlled through a process called the Vcs Daemon, started by the
server, it will perform all accesses to the files in this directory.   Each client connects to one of these
daemon processes to perform the appropriate VCS command, as will the razor command line and
IssueWeaver. The Vcs Daemon (rz_vcsd) is started by the server. Thus, the Vcs Daemon process, via
the server, is the only process that needs write access to the Archive directory. 


The bottom line is all file accesses are handled by the Vcs Daemon, and all file permissions are honored
via the Access_list file .


Q. How do I control who can bring the server up and down?


Most Razor-related operations can be controlled via the Access_list file. Out of the box, Razor permits
anyone to bring the server up and down. There is an operation called RAZOR_DOWN that controls who
can take the server down. For control of this and other Razor operations, refer to "Access Controls "
section.


Q. What is the advantage of disconnecting my remote connection as opposed to exiting the
application?


If you disconnect your remote connection, you have 10 minutes to reconnect to the same license token.
As long as the database server is still running, the reconnection time will be minimal. Exiting a remote
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application will force you to login again when the application is restarted and will force a complete reload
of information from the server.


Q. After making changes to Razor control files, when do I have to restart the database server or
client programs?


When making changes to the Razor group's Attributes file, either editing the file or running the Razor-
provided modification scripts,


YOU MUST STOP THE DATABASE SERVER!


All other Razor control files can be modified
    
WHILE THE SERVER IS RUNNING! 


...But you will need to re-run the appropriate Razor client application to verify your changes (also, any
currently running Razor clients WILL NOT exhibit the changes made).


The Razor database server reads each Razor group's Attributes file when the server is started. Basically,
the Attributes file defines a set of data that the server retains in memory. Changes to these files are only
read when the server is restarted.


On the other hand, ALL other Razor control files are read when the Razor application is started. Any
"attribute" information an application may need is provided to the client by the database server.


License manager-related


Q. Why does the Razor license manager (razor_lm) exit whenever I logout?


Your shell controls this. Try using the command: 'nohup razor_lm &' when starting the Razor license
manager.


Q. What does the term "floating license" mean?


The number of simultaneous users on a network. We do not lock usage of the tool to particular
machines or users. Usage may float around your network on an as-needed basis.


Q. How are license tokens used by remote clients?


Remote users are given the opportunity to disconnect from the database server without exiting the
application. This is intended to help users with dial-up connections. When a user reconnects, only the
objects that have changed in the currently subscribed group of the database will be reloaded. This will
save in the reconnection time. As with local UNIX clients, bringing up the application will consume a
license token. The action of disconnecting will NOT release the license token immediately. The license
token will remain in use until the user exits the application normally (with the Exit option of the File
menu or from the windows Close menu) or after one hour of being disconnected. This time limit is set to
handle the situation where a client exits abnormally (such as a power outage), that does not give the
server an exit notification. As with other "dead" clients, the server will eventually time them out after one
hour and release their license token.


Q. I just upgraded my pre-Razor 4.1e configuration and now I get "Razor password file does
not exist..." when I log in with my PC client.
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Notice the rest of the message says "You may wish to bring this to the attention of your Razor
Administrator". This means that the Razor Administrator needs to create Razor remote client password
accounts. Refer to "Remote client password " for all the details.


Issues-related


Q. Why are issue numbers structured as they are? 
What do the dots and dashes mean?


Issue numbers are intended to represent a sequence of 1 to 999,999. In showing the numbers to the
user, unused digits are replaced with dots and the comma becomes a dash.


Q. How can I handle the concept of assigning issues to one or more people?


This can be implemented in a number of ways. One popular way this is done is to define an
X_OF_MANY attribute which contains either peoples names or more generically their role/title.


Q. What's the best way to change where printouts from the issues program go to?
Change the print command via the Print Setup... option of the File pulldown menu. The defined command
will receive the contents of the information to print on stdin.  For example: "lpr -Peng" will send the print
output to print queue "eng".


Q. We have several databases. 
How do I get the issues program to switch from one to the other?


Create a file named Databases in the $RAZOR_LICENSE_DIR directory. In this file put tab separated
entries of the form:


<database name label> <path of RAZOR_UNIVERSE directory>


This will enable the Databases menu item on the main issues screen which contains the <database
name label> entries contained in the file.


NOTE: It may seem obvious, but the other database must be active (as a result of a razor up
command) to access it.


Q. What are those Bitmaps warnings about?
i.e. Invalid attribute label 'State' specified at line 30 in 
$RAZOR_UNIVERSE_DIR/DOMAIN_01/++ISSUES++.Testing/Tables/Bitmaps


In this particular case, the attribute label 'State' was changed in the Attributes file. This label was
probably associated with the STATE attribute. To avoid this warning each time the issues tool is
invoked, change references to 'State' to the new label for the STATE attribute in the file:


$RAZOR_UNIVERSE_DIR/DOMAIN_01/++ISSUES++.<group name>/Tables/Bitmaps


There are numerous types of Bitmaps warnings which are usually an indication of a change in an
attribute label or value without a similar change to the Bitmaps file.  Use the following scripts to rename/
remove an attribute label or value, as they will update the Bitmaps file as well as the Attributes file:
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$RAZOR_HOME/scripts/rz_rename_attr
$RAZOR_HOME/scripts/rz_rename_attr_val
$RAZOR_HOME/scripts/rz_remove_attr
$RAZOR_HOME/scripts/rz_remove_attr_val


Q. What if I choose not to have a STATE attribute on my issues form?


You are not required to include a STATE attribute, however, if you choose not to include this attribute,
you will probably receive BITMAP warnings when the database server is started. Also, a number of the
supplied scripts and reports may be affected. Hey, we warned you!


Q. Is there any easy way to rename existing issues groups?


You can rename issues groups using the UNIX move ("mv") command. Follow the steps below:


# razor down
# cd $RAZOR_UNIVERSE_DIR/DOMAIN_01
# mv ++ISSUES++.<old group> ++ISSUES++.<new group>
# razor up


If you have any related file activity associated with the renamed issues group, they will not be
automatically renamed. The following script snippet can be used to rename the history for the issues
group "first" to the issues group "second":


#!/bin/sh
cd $RAZOR_UNIVERSE_DIR/DOMAIN_01
list=`grep -l '++ISSUES++.first' */History/*/*`
for f in $list
do
   cat $f | \
       sed "s/++ISSUES++.first/++ISSUES++.second/" \
            > $TMPDIR/tmp
   cp $TMPDIR/tmp $f
   rm -f $TMPDIR/tmp
done


Q. How can I get better control of issues forms layout?


There is a very useful script in $RAZOR_HOME/examples called attr_to_xy. Usage:  attr_to_xy  [-g
<issue group>] [<outfile>]. It will generate an Xdefaults file which uses X/Y positioning for attributes on
an issue form. If <outfile> is specified, output will go to this file, otherwise, stdout will receive the output.


Q. What is the best procedure for modifying attributes?


Changing the forms and attributes shouldn't be a painful process. For a detailed procedure for updating
attributes see "Customizing the Attributes file ".


Q. After creating several issues, we've determined that we need another state. How do we
update our existing database?


Just take the server down and add it to the Attributes file. Upon restarting the database, the new states
will appear.
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Versions-related


Q. Can I still use command line SCCS/RCS now that I have Razor?


Yes & NO! You can use SCCS/RCS commands to get copies of files, but you should NOT use them to
lock files for edit or check them back in. Razor needs to handle these operations.


Q. How can I get Razor to check in/out complex collections of files which always travel
together?


This question often comes up with respect to using the versions program for archiving CAD drawings.
Many CAD packages read/utilize/write several files in a single shot, all related to the same single
drawing. What users often do is take advantage of the before and after scripts to pack and unpack the
collection.


Q. How do I change the filetype when a file is introduced?


Look at $RAZOR_HOME/examples/intro.before. Be sure to modify your Actions file to refer to this file.


Q. When I start versions I get the following warning...
SET_BASE_DIR: Unable to chdir to 'xxx'


Make sure that the startup directory for versions properties is a valid directory. Select Edit from the
versions tool menu and select Tool Properties. In the Versions Props dialog, verify the setting of Startup
Directory.


Q. Is there any easy way to rename existing file control groups?


You can rename file control groups using the UNIX move ("mv") command. BEFORE you rename
groups, however, there are a couple of things to consider.


-If you are renaming a file control group and have related issues to actions (check-outs, check-ins, etc.)
for files within this group, the associated Activity file will retain the original group name.  


For details of relating issues to files, refer to " Associating issues to editing activity " and "Checking
on related file activity ."


-If you have created a Project thread which includes a thread from the file control group to be renamed,
this thread will no longer be valid.


If the above does not apply to your situation, here are the steps you should follow:


# razor down
# rm $RAZOR_UNIVERSE_DIR/Mapping
# cd $RAZOR_UNIVERSE_DIR/DOMAIN_01
# mv <old group name> <new group name>
# mv <old group name>##Threads <new group name>##Threads
# razor up


... a new Mapping file will be generated


Q. How do I check in file checked out by someone else?
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Typically, only the file owner can check files back in or uncheck them. BUT, Razor allows users defined
in the RAZOR_ADMIN role to check files back in that they did not check out. Refer to " Checking files
back in " for the specifics.


Q. Can I add my existing SCCS or RCS database into Razor?


Yes. Check out "Injecting existing SCCS/RCS investments " for the details.


X-related


Q. Can I customize the icon label or header bar for the Razor programs?


Yes, along with dozens (if not hundreds) of other things, all via X resources. We'd encourage you to
check out Appendix C of this manual set, but to answer your question, just put lines similar to the
following in your ~/.Xdefaults file.


Issues*title:   Happy
Issues*iconName: Silly


Q. How do I get Razor to use the color scheme defined by my X desktop, as opposed to what it
is trying to assign for itself?


Just pass each of the applications the flag -'no_color', as in...
issues -no_color &
 
Q. I have a two button mouse. How do I get the functionality of the right button on a three
button mouse.


This is generally done using the ALT key with the right-most button on your two-button mouse.


Q. My X terminal gives me BadAlloc errors when I try to start any of the applications. What
should I do?


Try to limit the maximum size the main window of the applications using the following Xdefaults:


Issues*maxWidth:    nnn
Issues*maxHeight:   nnn
Versions*maxWidth:  nnn
Versions*maxHeight: nnn
Threads*maxWidth:   nnn
Threads*maxHeight:  nnn


Where 'nnn' would be the maximum width/height in pixels that you'd want to be able to resize the
window.


Q. I prefer to use Emacs as an editor.
Can I configure the issues program to allow that for input in the text panes?


Emulation of Emacs behavior can be enabled via Xdefaults. Take a look at the file $RAZOR_HOME/
examples/Xdefaults.sample for more details.


Q. I get this error when I start up issues "Warning: Cannot allocate colormap entry for
'seagreen4' "
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This means that you either have too little memory on your X workstation or you are running another
program (like Firefox) that has hogged some of the colors that Razor wants. Quit the piggy program, run
the Razor program, then re-run the piggy program. If you want to run in black & white, see "Not enough
color " for an explanation.


26.1 When good things happen


We're very interested in hearing from you, the customer; feedback from the field is extremely important
to us. Notes can run the gamut from spelling errors you discover in our manual to detailed suggestions
on how to improve our interface or functionality. And, if you feel inclined, we appreciate knowing when
we've done something well.  In fact, we've been especially flattered by the generosity and enthusiasm we've
generated in the field. Please feel free to check out 
http://www.visible.com/Download/Razor/demo_keys.htm.


To make contacting us easier, we've provided a simple e-mail interface directly into the product. If you
choose the E-mail comments option from the Help menu from any of our interfaces, you'll see a panel
similar to the one shown below.


We look forward to your comments.


26.2 when bad things happen


Not everything goes according to plan. That's why cars have seat-belts. 
If, for whatever reason, an unexpected error occurs during a Razor operation, then a popup similar to the
one shown below will appear.
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In the example above, the 'error' was that an attached script returned a non-zero exit code, resulting in a
message being shown to the operator.  In a strict sense, this is not really a Razor error. To learn more about


how this was done, See " Informing the user from attached scripts ."  In other cases, the text area will
show a potentially long collection of script debug statements. Details about the problem will be found at
the bottom of the text pane.


In the vast majority of cases, the problem is quickly discovered and fixed by the user. It's often
something as simple as running out of disk space or running the program from the wrong account.


If a quick examination of the text pane does not yield a solution, then selecting E-mail to support will
allow you to e-mail all of the notes directly to the support team.


Obviously, if your site does not allow you to e-mail to the outside world, this feature does not help a lot . 


You can change who the program will naturally send e-mail to. See " E-mail composition script ," but it can
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still be used to help our support staff work with you to solve the problem. If you need to call (800-6-
VISIBLE), then it is extremely helpful to have the error log available for discussion. In some cases, we
may ask that you email it to us at razor_support@visible.com.



mailto:razor_support@visible.com





Part


XXVII


Razor ®







Razor Manual394


© 1992-2009 Visible Systems Corporation, All rights reserved.


27 Razor Installation Instructions


· Windows Installation Instructions
· Windows Installation Troubleshooter
· Installing and Using IssueWeaver  
· IssueWeaver Admin Tool
· Razor Admin Tool for Windows Server
· Windows 2000  Server Installation
· Razor Installation for Client Application
· Installing and Using the Demonstration Database


27.1 Windows Installation Instructions


1. DOWNLOAD THE APPROPRIATE COPY OF RAZOR. 


NOTE: Win 9x/Me can only be used as clients for RazorPC. The DB's and the server must be installed on
Windows 2003 Server/2000. 


2. If installing both server and client portions of Razor, you must meet the following requirements:


a. The drive that will contain Razor MUST be NTFS partitioned. 
b. You MUST install as the original Administrator, not just a member of the Administrative group. 
c. You MUST have a NIC card and be connected to a network. 


3. After downloading, check your system for the presence of a POSIX subsystem by going into the CMD prompt
(Start->Run, type in "cmd" and press enter). At the prompt, type in "posix" and hit enter. If POSIX is present you
should get output saying "posix: command missing". This means that POSIX is present and not disabled. 


4. Make sure that the machine where Razor will be installed has a NIC card and is connected to a network. To
verify this, run "ipconfig" at the cmd prompt. Your output should be the Ethernet adapter number, your IP
address, subnet mask, and your default gateway. 


5. If you are installing on a system that did not have a Razor installation in the past, or upgrading your previous
installation that was setup successfully, proceed with the install process. If you attempted to uninstall a
previous installation and were not successful, please contact razor_support@visible.com for the proper
uninstall instructions. 


6. Once you have installed Razor by double-clicking on the Razor exe and choosing the appropriate
parameters, reboot the machine. 


7. Again, log in again as Administrator. Do not log in as a user with administrative privileges. This is very
important. 


8. Through the Windows Explorer, navigate to your TowerConcepts directory and find a file called "service.ini".
Open the file and verify that it contains the names of three services: Razor License Manager, Razor Syslog
Manager, and Razor Inetd. 


INSTALLING A RAZOR DATABASE: 


Once you have installed Razor following the parameters outlined in the above section, here's how to correctly
install a Razor database. 
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1. In the Razor Admin GUI, go to Database/New. 
2. Database Location: Should be similar to D:\TowerConcepts\ 
3. File Group name: Enter a name for a file versions control group if you plan to use the Versions tool. 
4. User: EXACTLY the SAME as the login ID you used to get on your computer. 
5. Password: EXACTLY the SAME as the password you used to login to your computer. 
6. Confirm Password: Confirm above password. 


-Now a database will have been created in the right area for Razor to gain access to. 
-You should see its service added to the Service Panel. If not, reboot again. 
-To start the new database, go to the Razor Admin GUI, start the LM and then enter the database's path
correctly. Choose start. 


ENTERING LICENSE KEYS: 


License keys are subject to strict syntax. Even the smallest errors will result in key rejection. You can only use
license keys for the machine they were requested for. If you try installing them on a different machine, the keys
will not take. 
All demo users must enter "DEMO" for their Razor ID when entering their license keys. 


1. Go to the Razor Admin GUI (Start/Programs/Razor/Razor Admin). 
2. Enter keys by going to the License Manager pull down menu and choose Keys. 
3. In the resulting GUI, enter your license keys. Make sure you enter "DEMO" in the ID field. 


*Troubleshooting the License Manager* 


1. If the license manager does not start, go to your Services menu and locate the service called Razor License
Manager. Double click on it and check the checkbox that says "This Account." Then, click on the small browse
button to the right of the checkbox and find the Administrator account. Choose the account and input the
password for Administrator twice. Click OK and try to start the service. 


2. If the service does not start, go to a Razor Csh prompt (Start->Programs->Razor->Razor csh). Wait for the
prompt. Change directories (cd) to the TowerConcepts directory and input "razor_lm up". If this starts the
License Manager, it means that the services did not properly register with windows. 


In the event that the License Manager does not start, it should give you a specific reason. Please reference the
Troubleshooting Guide.  Should you have further questions, please contact razor_support@visible.com.


CONNECTING TO A DATABASE: 


A problem that users sometimes run into when first using Razor follows: "The Host/Port you are trying to
connect to does not appear to be running the RAZOR license server program.  Please contact your RAZOR
Administrator." 


This type of error is generally related to incorrect path statements. Here's how paths should look. 
In the Razor Admin GUI, the path should be formatted as such... 
D:\TowerConcepts\Razor\ \RAZOR_UNIVERSE *Note- Backslashes, capital drive letter, syntax. 
In the Issues/Versions/Threads log in screen on the Razor Desktop, the path should look like this... 
//D/TowerConcepts/Razor/ /RAZOR_UNIVERSE *Note- forward slashes, capital drive letter, no colon, syntax. 


We recommend reviewing our online Razor FAQs . I think you'll find that they answer some of Razor's more
common questions. 
 
If you have any questions at anytime during the installation process, please contact Razor support at: 


Phone: (315) 363-8000 
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Email: razor_support@visible.com 


27.2 Windows Installation Troubleshooter


BEFORE THE INSTALLATION: 


1. Users MUST install on a Windows 2000 machine on a NTFS partitioned drive. 


2. Users MUST install with the original " Administrator " account. 


3. Verify that the POSIX subsystem is present and not disabled. 
a. POSIX subsystem can be detected by the presence of the following three files: 
i. PSXSS.EXE - the main component of POSIX subsystem. 


ii. PSXDLL.DLL - handles communication between applications and PSXSS.EXE . 
iii. POSIX.EXE - handles communications between POSIX and  Windows 2003 Serverexecutive. 


b. These files are all located in the System32 directory in Windows 2000. 


4. Before installing Razor, go to Start->Run and type in CMD, then press enter. This will spawn a command
line prompt. In the prompt enter: ipconfig and press enter. If you get the message "cable disconnected,"
connect your cable, so that when you run ipconfig again, you get your ip address in the output. 


INSTALL: 


5. AGAIN , install as the original Administrator, NOT as someone with administrative rights. 


6. After installing, restart the machine. 
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7. Input License Keys in the Razor Admin License Key window 


YOUR KEYS WILL BE DIFFERENT 


8. After Razor verifies the keys, try to start the License Manager. 
VERIFY POSIX AND INTERIX AFTER THE INSTALL : 


9. Go to Start->Programs->Razor->Razor csh, and type in "razor id". This should give you the name of your
machine, the OS, the processor type and the 8-digit razor id. 


If you were not able to get the prompt in the csh window, then check your POSIX or the Interix Installation. To
verify that the POSIX subsystem is functional, type "posix" at the CMD prompt. You should receive the following
output: " Posix: Command missing ." This means POSIX is functioning. 


10. If, when performing the "razor id" command, the output is all zeros, it means that the network card is not
configured properly or it has to be connected to the network. 


11. If POSIX works, we must check the Interix path: Go into the Control Panel and double click the System icon. 
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After entering the System folder, click on the "Environment" tab and find the environment variable called 
INTERIX_ROOT . Verify its path, which should be: //<drive>/TowerConcepts/Interix . 


12. We must also try to execute a command using Interix in order to test it. Go into a CMD prompt and cd to your
TowerConcepts directory, then to Interix, and then bin. In the bin directory you will find various UNIX commands
that can be executed via Interix and POSIX. To test Interix , just enter a command such as " ls " (this is the
equivalent of "DIR" in dos/cmd). 


Common LM problems: 


1. If, after the install process is complete, the license manager does not start from the GUI, attempt to start it
from the csh prompt by going to Start->Programs->Razor -> Razor csh. Wait for the prompt and cd to the
TowerConcepts/Razor/bin directory. Then type: " ./razor_lm up. " Razor should either start up or give you a
specific reason for not starting. 


2. In the event that the License Manager starts from the csh prompt but does not from the GUI, check the
following things: 


a. Run "ipconfig" in the CMD prompt, if not connected, connect. 
b. Go to the services menu and find a service called Razor License Manager. 
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You should get a window where you can specify the "Logon As" option. 


The "Startup Type" option can be Automatic or Manual. The "Log On As" option is the one that should be
changed. First Click on the This Account checkbox, then click on the small browse button to the right of the This
Account check box. 


Change the name to Administrator and input the password twice. Now attempt to start the service manually. 
You can also attempt to start the service from the CMD prompts by typing: net start "Razor License Manager"
(exactly as it appears). 
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Also, check the permissions on the TowerConcepts directory from the csh prompt. 


You can change the permissions for this directory by doing " chmod -R 775 TowerConcepts ", this should give
it the proper permissions to run the License Manager. 


Common Database problems. 


1. The database will not start . This usually happens when the DB is not created using the Administrator
account, causing it to have wrong permissions, or Razor was not installed as the original Administrator. Create
your databases and install Razor as Administrator to avoid this problem. 


2. In the event that a properly created DB does not start through the GUI, attempt to start it through the csh
prompt. Get the prompt -> cd to the TowerConcepts directory, start the LM if not already running, cd to the
database you would like to start, type in: source rz_prep, then type: razor up, this should start the DB or provide
a specific reason for not starting. 
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3. Often times, users are unable to connect to the database using one of the clients. The two biggest causes of
this are (1) not providing the correct ip address and (2) the path to the DB is incorrect. For example, if the path
to your database appears in the License Manager as: D:\TowerConcepts\razor_db\<your_db>
\RAZOR_UNIVERSE , then in your client you would specify it as: //D/TowerConcepts/razor_db/<your_db>/
RAZOR_UNIVERSE . Notice the forward slashes instead of the backslashes; also notice the two forward
slashes in front of the D (unix notation). 
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The screen shot contains the License Manager and the Versions client. The license manager has the path for
the DB in Windows notation; the Versions client has the Unix notation for the DB path. 


27.3 Installing and Using Issueweaver


This file contains information on how to install IssueWeaver.  If your Razor license does not have
IssueWeaver enabled, please contact our sales staff at: razor_sales@visible.com.


Required


Razor installation with an issues database 
A WebServer installed and running
A WebBrowser (We recommend Firefox)


Installation


NOTE: If you are installing IssueWeaver on Windows 2003 Server, please refer to the
installation instructions for Windows 2003 Server.


Preparation:


- RAZOR_HOME must be set to point to the Razor release area
- RAZOR_UNIVERSE_DIR must point to a Razor database


NOTE:  These environment variables are normally set as a result of sourcing (or dotting) an
appropriate rz_prep  file.  Please refer to the Razor manual for additional information.


Install:


cd $RAZOR_HOME
./scripts/rz_iw_install


NOTES: You will be prompted for the path to the cgi-bin and web server documents directory.  Links will
be created in these directories to the IssueWeaver executables and libraries, therefore, write permission
to these directories is required.  


For new installations, the directory Razor_iw_lib will be created in the web server's document directory. 
If this directory currently exists, ONLY "new" files will be added; no existing files will be overwritten.  


To force the creation of a "new" Razor_iw_lib, the install script may be invoked with the parameter "-o". 
The current Razor_iw_lib will be "moved" to Razor_iw_lib.<PID> and a "new" Razor_iw_lib will be
created.  Any customized files such as rules, etc. would then have to be copied from the "old"
Razor_iw_lib to the "new" Razor_iw_lib.


Currently defined RULES (refer to the IssueWeaver manual,  Chapter 4, "Basic rules" for a complete
description) are upward compatible.  New RULES will be described in the RELEASE NOTES as well as
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this README file.  


Rules File


A template file 'rules.conf' may be found in $RAZOR_HOME/Razor_iw_lib. This template file outlines all
supported RULES.


The rules file (<server documents>/Razor_iw_lib/rules.<identifier>) controls the look and behavior of
IssueWeaver.  The extension "identifier" may be used to distinguish the rules to be applied to additional
issues group within one database and/or additional databases.


As part of the IssueWeaver installation, a default 'rules' file is created which references the default issues
group in the database pointed to by the environment variable, RAZOR_UNIVERSE_DIR.  To access
a different issues group or a different database, copy Razor_iw_lib/rules to Razor_iw_lib/rules.<identifier>
and change the setting of the rules UNIVERSE and/or GROUP.  Additional customization may be made
via the 
rules file or via the IssueWeaver Admin tool (refer to the IssueWeaver manual and README.IWAdmin for
details).


Site Customization


We have found that not all environment variables are set for web server applications.  One example is the
environment variable TZ (time zone).  To accommodate the necessity for some sites to export
environment variables, the file 'rz_iw_site' will now be sourced by the issue_weaver script if it exists in
the web server's cgi-bin directory.  


Starting IssueWeaver


To run IssueWeaver with the default rules file, open the following from a web browser:


http://<server>/cgi-bin/issue_weaver


To run IssueWeaver with a customized rules file, open the following from a web browser:


http://<server>/cgi-bin/issue_weaver?Zrules=<rules file>


Difficulties


If you have any difficulties starting IssueWeaver, you may check your setup by opening the following
from a web browser:


http://<server>/cgi-bin/rz_iw_info


If you are unable to locate the source of the problem, please contact Razor/IssueWeaver support by
phone (800-6-VISIBLE) Email at: razor_support@visible.com.


Setting Filters
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Currently, IW supports use of user-specific startup filters. These filters are stored as filter_sort.<user> in
directory $RAZOR_UNIVERSE_DIR/Weaver/user. We have now added support for "system" filter files.
The system filter files (sys_filter.<issue group>.default, sys_filter.<issue group>.<user> in directory
$RAZOR_UNIVERSE_DIR/Weaver/user) provide the Razor system administrator with a means of limiting
the issues available to an individual user. The system filters are applied to the list of issues obtained
from the Razor DB server prior to presentation to the user. Hence, a user's system filter may be
constructed so as to limit:


- List of issues presented to user at IW startup
- Issues selectable (IW GUI "#" button)
- List of issues eligible for text match searching (IW GUI "Search" button)
- List of issues eligible for reporting (IW GUI "Reports" button)


The format of the sys_filter files is identical to that of the filter_sort files. However, a given sys_filter file
specifies the settings for a particular user only for a single issues group.


The use of the sys_filter files by IW is optional. The system filtering is configured as follows:


- If present, system filter in $RAZOR_UNIVERSE_DIR/Weaver/user/sys_filter.<group>.<user> will be
used when user <user> uses IW to access issue group <group>.


- If present, system filter in $RAZOR_UNIVERSE_DIR/Weaver/user/sys_filter.<group>.default will be
used when user accesses issue group <group>.


- If neither user or default system filter file is present, no system filtering is performed.


Can envision using the system filter enhancement to limit access to individual issues within a single
issue group based upon any combination of attribute values. E.g. assume that each Issue form contains
a
one-of-many attribute field (UserOrganization) that encodes the user organization (e.g. CompanyA,
CompanyB, CompanyC, ...) that "owns" the issue. Assume that the Actions file has been configured
such that an Issues-Create-After script runs each time a new issue is added to the issue group. This
script either fills in the UserOrganization field automatically or simply validates the UserOrganization
attribute value field. The Razor administrator could setup sys_filter files for each individual such that
users from Company A could only view/modify issues in which the UserOrganization field was set to
'CompanyA' users from Company B could only view/modify issues in which the UserOrganization field
was set to 'CompanyB', etc.


Finally


Enjoy!  Please feel free to send your suggestions/comments to: razor_support@visible.com


Your inputs (good or bad) are very important to us!


Visible Systems Corporation
www.visible.com


Visible Systems acknowledges the use of CGIC.


CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, by Thomas Boutell and Boutell.Com, Inc..
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Permission is granted to use CGIC in any application, commercial or noncommercial, at no cost.
HOWEVER, this copyright paragraph must appear on a "credits" page accessible in the public online
and offline documentation of the program. Modified versions of the CGIC library should not be distributed
without the attachment of a clear statement regarding the author of the modifications, and this notice
may in no case be removed. Modifications may also be submitted to the author for inclusion in the main
CGIC distribution.


27.4 Installing IssueWeaver Admin Tool


The IssueWeaver Admin tool is designed to provide a mechanism for creating site specific styles for your
IssueWeaver users.   


The intended user of this tool is the IssueWeaver Administrator and/or the Razor Administrator.


Several styles are provided with the IssueWeaver installation. These styles may be further refined to
customize your IssueWeaver users view of the issues databases at your location.


Required


Razor installation with an issues database 
A WebServer installed and running
A WebBrowser (We recommend Firefox)


Installation


The IssueWeaver Admin tool is included in the IssueWeaver installation.  No separate installation steps
are required. Refer to README.IssueWeaver for installation instructions.


Limiting Access


Access to this tool may be limited via the file 'Razor_iw/users'. This file will be installed in the Web
server's documents' directory.


Starting IssueWeaver Admin


To run the IssueWeaver Admin tool, open the following from a web browser:


http://<server>/cgi-bin/rz_iw_admin


Difficulties


If you experience problems when attempting to run the IssueWeaver Admin tool, please contact Razor
support by phone (800-6-VISIBLE) or e-mail (razor_support@visible.com).


IssueWeaver Installation
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This file contains information on how to install IssueWeaver.  If your Razor license does not have
IssueWeaver enabled, please contact our sales staff at 'razor_sales@visible.com'.


Required


Razor installation with an issues database
A WebServer installed and running
A WebBrowser (We recommend Firefox)


Installation


NOTE: If you are installing IssueWeaver on Windows 2003 Server, please refer to the installation
instructions in README.Windows 2003 Server.


Preparation:


- RAZOR_HOME must be set to point to the Razor release area
- RAZOR_UNIVERSE_DIR must point to a Razor database


NOTE: These environment variables are normally set as a result of sourcing (or dotting) an appropriate
rz_prep file.  Please refer to the Razor manual for additional information.


Install:


cd $RAZOR_HOME
./scripts/rz_iw_install


NOTES: You will be prompted for the path to the cgi-bin and web server documents directory.  Links will
be created in these directories to the IssueWeaver executables and libraries, therefore, write permission
to these directories is required.  


For new installations, the directory Razor_iw_lib will be created in the web server's document directory. 
If this directory currently exists, ONLY "new" files will be added; no existing files will be overwritten.  


To force the creation of a "new" Razor_iw_lib, the install script may be invoked with the parameter "-o". 
The current Razor_iw_lib will be "moved" to Razor_iw_lib.<PID> and a "new" Razor_iw_lib will be
created.  Any customized files such as rules, etc. would then have to be copied from the "old"
Razor_iw_lib to the "new" Razor_iw_lib.


Currently defined RULES (refer to the IssueWeaver manual,  Chapter 4, "Basic rules" for a complete
description) are upward compatible.  New RULES will be described in the RELEASE NOTES 
as well as this README file.  


Rules File


A template file 'rules.conf' may be found in $RAZOR_HOME/Razor_iw_lib. This template file outlines all
supported RULES.


The rules file (<server documents>/Razor_iw_lib/rules.<identifier>) controls the look and behavior of
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IssueWeaver.  The extension "identifier" may be used to distinguish the rules to be applied to
additional issues group within one database and/or additional databases.


As part of the IssueWeaver installation, a default 'rules' file is created which references the default issues
group in the database pointed to by the environment variable, RAZOR_UNIVERSE_DIR.  To access
a different issues group or a different database, copy Razor_iw_lib/rules to Razor_iw_lib/rules.<identifier>
and change the setting of the rules UNIVERSE and/or GROUP.  Additional customization may be made
via the 
rules file or via the IssueWeaver Admin tool (refer to the IssueWeaver manual and README.IWAdmin for
details).


Site Customization


We have found that not all environment variables are set for web server applications.  One example is the
environment variable TZ (time zone).  To accommodate the necessity for some sites to export
environment variables, the file 'rz_iw_site' will now be sourced by the issue_weaver script if it exists in
the web server's cgi-bin directory.  


Starting IssueWeaver


To run IssueWeaver with the default rules file, open the following from a web browser:


http://<server>/cgi-bin/issue_weaver


To run IssueWeaver with a customized rules file, open the following from a web browser:


http://<server>/cgi-bin/issue_weaver?Zrules=<rules file>


Difficulties


If you have any difficulties starting IssueWeaver, you may check your setup by opening the following
from a web browser:


http://<server>/cgi-bin/rz_iw_info


If you are unable to locate the source of the problem, please contact Razor/IssueWeaver support by
phone (800-6-VISIBLE) or e-mail (razor_support@visible.com).


Setting Filters


Currently, IW supports use of user-specific startup filters.  These filters are stored as filter_sort.<user> in
directory $RAZOR_UNIVERSE_DIR/Weaver/user. We have now added support for "system" filter files.
The system filter files (sys_filter.<issue group>.default, sys_filter.<issue group>.<user> in directory
$RAZOR_UNIVERSE_DIR/Weaver/user) provide the Razor system administrator with a means of limiting
the issues available to an individual user. The system filters are applied to the list of issues obtained
from the Razor DB server prior to presentation to the user. Hence, a user's system filter may be
constructed so as to limit:


- List of issues presented to user at IW startup
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- Issues selectable (IW GUI "#" button)
- List of issues eligible for text match searching
  (IW GUI "Search" button)
- List of issues eligible for reporting (IW GUI "Reports" button)


The format of the sys_filter files is identical to that of the filter_sort files. However, a given sys_filter file
specifies the settings for a particular user only for a single issues group.


The use of the sys_filter files by IW is optional. The system filtering is configured as follows:


- If present, system filter in  $RAZOR_UNIVERSE_DIR/Weaver/user/sys_filter.<group>.<user> will be
used when user <user> uses IW to access issue   group <group>.


- If present, system filter in  $RAZOR_UNIVERSE_DIR/Weaver/user/sys_filter.<group>.default will be
used when user accesses issue group <group>.


- If neither user or default system filter file is present, no system filtering is performed.


Can envision using the system filter enhancement to limit access to individual issues within a single
issue group based upon any combination of attribute values. E.g. assume that each Issue form contains
a one-of-many attribute field (UserOrganization) that encodes the user organization (e.g. CompanyA,
CompanyB, CompanyC, ...) that "owns" the issue. Assume that the Actions file has been configured
such that an
Issues-Create-After script runs each time a new issue is added to the issue group. This script either fills
in the UserOrganization field automatically or simply validates the UserOrganization attribute value field.
The Razor administrator could setup sys_filter files for each individual such that users from Company A
could only view/modify issues in which the UserOrganization field was set to 'CompanyA' users from
Company B could only view/modify issues in which the UserOrganization field was set to 'CompanyB',
etc.


Finally...


Enjoy!  Please send your suggestions/comments to: razor_support@visible.com


Your inputs (good or bad) are very important to us!


Visible Systems
Phone: 800-6-VISIBLE
Fax: 315-363-7488


Support Emails:  razor_support@visible.com


Visible Systems acknowledges the use of CGIC.


CGIC, copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, by Thomas Boutell and Boutell.Com, Inc..
Permission is granted to use CGIC in any application, commercial or noncommercial, at no cost. HOWEVER,
this copyright paragraph must appear on a "credits" page accessible in the public online and offline
documentation of the program. Modified versions of the CGIC library should not be distributed without the
attachment of a clear statement regarding the author of the modifications, and this notice may in no case be
removed. Modifications may also be submitted to the author for inclusion in the main CGIC distribution.
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27.5 Razor Admin Tool for 2003 Server


This file contains information on the Razor Admin tool for Razor 2003 Server 


The Razor Admin tool is currently available as part of the Razor 2003 Server installation.  This
application provides Windows users with the ability to administer the Razor installation via a graphical
user interface.  This tool allows the user to enter license keys, start/stop the license manager, create
and configure databases, start/stop database servers and review current connections. 


Refer to the Razor manual and the Help documentation associated with the various dialogs for details.


Refer to README, WINDOWS 2003 Server for details regarding the Razor Windows installation.


Please send your suggestions/comments to: razor_support@visible.com


Your inputs (good or bad) are very important to us!


Visible Systems
Phone: 800-6-VISIBLE
Fax: 315-363-7488


Support Emails:  razor_support@visible.com


27.6 2003/2000/XP Server Installation


Information on how to work with and install the 2003/2000/XP server


Introduction


For those already familiar with Razor in the UNIX environment (RazorUNIX), Razor server on 2003 (Razor)
will look quite familiar.


Razor supports all of the Razor remote clients which are PC clients, UNIX remote clients, and
IssueWeaver. Administrative functions may be performed via the Razor Admin program.


Note: For those installing UNIX , Linux distributions are in a tar.gz format and not tar.Z format.  This is a
slightly different install.


Requirements


- Networked Windows or greater.


- Administrator login account.  Installation as well as all of the administration of Razor can be done by a
user that is a member of the Administrative group for the machine.  
  
- NTFS disk partition with enough free disk space for installation.


- NTFS disk partition(s) with enough free space to create and maintain the desired Razor databases.
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Installation - General Notes


Those already familiar with the UNIX administration of Razor will notice that the classic installation steps
(uncompress, tar xf, rz_install) have been replaced by an automated install script.  Once installed, you
will find "Razor" installed on the Start menu.


The installation enforces certain rules, including, but not limited to...


- Installation must by performed by a member of the Administrative group.


- Installation must be installed on an NTFS partition.


- Installation path must not contain embedded spaces.


Among other things, the installation will create directory "/tmp", if it does not already exist, at the root
level of the partition containing the Razor installation.


Since Razor installs as "Razor", a conflict exists with pre-4.1e installations of RazorPC clients which
installed as "Razor".  If RazorPC clients are already installed, they must first be un-installed
before installing Razor.  Starting with the 4.1e release, installations of the RazorPC clients will install as
"RazorPC".


Prior to starting installation...


- Determine the NTFS partition on which Razor will be installed.


- Determine whether or not IssueWeaver is to be installed.  A web server must already be installed on
the licensed Windows host.  Once Razor is installed, Issueweaver may be installed at any time. Refer to
the section "Issueweaver installation" in this document.
  
- Determine the location for Razor databases.  Razor databases must reside on local NTFS disk
partitions.


- If installing for the first time, please follow the steps found in "Installation - Procedure".  Otherwise, if
upgrading, please follow the steps found in "Upgrade - Procedure".


Installation - Procedure


If upgrading an existing installation, please refer to the Upgrade procedure.  Otherwise, ...


Login as local Administrator or as a user that is a member of the Administrative group.


Terminate all windows applications.


Un-install the old RazorPC (pre-4.1e) client installation if it exists.


Install Razor, RazorPC*, and RazorSCC. All may be installed from the single self-extracting executable
"Razor_<version>.exe". (RazorSCC is an integration with Window-based IDE's.  Refer to Appendix E of
the
Razor manual for details.)
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Please install to the provided default directory.  If you choose to use the installer provided browser to
change the installation path, PLEASE TAKE CARE THAT THE CORRECT CASE IS PROVIDED IN THE
"Path" FIELD OF THE BROWSER BEFORE ACCEPTING IT.


Reboot the machine.


Login as local Administrator or as a user that is a member of the Administrative group.


Refer to "IssueWeaver installation" for details on installing IssueWeaver.


Upgrade - Procedure


Do not un-install the existing Razor installation.  The installation script will detect the current installation
and upgrade it.


All database servers, the license manager and the Syslog manager must be stopped via Razor Admin
(refer to "Razor Admin" in this document for instructions on starting this program).


Reboot the Windows workstation.


Login as local Administrator or a user that is a member of the Administrative group.


Terminate all Windows applications.


Install Razor, RazorPC*, and RazorSCC.  All may be installed from the single self-extracting executable
"Razor_<version>.exe".


The upgrade will install over the current installation directory.


Reboot the machine.


Login as local Administrator or a user that is a member of the Administrative group.


Refer to "IssueWeaver installation" for details on installing IssueWeaver.


Razor Admin


Administration/configuration of the Razor installation should be performed via the Razor Admin program.
This program is included in the Windows 2003 Server installation.  This graphical user interface is
invoked from
the start menu:


Start->Programs->Razor->Razor Admin


Select the "Help" button on the main dialog for additional information.


License Keys


To run Razor and RazorPC either as a demo or a purchased product, you will need to obtain license
keys.  Demo license keys may be obtained automatically via our web site at:
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http://www.visible.com/Download/Razor/demo_keys.htm


In order to provide license keys for purchased licenses, we require specific information about the
machine that will be licensed.  The required information can be obtained via the Razor Admin program. 
Please
forward the output from selecting "Razor ID" from the "License Manager" pulldown menu to 
razor_license@visible.com.


License keys (either evaluation or purchased) should be entered via the Razor Admin program.  Select
"Keys" from the "License Manager" pulldown menu.  Enter the keys in the appropriate fields on the
newly active GUI.  A "Help" button is available on this dialog for additional information.


License Manager Modes


The Razor license manager supports validation of the following
files for remote user verification:


- Razor password file (default)
- Local password file (Auto-Login capability)
- Local and Razor password file


The license manager mode may be changed via the Razor Admin program. To do this, stop the
database servers and license manager (select "OnApplication" from the "Help" pulldown menu for
details).  Once the license manager is stopped, select "Configuration" from the "License Manager"
pulldown menu.  The "Razor License Manager Configuration" dialog provides the validation selections. 
Select the "Help" button on this dialog for additional information.


If either the default (Razor password file only) or combined (local and Razor password files) validation
modes are used, the Razor administrator will be required to create and maintain the Razor password file
(refer to "Razor Passwords" in this document).  


Getting Started


Before you can start to use Razor, you must install the license keys and create a database. Popup
windows will be displayed to remind the user.


The Syslog manager, license manager and database servers may be started from the Razor Admin
program (refer to "Razor Admin" in this document).  Each of the following functions may be performed
from this
program.


Start License manager


Select the "Start" button in the "License Manager" status area.


Start Syslogd


Select "Start" from the "Syslog Manager" pulldown menu.



http://www.visible.com/Download/Razor/demo_keys.htm
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Create the database repository and your first database


Logged in as local Administrator, select "New" from the "Database" pulldown menu.  The "New
Database" dialog will be displayed.


Select the "Help" button for additional information.


We also offer a "tutorial".  Select "New Demo" from the "Database" pulldown menu.  The "New Demo
Database" dialog will be displayed.  Select the "Help" button for additional information.


Start database server


To start the database server, you must first select the database via the "Select" button.  Once you have
selected the database, the "Start" button will be available.


Run client against new database


Select "Programs->RazorPC->razor" from the Start menu.  This will start a PC client desktop.  Select
issues, versions, or threads from the desktop's Application pulldown menu.


An example of how the path statement should appear on the PC client follows:


D:\Visible\Razor\<database>\RAZOR_UNIVERSE


Refer to the Readme file via the desktop's Help->Readme menu selection for assistance connecting with
the Razor license manager and desired database server.


Razor Program Group


Once the installation process is complete, the following program items will be available:


- Razor Admin (Administration Tool)
- Razor csh (c shell)
- Razor ksh (korn shell)
- Shortcut to Services (Shortcut to Windows Services panel)


The Razor Admin program provides a GUI interface for administering the Razor installation.  Supported
functions include entering license keys, starting/stopping Syslog manager, license manager, database
server(s) as well as creating/configuring databases and adding database
groups.


The Razor csh and Razor ksh each start the requested shell.  These are Posix compliant versions of the
UNIX C shell and the Korn shell. 


Program items "Start License Manager" and "Stop License Manager" as well as "Start Syslog Manager"
and "Stop Syslog Manager" are provided as a convenience to the Razor administrator.  The same control
is
provided via the Windows Services panel.  This functionality may also be performed via the Razor Admin
tool.







Razor Manual414


© 1992-2009 Visible Systems Corporation, All rights reserved.


Program item "Shortcut to Services" is provided as another convenience to the Razor adminstrator and
does nothing more than popup the Windows Services panel.


Environment


Administration of the Razor installation should be performed via the Razor Admin program (refer to
"Razor Admin" in this document).  If you decide to administer Razor via the provided shells, we suggest
that the
"Razor csh" be used since that is the assumed environment for all examples.


The shells are POSIX compliant versions of the C shell and the Korn shell and, therefore, require POSIX
compliant shell syntax.  Of particular importance is the syntax used to represent drive letters,
"//<drive_letter>/".   For example, the "/tmp" directory of drive D: is known as "//D/tmp".  Referring to "/"
simply means the top level of the current drive.  When providing a fullpath (i.e. when creating a new
Razor database), it is important to include the drive letter, otherwise, the path will be relative to the
current drive rather than a fullpath. ALWAYS use upper case when providing the drive letter.


The system wide environment parameters, RAZOR_HOME and RAZOR_LICENSE_DIR, are established
during installation.  Parameter RAZOR_HOME points to the location of the Razor binaries, scripts, help
files, etc.  Parameter RAZOR_LICENSE_DIR points to the directory containing the license file, etc.  The
other important environment parameter is RAZOR_UNIVERSE_DIR.  This parameter points to one of any
number of databases.  These environment variables are used internally by the various Razor binaries and
scripts.  Pointing to a Razor database within the shell (csh only) is done by running the alias
RazorDB_<database> which will set RAZOR_UNIVERSE_DIR appropriately.


Starting one of the shells is as simple as double-clicking over the appropriate shortcut in the Razor
program group or selecting one via the Start menu (Start->Programs->Razor...).


Databases


Creation and configuration of databases as well as the addition of new groups to existing databases is
supported by the Razor Admin program.


It is recommended that a common repository (directory) be created that will contain all Razor databases.
 Although databases may be located on any NTFS partition and do not have to belong to a general
repository,
it is recommended that a common repository be created.  The recommended repository location is
"<Razor>/razor_db", where <Razor> is the location of the Razor installation such as "D:\Visible".


Once the repository is created, the individual database folders should be created.  The names used as
the database folders are up to the Administrator.  For example, databases DB1, DB2 and DB3 might be
represented as...


D:\Visible\razor_db\DB1,
D:\Visible\razor_db\DB2, and
D:\Visible\razor_db\DB3.


It is up to the Administrator to manually create a given database folder.  The database creation process
will prompt for the location of the database to be created at which time the database folder would be
entered as a fullpath such as D:\Visible\razor_db\DB1.
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Once the repository has been created, simply run the Razor Admin program to create a new database. 
Select New from the Database pulldown menu on the main toolbar of this program.  


Within the limits of system resources, any number of databases may be created on the Razor host.


Database administration


Database administration is performed via the Razor Admin program. The Razor Admin GUI enables the
user to create new databases, add groups for issues and file version control, and edit the database
control files with the editor that is provided. Select "On Application" from the Help pulldown menu on the
main toolbar of this program for details.


IssueWeaver installation


Before beginning the installation it is recommended that you first take the following actions...


- Verify a web server is installed and functioning properly.
- Record the location of the web server's cgi-bin and documents (i.e. htdocs) directories.


Open a "Razor csh" and do the following...


- If it does not already exist, create directory "/tmp" on the disk partition containing the web server
installation.
          
For example, if the web server is installed in "//F/Program  Files/Apache Group", create directory "//F/
tmp" with world access.


- Invoke the IssueWeaver installation script as follows...


% $RAZOR_HOME/scripts/rz_iw_install


Refer to the IssueWeaver manual for further instructions as to invoking IssueWeaver via a web browser.


Razor Passwords


If your site has decided that remote user validation will be performed against the Razor password file or
against both the local and Razor password files (refer to "License Manager Modes" in this document),
the Razor administrator will need to create and maintain the Razor password file.


Until the password file is created, remote clients may login as "guest" (no password required).  It is
recommended that the Razor administrator create the password file as soon as possible after
having completed the installation.


A Razor user account in the password file consists of user, password and user group.  Razor user
accounts are for Razor use only and need not have any association with UNIX/PC user accounts,
domains,
passwords and/or groups.


The password file may be created/modified via the Razor Admin program by selecting Remote Users
from the License Manager pulldown menu.  If this selection is not available ("grayed out"), make sure
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that the access
controls for modifying the password file (ADD_USER, MODIFY_USER and REMOVE_USER) are set for
the Razor administrator.  


To view/modify the access controls, select Editor from the Database pulldown menu.  Double-click on
the file "Access List" on the Razor Table Editor. 


Refer to the Razor manual, Chapter 2, "Remote client password", for details.


Limitations - email


Razor on Windows does not yet support receipt of email.  This means that email database
synchronization, email issue submittal and email query are not supported.


Razor's Windows Server supports sending email via Messaging Application Programming Interface
(MAPI). E-mail messages may be sent upon state changes of issues and submission of error logs to
support. Outlook and
Outlook Express are supported.


Your Windows machine must have a default simple MAPI client.


Razor administrators can enable capture of email message, which for any reason, have failed to send
successfully by making the minor modification to $RAZOR_HOME/scripts/rz_sendmail_nt as follows...


- Change the line that reads...


REMOVE_EMAIL_LOG=1


to...


#REMOVE_EMAIL_LOG=1


...If a failure occurs, the email message will not be removed.  The prospective email message will be
saved to a file named $RAZOR_HOME/email_log.<pid>.


Razor administrators can disable the sending of email by making a minor modification to
$RAZOR_HOME/scripts/rz_sendmail_nt as follows...


- Change the line that reads...


ATTEMPT_EMAIL_SEND=1


to...


#ATTEMPT_EMAIL_SEND=1


...This will simply disable the sending of email and the generation of the log file $RAZOR_HOME/
email_log.<pid>.


It is recommended that once enabled the Razor administrator periodically check $RAZOR_HOME for
email_log files and dispose of them appropriately most likely by emailing them directly to 
razor_support@visible.com.  The files are not aged out so the administrator should periodically delete
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them as well.


Finally


Enjoy!  Please send your suggestions/comments to:


razor_support@visible.com


Your inputs (good or bad) are very important to us!


Visible Systems
Phone: 800-6-VISIBLE
Fax: 315-363-7488


Support Email:  razor_support@visible.com


27.7 Razor Installation for Client Applications


An an overview of and installation instructions for the Razor client applications offered for Windows
2003/2000,XP


Client applications for Windows 2003 Server/2000/XP


README file contents 


- Distribution content
- Distribution formats
- Installation instructions
- Startup instructions
- Login instructions
- Troubleshooting


Distribution content


This distribution contains everything necessary to install the Razor/PC client applications (issues,
versions and threads) onto a WINDOWS platform.


RazorSCC, an integration with Windows IDE's, is also included.


Refer to the Razor manual, Appendix E, for details.


Distribution format
- RazorPC_<version>.exe    (self-extracting exe)


Installation instructions
If upgrading to a more recent version of Razor, it is only necessary to uninstall* if you are running a pre-
4.1e release.
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After retrieving the Razor/PC distribution to a Windows machine, simply run the self-extracting
executable.  RazorSCC may also be installed at this time (refer to Appendix E of the Razor manual for
details).


The Windows machine must be able to resolve the host name of the Razor license manager if using the
hostname instead of IP address when starting up.  If the PC is not setup for name service (DNS), add
entries to the local host table for the license manager host.


On Windows, this is done by activating the 'Uninstall' icon in the Razor program group.  On Windows, 
you should uninstall by executing 'Add/Remove Programs' from the Control Panel.  It is important that all
windows applications be terminated before uninstalling.


Startup instructions


WINDOWS):


Execute "razor" from the Start menu by selecting Start->Programs->RazorPC->razor.  This will start a
new Razor desktop.  


Specific Razor client applications may then be run on this new desktop by selecting from the
"Applications" menu pulldown on the Razor desktop.


Double click on the "razor" icon in the RazorPC program group in the Program Manager.  This will start a
new Razor desktop.


Specific Razor client applications may then be run on this new desktop by selecting from the
"Applications" menu pulldown on the Razor desktop.


Login instructions


Login involves two separate dialogs.  


The first dialog requests server information.  Specifically, the user is required to provide information
necessary to connect with the Razor license manager and desired Razor database server on the
network.


The second dialog requests user information.  The user/password information that is required is
dependent upon the Razor license manager mode.  The possible user authentication modes are to use
the Razor password file, the local password file or a combination of both.  Refer to  Chapter 2 of the
manual, "License manager" for details.  The Razor administrator will be able to provide the mode so that
you can determine the correct user/password information to enter.


Administrators should refer to the Razor manual or run "razor -help" for information regarding the
password file
and the Razor interface provided for password file maintenance.


It may be necessary to contact your local Razor administrator for some of the following information.  A
more detailed explanation of each field on the two dialogs follows:


UniverseDir
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The UniverseDir field must contain the fully expanded path to a Razor database as it would be entered
on the
database server host machine.  This path should end with RAZOR_UNIVERSE (without trailing '/').


NOTE: Remember to use the UNIX style slash ('/' is good and '\' is bad).


Port
The Port field must contain the port of the License manager.  The installation default is 16151.


Host
The Host field must contain the host of the License manager.  This may be given in either hostname
format or IP address format.


Local Host
This Host field specifies the IP address of the client machine.  This field appears disabled unless more
than
one IP address has been detected.  If multiple addresses are available, select the IP address by which
the PC is known to the machine hosting the database server.


UserID/Password


User/password combination dependent upon the license manager mode.  The possible modes are to use
the local password file, the Razor password file or a combination
of both.


Change password


This toggle will remain insensitive until the Razor password file is created by the Razor administrator. If
toggled on then the "New password" and "Verify" fields are made sensitive and are used to specify a
new password.


New password/Verify


Used to specify a new password. 


Troubleshooting


If you are experiencing difficulty connecting to a Razor database, one of the following problems may
exist:


1) A message similar to the following appears on the "Razor output log..." window.


"The Database server for "/home/joe/DB/RAZOR_UNIVERSE" does not appear to be running."


"Please contact your RAZOR Administrator."


This usually indicates that either the database is not being served or the database path contains a
typographic error.


Verify that the database path begins with a forward slash ('/').
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Verify that the database path ends with "/RAZOR_UNIVERSE" (no trailing '/').


Once you have verified the path is typographically correct, verify that a database server is running for
your particular database by logging onto the machine hosting the database server and entering the
command "razor info".  Remember to "source" or "dot" the appropriate 'rz_prep' or 'rz_prep.sh' file to set
the environment variables.
   
Each Razor database created will contain the files 'rz_prep' and 'rz_prep.sh'.  This pair of files will
uniquely configure the user's environment for operation with the corresponding database.
   
Following is a sample output from running "razor info".


-> razor info


The license manager is running on zoot, pid = 19854


Remote Clients are using Razor Password file


Connections: 


Database '/home/filmer/DB/test/RAZOR_UNIVERSE',
is active on kermit, rz_server pid = 5820


1 -   filmer is running Versions on machine waldorf, pid = 190
2 -   filmer is running Issues   on machine waldorf, pid = 164
3 -   filmer is running Threads  on machine waldorf, pid = 147
4 -   mark is running Versions on machine waldorf, pid = 61
5 -   deb is running Versions on machine waldorf, pid = 169


Database '/home/filmer/DB/SCCS/RAZOR_UNIVERSE',
is active on kermit, rz_server pid = 17630


1 -   filmer is running Versions on machine waldorf, pid = 180
2 -   filmer is running Issues   on machine waldorf, pid = 182


There are 7 applications connected.


The path you provide for "Universe Dir:" must exactly match one of the Databases as reported by "razor
info".  From the example above this would mean either "/home/filmer/DB/test/RAZOR_UNIVERSE" or 
"/home/filmer/DB/SCCS/RAZOR_UNIVERSE".


2) The following message appears on the "Razor output log..." window.


"The Host/Port you are trying to connect to does not appear to be running the RAZOR license server
program."


"Please contact your RAZOR Administrator."


This usually indicates that either the license manager is not running or the specified license manager
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host or port (or both) are incorrect.


You can detect whether or not the license manager is running by executing the command "ps" on the
machine which hosts the license manager and looking for "razor_lm" (i.e. "ps -elf | grep razor_lm").  If it
appears that the license manager is not running, contact your local Razor administrator.


If the license manager is running, you can verify the Host and Port by looking at the content of file
$RAZOR_LICENSE_DIR/License_status.


3) A notice dialog pops up with the message...


"Unknown Userid [<userid>]".


This indicates the the username provided does not appear in the password file being used by the license
manager.  Contact your local Razor administrator.


4) A notice dialog pops up with the message...


"Invalid password".


This indicates that the password provided is not the correct password for the username provided. 
Contact your local Razor administrator.


5) The following message appears on the "Razor output log..." window.


"Could not spawn kid."
"<path to razor scripts>/rz_remote_kid is missing."


The script used to start the clients helper application is missing as stated.  Contact your local Razor
administrator.


6) The following message appears on the "Razor output log..." window.


"Could not spawn kid."
"<userid> does not have execute permission for <path to razor scripts>/rz_remote_kid


The script used to start the clients helper application does not have the required execute permission.  
Contact your local Razor administrator.


7) The following message appears on the "Razor output log..." window.


"Kid did not connect."


Causes are varied.  A few things to check include the following... (NOTE: The environment variable
RAZOR_HOME is set by the file 'rz_prep' associated with the database you
are connecting to.)


- Verify that $RAZOR_HOME/bin/kid_of_issues,







Razor Manual422


© 1992-2009 Visible Systems Corporation, All rights reserved.


  $RAZOR_HOME/bin/kid_of_versions, 
  $RAZOR_HOME/bin/kid_of_threads exist and are executable.


- Verify that the client and server are not separated by a firewall.


8) A message similar to the following appears on the "Razor output log..." window.


"Error during program identification."
"Version mismatch - Server = v4.1d, Client = v4.1(c)"
"Please update your Razor installation on ALL platforms."


This typically indicates an incompatability between the version of Razor run by the client and the version
run by the server.  Verify the release version as follows:


PC client) Select "Help-->About" from the Razor desktop window and record the version and date.


Server host) cat $RAZOR_HOME/VERSION


Once it is demonstrated that indeed there is a version mismatch, it is generally recommended to
upgrade all platforms to the latest release version of Razor.


If the above suggestions do not help resolve the problem, please send the following information to '
razor_support@visible.com':


Login dialog fields


Universe Dir:


Host:


Port:


Username:


Password: (Please provide only the length of the password)


Software version


PC client) Select "Help-->About" from the Razor desktop window and record the version and date.


Server host) cat $RAZOR_HOME/VERSION


Error information


Please provide the complete contents of the "Razor output log..." window.


Please provide the complete content of the "exit notice" dialog if it appeared.



mailto:razor_support@visible.com
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Miscellaneous information


Does the problem seem to be isolated to a specific user or does it occur regardless of user?


Does the problem seem to be isolated to a specific database or does it occur regardless of database.


Is this a first attempt at using Razor's PC client application or has it worked in the past and now is
"broken"?


Have any Razor upgrades been made lately either to the PC client and/or Server installation?


Whatever other information you can provide regarding the circumstance of the failure, no matter how
trivial it may seem, may prove useful.  


Finally...


Enjoy!  And please send your suggestions/comments to: razor_support@visible.com


Your inputs (good or bad) are very important to us!


Visible Systems
Phone: 800-6-VISIBLE
Fax: 315-363-7488


27.8 Installing and Using the Demonstration Database


GUIDE TO DEMO DATABASE


With the release of Razor 4.2, we offer a demonstration database.  This
README is provided as a general overview of that database.  As always,
the Razor manual is the best source of information regarding
Razor, and this README is meant to supplement the manual.  This DEMO
database is intended to give you a brief look at some of the things you
can do with Razor.


ISSUES (Problem Tracking)


This Demo is comprised of two (2) Issues groups:  Code and
Action_items.


The Code group is intended to emulate a very basic Razor tutorial.
There are a few things configured for the Code group that demonstrate
some controls that you may implement at your site.  Start with Issue
I...-..1 by double-clicking on the Issue.  Read the text in the text
panes and follow the instructions.  The intent here is to guide you



mailto:razor_support@visible.com
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through some of the features of Razor.


The Action_items group is wide open, meaning that you have free reign
to do whatever you like (practice!) in that group.


This is what you see in the columns on the Main Issue form:


· State
· Priority
· Issue Number
· Title


The State and Priority are both Bitmap pictures (user defined) that
reflect at a quick glance what state and priority that Issue is at.


VERSIONS (Version Control)


The Versions program is the backbone of the configuration management
aspect of Razor.  Versions provides a straightforward mechanism for
controlling, monitoring, and archiving changes made to files in your
development environment.  In the Versions tool, you have two (2) file
control groups:  Code and Configuration.  The Code group is configured
to simulate an example software development process.  The Configuration
group is  wide open, meaning that you can practice and do whatever you
wish.  All of the configuration files that we modified for this demo
are placed in the Configuration group.


THREADS (Build/Release Management)


The Threads program is the final piece of the Razor trilogy.  It
provides a mechanism for defining which unique combinations of files
and versions "belong together" for the sake of a release or product
build.  A thread is what forms the relationship among specific versions
of files.  In the Threads tool, you have the same two file control
groups:  Code and Configuration.  In Threads, these groups are for
build management.  In the code group, the are two Threads:
code_baseline and patch.  These threads are designed to simulate a
possible release scenario.  The same idea applies to the Configuration
group.


FEEDBACK


We appreciate all customer feedback - both good and bad!  We'd really
like to hear from you in regards to your thoughts on the Demo.


Visible Systems
800-6-VISIBLE (V)
315-363-7488 (F)


Support:  razor_support@visible.com



mailto:razor_support@visible.com
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28 Guiffy Diff and Merge Tool


Guiffy's Trustworthy 3-way merge tool 


SureMerge automatically goes beyond the focus on "conflicts" in other merge tools. Guiffy's "Attention"
focus can be expanded by the user. And, SureMerge's heuristic algorithms result in fewer, easier to
resolve changes. Plus, a Parent Attention view is available for when it helps to see or copy parts of "the
way it was before".


Guiffy is a Pure Java application with a Swing GUI, available on all Java-enabled platforms including:
Windows (2000, XP), Linux, Unix, and MacOS. Guiffy features 2-way or 3-way merge interfaces. Guiffy's
very smart merge capability, called SureMerge, combined with an intuitive visual user interface and
cross-platform availability, make it an excellent tool for developers in collaborative communities. Guiffy
can be used as a stand-alone tool or integrated with CM/SCM products.


Guiffy is a File Compare Diff tool, Merge tool, and Folder compare tool  all-in-one. Its cross-platform,
comes with a command line interface, and includes an API package. Guiffy recognizes over 150 source
file encoding formats. And, Guiffy's Trustworthy 3-way merge, SureMerge, was designed from day 1 to
avoid all the problems that plague other 3-way diff based merge tools.  Guiffy's major features include...


Diff Tool


Guiffy includes our Advanced cross-platform File Compare Diff Tool. The Guiffy Diff Tool is available for
Windows, Linux/Unix, and MacOs systems. Guiffy allows you to edit either of the compare files and
save the result. The Guiffy Diff Tool includes a command line interface for automation and integration with
your other tools.


Guiffy's diff tool can be used to compare source files of any type with builtin support of Unicode(UTF8 &
UTF16), MBCS, SJIS, and over 150 File Encoding and character set formats.


Some of Guiffy's Advanced File Compare Diff Tool capabilities:


· Compare text files in over 150 encoding formats such as Unicode-8, Unicode-16, MBCS, SJIS,



http://www.guiffy.com/Diff-Tool.html

http://www.guiffy.com/Merge-Tool.html

http://www.guiffy.com/Folder-Compare.html

http://www.guiffy.com/features.html

http://www.guiffy.com/Diff-Tool.html

http://www.guiffy.com/help/GuiffyHelp/Encodings.html
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Big5, etc.
· Compare folders with Unicode file/folder names.
· Compare files with different end-of-line formats - the Guiffy diff tool ignores end-of-line format


differences.
·  Compare files side-by-side - the Guiffy diff tool highlights differences within the line.
·  Save compare reports - the Guiffy diff tool generates reports as HTML


Merge Tool


Guiffy includes our Advanced cross-platform Merge Tool, SureMerge. The Guiffy Merge Tool is available
for Windows, Linux/Unix, and MacOs systems. Our merge tool supports 2-way and 3-way (auto)
merging. The Guiffy Merge Tool includes a command line interface for automation and integration with
your other tools.
Some of Guiffy's Advanced Merge Tool capabilities:


· Merge text files in over 150 encoding formats such as Unicode-8, Unicode-16, MBCS, SJIS, Big5,
etc.


· Merge files with different end-of-line formats - the Guiffy merge tool ignores end-of-line format
differences.


· Some merge tools try to be "smart" and auto merge changes when both versions added code at the
same place. Not, SureMerge.


· Attentions focus beyond Conflicts - the Guiffy merge tool detects changes close to one another, not
just those which overlap.


There are several Merge Tools. But, only a few of them are available on Windows, Linux/Unix, and
MacOS. Only a couple of those merge tools support all of today's possible file encoding formats.


You may not need all of Guiffy's Merge Tool features today... But, what about tomorrow?


SureMerge is the only merge tool designed from day one to provide a trustworthy 3-way auto-merge -
which requires its own algorithm. Other merge tools were developed as an enhancement to a diff tool and
try to apply its "unique anchors" file compare algorithm for the 3-way merge solution. The authors of the
"unique anchors" compare algorithms admit, "applying the compare algorithm to a 3-way merge is
problematic". Put simply: Most of the time, it works... Sometimes, it doesn't!


Folder Compare


Guiffy includes our Advanced cross-platform Folder Compare Tool. The Guiffy Folder Compare Tool is
available for Windows, Linux/Unix, and MacOs systems. The Guiffy folder compare has an Explorer-like
interface with expandable sub-folders and popup menus for file synchronization operations. And, the
Guiffy Folder Compare Tool includes a command line interface for automation and integration with your
other tools.


Some of Guiffy's Advanced Folder Compare capabilities:


·  Compare folders with Unicode file/folder names.
·  Save compare reports - the Guiffy folder compare tool generates reports as HTML
·  Quickly launches a file compare from the folder compare.
·  Compare text files in over 150 encoding formats such as Unicode-8, Unicode-16, MBCS, SJIS,


Big5, etc.
·  Compare files with different end-of-line formats - the Guiffy diff tool ignores end-of-line format



http://www.guiffy.com/Merge-Tool.html

http://www.guiffy.com/
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differences.
·  User friendly folder compare view with Explorer-like interface and expandable sub-folders.
·  Folder Compare interface includes popup menus for file synchronization operations.
·  Recursive compare option - folder compare can do a file tree compare.


There are several Folder Compare Tools. But, very few of them (maybe only Guiffy) are available on
Windows, Linux/Unix, and MacOS. And, only a couple of those folder compare tools (maybe only Guiffy)
support all of today's possible file encoding formats.


Copyright Guiffy Software 2009.


28.1 Guiffy Table of Contents


Guiffy Help - JavaHelp/HTML


Guiffy's Help is implemented as JavaHelp - the content is HTML. The abbreviated Table of Contents
below gives you a sample of Guiffy's Help. Guiffy Help includes navigation via a complete Table of
Contents, Index, and Search engine.


Abbreviated Guiffy Help Table of Contents:


   1. How Do I...
   2. Have It Your Way...
   3. Top 10 Tips...
   4. Controlling Compare
   5. View Attributes
   6. Compare Views
   7. Saving Settings
   8. Searching/Scrolling Text
   9. Toolbar
  10. Guiffy Command Line Interface
  11. Jiff Command Line Interface
  12. guiffy.inside API
  13. HowTo use Guiffy from Windows Explorer
  14. HowTo use Guiffy from MacOS X Finder
  15. HowTo use Guiffy from Linux KDE
  16. Visual Studio Team Foundation Server integration
  17. Uninstall, Updates/Upgrades


28.2 Guiffy A Trustworthy 3 Way Merge (White Paper)


Guiffy SureMerge - A Trustworthy 3-Way Merge


By Bill Ritcher
Guiffy Software
Rev. 1.0


Abstract


SCM systems supporting concurrent development models have existed for a long time. Today, more
than ever, concurrent development is crucial to productivity. Any paradigm supporting concurrent



http://www.guiffy.com/help/GuiffyHelp/HowDoI.html

http://www.guiffy.com/help/GuiffyHelp/YourWay.html

http://www.guiffy.com/help/GuiffyHelp/Top10Tips.html

http://www.guiffy.com/help/GuiffyHelp/Control.html

http://www.guiffy.com/help/GuiffyHelp/View_Attr.html

http://www.guiffy.com/help/GuiffyHelp/View_Menu.html

http://www.guiffy.com/help/GuiffyHelp/Toolbar.html

http://www.guiffy.com/help/GuiffyHelp/Tool_Menu.html#searc

http://www.guiffy.com/help/GuiffyHelp/Toolbar.html

http://www.guiffy.com/help/GuiffyHelp/GuiffyCmd.html

http://www.guiffy.com/help/GuiffyHelp/GuiffyCmd.html

http://www.guiffy.com/help/GuiffyHelp/JiffCmd.html

http://www.guiffy.com/help/GuiffyHelp/WinExpCM.html

http://www.guiffy.com/help/GuiffyHelp/MacFinCM.html

http://www.guiffy.com/help/GuiffyHelp/LinKDECM.html

http://www.guiffy.com/help/GuiffyHelp/TeamFound.html

http://www.guiffy.com/help/GuiffyHelp/Uninstall.html
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development depends upon a trustworthy 3-way merge.


Although 3-way merge tools have been available for a long time, their trustworthiness has been
insufficient for a long time as well. This results in development environments with: a) concurrency
forbidden, b) "gotta-do-a-merge" blues, and/or c) additional CM staff to manually review all merge results.
All of these alternatives are productivity killers and feed the black hole where all theoretical ROI goes.


This paper describes an advanced 3-way merge solution. First, it discusses the many problems that
have plagued 3-way merge implementations -- test case kits are provided to detect their existence.
Then, it shows how solutions for these problems were designed and implemented in a working product,
Guiffy SureMerge.


1. Introduction


Tools which support concurrent development are more important today than ever before. Open Source
products, Offshore/Outsource development and maintenance, customer customization of packaged
application's procedures and/or metadata are among the most challenging concurrent development
environments. While a great deal of discussion about collaboration, XP, and Agility seems to assume
concurrency is practical and productive, very little discussion has occurred regarding these other
concurrent environments which are NOT collaborating. They are not collaborating in the sense that
developers making changes are for the most part unaware of each other. And, another significant
variance is the frequency of synchronization --- collaborating teams will tend to synchronize often while
these other more challenging types of concurrent environments will tend to synchronize infrequently.


In collaborating environments, changes are sometimes shared and then improved upon. These parallel
step-wise refinements can pose puzzling synchronization pattern challenges when they're "re-merged".


Any paradigm supporting concurrent development depends upon a trustworthy 3-way merge to automate
the synchronization process. In collaborating environments, the frequency of synchronization and team
awareness tend to minimize the concurrency problems which may occur. However, 3-way merges are
used to automate the process, regardless of the Branching Model [4] environment.


3-way merges take the original version of a file and two separate versions, and merge both sets of
changes back into a new file. The changes of each separate version are determined by comparing each
version with the original. The 3-way merge will automatically apply all the changes (which are not
overlapping) from each version. Then, if any changes were overlapping, those are brought to the attention
of the merge operator for resolution.
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SCM systems such as SCCS [2] and RCS [3] (plus dozens more based upon these tools) supporting
concurrent development models have existed for a long time. Although 3-way merge tools have been
available for a long time, their trustworthiness has been insufficient for a long time as well. These
problems can cause development environments to forbid concurrency --- which is not always possible
and counter-productive. When concurrency is supported in the environment, synchronization can
become a dreadful, depressing, counter-productive process for everyone involved. In some environments
the synchronization process is "managed" by the CM staff. This isolates the pain, but requires additional
CM resources.


This paper describes an advanced 3-way merge solution. First, it discusses the many problems that
have plagued 3-way merge implementations. Then, it shows how solutions for these problems were
designed and implemented in a working product, Guiffy SureMerge. Test case kits are provided to detect
the problems discussed and demonstrate the SureMerge solutions. It concludes with some observations
on the benefits of a trustworthy merge tool.


2. "Conflict" Definition


3-way merges look for "conflicts" defined as changes that overlap. However, implementations vary on
what is defined as an overlapping change. Some implementations do NOT treat lines inserted at the
same point in both version files as a conflict. Most of the time this may not be a problem, but you would
like to know and perhaps switch the order of inserted changes. On the other hand, if the inserted line(s)
in both versions are defining a new indexed value (i.e., a function number, message type, or error code,
etc.), both versions will be adding a new index definition with the same value. If these insertions are
automatically merged, the merged code will probably build properly, but one of the new indexed items
will NOT work. Because there is some central code like this in almost every product, it is important for
any trustworthy 3-way merge to consider inserts as potential conflicts.


The most dangerous deficiency found in some 3-way merges results in losing one of the version's
inserted changes.


The {1} Test Case Kit can be used to evaluate how a 3-way merge handles inserts at the same location.



http://www.guiffy.com/SureMergeWP.html#tck1
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3. Pathological Cases


The following scenarios pose challenging exceptions which are known to confuse some 3-way merges.
Sometimes, the 3-way merge identifies the conflict and non-conflicts satisfactorily, but it just looks
confusing. In the worst case scenario, the 3-way merge will become confused --- not identify a conflict,
lose a change, or auto-merge the wrong change.


3.1. BOF/EOF Stingers


For a variety of "reasons", 3-way merges can get confused by conflicting changes at the beginning or
end of the files. Some 3-way merges post-process their 3-way minimum lines of differences with
heuristics in order to improve their appearance or avoid problems caused by shifting unique anchors. If
they reach the beginning of the file while looking back or reach the end of file while looking forward, they
can "give up".


The {2} Test Case Kit can be used to evaluate how a 3-way merge handles changes in both versions at
the EOF.


3.2. Identical Twins


Most 3-way merges have been enhanced to recognize identical changes and not call them a conflict. If
the tool's merge result view is in reverse, though, such changes are usually visible and can be
distracting. 3-way reverse compare-merge result views may seem easier to understand in simple cases.
However, these reverse views (displaying all changes by both versions to the original) become so
confusing for complicated change patterns that users often quit the merge tool and do the job by hand.


Using a 3-way compare reverse view for merging is like driving down an Exit ramp in reverse.


The {3} Test Case Kit can be used to evaluate how a 3-way merge handles identical changes and how
they appear.


3.3. X-Tuplets


This change pattern usually started as identical twin changes shared in both versions. Then, some
further revisions are made in one or both versions. As a result, the identical change block contains a
(subset) change. Furthermore, it may even appear to be two or more subset changes within the area of
the original identical change when comparing version 1 with version 2.


The {4} Test Case Kit can be used to evaluate how a 3-way merge handles such change patterns.


3.4. Hungry Blobs


This change pattern includes separate changes in each version which are close or adjacent to each
other, resulting in one combined SureMerge "Attention". Such changes will usually not be detected as a
"conflict" in other 3-way merges and will be auto-merged.



http://www.guiffy.com/SureMergeWP.html#tck2

http://www.guiffy.com/SureMergeWP.html#tck3

http://www.guiffy.com/SureMergeWP.html#tck4
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The {5} Test Case Kit can be used to evaluate how a 3-way merge handles such change patterns.


4. SureMerge "Attentions" --- Beyond "Conflicts"


Guiffy's SureMerge considers changes of any type (NOT just lines changed). Likewise, SureMerge's
"Attention Focus" goes beyond looking for conflicts and catches changes which touch one another (but
don't overlap) or changes which are in close proximity to one another.


4.1. Minimum Blocks of Difference


Guiffy's SureMerge is based upon a special proprietary algorithm designed for the problems inherent in
smart merging. Other 3-way merges just apply the published compare algorithm [1] which they use 3
ways. Applying these "unique anchor" minimum lines of difference algorithms 3 ways is the fundamental
cause of most of the pathological problems discussed above. Indeed, the authors of those algorithms
have acknowledged that the "the 3-way merge is problematic and was not considered when designing
the compare algorithm". In other words, it will not work sometimes, and any post-processing attempts
will be "problematic" (not work in some cases).


4.2. 3-Way Auto Focus


SureMerge's Minimum Blocks of Difference algorithm tends to express the differences in fewer change
blocks (by treating separate changes close to each other as one change block). This naturally results in
expanded Attention Focus areas depending upon the size of the change. Moreover, a user control option
is provided to expand the Attention Focus (if you want to be extra sure).


This screen shows how a typical 3-way merge would auto-merge two changes (one from each version)
without seeing a "conflict".


And, this screen shows how SureMerge's Auto Focus would identify the changes as an "Attention". Just
one click of a button would keep the first two lines from the first version or the last two lines from the
second version.


5. Conclusion


The problems discussed in this paper have plagued 3-way merge tools for many years resulting in the



http://www.guiffy.com/SureMergeWP.html#tck5
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general warning from experienced veterans to "be careful when you do that merge". To avoid these
hazards, some folks resort to forbidding concurrent development completely or declare temporary
periods of "code freezes", which can last for weeks or months while CM/QA/Development do the release
"rain dance". In other environments concurrency is allowed, but everyone faces the dreaded merge
process. In larger organizations, additional CM staff are sometimes tasked with performing and/or
manually reviewing all the merges.


Guiffy SureMerge avoids all these hazards and provides a trustworthy 3-way merge capability. It can
make the difference between forbidding or embracing concurrent development. It can eliminate the
"dreaded merge blues".    It can shorten the time required for CM to package bug fix builds or synch up
a new release.


In today's world, "merge projects" to upgrade customizations with a new Open Source or packaged
product releases can take a team weeks to complete without a trustworthy 3-way merge. Teams using
Guiffy SureMerge have completed merge projects in half the time (sometimes less).


6. Test Case Kits


Each test case has 3 files: the two versions and the parent (common ancestor or original). The files are
named with extensions .1st, .2nd, and .parent. To aquaint yourself with each test case, begin by
comparing the parent and 1st, then compare the parent and 2nd. Then, perform the 3-way merge.


{1} Conflict Definition and Inserts:  conins.zip
This kit includes two test cases for lines inserted in each version at the the same point. The
FlownetController.cpp files are an example from the real world of two concurrent changes adding different
code at the same locations. The ErrorMsg.java files are an example of two concurrent changes adding
error message types with the same value.


{2} BOF/EOF Stingers:  eofsting.zip
This test case includes changes at the Beginning and End of File (BOF/EOF) in each version. In both
the 1st and 2nd Misc.java.versions code is added at the beginning and end of the file.


{3} Identical Twins:  idtwins.zip
This test case includes identical changes in each version. In both the 1st and 2nd About.java versions
line 7 in the parent was changed and a line was added after that. These two lines are identical in 1st and
2nd. The 2nd version has an additional change --- it //ed several lines near the end.


{4} X-Tuplets:  tuplets.zip
This test case includes a similar change in each version that was shared to begin with, then slightly
modified, resulting in 2 conflict/Attentions. In both the 1st and 2nd getCLIArgs.java versions a change
block added the code for processing the -fb and -fe arguments. Then, in the 2nd version, improvements
are made within that code. Other changes are made in both versions to be realistic and provide addtional
test validation points.


{5} Hungry Blobs:  blobs.zip
This test case includes separate changes in each version which are adjacent to each other, resulting in
one combined "Attention". In the RearViewMirror 1st version line 7 is changed to add an if condition. In
the RearViewMirror 2nd version line 6 is changed to add the sane condition in an exsiting if statement.
SureMerge's Auto Focus identifies the changes as an "Attention". Just one click of a button would keep
the first version or the second version.
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28.3 Guiffy Frequently Asked Questions


Guiffy Frequently Asked Questions


Q: How do you pronounce Guiffy?
I pronounce Guiffy like "Goofy". I know, it sounds bad and it takes alot of guts to say "Goofy" or "Goofy
Software". But, if you don't have alot of guts, you shouldn't be a Micro ISV. And, you shouldn't tackle a
problem that has puzzled tool vendors for 20 years --- the auto, 3-way merge.


Anyway, if you have a problem telling your boss or other folks that you use or recommend purchasing
"Goofy Software's product" --- You can always pronounce it some other way and/or say SureMerge.


As our White Paper explains --- Guiffy SureMerge isn't "goofy" at all... But, there are some "goofy" auto
merge things out there.


BTW: Guiffy kinda comes from --- GUI diFF and 3-waY merge.


Q: Guiffy hangs when I try to do a BIG folder compare with 1000s of files/subfolders.
You need to allow Guiffy to allocate more memory (heap space). See Tech Note 3 (also in Guiffy's
application Help) on how to increase the maximum heap size.


Q: Guiffy installer doesn't work on RedHat or Fedora Core Linux.
The "java" packaged with Fedora Core and RedHat Linux isn't a "standard" Java. You need to either 1)
Download and install the Java for Linux from Sun (make sure you replace the path for SUN's Java or 2)
Download the Guiffy install package for Linux X86 with the JRE included.


Q: Guiffy installer doesn't work on Ubuntu or Debian Linux.
The "java" packaged with Debian and Ubuntu Linux is the GNU gij tool - which does NOT support the
GUI AWT/Swing packages. You need to either 1) Download and install the Java for Linux from Sun
(make sure you replace the path for SUN's Java or 2) Download the Guiffy install package for Linux X86
with the JRE included.


Q: Guiffy doesn't display my file compare correctly - shows little box characters or "garbage".
You need to specify the Encoding format of your files and select a Unicode font. See: Options ->
Encoding(Charsets)... and Options -> Font...


Q: Guiffy's menus don't display the shortcuts (Mnemonics) underlined on Windows.
On newer Windows --- 2000, XP, 2003... there's a new Display control for hiding keyboard navigation
indicators. The exact location and name of the control may vary depending upon the release of
Windows. On XP in Control Panel, Display, Effects, Click to clear the Hide keyboard navigation
indicators ... check box, and then click OK. On other releases, in the Control Panel Help, search for
Hide Navigation to find the property.



http://www.guiffy.com/help/GuiffyHelp/Technot3.html
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Q: Guiffy's screen flickers and it responds very slowly to window resizes and the UI in general
is just very slow.
This problem has to do with your video driver and the way Java's screenio works. First, make sure you
have the latest driver for your video interface.


If the problem still exists with the latest driver installed for your video interface, check which release of
Java Guiffy is using - this is displayed in Guiffy's Help About dialog. If you're not using the latest release
of Java for your platform, download and install the latest release of Java. Then, re-install Guiffy and select
the newest release of Java just installed on your system during Guiffy's install.


If the problem still exists, disabling Java's direct draw hardware acceleration will usually fix the problem.
To disable direct draw, edit the guiffy.lax file in Guiffy's install folder as follows:


After the LAX.COMMAND.LINE.ARGS line:


lax.command.line.args=$CMD_LINE_ARGUMENTS$


add the line:


lax.nl.java.option.additional=-Dsun.java2d.noddraw=true


Q: On MacOS X, My mouswheel doesn't work.
The scrollwheel support was added in the 1.4 Java release. On MacOS X you usually have 2 Java's pre-
installed (1.3 and 1.4) with 1.3 being the default. Guiffy's Help dialog displays the JRE it is using.


To switch Guiffy to using the 1.4 JRE you need to edit the application package:


1) Control click on guiffy.application
2) Click on Show Package Contents
3) Click on Contents folder
4) Click on Info.plist
5) Edit Root/Java/JVM Version (double-click on value, set it to 1.4.*)


Q: The Guiffy downloads for Linux or Unix don't work. It just displays the text of the file (shell
script and then jibberish). I'm using MicroSoft's Internet Explorer to download for a Linux or
Unix platform. Whats wrong?
MS Internet Explorer is not aware of the .bin file type. The .bin file type is recognized by all other
browsers we've tested. Either use another browser on Windows to do the download or make a copy of
the ftp download url and use an ftp client to do the download. Or, do the download from your Linux or
Unix platform.


Q: The Guiffy install gets the following error - on my Unix/Linux system, whats wrong?
java.lang.NoClassDefFoundError:com/zerog/lax/LAX
This problem is caused by one of the following:


- JDK(or JRE)/bin is not included in your PATH environment variable
- The JAVA_HOME environment variable is set incorrectly or a symbolic link to the JDK/JRE conflicts
with the location for JAVA_HOME
- No JDK/JRE has been installed on your system


Q: How do I compare a whole file tree - instead of just one folder?
Options -> Folder Show... Show SubFolders (Recursively)
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Q: Guiffy doesn't work on my system when the local language isn't English.
Your Java runtime environment doesn't support your locale. Download and install an Internationl JRE for
your system, then re-install Guiffy using your Internationl JRE. Note: This will also make additional File
Encoding formats (for Asia etc.) available. Our download page has links for JRE providers: www.guiffy.
com/download/download


Q: I downloaded the Mac install file, it doesn't work on my Mac, what's wrong?
The Mac installer built with InstallAnywhere is created in MacBinary format so it can be easily
transported to diffferent operating systems. However, this means that the installer cannot be run directly
by double-clicking on it; it needs to be "de-MacBinaried" first via a tool like StuffitExpander 4.5.
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29 SSH and Razor for UNIX/Linux/Windows remote
clients


See following sub sections below:


üUNIX/Linux
üWindows
üRazor Remote CLI


29.1 UNIX/Linux


SSH AND RAZOR


The Razor 5.2 release introduces two elements that rely upon ssh.  The Razor remote command-line
extends a subset of the Razor 'local' command-line to remote users via ssh.  The ssh tool provides an
alternative approach to authenticating remote users against the local password file via 'rexec'.


OVERVIEW


The basic idea is to have each remote user create a public/private key pair as well as a passphrase. The
private key is retained on the host from which the remote Razor Versions, Issues, or Threads client will
be run.  The corresponding public key is installed on the Razor License Manager host.  The user will
provide the (optional) passphrase to indicate that they are the rightful owner of the keys.


Through the use of an ssh agent, the remote Razor user can avoid having to authenticate themselves
multiple times as they attempt to connect to remote Razor servers via remote command-line, Versions,
Threads, and/or Issues.


SSH SETUP


Each remote Razor user must create a public/private key pair.  Most non-Windows platforms include a
variant of the OpenSSH toolset.  This toolset includes utilities for generating a key pair.  The most
common utility is the 'ssh-kegen' tool.


Here's how the utility is used to generate a public/private key pair incorporating RSA encryption:


glscg5:brian$ ssh-keygen -t rsa
Generating public/private rsa key pair.
Enter file in which to save the key (/Users/brian/.ssh/id_rsa): 
Enter passphrase (empty for no passphrase): <<ENTER YOUR PASSPHRASE>>
Enter same passphrase again: <<ENTER YOUR PASSPHRASE>>
Your identification has been saved in /Users/brian/.ssh/id_rsa.
Your public key has been saved in /Users/brian/.ssh/id_rsa.pub.
The key fingerprint is:
27:1d:93:55:bc:1a:51:ea:85:ef:08:ce:39:97:5f:4a brian@glscg5.local


Let's review what we have.  The 'public' key has been saved as 'id_rsa.pub'.  This key will need to be
installed on the Razor License Manager host.  The corresponding private key has been saved as 'id_rsa'.
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 This key is NOT to be distributed.  The private key is also protected with the passphrase that you have
provided.


glscg5:brian$ cat id_rsa
-----BEGIN RSA PRIVATE KEY-----
Proc-Type: 4,ENCRYPTED
DEK-Info: DES-EDE3-CBC,3F220DB6D177D05E

-----END RSA PRIVATE KEY-----


glscg5:brian$ cat id_rsa.pub
ssh-rsa
AAAAB3NzaC1yc2EAAAABIwAAAQEAsWR1H91G25o6QAaHcuxuIYPBamjvS0ZZAXhVG6YXI5uevv/
rLKDkxqkwJs8cLvVfMpw7b40AERa1Tun8lOihZzuj3+LSr56ygI8M+6rFsz3/PXVXxsv0Kv
+mGfpugGyYkZZChwOiSiVaywEGEZ5Ndz8STIj6BGCUh7/rkF81+h+V5JCb/B2FzH/huww/6EMu/x87qs
+LFr/dll0RVwYmFdAoWude4Vm8mNVir23zwzgMJtqIVj//wShW6Pi7YOAF6swMGpLiZ2
+QK8GRlGCA3OJfINtVqFM+Llt6hR8mRG7h6RtF7fXdoEXCoOV7vkzSV4Utu7TWU/EuXrLmSePGIQ==
brian@glscg5.local


INSTALLING YOUR PUBLIC KEY


Your public key will need to be installed on the server that you will be connecting to via ssh.
Authenticating remote Issues, Versions, and/or Threads users against the local password file will require
that you install your public key on the Razor License Manager host.


Accessing your your Razor Database Manager via the Razor remote command-line will require that you
install your public key on the DB host.  If the Razor License and Database Managers are co-located
you'll need to install the key in a single location.
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You'll want to make a copy of your public key (id_rsa.pub) and place it on the server.  You must have an
account on the server that you'll be connecting to via ssh.  Once you have your key file on the server
you'll need to add its contents to your 'authorized_keys' file, i.e. $HOME/.ssh/authorized_keys.


If you've used ssh on the server file before then you'll already have an authorized_keys file.  You'll simply
append your public key file to the authorized_keys file.  


If you've never used ssh on the server you'll have some additional setup work to do.  Let's look at what is
required:


$ cd $HOME
$ mkdir .ssh
$ chmod 700 .ssh
$ cd .ssh
$ cat id_rsa.pub >> authorized_keys
$ chmod 600 authorized_keys


CONFIGURING SERVER SSH POLICIES


You'll need to work with the server's system admin to enable support for ssh as applicable.  The server's
'sshd_config' file is the place to start.  By convention all of the default values are commented out via "#"
token.  


Here are the more notable entries from the sshd_config template:


PubkeyAuthentication yes
AuthorizedKeysFile   .ssh/authorized_keys
AllowUsers  <<Your account>>


You'll need to make your changes and restart the ssh daemon.


TEST DRIVING SSH


Once you've installed your public key and enabled ssh on the server you'll want to try to ssh into the
remote server to validate your setup.  There's no point trying to utilize the Razor remote command-line or
authenticate via ssh until you've convinced yourself that you ssh setup is working.


glscg5:brian$  ssh <<Razor LM server host>>
Enter passphrase for key '/Users/brian/.ssh/id_rsa':<<ENTER PASSPHRASE>>
Last login: Thu Aug  9 15:51:50 2007 from glscg5
[brian@GlscLinux ~]$


At this point you have a terminal on the remote Razor LM host.  


In the event that ssh fails, you'll want to work with server sys admin to troubleshoot.  There are a few
places to start.  


On the server side you'll want to:


- Review sshd_config file
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- Review firewall configuration to verify that ssh is enabled
- Verify that the ssh daemon (sshd) is running
- Check the log files to see why access is denied


On the client side you'll want to:


- Review firewall configuration to verify that outgoing ssh connection is allowed
- Attempt to start the ssh connection using 'verbose' mode to see debugging info.  Use "ssh -v <<LM
host>>"


CONFIGURING SSH-AGENT


When the remote Razor client attempts to authenticate the user via ssh there is not opportunity for the
user to enter the ssh passphrase.  Therefore, the user must setup an ssh agent to effectively cache the
passphrase ahead of time.  Once the agent is started it will step in and complete the ssh authentication
on your behalf without having to reenter the passphrase.  


The agent is started via the command-line.  The ssh-agent options  will vary depending upon the shell
that the agent is launched from.  See the ssh-agent man pages for details.


When using a C-shell:


$ eval ̀ ssh-agent -c`
Agent pid 7398


When using a Bourne-shell:


$ eval `ssh-agent -s`  
Agent pid 7399


Before the agent can step-in you need to authenticate yourself just once:


$ssh-add


Enter passphrase for /Users/brian/.ssh/id_rsa: <<ENTER PASSPHRASE>>


Identity added: /Users/brian/.ssh/id_rsa (/Users/brian/.ssh/id_rsa)


Confirm that the agent is holding our private key for public key authentication.


$ssh-add -l
2048 b4:0e:22:7a:86:15:a8:73:3f:81:22:4d:e7:f0:d0:a6 /Users/brian/.ssh/id_rsa (RSA)


Let's verify that the ssh agent is ready to step up.
glscg5:brian% ssh glsclinux
Last login: Thu Aug  9 21:47:20 2007 from glscg5


If all is well, you should be connected directly to the remote server without having to provide your ssh
passphrase.


At this point all ssh-aware applications including the Razor remote clients, Razor remote command-line
will work with the ssh agent to obtain the necessary authentication without bothering the user for the
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passphrase.


It should be noted that the scope of the agent is limited to ssh-aware applications started from the
SAME terminal that the agent was started in.  If additional terminals are needed you'll need to start an
agent instance in each terminal.


USING SSH TO AUTHENTICATE REMOTE ISSUES, VERSIONS, THREADS USERS


By default the remote Issues, Versions, and Threads clients will seek authenticate against the local
password file using 'rexec' rather than ssh.  To override the default value, the
'RAZOR_USE_SSH_REMOTE_AUTH' environment variable must be set prior to launching the Razor
remote client(s).


FURTHER INFORMATION


The man pages for ssh, ssh-keygen, ssh-agent, ssh-add.
OpenSSH website (http://www.openssh.org)
SSH User Identities white paper (http://www.securityfocus.com/infocus/1810)
SSH and ssh-agent white paper (http://www.securityfocus.com/infocus/1812)


29.2 Windows


Windows


SSH AND RAZOR


The Razor 5.2 release introduces two elements that rely upon ssh.  The Razor remote command-line
extends a subset of the Razor 'local' command-line to remote users via ssh.  The ssh tool provides an
alternative approach to authenticating remote users against the local password file via 'rexec'.


OVERVIEW


The basic idea is to have each remote user create a public/private key pair as well as a passphrase. The
private key is retained on the host from which the remote Razor Versions, Issues, or Threads client will
be run.  The corresponding public key is installed on the Razor License Manager host.  The user will
provide the (optional) passphrase to indicate that they are the rightful owner of the keys.


Through the use of an ssh agent, the remote Razor user can avoid having to authenticate themselves
multiple times as they attempt to connect to remote Razor servers via remote command-line, Versions,
Threads, and/or Issues.


OBTAINING PuTTY TOOLSET


Most non-Windows platforms include a variant of the OpenSSH toolset.  For Windows, the PuTTY
toolset will be used.  The toolset can be downloaded from:


http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html


In particular the 'puttygen.exe', 'plink.exe', and 'pageant.exe' tools will be required.  These tools can be



http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html
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downloaded from the PuTTY site individually are as a bundle.


For purposes of example, the PuTTy tools have been installed in C:\PuttyTools.


SSH SETUP


Each remote Razor user mush create a public/private key pair.  The PuTTY toolset includes the
'puttygen.exe' utility for generating a key pair.


1) Launch the C:\PuttyTools\puttygen.exe tool.  
2) Select the 'Generate' button.
3) Move the mouse about the GUI's blank area to add a unique, random element to the key generation
process.
4) The key generation can take several minutes to complete.
5) When key generation is complete, the GUI will display the public key, key fingerprint, key comment,
as well as
fields for specifying and confirming the key 'passphrase'.
6) Specify a 'passphrase' that will be used to safegard your key.  The passphrase should be handled
like a account password.  For our example, a passphrase of "Over the hills and through the woods".
7) Select the 'Save public key' button to create a local copy of the key, e.g. C:\PuttyTools
\puttyXpPublicKey.
8) Select the 'Save private key' button to create a local copy of the key, e.g. C:\PuttyTools
\puttyXpPrivateKey.ppk
9) Razor may not be able to locate the PuTTY tools even if their installation directory is included in your
PATH.
Define a new environment variable, RAZOR_PUTTY_INSTALL_DIR, to specify where the PuTTY utilities
have been
installed, e.g. C:\PuttyTools


Let's review what we have.  The 'public' key has been saved as 'C:\PuttyTools\puttyXpPublicKey'.  This
key will need to be installed on the Razor License Manager host.  The corresponding private key has
been saved as 'C:\PuttyTools\putty\XpPrivateKey.ppk'.  This key is NOT to be distributed.  The private
key is also protected with the passphrase that you have provided.


INSTALLING YOUR PUBLIC KEY


Your public key will need to be installed on the server that you will be connecting to via ssh.
Authenticating remote Issues, Versions, and/or Threads users against the local password file will require
that you install your public key on the Razor License Manager host.


Accessing your your Razor Database Manager via the Razor remote command-line will require that you
install your public key on the DB host.  If the Razor License and Database Managers are co-located
you'll need to install the key in a single location.


You must have an account on the server that you'll be connecting to via ssh.  Once you have your key
file on the server you'll need to add its contents to your 'authorized_keys' file, i.e. $HOME/.ssh/
authorized_keys.


If you've used ssh on the server file before then you'll already have an authorized_keys file.  You'll simply
append your public key file to the authorized_keys file.  
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If you've never used ssh on the server you'll have some additional setup work to do.  Let's look at what is
required:


Establish a ssh connection to the server host using the PuTTY (C:\PuttyTools\putty.exe) tool.  Specify
the IP address of the server.  Login using username and password.


$ cd $HOME
$ mkdir .ssh
$ chmod 700 .ssh
$ cd .ssh
$ cp authorized_keys authorized_keys.<ddMMyyyy>
$ vi authorized_keys
<< Insert the public key by inserting the text in the 'PuTTY Key Generator' GUI's 'Public key for pasting
into
OpenSSH authorized_keys file:' window.  Save the file and verify that the new key was (pre)appended
properly.  There
should be one key entry per line. >>
$ chmod 600 authorized_keys


CONFIGURING SERVER SSH POLICIES


You'll need to work with the server's system admin to enable support for ssh as applicable.  The server's
'sshd_config' file is the place to start.  By convention all of the default values are commented out via "#"
token.  


Here are the more notable entries from the sshd_config template:


PubkeyAuthentication yes
AuthorizedKeysFile   .ssh/authorized_keys
AllowUsers  <<Your account>>


You'll need to make your changes and restart the ssh daemon.


CONFIGURING PuTTY's SSH-AGENT, PAGEANT


When the remote Razor client attempts to authenticate the user via ssh there is not opportunity for the
user to enter the ssh passphrase.  Therefore, the user must setup an ssh agent to effectively cache the
passphrase ahead of time.  Once the agent is started it will step in and complete the ssh authentication
on your behalf without having to reenter the passphrase.  


The agent is started by double-clicking C:\PuttyTools\pagent.exe.  You'll want to use the 'Add Key'
button to browse to your private key (C:\PuttyTools\puttyXpPrivatekey.ppk) and specify your passphrase
("Over the hills and through the woods").


At this point all ssh-aware applications including the Razor remote clients, Razor remote command-line
will work with the ssh agent to obtain the necessary authentication without bothering the user for the
passphrase.


TEST DRIVING SSH
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Once you've installed your public key and enabled ssh on the server you'll want to try to ssh into the
remote server to validate your setup.  There's no point trying to utilize the Razor remote command-line or
authenticate via ssh until you've convinced yourself that you ssh setup is working.


Open a Windows command prompt window.  We'll use PuTTY's 'plink' tool to run a command on the
server via ssh.


From the command line, enter:


C:\PuttyTools\plink -ssh -agent -i C:\PuttyTools\puttyXpPrivatekey.ppk <username>@<server IP addr>
<cmdn>


E.g. "C:\PuttyTools\plink -ssh -agent -i C:\PuttyTools\puttyXpPrivatekey.ppk brian@192.168.1.113
uname -a"


The plink tool should run your command directly on the the remote server.  Since the the pageant tool is
holding your authenticated key you should not be prompted for the passphrase.


In the event that ssh fails, you'll want to work with server sys admin to troubleshoot.  There are a few
places to start.  


On the server side you'll want to:


- Review sshd_config file
- Review firewall configuration to verify that ssh is enabled
- Verify that the ssh daemon (sshd) is running
- Check the log files to see why access is denied


On the client side you'll want to:


- Review firewall configuration to verify that outgoing ssh connection is allowed
- Attempt to start the ssh connection using 'verbose' mode to see debugging info.  Use "ssh -v <<LM
host>>"


USING SSH TO AUTHENTICATE REMOTE ISSUES, VERSIONS, THREADS USERS


By default the remote Issues, Versions, and Threads clients will seek authenticate against the local
password file using 'rexec' rather than ssh.  To override the default value, the
'RAZOR_USE_SSH_REMOTE_AUTH' environment variable must be set prior to launching the Razor
remote client(s).


FURTHER INFORMATION


The PuTTY help.  Select 'Help' button in pagent, puttygen, or putty tools.
The man pages for ssh, ssh-keygen, ssh-agent, ssh-add.
OpenSSH website (http://www.openssh.org)
SSH User Identities white paper (http://www.securityfocus.com/infocus/1810)
SSH and ssh-agent white paper (http://www.securityfocus.com/infocus/1812)


----------------------------------------------------------------------
----------------------------------------------------------------------
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CONFIGURING AN SSH SERVER FOR WINDOWS-BASED RAZOR SERVER


The previous portions of the README file discuss how to configure and operate an ssh client under
Windows.


The Razor remote command-line interface (CLI) interacts with a remote Razor server using the
OpenSSH, ssh and scp tools for authentication, execution of remote commands, and file transfers.


Use of the remote CLI requires that the Razor server operate an ssh server.  Most non-Windows
platforms include a variant of the OpenSSH server as part of the basic installation.


If your Razor server is hosted on a Windows platform you'll need to do a fair amount of work to get an
ssh server installed.  An OpenSSH server can be installed on your Windows host.


The following article provides an excellent procedure for installing, configuring, and testing your
OpenSSH installation on Windows.


http://pigtail.net/LRP/printsrv/cygwin-sshd.html


29.3 Razor Remote CLI


The Razor remote command-line interface (CLI) allows a subset of the razor 'local' command-line
functionality to be executed on a machine other than the Razor server host. The Razor remote CLI is
supports UNIX clients, Windows clients, UNIX-based Razor servers, and Windows-based Razor servers. 


The remote CLI currently requires ssh, i.e. secure shell, for use in executing commands on the remote
Razor server host machine.  The remote CLI currently requires 'scp', i.e. secure copy, for use in
uploading/downloading files to/from the remote Razor server.


Rather than requiring the user to specify ssh-related and scp-related arguments on the command-line for
each operation, the CLI makes use of 'remote database connection profiles'. A given profile caches all of
the information necessary to execute Razor commands remotely for a given Razor DB.  A user may
create multiple profiles for working with multiple Razor DBs.  A particular profile could be referenced on
the remote CLI to indicate the
applicable Razor DB.  In the absence of a specified profile, the default profile,
$HOME/.defaultRmtRzConnProfile.xml is used.  It should be noted that the default profile can
only reference a *single* Razor database.


Here's how a profile could be created for use by an Apple OS X client to run the Razor 
command-line remotely on a Linux-based Razor server.


razorRemote -c make_profile -conn /usr/bin/ssh -port 22 -copy /usr/bin/scp -host Glsclinux 
    -prep /usr/local/razoradm/razor_db/db1/rz_prep.sh -tmp /home/brian/tmp/cli


NOTE:  As no '-f' option was specified the profile is saved as $HOME/.defaultRmtRzConnProfile
NOTE:  The scp, ssh commands specify the command for execution on the CLIENT
NOTE:  The 'prep' option specifies the filename of the Razor DB prep file on the remote server
NOTE:  The 'tmp' option specifies the tmp directory on the REMOTE server


Let's dump the profile created in the previous example:


razorRemote -c view_profile



http://pigtail.net/LRP/printsrv/cygwin-sshd.html
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profile: [/Users/brian/.defaultRmtRzConnProfile.xml] conn: [/usr/bin/ssh] connOptions: [] xfer: [/usr/bin/
scp] xferOptions: [] user: [brian] host: [glsclinux] licenseDir: [/usr/local/razoradm/Razor_lm] razorHome:
[/usr/local/razoradm/Razor] userHome: [/Users/brian] prep: [/usr/local/razoradm/razor_db/db1/rz_prep.
sh] rmtTmpDir: [/usr/local/rztmp/remote]] JVM: [1.5.0_07-87] OS: [Mac OS X;10.4.9;ppc]


Usage:
    razorRemote -c  make_profile -conn <connMethod> [-connOpts <options>]
                                 -copy <copyMethod> [-copyOpts <options>] -host <hostname> [-user
<username>]
                                 -prep <prepFile> -tmp <tmpDir> -razorHome <RemotePath> -licenseDir
<RemotePath>
                                 [-f <profile>] [-dbgLevel <level>]
    razorRemote -c  view_profile [-f <profile>] [-dbgLevel <level>] 


Options:
       -c
               make_profile - Create default or named remote Razor DB connection profile for use with
                              subsequent remote command-line operations.  
               view_profile - View contents of default or specified remote Razor DB connection profile


       -conn      Connection method to be used to connect to remote Razor DB host.  E.g. 'ssh'
       -connOpts  Connection method optional parameters
       -copy      Copy method used to upload/download files to/from remote DB.  E.g. 'scp'
       -copyOpts  Copy method optional parameters
       -host      Remote Razor DB hostname.  Remote Razor command-line will execute 'local' razor
                  commands on this host
       -user      Username for Razor operations
       -prep      Specifies rz_prep filename for specific remote Razor DB to be used.


  NOTE:  If the login shell being used by the remote user is Bourne-shell based
   the Bourne-shell based 'rz_prep.sh' prep file should be utilized.  Otherwise, if


  a csh-based shell is used the csh-based 'rz_prep' prep file should be utilized.
       -tmp       Specifies temporary, working directory located on remote host
       -razorHome Specifies RAZOR_HOME on remote host
       -licenseDir Specifies RAZOR_LICENSE_DIR on remote host
       -f         Remote Razor DB connection profile filename.  If no filename is specified, the default
                  profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel  Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


    razorRemote -admin id                     - Display license id information
    razorRemote -admin license_info           - View license information
    razorRemote -admin version                - Display the current version information


    razorRemote -admin info                   - Displays connections to all db servers
    razorRemote -admin who                    - Display current connections to db server


File operations:


  razorRemote -c ci         -f <file> -g <group> [-d dir] -t <title> [-i <issue[<:issue group>]>[,<issue[<:
issue group>]]] [-p <file>] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c co         -f <file> -g <group> [-d dir] -t <title> [-o] [-i <issue[<:issue group>]>[,<issue[<:
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issue group>]]] [-p <file>] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c un_co      -f <file> -g <group> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c intro      -f <file> -g <group> [-b] [-k] [-d folder] [-i <issue[<:issue group>]>[,<issue[<:
issue group>]]] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c branch     -f <file> -g <group> [-v version] -t <title> [-i <issue[<:issue group>]>[,<issue
[<:issue group>]]] [-p <file>] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c terminate  -f <file> -g <group> -v <version> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c get        -f <file> -g <group> [-v version] [[-d dir] [-o] | [-z]] [-profile <file>] [-dbgLevel
<level>]
  razorRemote -c get_issue  -f <issue> [-v version] [-g <issue group>] [[-d dir] [-o] | [-z]] [-profile <file>] [-
dbgLevel <level>]
  razorRemote -c new_folder -f <folder> -g <group> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c rename     -f <name> -g <group> -n <new_name> [-profile <file>] [-dbgLevel <level>]
  razorRemote -c rm         -f <file> -g <group> [-i <issue[<:issue group>]>] [-q] [-profile <file>] [-dbgLevel
<level>]
  razorRemote -c rm_folder  -f <folder> -g <group> [-i <issue[<:issue group>]>] [-q] [-profile <file>] [-
dbgLevel <level>]
  razorRemote -c rm_issue   -f <issue> [-g <issue group>] [-q] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c modify_issue  -f <issue> [-g <issue group>] -a <attribute name:attribute value> [-profile
<file>] [-dbgLevel <level>]
  razorRemote -c promote    -f <file> -v <version> -s <state> -g <group> [-i <issue[<:issue group>]>[,
<issue[<:issue group>]]] [-profile <file>] [-dbgLevel <level>]
  razorRemote -c promote_issue   -f <issue> -s <state> [-g <issue group>] [-profile <file>] [-dbgLevel
<level>]
  razorRemote -c dup        -f <thread> -n <new name> -g <group> -t <title> [-i <issue[<:issue group>]>]
[-profile <file>] [-dbgLevel <level>]
  razorRemote -c bump       -f <file> -g <group> -t <title> [-r <new major>] [-i <issue[<:issue group>]>[,
<issue[<:issue group>]]] [-profile <file>] [-dbgLevel <level>]
 
Options:
       -c
               ci         - Check the specified <file> in.
               co         - Check the specified <file> out.
               un_co      - Un-check out the specified <file>.
               intro      - Introduce the specified <file>
               branch     - Branch the specified <file>
               terminate  - Terminate branch specified by <version> of <file>
               get        - Get a read only copy of the specified <file>.
               get_issue  - Get a read only copy of the specified Issue.
               new_folder - Create a folder.
               rename     - Rename a file or folder.
               rm         - Remove the specified file.
               rm_folder  - Remove the specified folder and all of its files.
               rm_issue   - Remove the specified Issue.
               modify_issue   - Modify the specified Issue.
               promote    - Promote the file to the specified state.
               promote_issue  - Promote the issue to the specified state.
               dup        - Duplicate the contents of the specified thread.
               bump       - Bump the major version of the specified file.
                            The default is to increment the major version by
                            one unless -r <new major> is specified.


       -a      Attribute name, value pair
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               For TIME_STAMP attributes must use same format as specified
               in Attributes file.
               For TEXT_PANE attributes must specify attribute value as file
               to replace (Writeable TEXT_PANEs) or append to (AppendOnly
               TEXT_PANEs) current text pane contents.
       -b      Use binary archival.
       -d      Optional directory to put/get file.  If none specified, use
               current directory.  For file introduction this name will
               represent the folder to introduce the file to.
       -f      Name of file on which to perform operation.
       -g      Name of group to which file belongs.  For issues commands,
               the <issue group> is the name of the group which appears
               in the issues Group pulldown.  For the main issues group,
               no group name should be entered.
       -i      An issue to relate to the operation.  More than one -i <issue>
               may appear on a line.  If the issue is in the default
               issue group, no <issue group> should be specified.  For other
               issue groups, the issue number must be followed by 
                       :<issue group>
               where <issue group> is the name that appears in the Group
               pulldown of issues.
       -k      Set file property such that keyword expansion is disabled.
       -n      New name.
       -o      Force overwrite of existing files.
       -p      File containing description text (prose).
       -q      No interactive query.  Do not ask user to confirm operation
       -r      Major revision number.
       -s      The state used for promotion.
       -t      Title for operation.
       -v      Version.
       -z      For get and get_issue operations, send output to stdout
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


Creating thread scripts:


    razorRemote -c thread -f <file> -g <group> [-t top dir] [-v version] [-d dir] [-o]  [-profile <file>] [-dbgLevel
<level>]
    Options:
       -c thread       -Generate a thread script.
       -d              -Optional directory to write script to.  If none 
                        specified, current directory will be used.
       -f              -Name of thread to generate script from.
       -g              -Name of group to which thread belongs.
       -t              -Optional top level directory to populate in script.
                        If none specified, $HOME will be used.
       -v              -Optional version of thread to generate script from.
                        If none specified, latest version will be used.
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'
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Comparing two versions of a thread or two different threads:


    razorRemote -c thread_compare -f <thread> [-f <thread>] -g <group> [-v <v1>] [-v <v2>] [-profile <file>]
[-dbgLevel <level>]
   
Options:


       -f              -Name of thread to compare.  If two thread names
                        are specified, the specified version of each thread
                        will be used.
       -g              -Name of group to which thread belongs.
       -v              -Version to compare.  If one version is specified.
                        the latest version will be used.
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


Creating a thread:


    razorRemote -c new_thread -f <name> -g <group> [-n <file>] [-i <issue[<:issue group>]>] [-m] [-profile
<file>] [-dbgLevel <level>]


Options:


       -c new_thread   -Create a thread.
       -f              -Name of new thread.
                        For threads, file contains 3 fields of:
                           < + | - >  <file>  <version>
                        where '+' indicates inclusion, '-' exclusion.
       -g              -Name of group to which thread belongs.
       -i              -An issue to relate this operation to.  See the '-i'
                        description above for more details.
       -m              -Allow multiple versions of a file (trunk/branch)
                        to be included in the thread .
       -n              -Alternate name of list file.  <name> is the default,
                        file should be in the format described for -f
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


Thread and project editing:


    razorRemote -c modify -f <name> -g <group> -t <title> [-v <ver>] [-p <file>] [-n <file>] [-i <issue[<:
issue group>]>] [-m] [-profile <file>] [-dbgLevel <level>]


Options:


       -c modify       -Modify a thread or project.
       -f              -Name of thread or project to edit.
                        For threads, file contains 3 fields of:
                           < + | - >  <file>  <version>
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                        For projects, file contains 4 fields of:
                           < + | - >  <thread>  <group>  <version>
                        where '+' indicates inclusion, '-' exclusion.
       -g              -Name of group to which thread belongs or ++PROJECT++.
       -n              -Alternate name of change file.  <name> is the default
       -p              -File containing description text (prose).
       -v              -Modify the specified version.  If no version is
                        specified, the latest version will be modified.
       -t              -Title for the modification
       -i              -An issue to relate this operation to.  See the '-i'
                        description above for more details.
       -m              -Allow multiple versions of a file (trunk/branch)
                        to be included in the thread .
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


Report functions:


    razorRemote -c report -f <name> -g <group> [-l <u | d>] [-profile <file>] [-dbgLevel <level>]


    Options:
       -c report       -Run a report.
       -g              -Name of group to which the report belongs.
       -f              -Name of report.
       -l              -Specifies report locale (user or database).
       -profile    Remote Razor DB connection profile filename.  If no filename is specified, the default
                   profile ($HOME/.defaultRmtRzConnProfile.xml) is used
       -dbgLevel   Debug level for console logger.  Level specified as 'DEBUG', 'INFO', 'WARN' or 'ERROR'


SAMPLE USAGE


_____________________________________________________________________________________


% razorRemote -admin info


The license manager is running on GlscLinux.localdomain, pid = 4894


Remote Clients are using Local and Razor Password files


Connections: 


Database '/usr/local/razoradm/razor_db/db1/RAZOR_UNIVERSE',
is active on GlscLinux.localdomain, rz_server pid = 4944
          1 -    brian is running Issues   on machine GlscLinux.localdomain, pid = 5551
          2 -    brian is running Versions on machine GlscLinux.localdomain, pid = 5553
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----


Database '/usr/local/razoradm/razor_db/demo/RAZOR_UNIVERSE',
is active on GlscLinux.localdomain, rz_server pid = 5604
          1 -    brian is running Versions on machine GlscLinux.localdomain, pid = 5613


There are 3 applications connected.


_____________________________________________________________________________________


% razorRemote -admin who


Connections: 


brian    is running Issues   on machine GlscLinux.localdomain.
brian    is running Versions on machine GlscLinux.localdomain.


_____________________________________________________________________________________


% razorRemote -c co -f ByteArrayPool.java -g db1_grp1 -d . -t "Adding RCS tags to header" -i I...-..5 
0 [main] ERROR com.visible.cli.rmt.RazorRemote  - Remote command [/usr/bin/ssh   brian@glsclinux 
source /usr/local/razoradm/razor_db/db1/rz_prep.sh ;  RAZOR_LICENSE_DIR=/usr/local/razoradm/
Razor_lm ; export RAZOR_LICENSE_DIR ; RAZOR_HOME=/usr/local/razoradm/Razor ; export
RAZOR_HOME ; /usr/local/razoradm/Razor/bin/razor -c co -f ByteArrayPool.java -g db1_grp1 -d /usr/
local/rztmp/remote -t "Adding RCS tags to header"  -o  -i I...-..5 ] failed with status of [1] stdout [] stderr
[Overwrite flag [-o] required]
 
% razorRemote -c co -f ByteArrayPool.java -g db1_grp1 -d . -t "Adding RCS tags to header" -i I...-..5 -o


% razorRemote -c ci -f ByteArrayPool.java -g db1_grp1 -d . -t "Adding RCS tags to header" -i I...-..5







Part


XXX


Razor ®
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30 Glossary of Terms


AFTER script


A script which will be run after a file operation occurs. The script is attached via a definition in the
Actions file.


ASCII


An acronym standing for some arcane phrase. Basically, it means simple text, nothing more. 


attributes


Characteristics of an object. For Razor, these characteristics define how an object is presented on the
display and how it is stored in the database. Examples of attributes types are ONE_OF_MANY,
X_OF_MANY, TEXT_FIELD, STATE, CHECK_BOX TIME_STAMP and LABEL. See "Attribute types
defined ."


awk


A very popular and powerful text processing program which comes standard with most UNIX systems. It
allows users to write programs specifically designed to parse ASCII files.


BEFORE script


A script which will be run before a file operation occurs. The script is attached via a definition in the
Actions file.


binary file


A "binary" file is typically considered to be one which contains something other than simple ASCII text.
In the context of Razor, a binary file is treated specially, in that the versions program will use its own
archival scheme instead of SCCS/RCS.


bitmap


The bitmap program is supplied with most X installations, and is a perfectly fine package for generating
the simple bitmap files which can be attached as glyphs to the issues, versions, and threads main
displays.


blessing


Level of promotion.


branch


A branch is a parallel path of modification for a file.


branching


To create a separate, uniquely tracked version of a file already under control. A branch is often created
to make parallel changes to a file. These changes are later merged into the main line and the branch is


183
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terminated.


browser


A software tool that can take a WWW Universal Resource Location (URL) and display a graphical
representation based on that location. A browser also handles user actions such as mouse clicks made
in response to a form. A browser is thus an interface between human users and the WWW.


cgi-bin


CGI stands for Common Gateway Interface and "bin" is short for "binary." A cgi-bin program or script is
capable of generating HTML dynamically and is an alternative to statically-generated HTML files
providing greater flexibility. IssueWeaver is a cgi-bin program.


CHECK_BOX


A widget which can have a value of set (1) or not set (0).


check-in


Return a file to the archive and remove the lock placed on it during a check-out operation.


check-out


The operation of obtaining an editable copy of a file and locking it so that others may not edit the same
version at the same time.


check-out readonly


Obtain a readonly copy of a file and not reserve it for edit.


client / server


A client generates requests and receives responses. A server waits for requests and generates
responses. Your web browser is a client relative to the Razor database manager/server.


clipboard


A temporary holding area employed during the association of issues to various check-in/check-out
efforts in the versions program.


cluster


The number of issue entries presented on one page.


configuration management


A practice used on every successful engineering project. This practice is greatly facilitated by the Razor
toolset, including IssueWeaver.


C M


Configuration Management. It's what Razor is all about.
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diff


A UNIX program used for discovering and displaying the differences between similar ASCII files. Most
systems will have an excellent set of man pages on this. (See also sdiff below.)


drag and drop


This is a common parlor trick employed by some GUI's. It allows you to physically drag icons across the
screen from one place to another instead of typing in commands to make associations or rearrange file
structures. For example, the Razor program allows you to use this technique to associate issues to
editing activity.


environment variable


This is a variable defined within a shell which may be used by various programs to control or alter their
behavior.


factory style


An IssueWeaver style as distributed "out-of-the-box". Factory styles are located in $RAZOR_HOME/
Razor_iw_lib/style_*. They should not be modified since they can be updated during a subsequent
release of Razor.


FAQ


An acronym for "Frequently Asked Questions". FAQ's are common and popular offerings provided by
various Usenet news groups.


filename expansion


A set of meta-characters may be used to define the expansion of filenames. Simple examples such as
'*' matching all characters and '?' matching any single character are commonly used. See UNIX in a
Nutshell from O'Reilly for a full discussion of filename meta-characters.


floating license


A scheme which allows licenses to be used by any user on a network. As users obtain a license, the
total number available to other users is decreased by one. When the user exits the program which uses
the license, the license is returned to the available pool.


form


An HTML document that supports user data input.


glyph


A small graphical image, used in the Razor programs to provide insight to the various files and issues
under control. See bitmap.


grep


A powerful UNIX utility which searches for matching text strings in ASCII files.
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group (UNIX)


All users on a UNIX operating system belong to at least one group, sometimes many.


group (Razor)


A collection of related files, all containing unique names. Sometimes viewed as being similar to a
directory.


group (user)


Either locally defined or a locally chosen entry in the Razor password file.  User group may be used to
grant/limit access to the Razor database based on membership.


guest account


An account used to gain access via Razor remote clients before a password file is created by the Razor
administrator.


gif file


A file containing a graphic in GIF format. HTML supports the GIF format.


glyph


A small graphical image. (Rhymes with 'cliff'.)


GUI


An acronym for "Graphical User Interface." Pronounced so as to rhyme with Huey, Louie, and Dewey.


hard rule


A 'hard rule' is a local convention that is being enforced by the Razor tool set, typically as the result of
the judicious attachment of shell scripts to the various Razor activities. This differs from a 'soft rule',
which is a convention agreed upon by the members of a team, but which has no programmatic
enforcement.


History file


The place in the Razor database where historical information regarding all operations on an object have
occurred. This file can be found in the History directory for the appropriate Razor group.


HTML


HyperText Markup Language. The interpreted document layout language that IssueWeaver uses to talk
to your web browser. It's what makes the web run. You may also want to consider IssueWeaver as a
way of providing Web access to your issues database.


iconic


When a window is minimized to a small picture (icon) on the desktop.
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icons


Graphical representations on the desktop.


Info file


The place in the Razor database where current status of an object is maintained. This file can be found
in the Info directory for the appropriate Razor group.


internet


A network of computers that communicate using the Internet Protocol.


intranet


A network of computers that communicate using Internet Protocol behind one or more firewalls. Contrast
with the Internet. It's the same thing, only different.


issue


A data record managed by a Razor database manager and accessed through the Razor IssueWeaver
tool or the classic issues tool.


Issue form


The object which represents an issue.


issues


A first rate program which may be used for problem reporting, bug tracking, issue definition, job jar, help
desk, customer calls, etc. 


IssueWeaver


Another fine product from Visible Systems. Purchased separately, it provides a turnkey method for
generating web page access in and out of your issues database.


Java


A computer language used to generate platform-independent code for downloading to WWW clients.
IssueWeaver itself does not use Java but you may customize IssueWeaver with your own Java applets.


LABEL


An attribute type used in issues to represent a text only field. This attribute is often used to provide
commentary or act as a visual delimiter on an issue form.


locale


The "visibility" of a report definition. A database locale can be accessed by everyone who has access to
the database, a user locale can only be accessed by you.
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locking a file


(see check-out)


major version number


See 'version number'


meta tag


A tag that can be referred to in a template file that gets replaced by IssueWeaver with its corresponding
value.


minor version number


See 'version number'


Motif


A widget set put together by a consortium of contributors to provide a consistent interface in the X-
windowing environment.


Occam the Icon


Our adapted mascot, sometimes called the silly sailor.


Occam's Razor


The following is quoted from The Academic American Encyclopedia, on-line edition, Grolier Electronic
Publishing, Danbury, CT., 1991, courtesy of Compuserve.


"Occam's razor is a logical principle attributed to William of Occam, although it was used by some
scholastic philosophers prior to him. The principle states that a person should not increase, beyond
what is necessary, the number of entities required to explain anything, or that the person should not
make more assumptions than the minimum needed. This principle is often called the principle of
parsimony. Since the Middle Ages it has played an important role in eliminating fictitious or unnecessary
elements from explanations. In the development of logic, logicians such as Bertrand Russell removed
traditional metaphysical concepts by applying Occam's razor.


ONE_OF_MANY
ONE_OF_MANY_LIST
ONE_OF_MANY_STACK


An attribute type which defines a list of items to which exactly one must be selected. The
ONE_OF_MANY object is displayed as a group of toggle buttons while the ONE_OF_MANY_STACK
are represented as a pull-down menu.


OpenLook


Sun Microsystems' attempt at a standard widget set for the X-windows environment. They ended up
abandoning it.


OS
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An abbreviation for Operating System.


owner of the database


The user who owns the RAZOR_UNIVERSE directory in a Razor database.  This user will also own all
subdirectories under RAZOR_UNIVERSE when a new database is created.  Care must be taken to
insure that modifications made to the configuration of the database be performed by this user.


pattern matching


(see regular expressions )


password file


A file maintained by the Razor administrator and used by the license manager to authenticate users.


Perl


Acronym for "Practical Extraction and Report Language". A powerful and useful scripting language.


port


A UNIX object used to define a TCP/IP socket connection.


problem report


Although everyone has their own ideas on this one, we choose to be generic and refer to them as
issues. What makes the most sense to you will stand as your definition.


promote
promotion


The ability to indicate that a file or issue has attained some level of maturity or importance.


project


A collection of threads. Sometimes referred to as a thread of threads.


QA


Quality Assurance. QA people are charged with the reponsibility of ensuring a product is stable and
meets customer requirements.


Razor


Rather than turn this into a sales pitch, Razor is a tool for developers of all ilks which provides the ability
to track issues, control file versions and define product releases.


Where the name Razor came from.  The engineers involved with the writing of this package had only one
driving force that helped them decide on a name for the product; they were all sick and tired of
acronyms. It seemed that the whole industry had become overrun by them... SCCS, RCS, CMF, CVS,
etc., etc. All of their meanings had become clouded, and it became rough to speak of them in
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conversation without confusion.


'Razor' has no direct intended meaning. Although a variety of cute sayings and sales pitches could be
made relating the name to one theme or another, we have decided to avoid doing that. There's too much
of that in the industry already. The name is just a name.


Long after that issue had been settled, however, the editors at SunExpert magazine found a link between
'Razor' and William of Occam that we found interesting.


razor


A collection of command line interfaces which allows users access to Razor system commands and
also allows them to extend some of the GUI functionality to a command line task.  A powerful, cost-
effective set of tools for problem tracking, release management, and file version control.


Razor Administrator


The last one in line who got stuck with installing and administering Razor. Actually, its not that bad.
Razor is designed to grow in capability and control as your requirements demand.


RAZOR_HOME


An environment parameter which points to the Razor distribution.


RAZOR_LICENSE_DIR


An environment parameter which points to the directory containing the Razor licensing information.


RAZOR_UNIVERSE_DIR


An environment parameter which points to the Razor database.


RAZOR_USER


An environment parameter that contains the name of the current Razor user. This is useful in attached
scripts.


RCS


"Revision Control System" -a freely distributable revision control tool; functionally and conceptually
similar to SCCS. If using RCS with Razor, it must be RCS version 5.7 or higher.


regular expressions


A means of defining simple or complex text patterns using standard characters and special characters.


revert


To make an older version of a file the latest version. Versions are not lost during this operation, rather a
new instance of the reverted version is created as the latest file version.


revision
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A modification, an update.


rz_prep
rz_prep.sh


Two files which setup the users environment. The rz_prep file is intended for C-shell users and should be
sourced from the users .login or .cshrc file. The rz_prep.sh file is intended for Bourne or Korn shell users
and should be dotted (.) in the user's .profile.


SCCS


"Source Code Control System" - a revision control tool.


sdiff


A UNIX utility which provides a side by side analysis of how two files differ. This is the work engine for
the displays that Razor offers. 


sed


A powerful UNIX utility which is a stream-oriented editor allowing users to update and edit files easily.


site style


An IssueWeaver style that can be customized to meet site-specific requirements. Site styles are
located in <server documents directory>/Razor_iw_lib/style_*. Any modifications here will be preserved
with subsequent releases of Razor.


styles


The definition of an IssueWeaver look. Styles are a collection of files and subdirectories that make up
the display background, colors, buttons, etc. Styles are either site-specific or factory (as distributed with
the Razor product).


soft rule


A 'soft rule', is a convention agreed upon by the members of a team, but which has no programmatic
enforcement. This differs from a 'hard rule' which is being enforced by the Razor tool set, typically as the
result of the judicious attachment of shell scripts to the various Razor activities.


state


A level of promotion that an issue, file, thread or project has attained.


superuser


On UNIX systems, this the 'root' account is provided special powers and security levels beyond that of
mortals. Hence the term superuser.


tar


UNIX utility for tape archival.
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tcl/tk


A public domain scripting language which provides the ability to create GUI interfaces to script output.


TCP/IP


A networking protocol.


template files


Text files expanded by IssueWeaver in the generation of the various displays. Template files can include
HTML, Javascript, and meta tags.


TEXT_FIELD


An attribute type which presents itself as a widget in which textual information may be entered.


TEXT_PANE


An attribute type which presents itself as a pane in which textual information may be entered.


threads


A tool in the Razor suite which allows users to define collections of files by name and version.


thread


A single collection of files defined by name and version.


TIME_STAMP


An attribute type used in issues to allow for the input of time based information. The format of the input
is configurable.


trunk


A trunk describes the state of a file that is not branched.


tweak


Tweak refers to the process of interactively refining a style to achieve your desired results. Or its the
sound a canary makes when you grab it by its beak.


umask


The default permissions that files created by a user will take.


universe


Synonymous with a Razor database.


URL
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Uniform Resource Locator. A location on the WWW.


version number


A version number is broken up into a number of parts (up to 4) as follows:
     
release.level[.branch.sequence]


The release number (sometimes referred to as major number) and level (sometimes referred to as minor
number) will always appear. Each time an object is modified, the level will change automatically. The
release number can also changed if the user chooses to have it changed. The branch and sequence
numbers are used only for branch files. The branch number will indicate which in the sequence of
branches from the release it occurred. The sequence number behaves in a similar fashion to the level
number.


versions


A tool in the Razor suite which provides for file version control operations.


Wdefaults


(see Xdefaults) Emulates X resource settings on PCs.


web server


A piece of software running on a network computer that receives requests from web browsers and
responds with HTML.


wildcards


(see filename expansion)


William of Occam


(c. 1285-1350) A philosopher from the middle ages who penned Occam's Razor. (see also Occam's
Razor)


WWW


World Wide Web. A planet-wide network of computers.


X_OF_MANY
X_OF_MANY_LIST


An attribute type which defines a list of items to which any combination of items may be selected.


X Resources


Default definitions for widgets and other X based application resources. These definitions can control
such things as font, color, height, width, etc.
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- 3 -
3 Way Merge     427, 429


- A -
A History file     266


A Latest file    


(issues only)     263


A Latest file (issues only)     266


Access  Controls     197


Access_list     263, 270


action buttons     79


Actions     263, 271


Adding batch commands     112


Adding serial commands     112


Additional Resources     358


Admin NT Server     409


Administering Databases     314, 373


Administration Files     263


Administrative functions     151


Administrator Account Password Changes     356


AFTER script     455


An Activity file (issues only)     266


An Info file     266


architecture     17


ASCII     455


Associating glyphs to file attributes     210


Associating issues to editing activity     108


attaching scripts to attachments     228


Attaching scripts to buttons     228


Attachments     61


Attachments to Issues     58, 61


attribute section     58


Attribute types defined     186


attributes     263, 271, 455


Audit Information     263, 266


Automatic start-up     46


Automatic start-up at boot time     46


awk     455


- B -
background colors     276


Basics: defining the terminology     186


Batch entry of passwords     48


BEFORE script     455


Before You Get Started     352


binary file     455


bitmap     455


Bitmaps     263, 271


blessing     455


branch     455


branched version of a file     124


branching     455


Bringing up issue forms by command line     159


bringing up issue forms via command line     63


Browse function     103


browser     455


Browsing files     103


Browsing Issues from the Versions GUI     63


Browsing Projects from the Versions GUI     140


Browsing Threads from the Versions GUI     123


bug tracking tool     54


build management     120


buttons for the file operations     228


buttons for threads     228


- C -
cgi-bin     455


Change password     295


changing attributes of files     95, 101


changing promotion level     145


Changing promotion level / state by command line    
158


changing state by command line     145


Changing the compression engine     225


CHECK_BOX     455


check-in     455


check-in a file     179


checking files in     79, 145


checking files out     79, 145


Checking files out for edit     108


Associating issues to editing activity     108


Filling in comments     108


Checking on related file activity     63


check-out     455


check-out a file     179


checkout display screen     108


check-out readonly     455


client / server     455


Client Application     417


Clients with Multiple IP Addresses     347, 348
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clipboard     455


cluster     455


CM     455


Command Line  Functionality    


Comparing two versions of a thread     162


Creating a thread     162


Duplicating a thread     162


Generating thread scripts     162


Modifying a project / thread     162


Working with threads     162


Command line functionality     145


Branching a file     155


Checking a file out for edit & checking it back in
again     155


Checking files in     155


Checking files in and out     155


Checking files out     155


Comparing file attributes     155


Creating a folder     155


Getting a read-only copy of a file     155


Incrementing the major version of a file     155


Introducing a new file     155


Obtaining a full text copy of an issue     155


Renaming a file or folder     155


Un-checking a file     155


command line methods     145


Commands     263, 271


common answers     380


common questions     380


common terms     455


Compare Tool     427


Comparing threads     137


Comparing two versions of a thread     171


Configuration Files     263, 269


configuration management     455


Configuring  the Issues Program    


$RAZOR_UNIVERSE_DIRECTORY     203


CONFIGURING AN SSH SERVER     443


Configuring the issues program     203


Configuring the LM_Access_list to Add Users     314,
369


Connecting to a Database     357


Containers    


and folders     183


folders     183


groups     183


Containers: databases    


and folders     183


Controlling the merge view     95


Controlling your view     58, 95, 114


Controls     183, 197


copy-and-paste issues     108


creating a razor database     37


Creating a Thread     171


Creating and editing threads     124


creating databases     37


Creating new issues     58, 61


Creating Razor databases     314, 351


Creating thread scripts     170


Creating/Modifying password information     153


custom commands     95


Custom help files     225


custom utilities     95, 112


Customization & Personalization     183


Customizing attributes     183


Customizing Attributes File     183


Customizing printouts of issues     228


Customizing the Attributes file    


Adding new attributes/values     196


Bringing the server down     196


Changing an existing attribute     196


Restarting the server     196


- D -
Database Creation     371


Database creation - an overview     354


Database Files     263, 266


Database server     44


Databases    


(issues only)     263


groups and attributes     36


Databases (issues only)     263


DB_Compatibility     263


Debugging suggestions     228


defect tracking tool     54


Definable roles    


$RAZOR_UNIVERSE_DIR     197


Defining threads     124


Defining threads by related issues     124


Defining who may promote files/threads     210


Deleting files     160


Deleting folders     160


Deleting issues     160


Deleting threads     160


Demonstration Database     423
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Determining Razor usage     151


diff     455


Diff Tool     427


Diff window rows/columns     275, 276


Difficulties starting the database server (rz_server)    
44


Discovering which version of Razor you have     151


Displaying modification dates     114


Displaying password information     153


Displaying system id     151


Downloading Razor     30


drag and drop     455


drawing your own glyph bitmaps     333


- E -
Edit Thread display     123


Email Back to Support     289


E-mail back to Support     275


E-mail composition script     225


E-mail entry of issues     175


Email Functionality in Windows 2003 Server, 2000 &
XP     373


e-mailing support from Razor     390


environment variable     455


environment variables     376


Extracting threads & generating thread scripts     131


- F -
factory style     455


FAQ     455


Feedback     11


File and thread attributes     210


File and thread STATEs     210


File by file decisions     124


file in a thread     124


filename expansion     455


files within Razor     81


filling in comments     108


filtering the display     114


floating license     455


Fonts for Razor GUI's     275, 276


foreground colors     276


form     455


Formatting text     145, 164


Frequently Asked Questions     455


Function buttons     225


- G -
general administration     28


General foreground and background colors     275


General GUI Fonts     275, 276


General GUI widths and heights     275


Getting help     11, 295


Getting read-only copies     103


gif file     455


Global tracking of issues     178


glossary of terms     455


glyph     333, 455


glyphs supplied with Razor     333


grep     455


group (Razor)     455


group (UNIX)     455


group (user)     455


Group-level Files     263, 271


Actions     263


Attributes     263


Bitmaps     263


Commands     263


Insensitive (issues only)     263


Prefix (issues only)     263


Promoters (versions & threads only)     263


Reports (issues only)     263


Solution_template (issues only)     263


groups     36


guest account     455


GUI     455


GUI heights     276


GUI widths     276


Guiffy     427, 429


Guiffy FAQ     435


Guiffy Frequently Asked Questions     435


Guiffy White Paper     429


gylphs     333


- H -
handling binary files     83


hard rule     455


heights and widths for Razor GUI's     275


help     11


help by e-mail     11


help by fax     11
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Help files    


customizing     225


help pull down menu     295


Hidden menus     17


History file     263, 455


history files     11, 103, 263


host field     295


How a database lays out     254, 256


HTML     455


- I -
iconic     455


icons     455


id    


identifying     151


Importing an existing thread     124


importing threads     124


including files based on issues relationships    


controlling     275


Including the latest version of every file in a thread    
124


Info file     455


Info files     263


Informing the user from attached scripts     228


Initial filter and display options     275


Injecting existing SCCS     39


Injecting existing SCCS/RCS     39


Injecting existing SCCS/RCS investments     83


Insensitive    


(issues only)     263


Insensitive (issues only)     271


Insensitive file    


(issues only)     263


Install     417


Installation     28, 31


PC Client     295


remote client     306


Installation and Administration    


automatic start-up     46


Rearranging things later     51


Installation and General Administration    


custom groups     40


installation of Razor     28


Installing  product upgrades     36


Installing  Razor     31


Installing (license) keys     31


Installing and Using IssueWeaver     394, 402


Installing and Using the Demonstration Database    
394, 423


Installing Issue Weaver     402


Installing IssueWeaver     374, 402


Installing Issueweaver Admin Tool     405


Installing License Keys     314, 370


Installing Razor on Windows     353


Installing the software     31, 295, 299, 306


integration with Windows IDEs     295, 299, 337


internet     455


intranet     455


introduce button     79


introducing buttons     83


introducing new files     79


isssues    


file control     108


issue     455


Issue form     455


modifying width of     275


modifying word-wraping     275


populate offset     275


issue form values  as     228


Issue States    


promoting by command line     158


issues     17, 54, 455


Adding Attachments     61


Additional information on the main display     66


assigning to multiple people     380


associating     108


Associating glyphs to attributes     203


associating threads     63


Attachment History     61


Controlling form layout     203


Controlling your view     66


Exporting Attachments     61


Filtering the collection     66


FormWorkArea     275


General suggestions     203


header/footer     55


main display     55


main list     55


menu bar     55


Pre-loading information into the text panes     203


Removing Attachments     61


Rules and restrictions     60


Saving and recalling sort/filter combinations     66


Searching for matching text strings     66


Sorting the collection     66
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issues     17, 54, 455


Subscribing to databases & issues groups     73


Text panes     60


Viewing Attachments     61


Issues form values as environment variables     228


Issues Miscellanea     275, 282


IssueWeaver     455


E-mail entry of issues     175


Global tracking of issues     175


Remote access by e-mail     175


Issueweaver Admin Tool     394, 405


- J -
Java     455


- L -
LABEL     455


labels     275


latest version of thread     124


License keys     31


License Manager    


Modes     42


License requirements     299


License.conf     263


License_status     263


Licenses     263


LM_Access_list     263


Local Host     295


Local Razor Clients     347, 349


locale     455


locking a file     455


Logging in     295


Logging off     295


looking at files     95, 103
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Main Issues Display     55


major version number     455


Making additional custom groups     40


Making additional file control groups     39


Making additional issues groups     40


Managing Razor Passwords     359


Managing Razor Passwords and Users     314


Managing Razor Users     359


Mapping Files Into Razor     299


Merge Tool     427


merging with sdiff     95


meta tag     455


Microsoft Source Code Control API     337


minor version number     455


Mixed Environments    


OpenLook vs. Motif (Sun only)     49


PC Clients     49


Remote UNIX Clients     49


Web Clients     49


X terminals     49


Modifying Issue Attributes     145, 159


modifying issues     58


Modifying/reviewing the license information     151


Motif     455


moving files to new folders     83


Multiple NIC's and IP Addresses     347
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networked application     17


new files     83


New password     295


NT Server     409


NT/2000  Server Installation     394, 409


NT/2000/XP Server     351


Additional Resources     351


Administrator Account Password Changes     351


Connecting to a Database     351


Database creation - an overview     351


Installing Razor on Windows     351


Razor Administration via Razor Admin     351


Razor administration via scripts     351


Registering License Keys     351


System requirements     351


Troubleshooting the License Manager     351


Upgrading     351
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Obtaining license keys     31


Occam the Icon     275, 290, 455


Occam's Razor     455


ONE_OF_MANY     455


ONE_OF_MANY_LIST     455


ONE_OF_MANY_STACK     455
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OpenLook     455


Operating System     455


Options     263, 270


OS     455


Overview     17


Overview of Razor    
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Hidden menus     24


Keyboard accelerators     24


Product basics     24


Scrolling list behavior     24


Scrolling lists     24


Using mouse buttons     24


owner of the database     455
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password file     455


Password file entries     48


Password functions     145, 153


pattern matching     455


PC Client     295


PC Client Applications     295


Perl     455


Permissions    


(issues only)     263


Permissions (issues only)     271


Personal files     273


port     455


Prefix    


(issues only)     263


Prefix (issues only)     271


Pre-loading an issues form     228


primary display     79


Printing     58


Running commands     73


Printing customization     225


problem report     455


problem tracking     54


Problem_template     263, 271


product trilogy     17


product upgrades     36


project     455


Project Editing     171


promote     455


Promoters    
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Promoters (versions & threads only)     271


Promoting files and threads     158


Promoting issue states     158


promoting selected files     95
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Promoting specific versions file-by-file     101


promotion     455
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QA     455


Quality Assurance     455
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Razor  PC    


file control     295


Razor Admin Tool     409


Razor Admin Tool for NT Server     394, 409


Razor Administration     314


Razor Administration via Razor Admin     314


Razor Administration Via Scripts     351, 370


Razor Administrator     455
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Razor API     340


Razor architecture     17


Razor database     455


Razor databases     275


Razor Directory Layouts     28, 254


Razor File Formats    
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Razor IDE menu items     295
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Razor Installation for Client Application     394


Razor Installation for Client Applications     394, 417
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Razor Online FAQ     358


Razor Overview     17
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Razor PC Applications    


Installing the Software     295


License Requirements     295


Logging In     295


Logging Off     295


System Requirements     295


Upgrading the Software     295


Razor Remote CLI     447


Razor sample installation     31


Razor Technical Support     358


RAZOR_HOME     455


RAZOR_LICENSE_DIR     455


RAZOR_UNIVERSE_DIR     455


RAZOR_USER     455


RazorSCC     337
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RazorSCC Information     299


RCS     455


RCS special keywords     101


Recording your modifications     63


Registering License Keys     355


regular expressions     292, 455


release management     120


Remote access via e-mail     179


Remote Client     308


installing the software     306


Remote client distribution     306


Remote client password     48


Remote Command Line     167


REMOTE COMMAND SAMPLE USAGE     172


Remote guest account     48


Remote Razor Clients     347, 348


Remote UNIX     306


Remote UNIX Client Applications    


Installing the software     306


Logging in     306


Starting the remote client     306


System requirements     306


Temporarily disconnecting     306
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rename     83


renaming files     83


renaming files under version control     83


Report Functions     172


Report Generation     183


Defining report filters     213


Defining report formats     213
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More about filter options     213


Running reports     213
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Reports (issues only)     263, 271


revert     455


reverting files     95, 110


Reviewing history     103


revision     455


Revision Control System     455


Roles     263, 270


rules and restrictions     58


Running batch reports     145, 164


Running commands     112


Running Razor SCC     337


Running RazorSCC     295, 299


running reports     95, 136


Running rz_install     31, 36


rz_add_users [ <file> [ <user group> ] ]     48


rz_mail_issue_catcher     175


rz_passwd     263


rz_prep     455


rz_prep.sh     455
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rz_startup     263
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SCC API     337


SCCS     455


SCCS special keywords     101
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